Voyager® 7.0
Cataloging User’s Guide

June 2008
# Contents

## About This Document
- Purpose xxxvii
- Intended Audience xxxvii
- Reason for Reissue xxxvii
- Document Summary xxxviii
- Conventions Used in This Document xxxix
- Document Reproduction/Photocopying xl
- Comment on This Document xli
  - To Submit Comments by E-mail xli

## 1 Getting Started
- Introduction 1-1
- Purpose of this Chapter 1-1
- Prerequisite Skills and Knowledge 1-1
- Before You Begin 1-2
  - Documentation and Online Help 1-2
  - Conventions 1-2
  - Commands 1-2
  - Ellipsis Button 1-2
  - Keyboard Functions 1-3
  - Logging into Cataloging 1-4
  - Exiting Cataloging 1-5

## 2 Record Types and Creating
- Introduction 2-1
- Types of Records 2-1
  - Record Relationships 2-2
  - Fields 2-3
- Bibliographic Records 2-3
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MARC Tab</td>
<td>2-4</td>
</tr>
<tr>
<td>Bibliographic Leader</td>
<td>2-4</td>
</tr>
<tr>
<td>Bibliographic 005 Fixed Field</td>
<td>2-6</td>
</tr>
<tr>
<td>Bibliographic 006 Fixed Field</td>
<td>2-6</td>
</tr>
<tr>
<td>Bibliographic 007 Fixed Field</td>
<td>2-9</td>
</tr>
<tr>
<td>Bibliographic 008 Fixed Field</td>
<td>2-12</td>
</tr>
<tr>
<td>Variable Fields (MARC Tab)</td>
<td>2-14</td>
</tr>
<tr>
<td>880 Fields and Unicode Implementation</td>
<td>2-14</td>
</tr>
<tr>
<td>Adding and Editing Variable Fields (MARC Tab)</td>
<td>2-15</td>
</tr>
<tr>
<td>Deleting Variable Fields (MARC Tab)</td>
<td>2-18</td>
</tr>
<tr>
<td>Entire Row</td>
<td>2-18</td>
</tr>
<tr>
<td>Individual Characters</td>
<td>2-19</td>
</tr>
<tr>
<td>Variable Fields (MARC Tab) Affecting the WebVoyage OPAC Display</td>
<td>2-20</td>
</tr>
<tr>
<td>Links - Overview</td>
<td>2-20</td>
</tr>
<tr>
<td>Links - URL Examples</td>
<td>2-21</td>
</tr>
<tr>
<td>Links - Link Text Examples</td>
<td>2-22</td>
</tr>
<tr>
<td>Links - Files on a Server Examples</td>
<td>2-22</td>
</tr>
<tr>
<td>Links - Image Server Link Examples</td>
<td>2-22</td>
</tr>
<tr>
<td>Links - DOI and URN Link Examples</td>
<td>2-23</td>
</tr>
<tr>
<td>Links - Verify Hypertext Links for Bibliographic Records</td>
<td>2-23</td>
</tr>
<tr>
<td>Links - Table of Contents</td>
<td>2-25</td>
</tr>
<tr>
<td>Links - Thumbnail Images</td>
<td>2-25</td>
</tr>
<tr>
<td>System Tab</td>
<td>2-25</td>
</tr>
<tr>
<td>OK to Export Option</td>
<td>2-26</td>
</tr>
<tr>
<td>Suppress from OPAC Option</td>
<td>2-27</td>
</tr>
<tr>
<td>History Tab</td>
<td>2-27</td>
</tr>
<tr>
<td>Sorting the columns</td>
<td>2-28</td>
</tr>
<tr>
<td>Lag Time</td>
<td>2-29</td>
</tr>
<tr>
<td>Viewing and Editing Line Items from Bibliographic Records</td>
<td>2-29</td>
</tr>
<tr>
<td>• Authority Records</td>
<td>2-29</td>
</tr>
<tr>
<td>MARC Tab</td>
<td>2-30</td>
</tr>
<tr>
<td>Authority Leader</td>
<td>2-30</td>
</tr>
<tr>
<td>Authority 008 Fixed Field</td>
<td>2-32</td>
</tr>
<tr>
<td>Variable Fields (Authority Record)</td>
<td>2-34</td>
</tr>
<tr>
<td>Verify Hypertext Links - Authority Records</td>
<td>2-35</td>
</tr>
<tr>
<td>System Tab</td>
<td>2-36</td>
</tr>
<tr>
<td>OK to Export Option</td>
<td>2-37</td>
</tr>
</tbody>
</table>
## Contents

- History Tab 2-38
  - Sorting the columns 2-39
  - Lag Time 2-39
- Holdings Records 2-39
- MARC Tab 2-40
  - Holdings Leader 2-40
  - Holdings 007 Fixed Field 2-42
  - Holdings 008 Fixed Field 2-45
  - Variable Fields (MARC Tab) 2-47
  - Get Call Number from Bib Record 2-48
    - Workflow Examples 2-48
    - Setting Up to Use Get Call Number from Bib Record 2-49
    - Using Get Call Number from Bib Record 2-51
    - Verify Hypertext Links - Holdings Records 2-54
- System Tab 2-55
  - OK to Export Option 2-56
  - Suppress from OPAC Option 2-57
- Bib Title(s) Tab 2-58
  - History Tab 2-58
    - Sorting the columns 2-59
    - Lag Time 2-59
  - Viewing and Editing Line Items from Holdings Records 2-59
- Item Records 2-60
  - Checking for Duplicate Barcodes - Item Records 2-61
  - Header Information 2-62
  - Location and Type 2-62
  - Item/Holdings 2-62
  - Item Details 2-64
  - Statuses 2-64
  - Statistical Categories 2-69

## 3 Creating, Opening, and Viewing Records

- Creating and Opening Records 3-1
  - Creating a Record 3-1
  - Opening a Record 3-8
    - From a Work Folder 3-8
Contents

From the OPAC 3-9
Bibliographic Tree 3-9
Importing Records 3-10
Importing Records From a File 3-11
Importing Records From Another Database 3-14
Available Locations 3-15
Selected Locations 3-16
Information About 3-16
Selecting a Database 3-16
Removing a Database 3-17
Exiting the Voyager Connection Options Dialog Box 3-17
Invalid Records 3-22
Accessing Replaced or Deleted Files 3-22
Creating New Bibliographic Records from Image Server 3-23
• Viewing Information 3-25
• Search Dialog Box 3-26
  Keyword Tab and Keyword Searching 3-27
  Command Line Searching 3-30
  Other Keyword Search Considerations/Options 3-31
Index Selection Tab 3-32
  Find and Browse Searches 3-36
  Heading Searches by Call Number 3-37
  Headings Keyword Searches 3-37
Builder Tab and Builder Searching 3-39
History Tab 3-42
• Titles Index Dialog Box 3-43
  Search Results List Re-Sort Options 3-46
  Re-Sort Configuration Options 3-47
    ServerSortList 3-48
    ASCIISortList 3-48
    ASCIIExpandColumn 3-49
  Considerations for Re-sorting Search Results 3-49
• Holdings Index Dialog Box 3-50
• Headings List Dialog Box 3-52
  Reference Information Dialog Box 3-56
    Scope Notes 3-57
    Narrower Term 3-58
    See Also 3-58
Contents

Select one or more authority records Dialog Box 3-59
  • Perform a Keyword Search 3-60
  • Perform an Index Selection Search 3-63
  • Perform a Builder Search 3-65
  • Access/Review the History Tab 3-68
  • Remote Searching 3-69
    Remote Databases 3-69
    Voyager Connection Options Dialog Box 3-70
    Searching Remote Databases 3-71
  • User-Defined Alternate Search Button 3-77
  • Setting Search Preferences 3-78
    Retain Last Search 3-78
    Automatic Truncation for Index Selection Searches 3-79
    Display Bibliographic Record Directly If Search Results In Only One Title 3-79
  • Search Limits 3-79
    Search Limits Dialog Box 3-80
    Limits.ini File 3-81
    Limits Stanza 3-82
    Search Limits Stanzas 3-83
      Rules for Search Limit Stanzas 3-84
      [Language] Stanza 3-84
      [Date] Stanza 3-85
      [Medium] Stanza 3-86
      [Type] Stanza 3-87
      [Place] Stanza 3-87
      [Status] Stanza 3-88
    Limiting a Search 3-89
  • MFHD-Bibliographic Combined Keyword Search (optional feature) 3-92
    Setup 3-94
    Search Options 3-95
    Search Results Display 3-95
    User Considerations 3-95
  • Searching in Cataloging Examples 3-96
    Keyword Search in the Cataloging Module 3-96
    Index Selection Search in the Cataloging Module 3-103
    Builder Search in the Cataloging Module 3-107
  • Additional Options for Displaying a Record - Web Server http POST 3-110
Contents

• Viewing and Editing Line Items (Acquisitions in Cataloging) 3-111
  System Administration Setup 3-112
  A Single Line Item 3-115
  Multiple Line Items 3-115
  No Line Items 3-116
• Retrieving Records Associated with Other Records 3-117
  Retrieve Holdings 3-117
  Retrieve Authority 3-119
  Retrieve Items 3-119
  Retrieve Bibliographic Record (Shortcut) 3-121
• Viewing Holdings Locations 3-122
• Linking and Unlinking Records 3-123
  Link Item to Bib 3-123
  Relink an Item to a Different Holdings 3-124
  Unlinking Holdings and Bib Records 3-125
  Copying an Item Record from an Existing Item Record 3-126

4 Changing, Saving, and Printing Information

• Changing Information 4-1
  Editing a Record 4-1
  Bibliographic Records 4-2
  Deleting a Record 4-2
  Adding a URL to an 856 Field 4-3
  Change Owning Library 4-4
• Changing Records with Bibliographic Overlay/Merge in Cataloging 4-5
  Record History - Overlay/Merge 4-9
• Saving and Printing Information 4-9
  Saving a Record 4-9
  Save 4-10
  Update Record Alert 4-10
  Save As... 4-11
  Save to Database 4-11
  Save and Security 4-12
  Save and ISBN/ISSN Validation 4-12
  Save and Duplicate Records 4-13
## Contents

- Save and Confirmation Message 4-14
- Save Considerations 4-14
- Save and Bibliographic Dedupe Detection 4-14
- Saving to the Database and to a File Simultaneously 4-16
- Validating a Bibliographic Heading 4-17
  - Subject Headings 4-18
  - Non-Subject Headings 4-18
- Make a Copy of a Record 4-19
- Printing a Record 4-19
- Printing Labels 4-20
  - Bibliographic Records 4-22
  - Holdings Records 4-22
  - Item Records 4-22
- Spine and Piece Label Print Template 4-23
  - Templates Stanza 4-23
  - [Print Options XXX] Stanza 4-23
- Print Template Spine/Print Template Piece Stanza 4-24
- Action Codes 4-25
  - Initiating and Ending Action Codes 4-26
- Printing Field Information 4-26
- Printing in the Alternate Font 4-26
- Changing Font Size 4-27
- Inserting a Blank Line 4-27
- Inserting a Tab 4-28
- Spine Label Field Codes 4-28
- Sample Template File 4-30
- Closing a Record 4-36

### 5 Cataloging & Bibliographic Record Linking

- Introduction 5-1
  - Displaying Related Records 5-1
  - Templates 5-5
- MARC Record Derivation Using Cataloging Templates 5-8
  - Multiple Subfields 5-12
  - Non-Matching Subfields 5-12
  - Rules and Examples for Derivation Fields 5-12
Contents

Template Example 5-16

• Session Defaults and Preferences 5-18
  Folders/Files Tab 5-18

6 Diacritics and Non-Roman Characters

• Introduction 6-1
• Special Character Entry 6-1
• Special Character Mode 6-3
  Special Character Mode Mapping 6-3
• Special Characters.cfg 6-7
  File Contents 6-7
  First Field 6-7
  Second Field 6-8
  Third Field 6-8
• Microsoft Character Map 6-8
• Regional Options for Non-Roman Characters 6-8
• Importing Records with Non-Roman Characters 6-9
• Other Diacritic Considerations 6-9

7 Pick and Scan

• Introduction 7-1
• Using Pick and Scan 7-2

8 Templates

• Introduction 8-1
• Creating, Editing, and Deleting Templates 8-2
  Special Considerations - Authority Templates 8-3
  System Generated Fields 8-3
  Custom Templates 8-3
  Default Preferences Setting 8-4
• Templated Input 8-5
## Contents

### 9 Authority Control
- Introduction 9-1
- Columns on the Authority Validation Dialog Box 9-2
- Buttons on the Authority Validation Dialog Box 9-4
- Global Headings Change and Preview Queue 9-6
  - Sample Global Headings Change Work Flow 9-9
    - Global Change Process 9-10
    - Original Heading 9-12
    - Proposed New Heading 9-12
    - Affected Authority Headings 9-13
    - Splitting a Heading 9-14
    - Heading Merge 9-14
    - Name/Title Heading Change 9-14
      - Behavior of the Dialog Box 9-14
    - Buttons 9-15
  - Global Headings Batch Job 9-16

### 10 Session Defaults and Menu Options
- Session Defaults and Preferences 10-1
  - General Tab 10-2
  - Validation Tab 10-4
  - Work Flow Tab 10-9
  - Item Defaults Tab 10-11
  - Folders/Files Tab 10-13
  - Mapping Tab 10-15
  - Colors/Fonts Tab 10-16
- Cataloging Menus 10-19
  - Main Workspace Menu Options 10-19
    - File Menu - Main Workspace 10-20
    - Record Menu - Main Workspace 10-20
    - Display Menu - Main Workspace 10-21
    - Options Menu - Main Workspace 10-21
    - Help Menu 10-21
  - Menu Options After Working with Active Records 10-22
    - File Menu - Working with Active Records 10-22
    - Edit Menu - Working with Active Records 10-23
# Contents

Record Menu - Working with Active Records 10-24
Related Records Menu - Working with Active Records (Bibliographic Records Only) 10-26
Item Menu - Working with Active Records (Item Records Only) 10-27
Display Menu - Working with Active Records 10-27
Options Menu - Working with Active Records 10-28
Window Menu - Working with Active Records 10-28
Help Menu - Working with Active Records 10-29

## A MARC Tag Tables

- Introduction A-1
  - Tag Tables and MARC Validation A-4
  - Structure of MARC Tag Tables Overview A-5
  - Stanzas in the MARC Tag Tables A-6
    - Stanza Names A-6
    - Stanzas That Reference Other Stanzas A-6
    - Stanza Components A-7
    - MARC tag field/ indicator field A-8
    - MARC subfield A-8
    - Software order number A-8
    - Subfield rule definition A-8
    - Subfield rule definition A-8
    - Subfield and subfield definition A-8
    - Indicator value A-9
    - Indicator and indicator definition A-9
- Xmarcfix.cfg Tag Tables A-9
  - Sample Xmarcfix.cfg Tag Table A-10
  - Grid Templates A-10
  - Defining Your Own Keyboard Shortcuts A-12
  - Stanzas in the Xmarcfix.cfg Tag Tables A-13
    - Code Type/Tab Stanzas [00xCode] A-14
      - Types of Code Type/Tab Stanzas A-14
      - Names of Tabs in the Cataloging Module A-15
      - Order of Tabs in the Cataloging Module A-17
      - Grid Templates in the Cataloging Module A-18
      - Template Stanzas [00x_???] A-18
    - Column 1 A-20
### Table of Contents

**Contents**

<table>
<thead>
<tr>
<th>Column 2</th>
<th>A-20</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column 3</td>
<td>A-20</td>
</tr>
<tr>
<td>Column 4</td>
<td>A-20</td>
</tr>
<tr>
<td>Column 5</td>
<td>A-20</td>
</tr>
<tr>
<td>Shortcut for Entering Numerical Data</td>
<td>A-23</td>
</tr>
</tbody>
</table>

**B Voyager Call Number Logic / Processing**

- Call Number Indexing  B-1
- Call Number Sorting and Searching  B-3
  - Call Number Input/Normalization Process  B-3
  - (Records Saved)  B-3
  - Call Number Searching and Display Results  B-4

**C Voyager with Unicode Considerations**

- Voyager with Unicode Overview  C-1
- Function Enhanced in Cataloging for Font Options and Input of Non-Roman Text  C-1
- Characteristics of a Unicode-Formatted Record in Voyager  C-2
- Diacritics and MARC21 Compliance Considerations  C-3
  - MARC21 Compliance Considerations  C-3
  - Considerations for Records Imported or Converted to Unicode  C-4
    - Database Conversion  C-4
    - Non-Converted Records (nc)  C-4
    - Message Logs  C-5
    - BulkImport  C-8
- Subfield Character  C-9
- Cataloging Templates  C-9
- Analyzing Inconsistencies  C-9
  - Hexadecimal Value  C-10
- Resources  C-10
Contents

D Templated Input D-1

- What is Templated Input? D-1
- Templated Input Requirements D-1
- Creating Templated Input User IDs D-1
- Login for Templated Input D-2
- Creating Records with Templated Input D-3
- Retrieving/Editing Records with Templated Input D-4
- Template Configuration Files D-5

  Template.ini File D-5
  [New Template] Stanza D-7
  [EditTemplates] Stanza D-7
  [NonFiling] Stanza D-8

  Template Configuration (.cfg) Files D-8
  [General] Stanza D-13
  [BibInitialization] Stanza D-14
  Leader field D-14
  006 and 007 Fields D-15
  008 Field D-15
  Variable Fields D-16

- Overview of Templates Produced by Template Configuration Files D-16

  Combination Boxes and Text Boxes D-20

  Combination Boxes D-21

  Combination Boxes Using Other Configuration Files D-21
  Source= element D-21
  Display= Element D-22

  Combination Box Values Set in Template Configuration Files D-25

  Text Boxes D-27

  [BibMarcMapping] Stanza D-28
  [BibMarcMapping] stanza elements D-30
  Leader Elements D-31
  006 and 007 Fields D-32
  008 Field D-32
  Other Variable Fields D-32

Example of Converting Operator Entered Information to MARC Records D-36
  Sample Text Box D-37
# Table of Contents

## Contents

<table>
<thead>
<tr>
<th>Sample Combination Box</th>
<th>D-39</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Multiple Control Properties in a Single Stanza</td>
<td>D-42</td>
</tr>
<tr>
<td>[BibMarcMapping] Stanza Using Text Boxes</td>
<td>D-44</td>
</tr>
</tbody>
</table>

## Index

<table>
<thead>
<tr>
<th>IN</th>
<th>Index</th>
<th>IN-1</th>
</tr>
</thead>
</table>
# Figures

## 1 Getting Started

1-1. Ellipsis Button 1-3
1-2. The Voyager Cataloging login dialog box 1-4
1-3. Select a cataloging location dialog box 1-5

## 2 Record Types and Creating

2-1. Voyager record relationships 2-2
2-2. Bibliographic Record - MARC Tab 2-4
2-4. Leader dialog box 2-5
2-5. 006 Button 2-7
2-6. 006 dialog box 2-7
2-7. Bibliographic 006: Grid displayed and values set 2-8
2-8. 007 Button 2-9
2-9. 007 - Physical Description dialog box 2-10
2-10. 007 - Physical description dialog box with grid displayed 2-11
2-11. 008 Button 2-12
2-12. 008 - General Description dialog box 2-13
2-13. Variable fields grid with 245 tag row 2-14
2-14. Selection Column 2-15
2-15. Editing options 2-16
2-16. Bibliographic template selection 2-17
2-17. Hypertext links dialog box 2-23
2-18. Missing Hypertext links message 2-24
2-19. Bibliographic Record - System Tab 2-26
2-20. Bibliographic Record History Tab 2-28
2-21. Authority record - MARC tab 2-30
2-22. Leader Button 2-31
2-23. Leader dialog box for authority information 2-31
2-24. 008 Button 2-32
2-25. 008 - General Description (Authority) dialog box 2-33
2-26. Hypertext links dialog box 2-35
2-27. Missing Hypertext links message 2-35
2-28. Authority Record : System Tab 2-37
3 Creating, Opening, and Viewing Records

3-1. New Record Button 3-2
3-2. Selecting a template for a new record 3-3
Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3-3.</td>
<td>New bibliographic record template example</td>
</tr>
<tr>
<td>3-4.</td>
<td>Error message for selecting an inappropriate template</td>
</tr>
<tr>
<td>3-5.</td>
<td>Error message for selecting an inappropriate template</td>
</tr>
<tr>
<td>3-6.</td>
<td>Create Holdings Button</td>
</tr>
<tr>
<td>3-7.</td>
<td>Dialog box for creating a Holdings record from an open Bibliographic record when one already exists</td>
</tr>
<tr>
<td>3-8.</td>
<td>Create Item Button</td>
</tr>
<tr>
<td>3-9.</td>
<td>Open Record from Work Folder Button</td>
</tr>
<tr>
<td>3-10.</td>
<td>Hierarchy Button</td>
</tr>
<tr>
<td>3-11.</td>
<td>Holdings and Items for Bibliographic Records</td>
</tr>
<tr>
<td>3-12.</td>
<td>Select Import File dialog box</td>
</tr>
<tr>
<td>3-13.</td>
<td>Selecting a record to import</td>
</tr>
<tr>
<td>3-14.</td>
<td>Voyager Connection Options dialog box</td>
</tr>
<tr>
<td>3-15.</td>
<td>Selecting databases to search</td>
</tr>
<tr>
<td>3-16.</td>
<td>Remote Search dialog box</td>
</tr>
<tr>
<td>3-17.</td>
<td>Search Status dialog box</td>
</tr>
<tr>
<td>3-18.</td>
<td>Titles Index dialog box</td>
</tr>
<tr>
<td>3-19.</td>
<td>Record imported from another database</td>
</tr>
<tr>
<td>3-20.</td>
<td>File Documents dialog box in ImageServer</td>
</tr>
<tr>
<td>3-21.</td>
<td>New Bibliographic Record in Cataloging</td>
</tr>
<tr>
<td>3-22.</td>
<td>Search dialog box</td>
</tr>
<tr>
<td>3-23.</td>
<td>Keyword tab of the Search dialog box</td>
</tr>
<tr>
<td>3-24.</td>
<td>Index Selection tab of the Search dialog box</td>
</tr>
<tr>
<td>3-25.</td>
<td>Search results after doing a find subject heading search for war?</td>
</tr>
<tr>
<td>3-26.</td>
<td>Search results after doing a browse subject heading search for war?</td>
</tr>
<tr>
<td>3-27.</td>
<td>Headings List for Headings Keyword Search</td>
</tr>
<tr>
<td>3-28.</td>
<td>Builder tab of the Search dialog box</td>
</tr>
<tr>
<td>3-29.</td>
<td>History tab of the Search dialog box</td>
</tr>
<tr>
<td>3-30.</td>
<td>Titles Index dialog box</td>
</tr>
<tr>
<td>3-31.</td>
<td>Titles Index Button</td>
</tr>
<tr>
<td>3-32.</td>
<td>Stop button seen with more than 100 search results</td>
</tr>
<tr>
<td>3-33.</td>
<td>Search results sort options</td>
</tr>
<tr>
<td>3-34.</td>
<td>Holdings Index dialog box</td>
</tr>
<tr>
<td>3-35.</td>
<td>Stop button seen with more than 100 search results</td>
</tr>
<tr>
<td>3-36.</td>
<td>Headings List dialog box</td>
</tr>
<tr>
<td>3-37.</td>
<td>Optional dashes for headings with subdivisions</td>
</tr>
</tbody>
</table>
Figures

3-38. Headings List Button 3-54
3-39. Stop button seen with more than 100 search results 3-54
3-40. Reference Information dialog box 3-56
3-41. Scope Notes for a heading 3-57
3-42. Narrower term for a heading 3-58
3-43. Search results from the narrower term 3-58
3-44. See Also for a heading 3-59
3-45. See Also search results 3-59
3-46. Select one or more authority records dialog box 3-60
3-47. Completed Keyword tab 3-61
3-48. Titles Index dialog box after performing a free text keyword search 3-62
3-49. Holdings Index dialog box 3-62
3-50. Type of search 3-63
3-51. Completed Index Selection tab 3-64
3-52. Builder search tab 3-66
3-53. Builder tab with multiple search terms and relationships 3-67
3-54. Remote... button on Search dialog box 3-69
3-55. Voyager Connection Options dialog box 3-70
3-56. Selected locations in the Voyager Connection Options dialog box 3-72
3-57. Remote Search dialog box, Search by options 3-73
3-58. Simultaneous Search dialog box 3-74
3-59. Search Status dialog box 3-75
3-60. Titles Index following a simultaneous search 3-76
3-61. Search dialog box with user-defined alternate search button 3-78
3-62. Bibliographic record 3-80
3-63. Search Limits dialog box 3-80
3-64. Sample limits.ini file 3-82
3-65. [Limits] stanza and the list of limits in the Search Limits dialog box 3-83
3-66. Language stanza example 3-84
3-67. Language limits 3-85
3-68. Date stanza example 3-85
3-69. Date limits 3-85
3-70. Medium stanza example 3-86
3-71. Medium limits 3-86
3-72. Type stanza example 3-87
Figures

3-73. Type limits
3-74. Place stanza example
3-75. Place limits
3-76. Status stanza example
3-77. Status limits
3-78. Search Limits dialog box
3-79. Expanded list of limits
3-80. Computer File selected as search limit
3-81. Selected search limits listed in the bottom portion of the dialog box
3-82. MFHD-Bibliographic Combined Keyword Search - command line example
3-83. Results of MFHD-Bibliographic Combined Keyword Search
3-84. SPAC holdings keyword definition
3-85. Boolean search for a MARC record
3-86. Titles Index dialog box listing the results of the Boolean search
3-87. Selected bibliographic record displays
3-88. Free text search for a bibliographic record
3-89. Titles Index dialog box listing the results of the Free Text search
3-90. Bibliographic record after conducting a Free Text search
3-91. Holdings Boolean search for items belonging to the Murray collection
3-92. Holdings Index listing the results of the Holdings Boolean search
3-93. MARC tab of the selected holdings record displays
3-94. Headings search
3-95. Headings List dialog box
3-96. Reference Information dialog box
3-97. Multiple authority records found
3-98. Authority record
3-99. Left anchored, limited search
3-100. Titles Index dialog box
3-101. MARC tab of the bibliographic record
3-102. Builder search
3-103. Titles Index dialog box
3-104. MARC tab of the bibliographic record
3-105. Send Record To WebVoyage
**Figures**

3-106. Establishing at least view-only access to line items in Acquisitions 3-113
3-107. Error message if not logged into both modules 3-114
3-108. Error message if logged into modules with different User IDs and Passwords 3-114
3-109. Line item that displays in the Acquisitions module 3-115
3-110. Dialog box for multiple line item matches in Acquisitions 3-116
3-111. Message associated line items do not exist 3-116
3-112. Retrieve Holdings Button 3-118
3-113. Retrieve Holdings dialog box 3-118
3-114. Select one or more authority records dialog box 3-119
3-115. Retrieve Items Button 3-120
3-116. Retrieve Items dialog box 3-120
3-117. Retrieve Bibliographic Record (Ctrl+J) 3-122
3-118. Show holdings Valid MARC Values dialog box 3-122
3-119. Link the item to a bibliographic record dialog box 3-123
3-120. Relink the item to a holding record dialog box 3-124

4 Changing, Saving, and Printing Information

4-1. System Administration merge profile example 4-6
4-2. Overlay Bibliographic Records options 4-7
4-3. Retrieve a Record dialog box 4-7
4-4. Overlaying and Merging Bibliographic Records dialog box 4-8
4-5. Merge Profile dropdown list options 4-8
4-6. Save Button 4-10
4-7. Update record alert dialog box 4-11
4-8. Save to Database button 4-12
4-9. Record menu dynamic ISBN/ISSN validation options 4-13
4-10. Bibliographic Dedupe Detection dialog box 4-15
4-11. Print Labels dialog box 4-21
4-12. Description of options in the [Print Options Bibliographic] stanza 4-24
4-13. Sample [Print Template Spine XXX] stanza 4-24
4-14. Sample [Print Template Piece XXX] stanza 4-25
4-15. Sample label print template file 4-30
Figures

5  Cataloging & Bibliographic Record Linking
5-1. Related Records listing applicable profiles for “Cinema Journal” 5-3
5-2. Preceding title for “Cinema Journal” and applicable profiles 5-4
5-3. No related records message 5-4
5-4. Create a New Record dialog box 5-6
5-5. Open Template File dialog box 5-7
5-6. Verify delete template message 5-8
5-7. Examples of derivation fields 5-9
5-8. Menu bar in the Cataloging module 5-19
5-9. Session Defaults and Preferences dialog box 5-20
5-10. Folders/Files tab for Session Defaults and Preferences 5-20
5-11. Select Bibliographic Template dialog box - no default Template folder 5-21
5-12. Template files in the Template folder 5-22
5-13. Bib template selected on Folders/Files tab 5-22
5-14. Menu bar in the Cataloging module 5-23
5-15. Select Directory dialog box 5-24
5-16. Default Template folder selected on Folders/Files tab 5-25

6  Diacritics and Non-Roman Characters
6-1. Special Character Entry 6-2

7  Pick and Scan
7-1. Pick and Scan dialog box 7-2
7-2. Permanent Location options 7-3
7-3. Temporary Type options 7-4
7-4. Delete warning message 7-4
7-5. Item Status/Clear All single step 7-5
7-6. Suppressed option 7-6
7-7. Voyager System Administration Profile Values tab 7-7
7-8. Voyager System Administration Profile Values Cont. tab 7-8
Figures

7-9. Items tab 7-9
7-10. Barcode text box 7-9
7-11. Check mark button 7-10
7-12. Select File ellipsis 7-10
7-13. Filename (path) entered 7-11
7-14. Carriage-return-delimited file 7-11
7-15. Processing report window 7-12
7-16. Item barcode not found 7-13

9 Authority Control

9-1. Authority Validation dialog box 9-2
9-2. Select Authority Template dialog box 9-5
9-3. Global Headings Change Queue Tree Levels 9-7
9-4. Global Heading Change & Preview Queues 9-8
9-5. Global Heading Preview: Initial State 9-10
9-7. Level One of Tree: Original Heading, outlined 9-12
9-8. Level Two of Tree: Proposed New Heading, outlined 9-13
9-9. Level Three of Tree: Authority Headings outlined 9-13

10 Session Defaults and Menu Options

10-1. Cataloging Session Defaults and Preferences: General tab 10-2
10-2. Session Defaults: Validation tab 10-5
10-3. Invalid MARC21 Characters message when storing record 10-9
10-4. Session Defaults: Work Flow tab 10-10
10-5. Session Defaults: Item Defaults tab 10-12
10-6. Session Defaults: Folders/Files tab 10-13
10-7. Session Defaults: Mapping tab 10-15
10-8. Session Defaults: Colors/Font tab 10-17
Figures

A  MARC Tag Tables

A-1. Files and directories in the Voyager/Catalog/Tagtable directory A-2
A-2. Various configuration files/tag tables in the MARC21 directory A-3
A-3. Cataloging format choices for MARC validation A-4
A-4. Sample report if MARC validation finds an error while saving a record to the database A-5
A-5. Sample comment area of a tag table A-6
A-6. Sample stanzas from the Hmarc0xx.cfg file for MARC21 format A-7
A-7. Sample Bmarcfix.cfg file stanza from the new MARC tag tables A-10
A-9. Grid for the 006 field of a bibliographic record A-12
A-10. Sample keyboard shortcut for the Books tab A-13
A-11. Code types/tabs that display in the Cataloging module for a bibliographic record A-14
A-12. Code type examples from the [006Code] stanza of a Bmarcfix.cfg file for MARC21 format A-16
A-13. The result in the Cataloging module of the [006Code] stanza in the Bmarcfix.cfg file A-17
A-14. Arrangement of tabs A-17
A-15. Sample template configuration stanza from a Bmarcfix.cfg file A-19
A-17. Result in Cataloging module of the sample template configuration stanza A-22
A-18. Sample stanza defining drop-down menu options for the 006 and 008 fields A-22
A-19. Result in the Cataloging module of the sample drop-down menu stanza A-23

C  Voyager with Unicode Considerations

C-1. Leader Ninth Position C-2
# Figures

## D  Templated Input

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-1.</td>
<td>Use Templated Forms check box (Voyager System Administration)</td>
</tr>
<tr>
<td>D-2.</td>
<td>Voyager Cataloging main screen</td>
</tr>
<tr>
<td>D-3.</td>
<td>Select a MARC Template Dialog Box</td>
</tr>
<tr>
<td>D-4.</td>
<td>Sample template.ini File</td>
</tr>
<tr>
<td>D-5.</td>
<td>Sample MARC record leader</td>
</tr>
<tr>
<td>D-6.</td>
<td>Sample [Edit Templates] stanza</td>
</tr>
<tr>
<td>D-7.</td>
<td>Sample Template Definition File</td>
</tr>
<tr>
<td>D-8.</td>
<td>Sample [General] stanza</td>
</tr>
<tr>
<td>D-10.</td>
<td>Sample [BibInitialization] stanza</td>
</tr>
<tr>
<td>D-11.</td>
<td>Sample 007 specification in the [BibInitialization] stanza</td>
</tr>
<tr>
<td>D-12.</td>
<td>Sample 008 field</td>
</tr>
<tr>
<td>D-13.</td>
<td>Sample variable MARC record fields</td>
</tr>
<tr>
<td>D-14.</td>
<td>Sample [BibMarcMapping] and control specification stanzas</td>
</tr>
<tr>
<td>D-15.</td>
<td>Sample Source= element line</td>
</tr>
<tr>
<td>D-16.</td>
<td>Sample stanza using the Source= and Display= elements</td>
</tr>
<tr>
<td>D-17.</td>
<td>[006/008SerialsFrequency] stanza in the Bmarcfix.cfg file</td>
</tr>
<tr>
<td>D-18.</td>
<td>Sample Frequency combination box using Display=cv</td>
</tr>
<tr>
<td>D-19.</td>
<td>Sample Frequency combination box using Display=v (the default)</td>
</tr>
<tr>
<td>D-20.</td>
<td>Sample control specification stanza</td>
</tr>
<tr>
<td>D-21.</td>
<td>Sample [title] stanza</td>
</tr>
<tr>
<td>D-22.</td>
<td>Sample Text Box Display</td>
</tr>
<tr>
<td>D-23.</td>
<td>Sample 300c and 500a specification in the [BibMarcMapping] stanza</td>
</tr>
<tr>
<td>D-24.</td>
<td>Sample [Size] stanza</td>
</tr>
<tr>
<td>D-25.</td>
<td>Sample 300c and 500a created from Size combination box</td>
</tr>
<tr>
<td>D-26.</td>
<td>Sample [BibMarcMapping] Stanza</td>
</tr>
<tr>
<td>D-27.</td>
<td>Sample 245 and 500 field template specifications in the [BibMarcMapping] stanza</td>
</tr>
<tr>
<td>D-28.</td>
<td>Sample line in the [BibMarcMapping] stanza</td>
</tr>
<tr>
<td>D-29.</td>
<td>Sample Combination Box Definition</td>
</tr>
<tr>
<td>D-30.</td>
<td>Sample Combination Box Display</td>
</tr>
<tr>
<td>Figure</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>D-31.</td>
<td>Sample new record template in Voyager Cataloging</td>
</tr>
<tr>
<td>D-32.</td>
<td>Sample control specification stanza</td>
</tr>
<tr>
<td>D-33.</td>
<td>Sample 773t specification in the [BibMarcMapping] stanza</td>
</tr>
<tr>
<td>D-34.</td>
<td>Sample Source box text</td>
</tr>
<tr>
<td>D-35.</td>
<td>Sample 773t created from Source box text</td>
</tr>
<tr>
<td>D-36.</td>
<td>Sample control specification stanza</td>
</tr>
<tr>
<td>D-37.</td>
<td>Display values in Size combination (drop-down) box</td>
</tr>
<tr>
<td>D-38.</td>
<td>Control stanzas</td>
</tr>
<tr>
<td>D-39.</td>
<td>Size drop-down values as seen by the template operator</td>
</tr>
<tr>
<td>D-40.</td>
<td>Excerpt of sample [BibMarcMapping] stanza</td>
</tr>
<tr>
<td>D-41.</td>
<td>Sample record</td>
</tr>
<tr>
<td>D-42.</td>
<td>Sample 245 [BibMarcMapping] specification</td>
</tr>
<tr>
<td>D-43.</td>
<td>Sample [title] stanza</td>
</tr>
<tr>
<td>D-44.</td>
<td>Sample Text Box Display</td>
</tr>
<tr>
<td>D-45.</td>
<td>Sample title in the Title text box</td>
</tr>
<tr>
<td>D-46.</td>
<td>Sample 245 [BibMarcMapping] specification</td>
</tr>
<tr>
<td>D-47.</td>
<td>Sample title as it appears in the record</td>
</tr>
<tr>
<td>D-48.</td>
<td>Sample [abstract] stanza</td>
</tr>
<tr>
<td>D-49.</td>
<td>Sample Text Box Display with Scroll</td>
</tr>
</tbody>
</table>
Figures
# Tables

## 2 Record Types and Creating

| 2-1. Description of Record Types | 2-1 |
| 2-2. Link-Capable Fields in Bibliographic Records | 2-20 |
| 2-3. Link Type | 2-21 |
| 2-4. Verify Hypertext Links for Bibliographic Records | 2-24 |
| 2-5. Link Status | 2-24 |
| 2-6. History Tab Field Descriptions | 2-27 |
| 2-7. Verify Hypertext Links - Authority Records | 2-36 |
| 2-8. Link Status | 2-36 |
| 2-9. History Tab Field Descriptions | 2-38 |
| 2-10. Verify Hypertext Links - Holdings Records | 2-55 |
| 2-11. Link Status | 2-55 |
| 2-12. History Tab Field Descriptions | 2-58 |
| 2-13. Item Record Header Information | 2-62 |
| 2-14. Item Record Location Options | 2-62 |
| 2-15. Item Record Holdings Options | 2-62 |
| 2-16. Item Record Detail Options | 2-64 |
| 2-17. Possible Statuses Listed According to Rank | 2-65 |

## 3 Creating, Opening, and Viewing Records

| 3-1. Description of Column Headings for Import Record List | 3-13 |
| 3-2. Function Key Options for Creating Bibliographic Records | 3-23 |
| 3-3. Description of the Keyword tab | 3-28 |
| 3-4. Description of the Index Selection tab | 3-33 |
| 3-5. Description of the Builder tab | 3-40 |
| 3-6. Description of the Titles Index dialog box | 3-45 |
| 3-7. Default Re-Sorting Options (when none are configured) | 3-47 |
| 3-8. Description of the Holdings Index dialog box | 3-51 |
| 3-9. Headings List Information | 3-53 |
| 3-10. Description of the Headings List dialog box | 3-55 |
| 3-11. Description of the Voyager Connection Options dialog box | 3-71 |
| 3-12. Page references for bibliographic search tabs | 3-74 |
| 3-13. Description of the Search Limits dialog box | 3-81 |
| 3-14. Retrieve Options Using Record Menu | 3-117 |
Tables

4 Changing, Saving, and Printing Information
4-1. Character Changes 4-2
4-2. Target/Source Record Definitions for Bibliographic Merge 4-5
4-3. Default Text in Print Labels Dialog Box - Bibliographic Record 4-22
4-4. Default Text in Print Labels Dialog Box - Holdings 4-22
4-5. Default Text in Print Labels Dialog Box - Item Record 4-22
4-6. Action codes descriptions 4-25
4-7. Generic Field Codes - 100 Series 4-28
4-8. Bibliographic Field Codes - 200 Series 4-28
4-9. Holdings Field Codes - 300 Series 4-28
4-10. Item Field Codes - 400 Series 4-29
4-11. Library Address Field Codes - 500 Series 4-29
4-12. Received Serial Issue Field Codes - 600 Series 4-30

5 Cataloging & Bibliographic Record Linking
5-1. Example of profile names and overrides 5-2
5-2. Description of the first example in line 1 of Figure 5-7 5-9
5-3. Description of the first example in line 2 of Figure 5-7 5-10
5-4. Examples of spacing in derivation fields 5-10
5-5. Example 1 - Derivation field 5-13
5-6. Example 2 - Derivation field 5-13
5-7. Example 3 - Derivation field 5-13
5-8. Example 4 - Derivation field 5-14
5-9. Example 5 - Derivation field 5-14
5-10. Example 6 - Derivation field 5-15
5-11. Example 7 - Derivation field 5-15
5-12. Example 9 - Derivation field 5-15
5-13. Example of a template using standard and derivation fields 5-17
## Tables

### Diacritics and Non-Roman Characters

- **6-1. Special Character Mode Mapping - Diacritic & Non-Roman Characters**  
  - 6-3

### Authority Control

- **9-1. Authority Validation Dialog Box**  
  - 9-2
- **9-2. Authority Validation Dialog Box**  
  - 9-4
- **9-3. Tree Descriptions**  
  - 9-6
- **9-4. Original Heading Information Displayed**  
  - 9-12
- **9-5. Proposed New Heading Information Displayed**  
  - 9-13
- **9-6. Authority Headings Information Displayed**  
  - 9-14
- **9-7. Button Descriptions**  
  - 9-15
- **9-8. Button Description for Preview Display**  
  - 9-15

### Session Defaults and Menu Options

- **10-1. General tab options for Session Defaults and Preferences**  
  - 10-2
- **10-2. Validation tab options for Session Defaults and Preferences**  
  - 10-5
- **10-3. Work Flow tab options for Session Defaults and Preferences**  
  - 10-10
- **10-4. Item Defaults tab options for Session Defaults and Preferences**  
  - 10-12
- **10-5. Folders/Files tab options for Session Defaults and Preferences**  
  - 10-14
- **10-6. Mapping tab options for Session Defaults and Preferences**  
  - 10-16
- **10-7. Record types available for color change**  
  - 10-17
- **10-8. File Menu**  
  - 10-20
- **10-9. Record Menu**  
  - 10-20
- **10-10. Options Menu**  
  - 10-21
- **10-11. Help Menu**  
  - 10-21
- **10-12. File Menu**  
  - 10-22
- **10-13. Edit Menu**  
  - 10-23
### Tables

<table>
<thead>
<tr>
<th>Number</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10-14</td>
<td>Record Menu</td>
<td>10-24</td>
</tr>
<tr>
<td>10-15</td>
<td>Item Menu</td>
<td>10-27</td>
</tr>
<tr>
<td>10-16</td>
<td>Display Menu</td>
<td>10-27</td>
</tr>
<tr>
<td>10-17</td>
<td>Options Menu</td>
<td>10-28</td>
</tr>
<tr>
<td>10-18</td>
<td>Window Menu</td>
<td>10-28</td>
</tr>
<tr>
<td>10-19</td>
<td>Help Menu</td>
<td>10-29</td>
</tr>
</tbody>
</table>

### A MARC Tag Tables

<table>
<thead>
<tr>
<th>Number</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A-1</td>
<td>Text Masking Options</td>
<td>A-21</td>
</tr>
</tbody>
</table>

### B Voyager Call Number Logic / Processing

<table>
<thead>
<tr>
<th>Number</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>B-1</td>
<td>852 first indicator values</td>
<td>B-1</td>
</tr>
<tr>
<td>B-2</td>
<td>852 first indicator non-standard values</td>
<td>B-2</td>
</tr>
<tr>
<td>B-3</td>
<td>Subfield 2 Codes</td>
<td>B-2</td>
</tr>
<tr>
<td>B-4</td>
<td>CACODOCS and UDC classifications</td>
<td>B-2</td>
</tr>
</tbody>
</table>

### C Voyager with Unicode Considerations

<table>
<thead>
<tr>
<th>Number</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>C-1</td>
<td>Record-Level Warnings &amp; Errors</td>
<td>C-6</td>
</tr>
<tr>
<td>C-2</td>
<td>Log Information Provided for Field-Level Warnings &amp; Errors</td>
<td>C-6</td>
</tr>
<tr>
<td>C-3</td>
<td>Code Page Numbering</td>
<td>C-7</td>
</tr>
<tr>
<td>C-4</td>
<td>Specific Warnings &amp; Errors</td>
<td>C-7</td>
</tr>
<tr>
<td>C-5</td>
<td>BulkImport Rules / Results</td>
<td>C-8</td>
</tr>
</tbody>
</table>

### D Templated Input

<table>
<thead>
<tr>
<th>Number</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>D-1</td>
<td>Shared elements</td>
<td>D-20</td>
</tr>
<tr>
<td>D-2</td>
<td>Combination box control property types</td>
<td>D-26</td>
</tr>
<tr>
<td>D-3</td>
<td>Text box layout variables</td>
<td>D-27</td>
</tr>
</tbody>
</table>
Tables

D-4. Combination box optional elements

D-33
Tables
Procedures

1 Getting Started
1-1. Logging into Cataloging 1-4

2 Record Types and Creating
2-1. Viewing the Bibliographic Leader 2-4
2-2. Editing the 006 Field 2-6
2-3. Editing the 007 Field 2-9
2-4. Editing the 008 Field 2-12
2-5. Adding and Editing Variable Fields 2-16
2-6. Deleting Row of Variable Field Information 2-18
2-7. Deleting Characters of Variable Field Information 2-19
2-8. Configuring the Authority Leader 2-30
2-9. Configuring the Authority 008 Field 2-32
2-10. Adding a Tag to the Grid 2-34
2-11. Deleting a Tag 2-34
2-12. Configuring the Holdings Leader 2-41
2-13. Configuring the Holdings 007 Fixed Field 2-42
2-14. Configuring the Holdings 008 Fixed Field 2-45
2-15. Adding Variable Fields 2-47
2-16. Setting the Call Number Hierarchy 2-49
2-17. Getting Call Number from Bibliographic Record 2-51
2-18. Assigning a Status 2-67
2-19. Assigning Statistical Categories 2-69

3 Creating, Opening, and Viewing Records
3-1. Creating a New Record 3-2
3-2. Creating a Holdings Record When a Bibliographic Record is Open 3-5
3-3. Creating an Item Record from an Active Holdings Record 3-7
3-4. Opening a Work Record 3-8
3-5. Importing Records From a File 3-11
3-6. Importing Records From Another Database 3-14
Cataloging User’s Guide

Procedures

3-7. Performing a keyword search
3-8. Index Selection Searching
3-9. Performing a Builder search
3-10. Accessing searches from the History tab
3-11. Searching remote databases
3-12. Setting Search Limits
3-13. Display Record in WebVoyáge - Example
3-14. Using the Acq in the Cat Function
3-15. Retrieve Holdings
3-16. Retrieve Authority
3-17. Retrieve Items
3-18. Linking Items to Bibliographic Records
3-19. Relink an Item to a Different Holdings
3-20. Unlinking Holdings and Bib Records

Changing, Saving, and Printing Information

4-1. Editing a Record
4-2. Deleting a Record
4-3. Adding a URL to an 856 Field
4-4. Changing Owning Library
4-5. Overlaying and Merging Bibliographic Records
4-6. Replace/Merge Incoming Record
4-7. Validating a Heading
4-8. Copy a Record
4-9. Print Spine and Piece Labels

Cataloging & Bibliographic Record Linking

5-1. Creating a New Template
5-2. Editing a Template
5-3. Deleting a Template
5-4. Defining a Default Template
5-5. Defining a Default Folder
5-6. Creating New Records Using Templates
Procedures

5-7. Creating New Records Using a Default Folder 5-26

6 Diacritics and Non-Roman Characters
6-1. Special Character Entry 6-2
6-2. Special Character Mode 6-3

7 Pick and Scan
7-1. Using Pick and Scan 7-2

8 Templates
8-1. Creating a New Template 8-2
8-2. Editing a Template 8-4
8-3. Deleting a Template 8-5

10 Session Defaults and Menu Options
10-1. Changing Colors and Fonts 10-17

A MARC Tag Tables
A-1. Accessing the 006 Field Grid A-11

D Templated Input
D-1. Creating Records with Templated Input D-3
D-2. Retrieving/Editing Records with Templated Input D-4
Procedures
About This Document

Purpose

This document provides instructions for working with the Cataloging module.

Intended Audience

This document is intended for Voyager customers who are responsible for customizing and implementing Voyager Cataloging.

Reason for Reissue

This user’s guide incorporates and is being reissued for the following reasons.

- Changes to the About chapter.
- Addition of the Default Tab and Save Settings buttons on the Search dialog box. See Table 3-3 on page 3-28, Table 3-4 on page 3-32, and Table 3-5 on page 3-39 for more information.
- Addition of new feature in the holdings Record menu, Retrieve Bibliographic Record. See Retrieve Bibliographic Record (Shortcut) on page 3-96.
- Updated Retain Last Search description. See Table 10-3 on page 10-10.
• Addition of **Search Result Colors** for suppressed records. See **Table 10-7** on page 10-17 for more information.

• Addition of **Suppressed** and **Unsuppressed** options with Pick and Scan. See **Figure 7-1** on page 7-2 and **Figure 7-6** on page 7-6 in the Pick and Scan chapter for more information.

• Addition of overlay/merge bibliographic records feature. See **Changing Records with Bibliographic Overlay/Merge in Cataloging** on page 4-5 for more information.

• Addition of ISBN/ISSN validation. See **Save and ISBN/ISSN Validation** on page 4-12 and **Table 10-2** on page 10-5.

• Changes requested through Customer First feedback.

---

**Document Summary**

This document consists of the following:

- **Chapter 1**  
  “*Getting Started*”  
  Chapter 1 provides an overview of Cataloging, including logging into the application, printing screens, and exiting from the application.

- **Chapter 2**  
  “*Record Types and Creating*”  
  Chapter 2 discusses the different types of records used by the Voyager system to contain your MARC records and procedures for editing the leader and other related MARC tags.

- **Chapter 3**  
  “*Creating, Opening, and Viewing Records*”  
  Chapter 3 details the creation of new records, and opening and viewing existing records.

- **Chapter 4**  
  “*Changing, Saving, and Printing Information*”  
  Chapter 4 details editing records, saving edited records and printing records, spine, and piece labels.

- **Chapter 5**  
  “*Cataloging & Bibliographic Record Linking*”  
  Chapter 5 details the implementation and use of bibliographic record linking from within the Cataloging module for related records.

- **Chapter 6**  
  “*Diacritics and Non-Roman Characters*”  
  Chapter 6 details the implementation and considerations of diacritics and non-Roman characters in a Unicode environment.

- **Chapter 7**  
  “*Pick and Scan*”  
  Chapter 7 details the procedure for using the Pick and Scan feature.
Chapter 8  “Templates”
Chapter 8 details the procedure for using templates when working with new records.

Chapter 9  “Authority Control”
Chapter 9 details the methods of maintaining Authority Control.

Chapter 10  “Session Defaults and Menu Options”
Chapter 10 details Session Defaults and Preferences for application throughout the Cataloging module, and also gives a list of options available through the menus at the top of the Cataloging window.

Appendix A  “MARC Tag Tables”
Appendix A contains information on viewing, using and configuring the MARC tag tables used by the Cataloging client.

Appendix B  “Voyager Call Number Logic / Processing”
Appendix B contains information on using different classification schemes with the Cataloging module.

Appendix C  “Voyager with Unicode Considerations”
Appendix C contains information regarding considerations relative to the Voyager with Unicode™ implementation.

Index
The Index is an alphabetical, detailed cross-reference of topics about which this document contains information.

Conventions Used in This Document

The following conventions are used throughout this document:

• Names of commands, variables, stanzas, files, and paths (such as /dev/tmp), as well as selectors and typed user input, are displayed in constant width type.

• Commands or other keyboard input that must be typed exactly as presented are displayed in constant width bold type.

• Commands or other keyboard input that must be supplied by the user are displayed in constant width bold italic type.

• System-generated responses such as error messages are displayed in constant width type.

• Variable portions of system-generated responses are displayed in constant width italic type.

• Keyboard commands (such as Ctrl and Enter) are displayed in bold.

• Required keyboard input such as “Enter vi” is displayed in constant width bold type.
• Place holders for variable portions of user-defined input such as `ls -l filename` are displayed in *italicized constant width bold* type.

• The names of menus or status display pages and required selections from menus or status display pages such as “From the **Applications** drop-down menu, select **System-wide**,“ are displayed in **bold** type.

• Object names on a window’s interface, such as the **Description** field, the **OK** button, and the **Metadata** tab, are displayed in **bold** type.

• The titles of documents such as *Curator Web Client User’s Guide* are displayed in *italic* type.

• Caution, and important notices are displayed with a distinctive label such as the following:

**NOTE:**
Extra information pertinent to the topic.

**IMPORTANT:**
*Information you should consider before making a decision or configuration.*

**CAUTION:**
*Information you must consider before making a decision, due to potential loss of data or system malfunction involved.*

**TIP:**
*Helpful hints you might want to consider before making a decision.*

**RECOMMENDED:**
*Preferred course of action.*

**OPTIONAL:**
*Indicates course of action which is not required, but may be taken to suit your library’s preferences or requirements.*

Document Reproduction/Photocopying

Photocopying the documentation is allowed under your contract with Ex Libris (USA) Inc. It is stated below:
All documentation is subject to U.S. copyright protection. CUSTOMER may copy the printed documentation only in reasonable quantities to aid the employees in their use of the SOFTWARE. Limited portions of documentation, relating only to the public access catalog, may be copied for use in patron instruction.

Comment on This Document

Please contact Customer Support to provide us with your feedback. For Customer Support contact information, see SupportWeb at:


To Submit Comments by E-mail

To submit comments by e-mail, please send your message to:

docmanager@exlibrisgroup.com
Getting Started

Introduction 2-1
Purpose of this Chapter 2-1
Prerequisite Skills and Knowledge 2-1
Before You Begin 2-2
- Documentation and Online Help 2-2
- Conventions 2-2
  Commands 2-2
  Ellipsis Button 2-2
- Keyboard Functions 2-3
- Logging into Cataloging 2-4
- Exiting Cataloging 2-5
Getting Started

Introduction

This chapter describes the prerequisite installation and configuration information necessary for beginning work in the Cataloging module.

For information on how the settings in the System Administration module affect the Cataloging module, see the Voyager System Administration User’s Guide.

Purpose of this Chapter

The purpose of this chapter is to provide prerequisite information needed for using and customizing the Cataloging module.

Prerequisite Skills and Knowledge

To use this document effectively, you need knowledge of the following:

- Basic Microsoft® Interface navigation
- Basic UNIX® commands and navigation
- Basic Voyager® System Administration Module
- Basic WebVoyage® configuration
• Intermediate knowledge of MARC record formats (for creating customized WebVoyage display directories)

Before You Begin

Working with the Voyager Cataloging software is enhanced by the availability of documentation, online help, and the use of common conventions. This section describes the purpose of these resources in order for you to effectively use them.

Documentation and Online Help

The documentation and online help are designed to work together to provide you with the information you need when you need it. You can access online help by pressing the F1 function key (F1) on your keyboard.

The user’s guides are designed to cover the applications in greater detail to include screen shots, advanced topics, and cross references to other user’s guides and topics.

Conventions

Most conventions used in the Voyager documentation are Windows standard conventions. For more information about these conventions, please refer to your Windows documentation.

Commands

Voyager functions and activities are accessed primarily through the menu and sub-menu options. To designate which menus and sub-menus are being referred to in the user’s guides and online help, we have adopted a convention of specifying the menu, sub-menu, and function or activity. For example, referring to the Exit activity on the File menu is specified as File>Exit.

Ellipsis Button

The Ellipsis button (see Figure 1-1) indicates that additional information is available either in a dialog box or in an expanded textbox. Click the ellipsis button to access this additional function or information.
Keyboard Functions

Some functions listed on Voyager menus have corresponding keyboard equivalents. In addition, certain functions are assigned keyboard shortcuts. Both types of keyboard access are described below. Keyboard equivalents and shortcuts are indicated on the menus.

Keyboard equivalents allow you to perform activities without requiring you to use the mouse. Keyboard equivalents are indicated by an underlined letter in the name of a menu or function. To access a menu or function using keyboard equivalents, press the alternate key (Alt) followed by the underlined letter. For example, to exit a Voyager module, press and release the Alt key, followed by the f key (for the File menu), followed by the x key (for Exit).

A number of functions are also assigned keyboard shortcuts. Keyboard shortcuts allow you to press and hold the control key (Ctrl) and then press the designated letter. For example, when the Save command is available you can press and hold the Ctrl key followed by the s key (for Save).

Following Windows conventions, the tab key (Tab) can be used to move the cursor to fields and buttons within dialog boxes and windows. Press and hold the Shift key and then press the Tab key to move the cursor in the opposite direction through the dialog box.

The F4 function key (or F8 in some instances) can be used to display drop-down arrow selections. These keys can also be used to display fields represented by ellipsis button. In addition, items listed in drop-down menus can be scrolled through by typing the first letter of the item that you want to display. To scroll through additional items that begin with the same letter, type that letter again.

You can use the arrow keys on your keyboard to move through lists of options. The up and down arrows can also be used to select radio buttons. The escape key (ESC) can be used to close certain dialog boxes. The space bar can be used to highlight selections in list boxes. Once a selection has been highlighted in a list box, you can press the Enter key to select it.
Cataloging User’s Guide

Logging into Cataloging

Before you can begin working in Voyager’s Cataloging module, you must log in with your operator ID and password. Your operator ID and password determine what Cataloging operations you can perform as well as at which Cataloging locations you can perform them. Your system administrator defines this security information in the Voyager System Administration module. See the Voyager System Administration User’s Guide for details.

The procedure for logging into cataloging is described in Procedure 1-1, Logging into Cataloging.

Procedure 1-1. Logging into Cataloging

Use the following to access Voyager Cataloging.

1. Open the Cataloging module on your PC.

Result: The Login dialog box opens (see Figure 1-2).

![Login dialog box]

Figure 1-2. The Voyager Cataloging login dialog box

2. Enter your Operator Id, Password, and click OK or Exit.

Result: The main Cataloging window displays if you successfully entered your Operator Id and Password. Using Exit closes the log in dialog box without logging you into the Cataloging module.

NOTE:
Voyager allows you to make up to three unsuccessful attempts to log in before terminating the program.
3. (Optional) For systems with more than one happening location defined in Voyager System Administration, a **Select a cataloging location** dialog box displays from which you need to select an appropriate Cataloging location (see Figure 1-3); and click **OK**.

Result: The main Cataloging window displays.

![Select a cataloging location dialog box](image)

**Figure 1-3. Select a cataloging location dialog box**

**Exiting Cataloging**

You can exit Cataloging by selecting **File>Exit**. If you have open records that have been edited but not saved, you are asked to save the records or ignore the changes.
Record Types and Creating

Introduction 2-1

Types of Records 2-1
• Record Relationships 2-2
• Fields 2-3

Bibliographic Records 2-3
• MARC Tab 2-4
   Bibliographic Leader 2-4
   Bibliographic 005 Fixed Field 2-6
   Bibliographic 006 Fixed Field 2-6
   Bibliographic 007 Fixed Field 2-9
   Bibliographic 008 Fixed Field 2-12
   Variable Fields (MARC Tab) 2-14
   Adding and Editing Variable Fields (MARC Tab) 2-15
   Deleting Variable Fields (MARC Tab) 2-18
   Variable Fields (MARC Tab) Affecting the WebVoyâge OPAC Display 2-20
• System Tab 2-25
   OK to Export Option 2-26
   Suppress from OPAC Option 2-27
• History Tab 2-27
   Sorting the columns 2-28
   Lag Time 2-29
• Viewing and Editing Line Items from Bibliographic Records 2-29
Authority Records 2-29
  • MARC Tab 2-30
    Authority Leader 2-30
    Authority 008 Fixed Field 2-32
    Variable Fields (Authority Record) 2-34
  • System Tab 2-36
    OK to Export Option 2-37
  • History Tab 2-38
    Sorting the columns 2-39
    Lag Time 2-39
Holdings Records 2-39
  • MARC Tab 2-40
    Holdings Leader 2-40
    Holdings 007 Fixed Field 2-42
    Holdings 008 Fixed Field 2-45
    Variable Fields (MARC Tab) 2-47
    Get Call Number from Bib Record 2-48
  • System Tab 2-55
    OK to Export Option 2-56
    Suppress from OPAC Option 2-57
  • Bib Title(s) Tab 2-57
  • History Tab 2-58
    Sorting the columns 2-59
    Lag Time 2-59
  • Viewing and Editing Line Items from Holdings Records 2-59
Item Records 2-60
  • Checking for Duplicate Barcodes - Item Records 2-61
  • Header Information 2-62
  • Location and Type 2-62
  • Item/Holdings 2-62
  • Item Details 2-64
  • Statuses 2-64
  • Statistical Categories 2-69
Record Types and Creating

Introduction

Voyager’s Cataloging module provides a powerful and user-friendly means by which MARC 21-based records are created and maintained. You can create authority, bibliographic, holdings, and item records using the convenient and straightforward record displays. Integration between Cataloging and the Online Public Access Catalog (OPAC) means that you can easily build and maintain a complete, MARC 21-based catalog.

Types of Records

Voyager uses MARC 21 standard authority, bibliographic, and holdings records and a Voyager-defined item record. See Table 2-1 on page 2-1.

The bibliographic record is the key component in the relationship of these different types of records. See Figure 2-1.

Table 2-1. Description of Record Types

<table>
<thead>
<tr>
<th></th>
<th>Authority</th>
<th>Bibliographic</th>
<th>Holdings (MFHD)</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>MARC 21</td>
<td>MARC 21</td>
<td>MARC 21</td>
<td>Voyager</td>
</tr>
<tr>
<td>Linked to</td>
<td>Bibliographic</td>
<td>Bibliographic</td>
<td>Holdings</td>
<td></td>
</tr>
</tbody>
</table>
Authority records are optional and link to bibliographic records as either type of record is saved.

A Holdings record is also known as a MFHD, MARC Format for Holdings Data.

Item records are used for circulating library material.

**Record Relationships**

Holdings records are linked to bibliographic records to represent each copy that your library has. Item records are linked to holdings records for each volume and/or circulating piece of a copy. See Figure 2-1.

---

**Table 2-1. Description of Record Types**

<table>
<thead>
<tr>
<th>Source</th>
<th>Authority</th>
<th>Bibliographic</th>
<th>Holdings (MFHD)</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Original</td>
<td>Original</td>
<td>Original</td>
<td>Original</td>
</tr>
<tr>
<td></td>
<td>or Utility</td>
<td>or Utility</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**Figure 2-1. Voyager record relationships**
Voyager uses the 852 field for the location and call number.

- Subfield b records the item’s location using location codes defined in System Administration.
- Subfields h and i have the call number.

⚠️ IMPORTANT:
These are the only indexed fields in the holdings record.

The 866 field is often used to display a library’s summary holding information for serials and multi-volume sets. This displays in the OPAC to inform library patrons of what you own.

Voyager item records include information about an item’s permanent and temporary location and an item’s type and temporary type. This information along with the barcode stored in the item record is used by the Circulation module for circulation transactions. The copy number, enumeration, and chronology fields in an item record are used to augment the OPAC display when the item is charged out or has another informational status.

Bibliographic Records

Bibliographic records contain all the bibliographic information for a library item.

The bibliographic record displays with the following three tabs.

- MARC tab
- System tab
- History tab

For information about creating a bibliographic record, see Creating a Record on page 3-1.

Only the MARC and System tabs display when you initially create a bibliographic record. Subsequently, the History tab displays when an action is taken against the record such as saving it to the database.
MARC Tab

The MARC tab of the bibliographic record (see Figure 2-2) contains a Leader, a 005 fixed field, a 008 fixed field, and variable fields. It can also contain multiple 006 and 007 fields. All values correspond to the published MARC standard.

Figure 2-2. Bibliographic Record - MARC Tab

Bibliographic Leader

The Bibliographic Leader information allows you to select the Bibliographic Record Status, Type of Record, Bibliographic Level, Type of Control, Encoding Level, and Cataloging Form.

The Bibliographic Leader displays as a grid which is completely configurable using Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details on the MARC tag tables.

The procedure for viewing the Bibliographic Leader is shown in Procedure 2-1, Viewing the Bibliographic Leader, on page 2-4.

Procedure 2-1. Viewing the Bibliographic Leader

Use the following to select the Bibliographic Leader information from a bibliographic record.

1. Click the Leader button. See Figure 2-3.
Figure 2-3. Bibliographic Leader Button

Result: The Leader dialog box opens as a grid. See Figure 2-4.

Figure 2-4. Leader dialog box

2. Select values from the grid by clicking a particular cell and the down arrow to display drop-down menu selections.

Result: Leader options display for you to select.

NOTE:
Use either the mouse or the up/down arrow keys on your keyboard to move from cell to cell within the grid or from option to option in the drop-down lists. The Tab
key is not available for use within the grid. Using the **Tab** key takes you outside the grid altogether.

**TIP:**
*You can also enter the letter or number that precedes an option in a drop-down list to make a selection. For instance, if you want to jump from subfield z within the drop-down list to subfield a, simply press the letter a.*

3. **Click OK or Cancel.**

Result: This saves your work and exits the **Leader** dialog box or exits the dialog box without saving.

---

### Bibliographic 005 Fixed Field

The **005** field is a system-applied field containing 16 characters that specify the date and time of the latest record transaction. These characters are recorded in the pattern YYYYMMDDHHMMSS.F that represents year, month, day, hour, minute, second, and decimal fraction of a second.

### Bibliographic 006 Fixed Field

The **006** field is a repeatable field that allows you to add other bibliographic formats.

The **006** field displays as a tabbed dialog box which is completely configurable using Voyager’s MARC tag tables. See [MARC Tag Tables](#) on [page A-1](#) for details on the MARC tag tables.

The procedure for editing the **006** field on the **MARC** tab is shown in [Procedure 2-2, Editing the 006 Field](#), on [page 2-6](#).

---

### Procedure 2-2. Editing the 006 Field

Use the following to edit the **006** field on the **MARC** tab of an open bibliographic record.

1. **Click the 006 button** (see [Figure 2-5](#)) on the **MARC** tab of an open bibliographic record.
Figure 2-5. 006 Button

Result: The 006 field displays a tabbed dialog box (see Figure 2-6) from which you can select a bibliographic format type.

Figure 2-6. 006 dialog box

2. Select a tab representing the bibliographic format type you want to enter.

Result: A blank workspace displays with the New button active.

TIP:
You can use the mouse or keyboard shortcuts to access tabs. To use the keyboard shortcut, hold the Alt key; and type the letter that is underlined in the tab name such as Alt+b to access the Books tab. See MARC Tag Tables on page A-1 for details on how to define your own keyboard access keys.

3. Click the New button.
Result: A grid displays with various options. See Figure 2-7.

4. Select options from the grid by clicking a particular cell, and the down arrow to display drop-down menu selections.

**NOTE:**
Use either the mouse or the up/down arrow keys on your keyboard to move from cell to cell within the grid or from option to option in the drop-down lists. The Tab key is not available for use within the grid. Using the Tab key takes you outside the grid altogether.

**TIP:**
You can also enter the letter or number that precedes an option in a drop-down list to make a selection. For instance, if you want to jump from subfield z within the drop-down list to subfield a, simply press the letter a.

5. Click Apply.

Result: This stores the options you selected and a check mark displays in the check box directly to the left of the tab name indicating that values have been selected for that tab. See Figure 2-7 which has values for the Books tab added and applied.

![Figure 2-7. Bibliographic 006: Grid displayed and values set](image-url)
The **Delete** button becomes active allowing you to delete what you have applied.

6. Click **Close**.

Result: You exit the 006 linking field dialog box.

---

**Bibliographic 007 Fixed Field**

The **007** field is a repeatable field that allows you to add other material categories.

The Bibliographic **007** field displays as a grid which is completely configurable using Voyager’s MARC tag tables. See [MARC Tag Tables](#) on page **A-1** for details on the MARC tag tables.

The procedure for editing the **007** field on the **MARC** tab is shown in [Procedure 2-3, Editing the 007 Field](#), on page **2-9**.

---

**Procedure 2-3. Editing the 007 Field**

Use the following to edit the **007** field on the **MARC** tab of an open bibliographic record.

1. Click the **007** button (see [Figure 2-8](#)) from the **MARC** tab of an open bibliographic record.

---

![Figure 2-8. 007 Button](#)

Result: The **007** field displays a tabbed dialog box (see [Figure 2-9](#)) from which you can select a material category.
2. Select a tab representing the physical material you want to enter.

Result: A blank workspace displays with the **New** button active.

**TIP:**
You can use a mouse or keyboard shortcuts to access tabs. To use the keyboard shortcut, hold the **Alt** key; and type the letter that is underlined in the tab name such as **Alt+m** to access the **Map** tab. See **MARC Tag Tables** on page A-1 for details on how to define your own keyboard access keys.

3. Click the **New** button.

Result: A grid displays with various options. See **Figure 2-10**.

4. Select options from the grid by clicking a particular cell, and the down arrow to display drop-down menu selections.

Result: You can enter the **007** field information to match your material.

**NOTE:**
Use either the mouse or the up/down arrow keys on your keyboard to move from cell to cell within the grid or from option to option in the drop-down lists. The **Tab**
key is not available for use within the grid. Using the **Tab** key takes you outside the grid altogether.

**TIP:**
You can also enter the letter or number that precedes an option in a drop-down list to make a selection. For instance, if you want to jump from subfield **z** within the drop-down list to subfield **d**, simply press the letter **d**.

5. **Click Apply.**

Result: This stores the options you selected and a check mark displays in the check box directly to the left of the tab name indicating that values have been selected for that tab. See **Figure 2-10** which has values for the **Books** tab added and applied.

![Figure 2-10](image.png)

**Figure 2-10.** 007 - Physical description dialog box with grid displayed

**NOTE:**
The **Delete** button becomes active allowing you to delete what you have applied.

6. **Click Close.**

Result: You exit the 007 linking field dialog box.
Bibliographic 008 Fixed Field

The 008 is a header in the main record used to describe the main format in the Leader. The 008 is required and non-repeatable.

The Bibliographic 008 field displays as a grid which is completely configurable using Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details on the MARC tag tables.

The procedure for editing the 008 field on the MARC tab is shown in Procedure 2-4, Editing the 008 Field, on page 2-12.

Procedure 2-4. Editing the 008 Field

Use the following to edit the 008 field on the MARC tab of an open bibliographic record.

1. Click the 008 button (see Figure 2-11) from the MARC tab of an open bibliographic record.

Figure 2-11. 008 Button

Result: The 008 field displays a grid-style dialog box (see Figure 2-12) with various drop-down menus and text boxes.
Figure 2-12. 008 - General Description dialog box

2. Enter the required information in the 008 dialog box.

These fields accept ASCII characters. See MARC Tag Tables on page A-1 for more information.

Use either the mouse or the up/down arrow keys on your keyboard to move from cell to cell within the grid or from option to option in the drop-down lists. The Tab key is not available for use within the grid. Using the Tab key takes you outside the grid altogether.

Result: The required information is identified for the 008 field.

NOTE:
The date information must be 4 characters long. The first character must be a digit greater than zero followed by another digit or the characters u, x, y, or a question mark (?).

TIP:
You can also enter the letter or number that precedes an option in a drop-down list to make a selection. For instance, if you want to jump from subfield t within the drop-down list to subfield b, simply press the letter b.
3. Click **OK** or **Cancel**.

   Result: This saves your work and exits the **008** dialog box or exits the dialog box without saving.

---

**Variable Fields (MARC Tab)**

The variable fields grid allows you to add tags with first and second indicators and bibliographic data (subfields). The grid is made up of rows which store information about each tag. Each row is broken into segments for the tag, two indicators and the variable subfield text. When you create a bibliographic record, a grid template is supplied by the system and provides the required title statement (**245** tag) row. See **Figure 2-13**.

---

**Figure 2-13.** Variable fields grid with **245** tag row

---

**880 Fields and Unicode Implementation**

Voyager supports the creation and editing of bibliographic **880** (Alternate Graphic Representations) fields in Cataloging.

For more information about the support of non-Roman characters and Unicode, see Chapter 6, **Diacritics and Non-Roman Characters** on page 6-1 and Appendix C, **Voyager with Unicode Considerations** on page C-1.
Adding and Editing Variable Fields (MARC Tab)

There are several features that are common to adding and editing variable fields. Right click the selection column (containing the row marker) of the grid on the MARC tab to display the following input and editing options. See Figure 2-14 and Figure 2-15.

- Cut this field
- Copy this field
- Paste before this field
- Move this field up by one (moves the focus row up by one row)
- Move this field down by one (moves the focus row down by one row)
- Delete this field
- Validate heading in the field

This menu dynamically changes for the conditions of each row. Only the active options display.

**NOTE:**
These menu options only apply to the row that you clicked. When more than one row is selected, use the menu bar options for cut, copy, or delete.

---

**Figure 2-14.** Selection Column
Procedure 2-5. Adding and Editing Variable Fields

Use the following to add and edit variable fields.

1. Click Record>New>Bibliographic and select a bibliographic template. See the example in Figure 2-16.

   Result: The MARC tab of a new bibliographic record displays with the leaders and variable fields grid.

2. Click the Subfield Data cell to enter the ‡a information for the 245 tag.

   Result: The content for ‡a is entered.

**NOTE:**
When you enter non-Roman characters for a language that is read right to left, the system dynamically adjusts for each subfield affected to flow the text in the proper direction. The Left / Right arrows on the keyboard adapt for movement through the text that is read right to left.

**IMPORTANT:**
Hebrew and/or Arabic language support needs to be installed in the operating system for them to display in the correct order.
NOTE:
Backspacing to erase diacritic characters may require you to press the backspace key twice. Diacritic characters are usually stored in the system as two separate components, the alphabetic character first and then the diacritic character. See Diacritics and Non-Roman Characters on page 6-1 and Voyager with Unicode Considerations on page C-1 for more information.

3. Click Edit>Insert Field Before (F3) or Edit>Insert Field After (F4) to add a tag to the grid.

Result: This inserts a field before or after the current row.

4. Click the Tag cell and enter a tag number or press F2 to select a valid tag from the Valid Values dialog box.

Result: The tag displays in the cell.

5. Click the indicator cell and type the indicator number or press F2 to select a valid indicator from the Valid Values dialog box.

Result: A number representing the indicator displays in the indicator cell.

---

Figure 2-16. Bibliographic template selection

6. Click the bibliographic data cell labeled Subfield Data and press F9.
Result: This inserts a subfield delimiter in the **Subfield Data** cell.

**NOTE:**
The subfield delimiter may be automatically entered depending on the settings in your Session Defaults and Preferences (**General** tab). See Chapter 10, **General Tab** on page 10-2.

7. Type the subfield or press F2 to select a valid subfield.

   Result: A valid subfield is entered.

8. Enter the subfield data.

   Result: The bibliographic data is entered.

9. Click **Save to DB**.

   Result: This stores the bibliographic record in the Voyager database.

**NOTE:**
In a **010** field, the leading signification spaces are not trimmed. To accurately have three leading spaces in a **010** field, you need four spaces between the subfield marker and the first digit of the LCCN. The space immediately after the subfield is added and removed by the Voyager Cataloging client to be consistent in its display of data.

---

**Deleting Variable Fields (MARC Tab)**

Use the **Delete** key to delete a row of variable information or individual characters within a row.

**Entire Row**

The procedure for deleting a row of variable field information is shown in Procedure 2-6, **Deleting Row of Variable Field Information**, on page 2-18.

---

**Procedure 2-6. Deleting Row of Variable Field Information**

Use the following to delete an entire row of variable field information.

1. Click the cell in the Selection Column (see **Figure 2-14**) next to the row you want to delete.
Result: This identifies via highlighting the material to be deleted.

2. Press the **Delete** key (or click **Edit>Delete Field** or right-click and select **Delete this field**).

   Result: The system displays a warning dialog box.

3. Click **Yes** or **No**.

   Result: Selecting Yes deletes the highlighted material or selecting No cancels the delete request.

4. Click **Save to DB**.

   Result: This updates the record in the database with the deletion.

---

**Individual Characters**

The procedure for deleting individual characters of variable field information is shown in **Procedure 2-7, Deleting Characters of Variable Field Information**, on page 2-19.

**Procedure 2-7. Deleting Characters of Variable Field Information**

Use the following to delete one or more characters of variable field information.

1. Click next to the character you want to delete.

   Result: The insertion point is positioned to the left of the character you want to delete.

2. Press the Delete key.

   Result: This deletes one character at a time of variable information.

3. Click **Save to DB**.

   Result: This updates the record in the database with the deletions.
Variable Fields (MARC Tab) Affecting the WebVoyage OPAC Display

Voyager’s WebVoyage module allows your institution to define what displays from your bibliographic, holdings, and item records. Certain information can be added to your bibliographic or holdings records which can be displayed in a special manner in WebVoyage.

To specify that certain documents, images, World Wide Web pages, or other resources are available in the WebVoyage OPAC when a specific record is selected, you must use a link-capable field in a bibliographic record according to the MARC 21 standard (refer to www.loc.gov/marc/).

See Table 2-2 for a list of link-capable fields/subfields.

Table 2-2. Link-Capable Fields in Bibliographic Records

<table>
<thead>
<tr>
<th>URI</th>
<th>Link Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>505 u</td>
<td>‡a</td>
</tr>
<tr>
<td>506 u</td>
<td>‡a</td>
</tr>
<tr>
<td>514 u</td>
<td>‡a</td>
</tr>
<tr>
<td>520 u</td>
<td>‡a</td>
</tr>
<tr>
<td>530 u</td>
<td>‡a</td>
</tr>
<tr>
<td>540 u</td>
<td>‡a</td>
</tr>
<tr>
<td>545 u</td>
<td>‡a</td>
</tr>
<tr>
<td>552 u</td>
<td>‡z or ‡a</td>
</tr>
<tr>
<td>555 u</td>
<td>‡a</td>
</tr>
<tr>
<td>563 u</td>
<td>‡a</td>
</tr>
<tr>
<td>583 u</td>
<td>‡z or ‡a</td>
</tr>
<tr>
<td>856 u</td>
<td>‡y or ‡z</td>
</tr>
</tbody>
</table>

Links - Overview

Voyager handles the following types of links. See Table 2-3.

- URI (Uniform Resource Identifier)
- URL (Unifrom Resource Locator)
- URN (Uniform Resource Name)
- DOI (Digital Object Identifier)
- Images on a server
• DOS

Table 2-3.  Link Type

<table>
<thead>
<tr>
<th>Link Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URI/URL/URN/DOI Links</td>
<td>URLs, URNs, and DOIs are subsets of URI</td>
</tr>
<tr>
<td></td>
<td>If you click a URL link, it launches the Web browser and displays the specified file.</td>
</tr>
<tr>
<td></td>
<td>In order for DOI and URN links to be verified and processed, the addresses of the DOI and URN handler servers must be entered in the DOI and URN fields on the Validation tab of the Session Defaults and Preferences window. See Validation Tab on page 10-4 for more information about DOI and URN 856 link servers.</td>
</tr>
<tr>
<td>Links to Images on a Server</td>
<td>Use either Image Server or a Web browser as determined by the name specified on the Validation tab in Cataloging’s Session Defaults and Preferences.</td>
</tr>
<tr>
<td>DOS Links</td>
<td>DOS network links are determined by the operating system specified in the MARC record 856 field.</td>
</tr>
</tbody>
</table>

To include a World Wide Web resource or any other linked resource in a bibliographic record, use a link-capable field/subfield combination. There are many options for storing linked resources in MARC records. Your requirements will determine the options that best meet the needs of your institution.

The following examples are provided to assist you in thinking about some of the options available.

Links - URL Examples

The following is an example that uses the 856 variable field and ‡u in a MARC record to specify URLs.

```
856  _ _ ‡u http://www.akc.org
856  4 _ ‡u http://www.whitehouse.gov
```

The following is an example that uses the 856 variable field, indicator 7, ‡3, ‡2, and ‡u in combination.

```
856  7 _ ‡3 Table of Contents ‡2 HTTP ‡u http://lcweb.loc.gov/cardir/toc/
```

This example causes the following to display in WebVoyáge as a hypertext link.

Table of Contents
The `‡2` and string `HTTP` indicates that the link is an http-type link when thumbnails are generated in the OPAC. If this is used, the thumbnail image displays in the OPAC in the thumbnails column. The 856 field containing the thumbnail must be the first 856 field listed in the MARC record.

**Links - Link Text Examples**

The following is a MARC record example that combines the URL and link text. The link text that displays in the OPAC accesses the URL specified.

```
856 4 _ ‡u http://www.akc.org ‡z The American Kennel Club Web page
856 4 _ ‡u http://www.whitehouse.gov ‡z the White House Web page
```

These examples cause the following to display in WebVoyâge as hypertext links.

- The American Kennel Club Web page
- The White House Web page

**Links - Files on a Server Examples**

If you want to link to files stored on a server, you can use `‡d`, `‡f`, and `‡o`. `‡o` may contain the literals UNIX or DOS® identifying the type of server to which the link points.

The following is an example of a MARC record that specifies a link to a file on a server.

```
856 _ _ ‡d c:\word\winword ‡f schedule.doc ‡o dos ‡z 1995 Fall Class Schedule
```

**NOTE:**
When a record displays with a link to a file on a server, a thumbnail displays in the Titles Index in WebVoyâge.

**Links - Image Server Link Examples**

If your library uses Image Server and you want to specify a link to images stored in the Image Server database, 7 is the first indicator in the 856 variable field as in the following example.

```
856 7_ ‡2 sdc ‡f 10, 10, 4 ‡z Link Text
```

When a record with an Image Server link displays in the Title Index in WebVoyâge, a thumbnail displays.
Image Server adds a link to both existing bibliographic records and existing holdings records. The 856 field is created automatically with a value of 7 in the first indicator. ‡2, ‡f, and ‡z are also filled in during the creation.

Links - DOI and URN Link Examples

If you want to link to a DOI or URN, you can use ‡g as in the following example.

856  _ _ ‡g DOI:87955754 ‡z DOI link to somewhere

For information about what needs to be set up in order for DOI or URN links to be successful in OPAC, see the Voyager WebVoyage User’s Guide.

Links - Verify Hypertext Links for Bibliographic Records

You can verify the integrity of hypertext links in the current bibliographic record (or authority or holdings records ... see Verify Hypertext Links - Authority Records on page 2-35 and/or Verify Hypertext Links - Holdings Records on page 2-54) by selecting Record>Verify Hypertext links from the Cataloging main menu, or by using the Ctrl + K keystroke. This opens the Hypertext link dialog box. See Figure 2-17.

Figure 2-17. Hypertext links dialog box

NOTE:

If the record does not have any links, a message displays. See Figure 2-18.
See Table 2-4 that highlights the fields in bibliographic records validated when Record>Verify Hypertext links is selected.

Table 2-4. Verify Hypertext Links for Bibliographic Records

<table>
<thead>
<tr>
<th>URI</th>
<th>Link Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>505 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>506 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>514 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>520 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>530 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>540 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>545 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>552 ‡u</td>
<td>‡z or ‡a</td>
</tr>
<tr>
<td>555 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>563 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>583 ‡u</td>
<td>‡z or ‡a</td>
</tr>
<tr>
<td>856 ‡u</td>
<td>‡y or ‡z</td>
</tr>
</tbody>
</table>

See Table 2-5 for a description of valid and invalid links.

Table 2-5. Link Status

<table>
<thead>
<tr>
<th>Link Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid Links</td>
<td>Display underlined and in blue. Clicking a valid link (blue and underlined) initiates that connection.</td>
</tr>
<tr>
<td>Invalid Links</td>
<td>Display in red with a diagnostic message. Invalid links can be corrected by editing the hypertext field in the MARC record.</td>
</tr>
</tbody>
</table>
Chapter 2: Record Types and Creating Links - Table of Contents

To display a formatted Table of Contents in the OPAC, you must define the 505 variable field in the bibliographic record. The OPAC displays the information stored in subfield ‡a and formats the information in one line that wraps to fit each screen and starts a new line at each double dash.

Links - Thumbnail Images

In order for thumbnail images to display in WebVoyáge for a particular link, you must have a separate link-capable field that refers to an image file that displays before any of the other link-capable fields in the MARC record. The only types of links that may cause thumbnails to display are links to server files, scandoc links, and HTTP links.

A file only has a unique thumbnail image display in OPAC if it is a still image file such as a .gif file, a .bmp file, or a scandoc document which is a still image. If the link leads to a .AVI, .MOV, .MPG, .PDF, .TXT, or .WAV file, or to a URL link, a generic thumbnail is supplied. See the Voyager WebVoyáge User’s Guide for more information.

System Tab

Press Alt + S from an open bibliographic record to switch to the System tab.

The System tab contains the options to approve records for export and to suppress records from OPAC. In addition, the Owning Library for the record displays. See Figure 2-19.
Figure 2-19. Bibliographic Record - System Tab

All the information relating to **OK to export** is located on the **System** tab to include the following.

- Whether or not the record is OK to be exported (YES/NO)
- The date on which the **OK to export** option should take effect
- The date on which the **OK to export** option was last set
- The operator who set the record as **OK to export**
- The location at which **OK to export** was set

**OK to Export Option**

The **OK to export** option is used by libraries that export records. For instance, you may export records to a bibliographic utility on a regular basis to have holdings records attached. You can use Voyager’s Pmarcexport program to export records. See the **Voyager Technical User’s Guide** for details.

Checking the **OK to export** box confirms that the bibliographic record is acceptable for export. You must click the **Save to Database** button for it to take effect. If the **OK to export** box already contains a check mark, that indicates that an operator has either approved the record for export at an earlier date, or the
record was automatically authorized for export when it was imported. To automatically mark records as **OK to export**, see the "Bulk Export of MARC Records" section of the **Voyager Technical User’s Guide**.

When the **OK to export** box is checked, two radio buttons become active on the **System** tab, allowing you to either select the last date on which the **OK to export** option was set, or to select today’s date (**Change to Today** radio button). Selecting the **Change to Today** radio button and then clicking the **Save to Database** button will cause the **OK to export** date to change to today’s date.

**NOTE:**
The **OK to export** option resets during the actual export process. The date, operator, and location at which the **OK to export** option was last set display below the **OK to export** check box and the two radio buttons indicating export dates, in the **Last set for**, **By**, and **At** textboxes.

**Suppress from OPAC Option**

To prevent a bibliographic record from displaying in the OPAC module, mark the check box labeled **Suppress from OPAC** (or press Alt + P). This also prevents any information about attached holdings and item records from displaying in the OPAC. However, if the **Suppress from OPAC** check box for a location is checked in the System Administration module, you cannot uncheck the **Suppress from OPAC** check box in Cataloging. See the **Voyager System Administration User’s Guide** for details.

**TIP:**
*When the **Suppress from OPAC** box is checked, the small book icon in the top left corner of the record is greyed. When the check box is unchecked, the icon displays in a reddish-burgundy shade. This gives you a visual indication of the status of that record.*

**History Tab**

Press Alt + Y from an open bibliographic record to switch to the **History** tab.

The **History** tab includes a list of every change ever made to a bibliographic record (see Figure 2-20). These changes are described in **Table 2-6**.

**Table 2-6. History Tab Field Descriptions**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td>The date and the time the change was made.</td>
</tr>
</tbody>
</table>
Sorting the columns

You can sort the History tab columns in ascending or descending order by clicking the column header.
Lag Time

In cases where a record has undergone massive amounts of changes such as 1000 updates, you may find a small lag time when you click the History tab (or select Alt + Y). This is because the History tab is dynamically updated by your Voyager system. The lag time should not be more than a few seconds.

Viewing and Editing Line Items from Bibliographic Records

It is possible to view and then manipulate a line item in the Acquisitions module from the associated bibliographic or holdings record in the Cataloging module. This feature is known as Acquisitions in Cataloging or Acq in the Cat.

Acq in the Cat is the second half of the two-way communication between the Acquisitions and Cataloging modules. See the Voyager Acquisitions User’s Guide for details. Cat in the Acq allows you to view and then edit a MARC record in the Cataloging module from the associated line item in the Acquisitions module.

For details and instructions on using the Acq in the Cat feature, see Viewing and Editing Line Items (Acquisitions in Cataloging) on page 3-86.

Authority Records

An Authority Record is created when you select an authority template from the Select Authority Template dialog box (see Creating a Record on page 3-1) or when you click Create from the Authority Validation dialog (see Chapter 9, Introduction on page 9-1).

The authority record contains three tabs.

• MARC tab
• System tab
• History tab

When you create a new authority record, only the MARC and System tabs display since the record has no history yet.
MARC Tab

The MARC tab of an authority record (see Figure 2-21) contains a Leader, an 008 fixed field, and variable fields. All values correspond to the published MARC standard.

Authority Leader

The Authority Leader Information allows you to select the Record Status and the Encoding Level. The Authority Type has only one type, so it always displays a “z.”

The Authority Leader field displays as a grid, which is completely configurable using Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details on the MARC tag tables.

The procedure for configuring the Authority leader is shown in Procedure 2-8, Configuring the Authority Leader, on page 2-30.

Procedure 2-8. Configuring the Authority Leader

Use the following to configure the Authority leader.

1. Click the Leader button (see Figure 2-22) from an open Authority record.
Chapter 2: Record Types and Creating

Figure 2-22. Leader Button

Result: The Leader dialog box (see Figure 2-23) opens as a grid.

![Leader dialog box](image)

Figure 2-23. Leader dialog box for authority information

2. Choose a record status and an encoding level from the appropriate drop-down menus by clicking the cell and then the **down arrow** to display the drop-down menu selections.

To display and browse drop-down menu selections, click the **down arrow** or press **F4** or the space bar. Use the **up** and **down arrows** on your keyboard to navigate within the drop-down menu. From within a drop-down menu, you can enter the letter or number that precedes a particular selection. For instance, if you want to jump from subfield z within the drop-down menu to subfield a, you can simply press the letter a.

3. Click **OK** to exit and save your work; click **Cancel** or **Esc** to exit without saving.
Authority 008 Fixed Field

The **008** is a header in the main record used to describe the main format in the **Leader**. The **008** is required and non-repeatable.

The Authority **008** field displays as a grid which is completely configurable using Voyager’s MARC tag tables. See [MARC Tag Tables](#) on [page A-1](#) for details on the MARC tag tables.

The procedure for configuring the Authority 008 Field is shown in Procedure 2-9, Configuring the Authority 008 Field, on page 2-32.

---

**Procedure 2-9. Configuring the Authority 008 Field**

Use the following to configure the Authority **008** field.

1. Click the **008** button (see Figure 2-24) from an open authority record.

---

**Figure 2-24. 008 Button**

Result: The **008 - General Description (Authority)** dialog box (see Figure 2-25) opens as a grid.
2. Select values from the grid by clicking a particular cell and then the down arrow to display drop-down menu selections.

You must use either the mouse or the up and down arrows on your keyboard to move from cell to cell within the grid. To use the latter, first click in a particular cell and then use the up and down arrows to navigate from cell to cell. Do not click the down arrow. This causes you to browse the selections within a particular drop-down menu. Note that you cannot use the Tab key to move from cell to cell on the grid. This takes you outside the grid altogether.

To display and browse drop-down menu selections, click the down arrow or press F4 or the space bar. Use the up and down arrows on your keyboard to navigate within the drop-down menu. From within a drop-down menu, you can enter the letter or number that precedes a particular selection. For instance, if you want to jump from subfield z within the drop-down menu to subfield a, you can simply press the letter a.

NOTE:
In the 008 dialog box, the Heading Use selections are made via drop-down menus.

3. Once you make selections, click OK to exit and save your work; click Cancel or Esc to exit without saving.
Variable Fields (Authority Record)

The Variable Fields grid allows you to add Tags, with First and Second Indicators, and Subfield Data.

In order to add or edit information in the Variable Fields grid, you must first place your cursor in that grid. To do this, position and click your mouse in the Variable Fields portion of the record.

The procedure for adding a tag to the grid is shown in Procedure 2-10, Adding a Tag to the Grid, on page 2-34.

Procedure 2-10. Adding a Tag to the Grid

Use the following to add a tag to the grid.

1. Select Edit>Insert Field Before (F3), or Edit>Insert Field After (F4).

2. Select the Tag cell by clicking in the cell under Tag heading. Type the tag or press F2 to select a valid tag from the Cataloging Tips scroll box. The tag displays in the cell.

3. Select an indicator by clicking in the indicator cell. Type the indicator or press F2 to select a valid indicator from the Cataloging Tips scroll box. A number representing the indicator displays in the indicator cell.

4. Select the Subfield Data cell. Press F9 to insert a subfield delimiter in the cell. Type the subfield or press F2 to select a valid subfield from the Cataloging Tips scroll box. Enter the subfield data. If necessary, click the ellipse box to expand the data cell.

The procedure for deleting a tag is shown in Procedure 2-11, Deleting a Tag, on page 2-34.

Procedure 2-11. Deleting a Tag

Use the following to delete a tag.

1. Click the row label (the grey, left column).

2. Press the Delete key on the keyboard.
3. Respond to the confirmation message.

Verify Hypertext Links - Authority Records

You can verify the integrity of hypertext links in the current authority record (or bibliographic or holdings records ... see Links - Verify Hypertext Links for Bibliographic Records on page 2-23 and/or Verify Hypertext Links - Holdings Records on page 2-54) by selecting Record>Verify Hypertext links from the Cataloging main menu, or by using the Ctrl + K keystroke. This opens the Hypertext link dialog box. See Figure 2-26.

NOTE:
If the record does not have any links, a message displays. See Figure 2-27.

Figure 2-26. Hypertext links dialog box

Figure 2-27. Missing Hypertext links message
See Table 2-7 that highlights examples of fields in authority records that are validated when Record>Verify Hypertext links is selected.

Table 2-7. Verify Hypertext Links - Authority Records

<table>
<thead>
<tr>
<th>URI</th>
<th>Link Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>670 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>678 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>856 ‡u</td>
<td>‡z or ‡a</td>
</tr>
</tbody>
</table>

See Table 2-8 for a description of valid and invalid links.

Table 2-8. Link Status

<table>
<thead>
<tr>
<th>Link Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid Links</td>
<td>Display underlined and in blue. Clicking a valid link (blue and underlined) initiates that connection.</td>
</tr>
<tr>
<td>Invalid Links</td>
<td>Display in red with a diagnostic message. Invalid links can be corrected by editing the hypertext field in the MARC record.</td>
</tr>
</tbody>
</table>

System Tab

Pressing Alt + S from an open authority record switches you to the System tab. See Figure 2-28.
The System tab contains the option to approve records for export. All the information relating to **OK to export** is located on the **System** tab, including whether or not the record is OK to be exported (**YES/NO**), the date on which **OK to export** should take effect, the date on which **OK to export** was last set, the operator who set the record as **OK to export**, and the location at which **OK to export** was set.

**OK to Export Option**

The **OK to export** check box is for libraries that export records. You can confirm that the record is acceptable for export by checking the box. You must click the **Save to Database** button for changes to take effect. If the **OK to export** box is already checked, that indicates that an operator has either approved the record for export at an earlier date, or the record was automatically authorized for export when it was imported. To automatically mark records as **OK to export**, see the "Bulk Export of MARC Records" section of the *Voyager Technical User’s Guide*.

When the **OK to export** box is checked, two radio buttons become active on the **System** tab, allowing you to either select the last date on which the **OK to export** option was set, or to select today’s date (**Change to Today** radio button). If you
select Change to Today and then click the Save to Database button, the OK to export date will change to today’s date.

NOTE:
The OK to export option resets during the actual export process. The date, operator, and location at which the OK to export option was last set display below the OK to export check box and the two radio buttons indicating export dates, in the Last set for, By, and At textboxes.

History Tab

Press Alt + Y from an open authority record to switch to the History tab.

The History tab includes a list of every change ever made to an authority record (see Figure 2-29). These changes are described in Table 2-9.

Table 2-9. History Tab Field Descriptions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td>The date and the time the change was made.</td>
</tr>
<tr>
<td>Operator</td>
<td>The operator who made the change (actually the operator name as assigned in System Administration).</td>
</tr>
<tr>
<td>Cataloging Location</td>
<td>The happening location (as defined in System Administration) at which the change was made.</td>
</tr>
<tr>
<td>Action</td>
<td>The action performed on the record (UPDATE, CREATE, MERGE, REPLACE, or RELINK).</td>
</tr>
<tr>
<td>Encoding Level</td>
<td>The encoding level as set in the Leader field of the record.</td>
</tr>
<tr>
<td>Suppress Action</td>
<td>Whether or not the Suppress from OPAC check box was checked on the System tab.</td>
</tr>
</tbody>
</table>
Sorting the columns

You can sort each of the History tab columns in ascending or descending order by clicking the column header.

Lag Time

In cases where a record has undergone massive amounts of changes such as 1000, you may find a small lag time when you click the History tab (or select Alt + Y). This is because the History tab is dynamically updated by your Voyager system each time you click it. The lag time should not be more than a few seconds.

Holdings Records

Holdings Records (MFHDs) contain all the holdings information for bibliographic records. A holdings record can be created by selecting Record>Create Holdings, or by clicking the Create Holdings button when a bibliographic record is the active record. Before you can save a holdings record to the database, you must define field 852 subfield b with a valid location code (as defined in System Administration).

The Holdings Record window (see Figure 2-30) consists of four tabs.
Cataloging User’s Guide

- MARC tab
- System tab
- Bib Title(s) tab
- History tab

Figure 2-30. Holdings Record - MARC Tab

MARC Tab

The MARC tab of a holdings record contains a Leader, an 008 fixed field, and variable fields. It also contains only one 007 fixed field. All values correspond to the published MARC standard.

Once a holdings record is saved to the database (see Saving a Record on page 4-9) the title of the associated bibliographic record is displayed on the title bar of the holdings record, and on the BibTitle(s) tab.

Holdings Leader

The Holdings Leader field allows you to select the Record Status, Type of Record, and Encoding Level.

The Holdings Leader field displays as a grid which is completely configurable using Voyager’s MARC tag tables. See MARC Tag Tables on page A-1 for details on the MARC tag tables.
The procedure for configuring the holdings leader is shown in Procedure 2-12, Configuring the Holdings Leader, on page 2-41.

Procedure 2-12. Configuring the Holdings Leader

Use the following to configure the holdings leader.

1. Click the Leader button from the MARC tab of an open holdings record. The Leader dialog box (see Figure 2-31) for holdings information displays as a grid.

![Leader dialog box for holdings information](image)

2. Select values from the grid by clicking a particular cell and then the down arrow to display drop-down menu selections.

You must use either the mouse or the up and down arrows on your keyboard to move from cell to cell within the grid. To use the latter, first click in a particular cell and then use the up and down arrows to navigate from cell to cell. Do not click the down arrow. This causes you to browse the selections within a particular drop-down menu. Note that you cannot use the Tab key to move from cell to cell on the grid. This takes you outside the grid altogether.
To display and browse drop-down menu selections, click the **down arrow** or press **F4** or the space bar. Use the **up** and **down arrows** on your keyboard to navigate within the drop-down menu. From within a drop-down menu, you can enter the letter or number that precedes a particular selection. For instance, if you want to jump from subfield **z** within the drop-down menu to subfield **a**, you can simply press the letter **a**.

3. Click **OK** to exit and save your work; click **Cancel** or **Esc** to exit without saving.

### Holdings 007 Fixed Field

The **007** field is a non-repeatable field that allows you to define a material category.

The Holdings **007** field displays as a grid which is completely configurable using Voyager’s MARC tag tables. See **MARC Tag Tables** on page A-1 for details on the MARC tag tables.

The procedure for configuring the holdings **007** fixed field is shown in **Procedure 2-13. Configuring the Holdings 007 Fixed Field**, on page 2-42.

#### Procedure 2-13. Configuring the Holdings 007 Fixed Field

Use the following to configure the holdings **007** fixed field.

1. Click the **007** button (see Figure 2-32) from the **MARC** tab of an open holdings record.

![007 Button](image-url)

**Figure 2-32. 007 Button**

Result: The **007** field displays a tabbed dialog box (see Figure 2-33).
2. Select a tab on which you want to enter values.

**NOTE:**
You can use keyboard shortcuts to access tabs without the use of the mouse by holding down the Alt key and the key that is underlined on the tab name. For example, from the 007 dialog box in Figure 2-34, you can use the Alt+m keystroke to access the Maps tab without using the mouse. See MARC Tag Tables on page A-1 for details on how to define your own keyboard access keys.

3. Click the New button at the bottom of the dialog box to add a category. A grid displays with various drop-down menus (Figure 2-34). Select values from the grid by clicking a particular cell, and then the down arrow to display drop-down menu selections.

After you make your selections, click Apply. Notice that a check displays in the check box indicating that values have been selected for that tab such as in Figure 2-34 values have been added and applied on the Map tab).

You must use either the mouse or the up and down arrows on your keyboard to move from cell to cell within the grid. To use the latter, first click in a particular cell and then use the up and down arrows to navigate from cell to cell. Do not click
the **down arrow**. This causes you to browse the selections within a particular drop-down menu. Note that you cannot use the **Tab** key to move from cell to cell on the grid. This takes you outside the grid altogether.

To display and browse drop-down menu selections, click the **down arrow** or press **F4** or the space bar. Use the **up** and **down arrows** on your keyboard to navigate within the drop-down menu. From within a drop-down menu, you can enter the letter or number that precedes a particular selection. For instance, if you want to jump from subfield **z** within the drop-down menu to subfield **a**, you can simply press the letter **a**.

![Figure 2-34. 007 - Physical Description dialog with grid displayed](image)

**NOTE:**
Provided you have entered and applied values for the tab, you do not have to click the **New** button the next time you select that particular tab. Rather, the tab displays in grid format with the values you selected.

4. Update a category: Complete the fields and click the **Apply** button. This will make the change(s) to the current display.

5. Delete a category: Click the **Delete** button.

6. Exit the **007** Field display: Click the **Close** or **Esc** buttons. Any changes you have made will not be saved unless the **Apply** or **Delete** buttons were clicked.
Holdings 008 Fixed Field

The 008 is a header in the main record used to describe the main format in the Leader. The 008 is required and nonrepeatable.

The Holdings 008 field displays as a grid which is completely configurable using Voyager's MARC tag tables. See MARC Tag Tables on page A-1 for details on the MARC tag tables.

The procedure for configuring the holdings 008 fixed field is shown in Procedure 2-14, Configuring the Holdings 008 Fixed Field, on page 2-45.

Procedure 2-14. Configuring the Holdings 008 Fixed Field

Use the following to configure the holdings 008 fixed field.

1. Click the 008 button (see Figure 2-35) from the MARC tab of an open holdings record.

Figure 2-35. 008 Button

Result: The 008 dialog box (see Figure 2-36) opens in a grid format.
2. In the Cancellation Date, Number of Copies, and Date of Report fields, enter values if applicable.

3. Select other values from the grid by clicking a particular cell, and then the **down arrow** to display drop-down menu selections.

You must use either the mouse or the **up** and **down arrows** on your keyboard to move from cell to cell within the grid. To use the latter, first click in a particular cell and then use the **up** and **down arrows** to navigate from cell to cell. Do not click the **down arrow**. This causes you to browse the selections within a particular drop-down menu. Note that you cannot use the **Tab** key to move from cell to cell on the grid. This takes you outside the grid altogether.

To display and browse drop-down menu selections, click the **down arrow** or press **F4** or the space bar. Use the **up** and **down arrows** on your keyboard to navigate within the drop-down menu. From within a drop-down menu, you can enter the letter or number that precedes a particular selection. For instance, if you want to jump from subfield **z** within the drop-down menu to subfield **a**, you can simply press the letter **a**.

**NOTE:**

For a Holdings record created in the Cataloging module, the default Method of Acquisition is **u** (for unknown).
4. After you make your selections, click **OK** to exit and save your work; click **Cancel** or **Esc** to exit without saving.

Variable Fields (MARC Tab)

The Variable Fields grid allows you to add Tags (with First and Second Indicators), and Bibliographic Data (subfields). The system grid template provides the required Location/Call Number (852 tag) row with the subfield **b** entered with the location specified in Session Defaults (see 10-1).

**NOTE:**
Voyager accepts Dewey call numbers that have more than one decimal point, as well as call numbers that only have a decimal point after the Dewey root/Cutter combination such as D255.2F K88 v.3; B985 DUN.B.

In order to add or edit in the Variable Fields grid, you must first place your cursor in that grid. To do this, position and click your mouse in the Variable Fields portion of the record.

The procedure for adding variable fields is shown in **Procedure 2-15, Adding Variable Fields**, on page 2-47.

**Procedure 2-15. Adding Variable Fields**

Use the following to add variable fields.

1. Select **Edit>Insert Field Before** (F3) or **Edit>Insert Field After** (F4) to add a tag to the grid.

2. Select the Tag cell by clicking in the cell under Tag heading. Type the tag or press **F2** to select a valid tag from the Cataloging Tips scroll box. The tag displays in the cell.

3. Select an indicator by clicking in the indicator cell. Type the indicator or press **F2** to select a valid indicator from the Cataloging Tips scroll box. A number representing the indicator displays in the indicator cell.

4. Select the Bibliographic Data cell. Press **F9** to insert a subfield delimiter in the cell. Enter the subfield or press **F2** to select a valid subfield from the Cataloging Tips scroll box. Enter the subfield data. If necessary, click the ellipse box to expand the data cell.
To delete a tag, click the row label (the grey, left column). Press the **Delete** key and respond to the confirmation message.

**NOTE:**
A function has been added to the Cataloging module allowing you to automatically add a bibliographic record call number **852 h** and **852 i** into a holdings record. This function is discussed in [Get Call Number from Bib Record](#) on page 2-48.

---

**Get Call Number from Bib Record**

The get call number from bib record function improves material processing by automatically adding a call number to an existing MFHD. This MFHD can either lack a call number or contain an existing call number that needs to be replaced.

**Workflow Examples**

Below are two instances in which the get call number from bib record function would be useful.

- The get call number from bib record function would be useful when a MFHD is created without a call number (e.g., in Acquisitions). Holdings records do not, as a rule, include a call number when they are created in Acquisitions. Usually, they contain only a location (**852b** field).
- Get call number from bib record would also be useful when an existing MFHD has a call number that is being replaced. Perhaps your library is engaging in a retrospective conversion or a re-classification project in which call numbers are being reviewed and/or replaced.

In either of these instances, using the get call number from bib record function would simplify the insertion of the call number into the MFHD (**852h** and **852i** fields). Rather than having to type in the call number or copy and paste the call number from the MFHD’s associated bibliographic record, the call number could be automatically inserted into the MFHD (via the appropriate menu option). This minimizes keystrokes and associated errors. It also eliminates the overall awkwardness of copying the call number from an open bib record and pasting it into the appropriate MFHD field.

**NOTE:**
If a bibliographic record contains multiple instances of call number information as specified in the call number hierarchy such as more than one **090 ‡a**, the system adds the last instance of the call number information, **090 ‡a**, to subfield **h** and subfield **i** of the MFHD.
Setting Up to Use Get Call Number from Bib Record

You must select a call number hierarchy in Cataloging’s Session Defaults and Preferences in order to use get call number from bib record. The call number hierarchy indicates the type of call number such as LC or Dewey placed in the MFHD. For instance, if you want an LC call number to be placed in the MFHD, you would select the LC call number hierarchy. If you do not select a call number hierarchy in Cataloging’s Session Defaults and Preferences, you are not able to use the get call number from bib record function.

⚠️ IMPORTANT:
The fields of the bibliographic record in which the system checks for call numbers such as 050, 082, 090, and so on differ for each call number type. You must define these fields for each call number type in the System Administration module, and then select the call number type as part of the appropriate Cataloging Policy Group. See the Voyager System Administration User’s Guide for details.

The procedure for setting the call number hierarchy is shown in Procedure 2-16, Setting the Call Number Hierarchy, on page 2-49.

Procedure 2-16. Setting the Call Number Hierarchy

Use the following to set the call number hierarchy.

1. Select Options>Preferences from the Cataloging toolbar.

   Result: The Session Defaults and Preferences dialog box opens.

2. From the General tab, click the arrow at the far right of the Call Number Hierarchies drop-down menu.

   Result: A list with hierarchy names, codes, and call number classes displays (see Figure 2-37).

3. Select from the list the call number hierarchy you want to input in the MFHD, and click the OK button.

   Example: If you want to have an LC call number placed in the MFHD, select the LC call number hierarchy.
NOTE:
Each call number hierarchy is associated with a holdings/item default location (defined in Voyager’s System Administration module for the appropriate Cataloging Policy Definition to which the holdings/item default location belongs). If you select a call number hierarchy in Cataloging’s Session Defaults and Preferences that is not associated with the specified holdings/item default location, you get a warning message (see Figure 2-38).

If you select Yes, the classification scheme for the call number hierarchy is changed in Cataloging. If you select No, the classification scheme for the call number hierarchy is not changed. You get the same message when you log into the Cataloging module if the hierarchy selected still does not match the holdings/item default location.
Figure 2-38. Setting call number hierarchy to a non-corresponding default holdings/item location

Using Get Call Number from Bib Record

Once setup is complete, you are ready to use the following procedure to get the call number from the bibliographic record.

The procedure for getting a call number from a bibliographic record is shown in Procedure 2-17, Getting Call Number from Bibliographic Record, on page 2-51.

Procedure 2-17. Getting Call Number from Bibliographic Record

Use the following to get a call number from a bibliographic record.

1. Retrieve an existing MFHD using standard Cataloging functions.

   IMPORTANT:
   *It is not required to have the MFHD’s corresponding bib record open to use the get call number from bib record function. However, you can have the bib record open if you wish. The system will know which bib record corresponds to the MFHD because bib records and MFHDs are linked in Voyager.*

2. When you are ready to insert the call number, select Record>Get call number from bib record from the Cataloging toolbar (see Figure 2-39), or use the Ctrl+n keystroke. This causes the call number to be placed in the 852|h and 852|i field of the MFHD. The call number is automatically placed in the appropriate field regardless of where your cursor is positioned in the MFHD fields.
NOTE:
If you only have a bib record open but not a MFHD, the **Record>Get call number from bib record** menu option is grayed out, and the **Ctrl+n** keystroke does not do anything.

![Figure 2-39. Get call number from bib record menu option](image)

NOTE:
If the associated bib record does not include the call number fields defined in the call number hierarchy you selected such as the fields are deleted, get call number from bib record does not work. You still see the function on the **Record** menu of the Cataloging toolbar (it is not grayed out), but selecting the function does not cause an effect in the MFHD 852 field. For example, if you have selected an LC call number hierarchy based on the 050 field, but the associated bibliographic record does not contain the 050 field, you are not able use the function.
On the other hand, if the associated bib record includes call number fields that are empty of data, you receive two warning messages when using get call number from bib record.

The first message informs you that the call number field is invalid, and that you need to check for the presence of subfield diameters and codes. Then, if you click **OK**, you receive a second message.

The second message informs you that the system is unable to assemble the holdings record (or unable to assemble the bib record if the associated bib record is open). For example, if the MFHD’s associated bib record contains an **050** field that is empty of data but the field itself is not deleted, you receive the two warning messages.

3. Save your MFHD in standard Voyager Cataloging fashion.

**NOTE:**
In cases where you are replacing an existing call number with one from the same classification scheme or not, you receive a warning message before the call number is replaced. See Figure 2-40. If you click **Yes**, the existing call number will be replaced; if you click **No**, the call number will not be replaced.

![Message for replacing an existing call number with a new one](image)

Figure 2-40. Message for replacing an existing call number with a new one

If you are replacing the call number with one from a different classification scheme such as LC to Dewey), you receive a second warning message. See Figure 2-41. This warning message ensures that you are aware that the existing call number is from a different classification scheme than the new one. If you click **Yes**, the call number is replaced. This also automatically changes the **852** field’s first indicator to the appropriate value. If you click **No** the call number is not replaced.
Verify Hypertext Links - Holdings Records

You can verify the integrity of hypertext links in the current holdings record (or bibliographic or authority records ... see Links - Verify Hypertext Links for Bibliographic Records on page 2-23 and/or Verify Hypertext Links - Authority Records on page 2-35) by selecting Record>Verify Hypertext links from the Cataloging main menu, or by using the Ctrl + K keystroke. This opens the Hypertext link dialog box. See Figure 2-42.

NOTE:
If the record does not have any links, a message displays. See Figure 2-43.
Figure 2-43. Missing Hypertext links message

See Table 2-10 that highlights examples of fields in holdings records that are validated when Record>Verify Hypertext links is selected.

Table 2-10. Verify Hypertext Links - Holdings Records

<table>
<thead>
<tr>
<th>URI</th>
<th>Link Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>563 ‡u</td>
<td>‡a</td>
</tr>
<tr>
<td>583 ‡u</td>
<td>‡z or ‡a</td>
</tr>
<tr>
<td>856 ‡u</td>
<td>‡y or ‡z</td>
</tr>
</tbody>
</table>

See Table 2-11 for a description of valid and invalid links.

Table 2-11. Link Status

<table>
<thead>
<tr>
<th>Link Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid Links</td>
<td>Display underlined and in blue. Clicking a valid link (blue and underlined) initiates that connection.</td>
</tr>
<tr>
<td>Invalid Links</td>
<td>Display in red with a diagnostic message. Invalid links can be corrected by editing the hypertext field in the MARC record.</td>
</tr>
</tbody>
</table>

System Tab

Pressing Alt + S from an open holdings record switches you to the System tab.

The System tab contains the options to approve records for export and to suppress records from OPAC. In addition, the Owning Library for the record displays. See Figure 2-44.

All the information relating to OK to export is located on the System tab to include the following.

- Whether or not the record is OK to be exported (YES/NO)
The date on which the **OK to export** option should take effect
The date on which the **OK to export** option was last set
The operator who set the record as **OK to export**
The location at which **OK to export** was set

---

Figure 2-44. Holdings Record: System Tab

**OK to Export Option**

The **OK to export** option is used by libraries that export records. See the "Bulk Export of MARC Records" section of the *Voyager Technical User’s Guide* for details on exporting records.

Checking the **OK to export** box confirms that the holdings record is acceptable for export. You must click the **Save to Database** button for it to take effect. If the **OK to export** box already contains a check mark, that indicates that an operator has either approved the record for export at an earlier date, or the record was automatically authorized for export when it was imported. To automatically mark records as **OK to export**, see the "Bulk Export of MARC Records" section of the *Voyager Technical User’s Guide*.

When **OK to export** is set and the record has been saved to the database, two radio buttons become active on the **System** tab. These radio buttons allow you to either select the last date on which the **OK to export** option was set, or to select
today's date (Change to Today radio button). If you select Change to Today and then click the Save to Database button, the OK to export date will change to today's date.

**NOTE:**
The OK to export option resets during the actual export process. The date, operator, and location at which the OK to export option was last set display below the OK to export check box and the two radio buttons indicating export dates, in the Last set for:, By:, and At: textboxes.

### Suppress from OPAC Option

To prevent a holdings record from displaying in the OPAC module, mark the Suppress from OPAC check box. This does not prevent the display in OPAC of information from the bibliographic record. However, this prevents information from attached item records from displaying in the OPAC. However, if the Suppress from OPAC check box for a location is checked in the System Administration module, you cannot uncheck the Suppress from OPAC check box in Cataloging. See the "Locations" section of the Voyager System Administration User's Guide for details.

**TIP:**
When the Suppress from OPAC box is checked, the small book icon in the top left corner of the record is greyed. When the check box is unchecked, the icon displays in a reddish-burgundy shade. This gives you a visual indication of the status of the record.

### Bib Title(s) Tab

The Bib Title(s) tab (see Figure 2-30) shows the associated bibliographic ID and title for the holding. Double-click the title to display the bibliographic record.
Figure 2-45. Holdings Record Bib Title(s) Tab

Typically, only one title displays. If the holding record is bound with, multiple titles display, one title for each bibliographic record within the bound holding.

History Tab

Press Alt + Y from an open holdings record to switch to the History tab.

The History tab includes a list of every change ever made to a holdings record. See Figure 2-46. These changes are described in Table 2-12.

Table 2-12. History Tab Field Descriptions

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td>The date and the time the change was made.</td>
</tr>
<tr>
<td>Operator</td>
<td>The operator who made the change (actually the operator name as assigned in System Administration).</td>
</tr>
<tr>
<td>Cataloging Location</td>
<td>The happening location (as defined in System Administration) at which the change was made.</td>
</tr>
<tr>
<td>Action</td>
<td>The action performed on the record (UPDATE, CREATE, MERGE, REPLACE, or RELINK).</td>
</tr>
<tr>
<td>Encoding Level</td>
<td>The encoding level as set in the Leader field of the record.</td>
</tr>
<tr>
<td>Suppress Action</td>
<td>Whether or not the Suppress from OPAC check box was checked on the System tab.</td>
</tr>
</tbody>
</table>
Chapter 2: Record Types and Creating

Sorting the columns

You can sort each of the History tab columns in ascending or descending order by clicking the column header.

Lag Time

In cases where a record has undergone massive amounts of changes such as 1000, you may find a small lag time when you click the History tab (or select Alt + Y). This is because the History tab is dynamically updated by your Voyager system each time you click it. The lag time should not be more than a few seconds.

Viewing and Editing Line Items from Holdings Records

It is possible to view (and then manipulate) a line item in the Acquisitions module from the associated bibliographic or holdings record in the Cataloging module. This feature is known as Acquisitions in Cataloging or Acq in the Cat.
Acq in the Cat is the second half of the two-way communication between the Acquisitions and Cataloging modules. See the "Viewing and Editing MARC Records" section of the Voyager Acquisitions User’s Guide for details. Cat in the Acq allows you to view and then edit a MARC record in the Cataloging module from the associated line item in the Acquisitions module.

For details and instructions on using the Acq in the Cat feature, see Viewing and Editing Line Items (Acquisitions in Cataloging) on page 3-86.

Item Records

An Item Record (see Figure 2-47) describes a single item owned by your institution. An item record can be created by selecting Record>Create Items, or by clicking the Create Items button when a bibliographic or holdings record is the active record.

Figure 2-47. Example of an Item Record
Checking for Duplicate Barcodes - Item Records

Any time an item barcode is being created or edited, Voyager tests for the existence of duplicate barcodes in the database. When the barcode you are attempting to attach to an item is already in use elsewhere, you will be advised of this fact with a dialog box and asked if the barcode should be used anyway.

You may enable or disable this feature by clicking the Check for Duplicate Item Barcodes check box on the Work Flow tab in Cataloging’s Session Defaults and Preferences (see Figure 2-48).

---

Figure 2-48. Enabling/Disabling the Check for Duplicate Barcodes option
Header Information

You cannot add to or change the item record information described in Table 2-13.

Table 2-13. Item Record Header Information

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title(s)</td>
<td>Lists the title of the item. If more than one bibliographic record is attached to that item record such as two books in one binding, this section displays a drop-down list with all associated titles.</td>
</tr>
<tr>
<td>Location</td>
<td>The location's name from the holdings record.</td>
</tr>
<tr>
<td>Call #</td>
<td>The call number, as specified in the 852 field of the holdings record.</td>
</tr>
</tbody>
</table>

Location and Type

You can add to or change the information described in Table 2-14 by selecting from the appropriate drop-down list(s). However, if a location is assigned to an item, and that location does not belong to a Circulation Group as defined in System Administration, then that item cannot be charged to any patron.

Table 2-14. Item Record Location Options

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perm. Loc</td>
<td>The item's permanent location.</td>
</tr>
<tr>
<td>Item Type</td>
<td>The item's permanent type.</td>
</tr>
<tr>
<td>Temp. Loc.</td>
<td>The item's temporary location (if any).</td>
</tr>
<tr>
<td>Temp. Type</td>
<td>The item's temporary assigned type (if any).</td>
</tr>
<tr>
<td>Media Type</td>
<td>The item's media type (if any).</td>
</tr>
</tbody>
</table>

Item/Holdings

You can add to or change the information described in Table 2-15 by entering the appropriate text.

Table 2-15. Item Record Holdings Options

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enumeration</td>
<td>The item's enumeration such as the volume number.</td>
</tr>
</tbody>
</table>
### Table 2-15. Item Record Holdings Options

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chronology</td>
<td>The item's chronology such as April.</td>
</tr>
<tr>
<td>Year</td>
<td>The enumeration year (if serially published) or the publication year (if an individual item).</td>
</tr>
<tr>
<td>Caption</td>
<td>Any additional title information.</td>
</tr>
<tr>
<td>Free Text</td>
<td>Any additional item information.</td>
</tr>
<tr>
<td>Spine</td>
<td>Any additional item information that displays on the spine label.</td>
</tr>
<tr>
<td>Note</td>
<td>Click the Note icon. See Figure 2-49. Enter any note that relates to the item up to 910 characters.</td>
</tr>
</tbody>
</table>

---

**Figure 2-49.** Item record Note icon
Item Details

You can add to or change the following information by entering the appropriate text.

Table 2-16. Item Record Detail Options

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Barcode</td>
<td>This is the barcode for the item. There can be one active and possibly several inactive barcodes in a drop-down list.</td>
</tr>
</tbody>
</table>

**NOTE:** Pressing either F4 or the ellipses button brings up the Barcodes dialog box from which you can add or delete barcodes. The F4 button does not bring up the Barcodes dialog box if the item record is new and has not yet been saved to the database. Likewise, the ellipses button is disabled if the record is new and has not yet been saved to the database. If you click inside another field before pressing F4, the Barcodes dialog box does not display.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>The copy number.</td>
</tr>
<tr>
<td>Pieces</td>
<td>The number of pieces that go with the item.</td>
</tr>
<tr>
<td>Price</td>
<td>The item price. If no price is assigned, and replacement costs are designated to be calculated for lost items, the default replacement for the item type is used.</td>
</tr>
</tbody>
</table>

Statuses

Each item record has a status field that describes the item's state of being such as checked out or damaged. If more than one status applies, the items are kept in reverse chronological order according to the date they were assigned. The Status button is shown in Figure 2-50.

Figure 2-50. Status Button
NOTE:
You can only view item statuses when an item record is the active record.

See the Voyager WebVoyage User’s Guide for information about user-defined item status terminology in OPAC.

Table 2-17 contains a complete list of possible statuses. Statuses are listed according to rank. A status is only viewed in the module if all of the other statuses currently applied to the item are below it in rank. Thus, a status higher on the list takes precedence over a status lower on the list.

### Table 2-17. Possible Statuses Listed According to Rank

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled</td>
<td>Assigned automatically when the item has been scheduled by the Media Scheduling module.</td>
</tr>
<tr>
<td>In Process</td>
<td>Assigned manually when the item’s record is being reviewed, or some similar activity is being performed.</td>
</tr>
<tr>
<td>Lost (system)</td>
<td>The status is automatically assigned to overdue items that have not been returned within an interval defined by the library. The system will not calculate additional late fees once this status is given.</td>
</tr>
<tr>
<td>Lost (library)</td>
<td>The status is manually assigned to overdue items that have not been returned within an interval defined by the library. The system will not calculate additional late fees once this status is given.</td>
</tr>
<tr>
<td>Missing</td>
<td>The item has been labeled missing according to library policies. May be manually assigned.</td>
</tr>
<tr>
<td>At bindery</td>
<td>The item has been sent to the bindery. This status can only be assigned manually.</td>
</tr>
<tr>
<td>Charged</td>
<td>Currently charged to a patron with a future due date. Automatically assigned.</td>
</tr>
<tr>
<td>Renewed</td>
<td>Currently charged to a patron for an additional period with a future due date. Automatically assigned.</td>
</tr>
<tr>
<td>Overdue</td>
<td>Currently charged to a patron with a past due date, but not yet lost or stolen. Automatically assigned.</td>
</tr>
</tbody>
</table>
Table 2-17. Possible Statuses Listed According to Rank

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Hold</td>
<td>An item is on a hold shelf waiting for the patron who placed a recall/hold request for the item. Automatically assigned.</td>
</tr>
<tr>
<td>In Transit</td>
<td>An item is en route from one location to another. May be manually assigned.</td>
</tr>
<tr>
<td>In Transit (Discharged)</td>
<td>A courtesy discharge has taken place and the item is now on its way home. Automatically assigned.</td>
</tr>
<tr>
<td>In Transit (On Hold)</td>
<td>An item is en route to a hold shelf at a location selected by the requesting patron. Automatically assigned.</td>
</tr>
<tr>
<td>Recall Request</td>
<td>One or more patrons have placed a request for an item currently charged to another patron; a recall request can shorten the loan interval in effect. Automatically assigned.</td>
</tr>
<tr>
<td>Hold Request</td>
<td>One or more patrons have placed a request for an item that may or may not be currently charged to another patron. A hold request never affects the loan interval if the item is currently charged. Automatically assigned.</td>
</tr>
<tr>
<td>Short Loan Request</td>
<td>One or more patrons have placed a short loan request for an item.</td>
</tr>
<tr>
<td>Remote Storage Request</td>
<td>One or more patrons have placed a request for an item that is in a remote storage area.</td>
</tr>
<tr>
<td>Call Slip Request</td>
<td>One or more patrons have placed a request for an item in a closed stacks area.</td>
</tr>
<tr>
<td>Discharged</td>
<td>An item has been discharged and is currently on the shelf or in its way there and is in effect until the expiration of the circulation policy group shelving interval. Automatically assigned.</td>
</tr>
<tr>
<td>Not Charged</td>
<td>Should be on the shelf and is assigned after discharge and expiration of shelving interval for the applicable circulation policy group. Automatically assigned.</td>
</tr>
<tr>
<td>Catalog Review</td>
<td>The item has been marked for Catalog review. May be manually assigned.</td>
</tr>
</tbody>
</table>
The procedure for assigning a status is shown in Procedure 2-18, Assigning a Status, on page 2-67.

Table 2-17. Possible Statuses Listed According to Rank

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Circulation Review</td>
<td>The item has been marked for Circulation review. May be manually assigned.</td>
</tr>
<tr>
<td>Claims returned</td>
<td>A patron reports an item as having been returned, but there is no record of discharge. Usually such an item is also overdue and possibly missing or lost. May be manually assigned. This status only exists with other statuses and takes on the rank of the other status.</td>
</tr>
<tr>
<td>Damaged</td>
<td>The item has been damaged according to library policies. May be manually assigned. This status only exists with other statuses and takes on the rank of the other status.</td>
</tr>
<tr>
<td>Withdrawn</td>
<td>The item has been withdrawn from the circulating collection. May be manually assigned. This status only exists with other statuses and takes on the rank of the other status.</td>
</tr>
</tbody>
</table>

The procedure for assigning a status is shown in Procedure 2-18, Assigning a Status, on page 2-67.

Procedure 2-18. Assigning a Status

Use the following to assign a status to an item.

1. Select Item>View Status. The Item Status dialog box opens (see Figure 2-51).
Figure 2-51. Item Status dialog box

There are two areas displayed for status information, the actual applied Status box, and the Status List which contain the possible statuses. The number, if any, which displays at the top of the dialog box is the barcode assigned to the current item.

2. To apply a status, select the appropriate status from the Status List drop-down list and click the blue up arrow (see Figure 2-52). The status displays in the Status box. Once a status is applied to an item, it is no longer available in the Status List.

To delete the status, highlight the appropriate status in Status box and click the red down arrow (see Figure 2-52). The status returns to the Status List drop-down list.

Figure 2-52. Blue Up and Red Down Buttons

3. Click the OK button to save the item statuses you’ve added or deleted and close the Item Status dialog box.
Statistical Categories

For statistical purposes, a site can define types of item characteristics that are not needed for cataloging but are useful for statistical compilations. The statistical categories are not associated with any one item type and there is no limit on the number created. When an operator creates a item record and assigns the item type an operator can select one or more statistical categories from the list. The **Statistical Categories** button is shown in Figure 2-53.

![Figure 2-53. Statistical Categories Button](image)

Item Statistical Categories are defined from System Administration and can only be assigned manually.

**NOTE:**
You can only view item statistical categories when an item record is the active record.

The procedure for assigning Statistical Categories is shown in **Procedure 2-19, Assigning Statistical Categories**, on page 2-69.

**Procedure 2-19. Assigning Statistical Categories**

Use the following to assign a statistical category to an item.

1. Select **Item>View Statistics**. The **Item Statistical Categories** dialog box opens (see Figure 2-54).
There are two areas displayed for category information, the actual applied Statistical Category box, and the Statistical Categories List which contain the possible categories. The number which displays at the top of the dialog box is the barcode assigned to the current item.

2. To apply a statistical category, select the appropriate category from the **Statistical Categories List** and click the blue **up arrow** (see Figure 2-55). The category displays in the Statistical Categories box. Once a category is applied to an item, it is no longer available in the Statistical Categories List.

3. Click the **OK** button to save the statistical categories that you have added or deleted and close the **Item Statistical Categories** dialog box.
Creating, Opening, and Viewing Records

Creating and Opening Records

• Creating a Record 3-1
• Opening a Record 3-8
  From a Work Folder 3-8
  From the OPAC 3-9
• Bibliographic Tree 3-9
• Importing Records 3-10
  Importing Records From a File 3-11
  Importing Records From Another Database 3-14
  Invalid Records 3-22
  Accessing Replaced or Deleted Files 3-22
• Creating New Bibliographic Records from Image Server 3-23

Viewing Information 3-25

Search Dialog Box 3-26

• Keyword Tab and Keyword Searching 3-27
  Command Line Searching 3-30
  Other Keyword Search Considerations/Options 3-31
• Index Selection Tab 3-32
  Find and Browse Searches 3-36
  Heading Searches by Call Number 3-37
  Headings Keyword Searches 3-37
• Builder Tab and Builder Searching 3-39
• History Tab 3-42
Cataloging User's Guide

Titles Index Dialog Box 3-43
• Search Results List Re-Sort Options 3-46
  Re-Sort Configuration Options 3-47
  Considerations for Re-sorting Search Results 3-49

Holdings Index Dialog Box 3-50

Headings List Dialog Box 3-52
• Reference Information Dialog Box 3-56
  Scope Notes 3-57
  Narrower Term 3-58
  See Also 3-58
• Select one or more authority records Dialog Box 3-59

Perform a Keyword Search 3-60

Perform an Index Selection Search 3-63

Perform a Builder Search 3-65

Access/Review the History Tab 3-68

Remote Searching 3-69
• Remote Databases 3-69
• Voyager Connection Options Dialog Box 3-70
• Searching Remote Databases 3-71

User-Defined Alternate Search Button 3-77

Setting Search Preferences 3-78
• Retain Last Search 3-78
• Automatic Truncation for Index Selection Searches 3-79
• Display Bibliographic Record Directly If Search Results In Only One Title 3-79

Search Limits 3-79
• Search Limits Dialog Box 3-80
• Limits.ini File 3-81
  Limits Stanza 3-82
  Search Limits Stanzas 3-83
• Limiting a Search 3-89

MFHD-Bibliographic Combined Keyword Search (optional feature) 3-92
• Setup 3-94
• Search Options 3-95
• Search Results Display 3-95
• User Considerations 3-95
Chapter 3: Creating, Opening, and Viewing Records

Searching in Cataloging Examples 3-96
• Keyword Search in the Cataloging Module 3-96
• Index Selection Search in the Cataloging Module 3-103
• Builder Search in the Cataloging Module 3-107

Additional Options for Displaying a Record - Web Server http POST 3-110

Viewing and Editing Line Items (Acquisitions in Cataloging) 3-111
• System Administration Setup 3-112

Retrieving Records Associated with Other Records 3-117
• Retrieve Holdings 3-117
• Retrieve Authority 3-119
• Retrieve Items 3-119
• Retrieve Bibliographic Record (Shortcut) 3-121

Viewing Holdings Locations 3-122

Linking and Unlinking Records 3-123
• Link Item to Bib 3-123
• Relink an Item to a Different Holdings 3-124
• Unlinking Holdings and Bib Records 3-125
• Copying an Item Record from an Existing Item Record 3-126
Creating, Opening, and Viewing Records

Creating and Opening Records

This section describes creating and working with records in the Cataloging module.

Creating a Record

Before you can create a record, there must be at least one template for the type of record that you want to create in the Cataloging folder of the Voyager directory. The Cataloging client comes installed with the following templates.

- bib.tem
- auth.tem
- hldg.tem

For information on creating your own templates, see Creating a New Template on page 8-2.

This section describe how to create new records for the following.

- Authority/Bibliographic entries. See Procedure 3-1, Creating a New Record, on page 3-2.
- Holdings when a bibliographic record is open. See Procedure 3-2, Creating a Holdings Record When a Bibliographic Record is Open, on page 3-5.
Item entries from an active Holdings record. See Procedure 3-3, Creating an Item Record from an Active Holdings Record, on page 3-7.

The procedure for creating a new record is shown in Procedure 3-1, Creating a New Record, on page 3-2.

Procedure 3-1. Creating a New Record

Use the following to create a new record.

1. Select from the toolbar Record>New>Authority or Record>New>Bibliographic (Or click the arrow next to the Create a new record from a template button, and select Authority or Bibliographic. See Figure 3-1.)

Figure 3-1. New Record Button

NOTE:
You can only choose between creating a new Authority or Bibliographic record here because Holdings records can only be created when a Bibliographic record is the active record, and Item records can only be created when a Holdings record is the active record.

Result: The Select Bibliographic Template dialog box opens (see Figure 3-2) if you have not specified a particular template in your Session Defaults and Preferences. Session Defaults and Preferences allows you to specify a file path for the Authority/Bibliographic templates. Your result may differ depending on what Session Defaults and Preferences have been set.
Chapter 3: Creating, Opening, and Viewing Records

Figure 3-2. Selecting a template for a new record

2. Select the template you want to use, and click **Open**. (If you have specified a template in your Session Defaults and Preferences, this dialog box does not open.)

Result: The new record displays (see Figure 3-3) with a minimal template that contains a **Leader**, fixed fields, and variable fields.
NOTE:
You must select a template from the Select Bibliographic Template or Select Authority Template dialog box that corresponds with the type of record you elected to create. For example, if you elected to create an Authority record, you can only choose a template for Authority records. Otherwise, you get the following error message (see Figure 3-4).

3. Complete the appropriate fields in the record and click Save.

The fields entered are different for each record type. For more information, see Bibliographic Records on page 2-3, see Authority Records on page 2-29, see Holdings Records on page 2-39, or see Item Records on page 2-60.
Chapter 3: Creating, Opening, and Viewing Records

Result: A New Record is saved to the database.

**NOTE:**
When adding a Bibliographic record, it is important to remember that the assigned Owning Library is the Owning Library of the Cataloging location the user logs in with. For more details on Owning Libraries, see the *Voyager System Administration User’s Guide*.

The procedure for creating a holdings record when a bibliographic record is open is shown in Procedure 3-2, Creating a Holdings Record When a Bibliographic Record is Open, on page 3-5.

Procedure 3-2. Creating a Holdings Record When a Bibliographic Record is Open

Use the following to create a holdings record when a bibliographic record is open.

1. Select Record>Create Holdings or click the Create Holdings button (see Figure 3-6).

Result: A new holdings record displays for the active bibliographic record (see Figure 3-7) if you have selected a default template in Cataloging’s Session Defaults and Preferences (Folders/Files Tab on page 10-13).

If you have not selected a default template, the Create Holdings button opens the Select Holdings Template dialog box allowing you to navigate to the appropriate template. If you select a template from the Select Holdings Template dialog box that is not a holdings record template, you get the following error message (see Figure 3-5).

![Error message for selecting an inappropriate template](image)

Figure 3-5. Error message for selecting an inappropriate template
NOTE:
If the bibliographic record contains more than one instance of the field that contains the call number, the last one listed in the bibliographic record is used in the new holdings record.

2. Complete the appropriate fields in the record and click Save.

Result: A New Holdings Record is saved to the database.

NOTE:
If the active bibliographic record already has a holdings record associated with it, Voyager opens a dialog box that warns you of the existing holdings record (Figure 3-7). This dialog box only opens if you have not selected Always create a
holding when adding holdings to a bib on the Workflow tab in Cataloging's Session Defaults and Preferences (Work Flow Tab on page 10-9).

From this dialog box you can do the following.

- Retrieve the existing holdings record by clicking the Retrieve button
- Create a new one by clicking the New button
- Cancel by clicking the Cancel button.

⚠️ IMPORTANT:
If the Cataloging user is not allowed to attach a Holdings record to an Owning Library, the Owning Library of the location in the 852|b field is checked against the Owning Library of the linked Bibliographic record. Then, if the Owning Libraries are different, a message is displayed in Cataloging, and the user is barred from saving the Holdings record. This check is only performed if the Location is a valid Location for the user's login. For more details on Owning Libraries, see the Voyager System Administration User's Guide.

The procedure for creating an item record from an active holdings record is shown in Procedure 3-3, Creating an Item Record from an Active Holdings Record, on page 3-7.

Procedure 3-3. Creating an Item Record from an Active Holdings Record

Use the following to create an item record from an active holdings record.

1. Select Record>Create Items, or click the Create Item button (see Figure 3-8).

   Result: A default Item record opens.

2. Complete the appropriate fields, and click Save.
Result: A New Item Record is saved to the database.

Opening a Record

This section describes opening a record from a work folder and from the OPAC.

From a Work Folder

Voyager Cataloging allows you to create, edit, and save records in work folders, as well as in the database. Records that are saved in work folders are called, work records. These records operate in the same way as other records except they are not validated against the MARC tag tables or authority records (until the records are saved to the database). The Open Record from Work Folder button is shown in Figure 3-9.

Figure 3-9. Open Record from Work Folder Button

TIP:
If you are copying records between internal databases, it is recommended that you use the import function instead of saving records to work folders and opening them in the new database. This is because work records keep the 001 field, and no duplication checking occurs between a work record and the database.

The procedure for opening a work record is shown in Procedure 3-4, Opening a Work Record, on page 3-8.

Procedure 3-4. Opening a Work Record

Use the following to open a work record.

1. Select File>Work Record>Open.
Chapter 3: Creating, Opening, and Viewing Records

Result: The Select Work File dialog box opens.

You can specify a folder to which this dialog box defaults in Cataloging’s Session Defaults and Preferences. See Folders/Files Tab on page 10-13 for details.

NOTE:
If Voyager does not find a folder called work, one will be created for you. However, you can open (or save) records to any directory.

2. Click the appropriate record name from the work folder. The suffix of the record file indicates what type of record it is.

Result: The record name is highlighted.

3. Click Open to open the record, or click Cancel to close the dialog box without opening a record.

Result: Open displays the Select work records dialog box. Cancel returns you to the main Cataloging display.

NOTE:
Because the Suppress from OPAC check box is not a part of the MARC 21 record, that information is not saved when the record is saved as a work record. Each time that you retrieve a work record in order to save it to the database, the Suppress from OPAC check box must be marked appropriately.

From the OPAC

To retrieve a record from the Online Public Access Catalog (OPAC), you must use Record>Search to find and open a record. For more information, see Search Dialog Box on page 3-26.

Bibliographic Tree

When you click the Hierarchy button (see Figure 3-10) from an open record (or select Record>Show Associated Records from the Cataloging toolbar), the bibliographic, holdings, items, and bound with information displays in a hierarchy dialog box. The hierarchical tree displays in colors that you set in Cataloging’s Session Defaults and Preferences (see Session Defaults and Preferences on page 10-1).
If more information is associated with the Bibliographic ID or Holdings, a + (plus sign) displays to the left of the preceding ID number. When you click the plus sign, the Holdings, Item, or Bound Withs display (see Figure 3-11). If you want to display a record, highlight it and then click the Retrieve button. Click Close to close the Holdings and Items dialog box.

NOTE:
Holdings records also display any associated on-order information.

Importing Records

You can import MARC-formatted bibliographic and authority records into Voyager using Cataloging’s importing features. Any MARC 21 record can be imported, including records you download from a cataloging utility such as OCLC or RLIN. You can specify the character set to which you want imported records mapped such as the following in Cataloging’s Session Defaults and Preferences.

- Latin1 (non-Unicode)
• MARC 21 MARC8 (non-Unicode)
• MARC21 UTF-8
• OCLC (non-Unicode)
• RLIN legacy (non-Unicode)
• Voyager legacy (non-Unicode)

See Mapping Tab on page 10-15 for more information.

Depending on the Import/Replace profile you have established in the System Administration module, imported records can either replace existing records, merge with existing records, be added to the database, or not be added to the database. See the Voyager System Administration User’s Guide for details on Import/Replace profiles. The Import/Replace profile you establish in System Administration is defined in Cataloging’s Session Defaults and Preferences. See Session Defaults and Preferences on page 10-1 for more information.

Records can be imported in the following ways through the Voyager Cataloging module.

• From a file, a new file, or one you previously accessed
• From another database

NOTE:
Records can also be imported in batch mode which is a method of processing many records as a group versus one at a time. This method utilizes the Voyager BulkImport and Prebulk programs. For more information about utilizing this method for importing, see the Voyager Technical User’s Guide.

Importing Records From a File

The procedure for importing records from a file is shown in Procedure 3-1, Creating a New Record, on page 3-2.

Procedure 3-5. Importing Records From a File

Use the following to import records from a file.

1. Select Record>Import>From new file or Record>Import>From previous file.

You can specify a default folder from which you want to import records in Cataloging’s Session Defaults and Preferences (see 10-13).
Result: The **Select Import File** dialog box opens (see Figure 3-12).

**NOTE:**
For the **Record>Import>From previous file** command to be enabled, you must first select a new file (via the **Record>Import>From new file** command). If you have not selected a new file, or if you exit Cataloging and log back in, the **Record>Import>From previous file** command will be grayed out.

![Select Import File dialog box](image)

**Figure 3-12.** Select Import File dialog box

2. Select the file you want to import and click **Open**.

Result: A dialog box opens, allowing you to select the specific record you want to import (Figure 3-13).
3-13

Figure 3-13. Selecting a record to import

The dialog box that opens when you select a file from which you want to import records includes the four columns described in Table 3-1. See Figure 3-13.

Table 3-1. Description of Column Headings for Import Record List

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seq #</td>
<td>Sequential count of the order in which the record was added to the import file. For example, if the record was added to the import file fourth, the Seq # would be 4.</td>
</tr>
<tr>
<td>ID</td>
<td>Record ID assigned by the database or utility of origin.</td>
</tr>
<tr>
<td>Type</td>
<td>Record type and bibliographic level from bytes 6 and 7 of the Leader field.</td>
</tr>
<tr>
<td>Title/Heading</td>
<td>The 245 field (if a bibliographic record), or the 1XX field (if an authority record).</td>
</tr>
</tbody>
</table>

NOTE:
The number of valid records and the number of invalid records in the file are displayed in the Status bar of the Cataloging module. Invalid records are not displayed in the dialog box listing records to import, and cannot be imported. For resolving problems with invalid records, see Invalid Records on 3-22.

3. Highlight the record(s) you want to import. The number of records you can import at one time depends on your machine’s available memory.

Result: The records are highlighted for import.
4. Click **OK** to import the selected record(s), or click **Cancel** to close the dialog box without importing the selected record(s).

   Result: An imported record is displayed with a new **035** field which contains the old **003**, followed by the **001**.

5. Save the records as work files, or save them to the database.

   Result: Duplication checking occurs when a record is saved to the database. For more information, see [Save to Database](#) on page 4-11.

---

**Importing Records From Another Database**

In addition to importing records from a new or previously used file, it is also possible to import records from another database. You can import records from a remote database directly from the **Search** dialog box, as well as perform a simultaneous search of many databases at once.

In order to search for and import records from other databases, you must define the databases to which you want to connect. This is done in the Database Definitions portion of the System Administration module. See the [Voyager System Administration User’s Guide](#) for details.

The procedure for importing records from another database is shown in [Procedure 3-6, Importing Records From Another Database](#), on page 3-14.

**Procedure 3-6. Importing Records From Another Database**

Use the following to import records from another database.

1. Click the **Search** button from the Cataloging toolbar, or select **Record>Search**....

   Result: The **Search** dialog box opens.

2. Click **Remote**, or press **Alt + R**.

   Result: The **Voyager Connection Options** dialog box displays. See Figure 3-14.

   From this dialog box, you can choose the database(s) to which you want to connect, simultaneously search, and import records.
IMPORTANT:
For the Remote... button to display on the Search dialog box, you must establish and define the databases you want to search and import records from in Voyager’s System Administration module. For details on this process, see the Voyager System Administration User’s Guide.

Figure 3-14. Voyager Connection Options dialog box

From this dialog box, you can choose the database(s) to which you want to connect, simultaneously search, and import records.

The Voyager Connection Options dialog box is divided into three sections.

• Available Locations
• Selected Locations
• Information About

Available Locations

This section contains a list of all the databases (as you have defined in System Administration), to which you are able to connect and search. You can navigate through this list, by clicking a particular database and using the up and down arrows on your keyboard.

The list is divided into four columns.
- The first column contains a check box indicating whether or not the database is selected as one to connect to and search.
- The **Database Name** column indicates the name of the database to which you are connecting.
- The **Connection** column indicates the type of connection for the database such as Voyager or Z39.50.
- The **Type** column indicates the type of database like Bibliographic or Citation.

Remember, the database name, connection, type, and so on for each database is established and defined in the Database Definitions portion of Voyager’s System Administration module. See the *Voyager System Administration User’s Guide* for details.

**Selected Locations**

This section includes one column, listing the databases by database name you have selected.

**Information About**

This section contains the description of the database highlighted in the list of Available Locations. The database does not have to be listed in Selected Locations for the description to display. This description is established in a free text field in the Database Definitions portion of Voyager’s System Administration module, and may or may not contain the name of the database or the associated institution’s online catalog. See the *Voyager System Administration User’s Guide* for details.

3. You can add and remove databases from the list of **Available Locations**.

**Selecting a Database**

From the list of **Available Locations**, highlight one by one the database(s) to which you want to connect, and click the **Add>>** button (or Alt + A). This moves the database name over to the list of **Selected Locations** (Figure 3-15). You can also double-click the database in the list of **Available Locations** to select it. You can select as many databases as you want. If you select more than one, they are searched simultaneously.

**TIP:**

*When a database is selected, a check mark displays in the check box located directly to the left of the database name in the list of Available Locations.*
Removing a Database

To remove a database from the list of Selected Locations, highlight the database and click the Delete>> button (or Alt + D). You can also double-click the database in the list of Available Locations to remove it. To remove all the databases from the list of Selected Locations at once, click the Clear button.

Exiting the Voyager Connection Options Dialog Box

Click the Cancel button to exit the dialog box without connecting to a database(s), or press Alt + N.

⚠️ IMPORTANT:
The default database searched during Cataloging’s staff-side searching is your local database. However, if you want to search your local database at the same time as another database(s), you must select Local Database from the list of Available Locations in addition to the other database(s) to which you want to connect and search. If you do not select Local Database, only the other database(s) you select are searched.

---

Figure 3-15. Selecting databases to search
4. Click the **Connect** button (or press **Alt + C**) to connect to the database(s) you have selected. If you are connecting to one database, the **Remote Search** dialog box opens, with the name of the database to which you are connected displayed after the colon (Figure 3-16). If you are connecting to more than one database, the **Simultaneous Search** dialog box opens.

![Remote Search dialog box](image)

**Figure 3-16.** Remote Search dialog box

5. Enter the criteria by which you want to search. For detailed information on searching for records in the Cataloging module, see the **Search Dialog Box** on page 3-26.

**NOTE:**
Searching for records in other databases, especially if they are non-Voyager databases, may be different from searching for records your local database. For instance, if you are performing a simultaneous search of your local database and a non-Voyager database, only the attributes that the databases have in common as defined in System Administration’s Database Definitions display in the **Search by** section of the **Search** dialog box.

Thus, if you are searching a remote database and your local database simultaneously, and the only attribute the two databases have in common is the author attribute, you will only be able to perform a search by author. Additional searching rules apply if you are searching other databases such as connecting to multiple databases disables heading searches.

Z39.50 databases do not support search limits. For more information on simultaneous searching, including setting up search attributes, see the **Voyager System Administration User’s Guide**.
6. After you enter your search criteria, click the **Do Search** button (or Alt + S). What displays next depends on whether or not you are searching multiple databases or a single database.

**NOTE:**
If you receive an error message, such as Malformed Query or Search Failed, check your Database Definitions in System Administration module.

The **Search Status** dialog box opens if you are searching more than one database at once. It displays the database name as defined in System Administration and the status of the search such as Searching, Receiving, or Done. See Figure 3-18. The **Stop Search** button allows you to stop the search at any time, if the status of the search is **Searching** or **Receiving**.

![Search Status dialog box](image)

**Figure 3-17. Search Status dialog box**

To display the search results from the **Search Status** dialog box, click the **Show Results** button. This causes the **Titles Index** dialog box to open with the results for the databases you selected. See Figure 3-18.

If you are searching your local database as well as a remote database(s), the **Titles Index** will display records in the sort order you specify in System Administration, depending on the type of search you performed. See the **Voyager System Administration User's Guide** for details on sort order. If you are searching only remote databases and not your local database as well, the **Titles Index** displays in the sort order specified for the first database you selected in the **Voyager Connection Options** dialog box.
NOTE:
If you are searching more than one database, the **Titles Index** dialog box contains a **Status** button and a **Database** column. Click the **Status** button to bring up the **Search Status** dialog box. The **Database** column lists the name of the database name as established in System Administration.

The **Titles Index** dialog box opens immediately if you are searching only one database. The **Search Status** dialog box does not display at all.

---

![Figure 3-18. Titles Index dialog box](image)

For detailed information on the **Titles Index** dialog box, see **Titles Index Dialog Box** on page 3-42.

7. Highlight the record you want to import on the **Titles Index** dialog box (or use the **Ctrl** or **Shift** keys to select more than one), and click **OK** (or double-click the record). The bibliographic record displays (Figure 3-19).

Click **Cancel** to exit the Titles Index.
Figure 3-19. Record imported from another database

For details on bibliographic records, see the Bibliographic Records section on 2-3.

8. Once the record is imported into your database, you can manipulate it as necessary and save it to your database or to a work file. For detailed information on saving records, see Saving and Printing Information on page 4-9.

NOTE:
The title bar of the bibliographic record indicates that it has been imported. See Figure 3-19. However, once the record is saved to your database, the title bar displays the bibliographic record ID.

After you have searched a remote database, the last search settings defined on the Voyager Connection Options dialog box applies until you either change the remote search settings or exit the Cataloging module. Thus, if you want to perform a standard staff-side search of your local database, you must reset your search settings so that only your local database is searched.
To do so, open the Search dialog box and click Remote.... Press the Clear button located toward the center of the dialog box, and then click Connect. This connects you only to your local database. In this case, it is not necessary for your local database in the list of Available Locations to be selected as a Selected Location for this to work. This is because your local database is the default database searched.

Invalid Records

You cannot import records that are invalid from either a file or from a remote database. This is because the system cannot import a record that it cannot read. Generally speaking, the system cannot read a MARC record if its length as defined in the record's first five bytes is incorrect, or if there is a critical element missing in the record such as a field tag displays without a subfield delimiter. If you encounter this situation, you can opt to either fix the record’s error such as in the file or manually key the record into the Cataloging module.

RECOMMENDED:
If you attempt to fix the error in the file, we recommend that you re-export the record from your utility and then try the import again.

Alternatively, provided you can associate the import record file with an appropriate application such as Notepad, you can display the record outside of Voyager, diagnose the problem (most likely there are missing field tags, subfield delimiters, end of field marks, and so on), make the necessary corrections, and then import the record. However, unless you are very familiar with MARC and have the available time, it is unlikely that this will be your preferred method. Keying the record into Voyager is generally the easiest and quickest solution for dealing with invalid records.

TIP:
When it comes to invalid records, you should follow your utility's procedures for reporting problems.

Accessing Replaced or Deleted Files

In order to access deleted and discarded files, you must have permission to access the server. Every MARC record imported into Voyager that is either overlaid or deleted gets written to a deleted file; every incoming MARC record that is not added such as a duplicate or canceled is put into a discard file.
Using standard commands for your server, you can access and view the following files (created during the import and delete functions in the Cataloging module). You can FTP these files to the Cataloging client (actually your PC) using standard FTP procedures.

- deleted.bib.marc
- deleted.mfhd.marc
- deleted.auth.marc
- discard.bib.marc
- discard.auth.marc

**NOTE:**
The files produced when you import records through Voyager’s Bulk Import batch job have the same names as the files listed above with the exception that .marc in the filename is replaced by .yyyyymmdh.hhmm. For details on Bulk Import, see the *Voyager Technical User’s Guide*.

### Creating New Bibliographic Records from Image Server

If your library has installed Image Server, you can create a new bibliographic record in Cataloging with a link to images. You can specify certain bibliographic information (such as Name, Title, and so on) on the **File Documents** folder and it will be transferred to a new bibliographic record in Cataloging. Bibliographic information is mapped into appropriate MARC fields to images displaying in the **856** fields. From the **File Documents** dialog box in Image Server (Figure 3-20), you can create a new bibliographic record that contains the specified bibliographic information as well as the image link by pressing function keys. See **Table 3-2**.

**Table 3-2. Function Key Options for Creating Bibliographic Records**

<table>
<thead>
<tr>
<th>Function Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F8</td>
<td>Creates an <strong>856</strong> tag(s) in a open bibliographic record in Cataloging for selected documents.</td>
</tr>
<tr>
<td>F9</td>
<td>Creates <strong>856</strong> tags in a open bibliographic record in Cataloging for all documents.</td>
</tr>
<tr>
<td>Alt-F8</td>
<td>Creates new bibliographic record in Cataloging for the values in Folder Name and creates <strong>856</strong> tags(s) for the selected document(s).</td>
</tr>
<tr>
<td>Alt-F9</td>
<td>Creates a new bibliographic record in Cataloging for the values in Folder Name and creates <strong>856</strong> tags for all the documents in the folder.</td>
</tr>
</tbody>
</table>
When the bibliographic record is created in Cataloging (Figure 3-21), the information from the bibliographic template specified in Session Defaults is combined with the information from ImageServer to create the bibliographic record. All of the information from both sources is entered into the record. If there is no bibliographic template specified in Session Defaults, Cataloging supplies dummy information in the Leader and the 008 fields. This information must then be edited before the record is saved to the database.
Chapter 3: Creating, Opening, and Viewing Records

Figure 3-21. New Bibliographic Record in Cataloging

NOTE:
The Title field in ImageServer is required. This information is placed into a new 245 field in the new record during the transfer. If the bibliographic template you are using already has a 245 field defined, delete one of the 245 fields before saving the record. You find duplicate fields in your new record if you have certain fields defined in the template and also specify the same information in the File Documents dialog box.

Generally, you will have a bibliographic template that is for the purpose of creating records with ImageServer links. Typically, you will want to define a template for the purpose of creating bibliographic records from ImageServer. You would then select this template in your Session Defaults prior to adding any record.

Duplicate fields will only be detected if you have MARC validation on in Session Defaults and Preferences when you save the record. If MARC Validation is off, be sure to check the record yourself for any duplications or other errors.

Viewing Information

This section discusses the different methods for viewing information through the Cataloging module such as the following.
Search Dialog Box

The Search dialog box (Figure 3-22), available in all of the Voyager staff modules, provides a way to search your library’s catalog. It contains the following tabs.

- **Keyword** tab (see Keyword Tab and Keyword Searching on page 3-27)
- **Index Selection** tab (see Index Selection Tab on page 3-31)
- **Builder** tab (see Builder Tab and Builder Searching on page 3-38)
- **History** tab (see History Tab on page 3-42)

![Search dialog box](image)

**Figure 3-22. Search dialog box**

**NOTE:**
By default, the Index Selection tab displays when the Search dialog box opens. To navigate between search tabs, you can either click the appropriate tab or press the Alt key plus the letter underlined in the tab name.
If configured, there can be two other features available on each tab regardless of the type of search. These features are remote searching and a user-defined search. See Remote Searching on page 1-1 and User-Defined Alternate Search Button on page 1-1.

User-defined limits can be applied to some searches. See Search Limits on page 3-67.

Keyword Tab and Keyword Searching

The Keyword tab (Figure 3-23) of the Search dialog box allows you to conduct keyword searches of all MARC fields and subfields in the bibliographic and holdings records. Users can specify the tag/subfields to search or specify an index to search by including the tag/subfield or index code before the search term.

NOTE:
The Holdings Boolean radio button is an optional feature which your site may or may not have chosen to implement.

Figure 3-23. Keyword tab of the Search dialog box

Limits can be applied to the Boolean and Free Text Keyword searches. However, they cannot be applied to the Holdings Boolean search. See Search Limits on page 3-67.
Users must select a search type radio button and enter search criteria in the
**Search for** field to enable the **Do Search** button. See **Table 3-3** for a description
of the options available on the **Keyword** tab to invoke a keyword search.

**NOTE:**
An (R) in the first column of the table designates a required entry. Unless
otherwise specified, characters can be alphabetic or numeric, uppercase and/or
lowercase, and may include punctuation and spaces.

**Table 3-3. Description of the Keyword tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>Performs a keyword search of the bibliographic record using Boolean terms (and, or, not) without using relevance. When you select <strong>Boolean</strong>, remember to insert Boolean terms. Otherwise, you receive a <strong>Malformed Query</strong> error message.</td>
</tr>
<tr>
<td>Free Text</td>
<td>Performs a keyword search of the bibliographic record using relevance without Boolean operators.</td>
</tr>
<tr>
<td>Holdings Boolean (optional feature)</td>
<td>Performs a keyword search, without using relevance, of holdings records in your local database. Provides the flexibility to locate coded data, for example, inside the call number of MARC holdings records. Must use Boolean operators if using more than one search term. The default index searched is HKEY.</td>
</tr>
</tbody>
</table>

**NOTE:**
This search is not available for remote searching.
Chapter 3: Creating, Opening, and Viewing Records

Search for (R)
Enter search criteria in this field. Search criteria separated by spaces may require quotation marks to achieve the intended result. Example:

“world war”
“41051654 //r944”

Wildcard characters are as follows.

- ? (question mark)
  Use the question mark for multiple-character, wildcard searches at the beginning, middle, or end of your search terms.
- % (percent sign)
  Use the percent sign for single-character wildcard searches.

NOTE:
Wildcard characters can be used in Free Text searches, Builder searches, and command line searches (that do not use a subfield-limited keyword index). Wildcard characters are not available for use with Z39.50 searches.

Add one of the following operators before the search term (in a Free Text search) to specify additional characteristics.

- + (plus sign)
  The term must display in the record.
- ! (exclamation point)
  Records with the term are to be excluded.
- * (asterisk)
  The term is important.

You can also do command line searching. See Command Line Searching on page 3-30.

Table 3-3. Description of the Keyword tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search for (R)</td>
<td>Enter search criteria in this field. Search criteria separated by spaces may require quotation marks to achieve the intended result. Example:</td>
</tr>
<tr>
<td></td>
<td>“world war”</td>
</tr>
<tr>
<td></td>
<td>“41051654 //r944”</td>
</tr>
</tbody>
</table>

Wildcard characters are as follows.

- ? (question mark)
  Use the question mark for multiple-character, wildcard searches at the beginning, middle, or end of your search terms.
- % (percent sign)
  Use the percent sign for single-character wildcard searches.
Table 3-3. Description of the Keyword tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default Tab  | Identifies which tab displays as the default when the Search function is initiated.  
This button is inactive on the tab selected as the default. 
At installation, the Index Selection tab is the default. 
This option is available on the following tabs: Keyword, Index Selection, and Builder.  
NOTE: This button does not display when Retain Last Search is selected. |
| Do Search    | Executes the search.  

Cancel       | Cancels the search and closes the Search dialog box.                                         

Clear        | Deletes the search term(s) in the Search for text box.                                         

Limit        | Opens the Search Limits dialog box, where you can limit your search by language, location, date, or other variables you’ve configured. 

NOTE: Limits cannot be applied to holdings keyword searching. 
See Search Limits on page 3-67. |

Remote       | The Remote button, if configured, allows users to search remote databases. 
See Remote Databases on page 2-45 |

URI Search   | If configured, this button invokes a user-defined URI (Uniform Resource Identifier) to search outside the Voyager database. 
See User-Defined Alternate Search Button on page 3-66. |

Results of Boolean and Free Text searches are displayed in a Titles Index dialog box, and results of Holdings Boolean searches are displayed in a Holdings Index dialog box. See Titles Index Dialog Box on page 3-42.

Command Line Searching

Users can do command line searching by specifying MARC record tags/subfields to search or an index to search and the existing rules for Boolean searching.
• To search keyword composite indexes use the 4 letter code (see the *Voyager System Administration User’s Guide*). For example, the search code NKEY (author name) searches by tags 100 aqd, 110 abcddefgl, and so forth. Another command line search example using GKEY as the keyword index code is as follows.

**GKEY pinnochio and GKEY disney**

• To search tags, use the three-numeric character of the tag followed by the single subfield (245b, 010a, 035a, 650x). The search is keyword except for number fields such as LCCN, ISBN, and ISSN which are left-anchored.

Truncation as well as boolean operators and quotation marks for phrase searching may be used (245a text? AND commentary) for the keyword indexed searches. You may also search for more than one tag at a time (650a "middle eastern literature" AND 100a pritchard).

**Other Keyword Search Considerations/Options**

Optionally, your system administrator may implement dynamic noise word reduction to improve performance of keyword searches. This option eliminates common words from a user’s query for the purpose of searching but retains them for the purpose of relevance ranking.

The following is a list of stop words used with this feature.

• **AND**
• **OR**
• **NOT**
• **OF**
• **IN**
• **THE**
• **WITH**
• **TO**
• **FOR**

The dynamic noise word reduction capability is set with NOISEWORDFILTER in the server-side voyager.ini file. Refer to the *Voyager Technical User’s Guide* or see your system administrator for more information.
Index Selection Tab

Headings/Index Selection searching allows users to perform left-anchored bibliographic searches, holdings searches, authorities searches, and headings searches. In addition to system defined searches, your institution can define additional searches. Search types are created in System Administration. See the Voyager System Administration User’s Guide for details.

Limits can be applied to those Index Selection searches conducted on left-anchored indexes. However, they cannot be applied to headings searches. See Search Limits on page 3-67.

Figure 3-24 displays the Index Selection tab of the Search dialog box.

![Index Selection tab of the Search dialog box](image)

Table 3-4 describes the Index Selection tab. When a heading search is selected from the drop-down menu, the user must select either the Find or Browse radio button to govern the search. See Find and Browse Searches on page 3-36.
**NOTE:**
An (R) in the first column of the table designates a required entry. Unless otherwise specified, characters can be alphabetic or numeric, uppercase and/or lowercase, and may include punctuation and spaces.

### Table 3-4. Description of the Index Selection tab

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>Find searches match specific records of the <strong>Search by</strong> type to the terms entered in the <strong>Search for</strong> field. The result is a finite number of records. See <a href="#">Find and Browse Searches</a> on page 3-36 for more information.</td>
</tr>
<tr>
<td>Browse</td>
<td>Displays an index of headings that can be browsed based on the <strong>Search by</strong> selection, any corresponding filter selections, and a <strong>Search for</strong> value. Available with headings or call number searches. See <a href="#">Find and Browse Searches</a> on page 3-36 for more information.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Displays a headings list from which to select when exact word order or the initial words are unknown. See <a href="#">Headings Keyword Searches</a> on page 3-37 for more information.</td>
</tr>
<tr>
<td>Search type drop-down list (R)</td>
<td>Unlabeled field containing a drop-down menu of searches available. The list is determined by search usage with the most used search at the top of the drop-down. The types of searches are system defined and user defined in the System Administration module. See the <a href="#">Voyager System Administration User's Guide</a>.</td>
</tr>
</tbody>
</table>

**NOTE:**
OPAC headings searches and Staff headings searches are available in the Cataloging module. However, only OPAC headings searches are available in the Acquisitions and Circulation modules.
Table 3-4. Description of the Index Selection tab

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Heading Types Filter  | Users can select a Heading Type filter to further limit a heading or a headings keyword search. Resulting records must contain the heading type selected and match the search criteria.  
The types of searches are system defined.                                                                                   |
|                       | **NOTE:** These filters may be suppressed in the System Administration module.                                                                                                                                |
| Locations Filter      | Users can select a Locations filter to further limit a search when doing call number searches.  
Locations are defined locally in the System Administration module. See the Voyager System Administration User’s Guide.                                                                                   |
|                       | **TIP:** By limiting a call number search by location, you can get an online shelf list.                                                                                                                      |
| Search for (R)        | Enter your search term(s) or phrase(s) in the **Search for** field (1-149 characters).  
Use Boolean operators (and, or, not) to achieve the best match with your search string.  
Use quotation marks to identify phrases.  
Use a question mark (?) to truncate the search term if not automatically truncated. See Automatic Truncation for Index Selection Searches on page 3-67 for more information. |
| Default Tab           | Identifies which tab displays as the default when the Search function is initiated.  
This button is inactive on the tab selected as the default.  
At installation, the **Index Selection** tab is the default.  
This option is available on the following tabs: **Keyword**, **Index Selection**, and **Builder**.  
**NOTE:** This button does not display when **Retain Last Search** is selected. |
Chapter 3: Creating, Opening, and Viewing Records

Table 3-4. Description of the Index Selection tab

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Settings</td>
<td>Saves values on the current search tab. The search code for the index is saved. The saved settings display each subsequent time this tab is accessed. To change settings, enter new values on the tab and click <strong>Save Settings</strong>.</td>
</tr>
</tbody>
</table>

**NOTE:** When the index is deleted, the index code is changed, or it is suppressed, a standard error message is displayed. When the user responds by clicking **OK**, the default setting is cleared and the first index in the list and the first connector display.

This option is available on the following tabs: **Index Selection** and **Builder**.

**NOTE:** This button does not display when **Retain Last Search** is selected.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do Search</td>
<td>Executes the search.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the search.</td>
</tr>
<tr>
<td>Clear</td>
<td>Deletes the search term(s) in the <strong>Search for</strong> field.</td>
</tr>
<tr>
<td>Remote</td>
<td>The <strong>Remote</strong>... button, if configured, allows users to search remote databases. See <strong>Remote Databases</strong> on page 2-45.</td>
</tr>
<tr>
<td>Limit</td>
<td>Opens the <strong>Search Limits</strong> dialog box, where you can limit your search by language, location, date, or other variables you’ve configured. The <strong>Limits</strong> button is not available for Headings or Holdings Keyword searches.</td>
</tr>
<tr>
<td>URI Search</td>
<td>If configured, this button invokes a user-defined URI (Uniform Resource Identifier) to search outside the Voyager database. See <strong>User-Defined Alternate Search Button</strong> on page 3-66.</td>
</tr>
</tbody>
</table>

See **Remote Databases** on page 2-45. See **Search Limits** on page 3-67.
Results of searches from the Index Selection tab display in either the Titles Index dialog box or Headings List dialog box. See Titles Index Dialog Box on page 3-42 and Headings List Dialog Box on page 3-50.

Find and Browse Searches

The radio buttons of either Find or Browse are available if you are performing a heading or call number search. Selecting Find or Browse affects the search results received.

A Find search returns specific, finite results that match the search criteria. For example, a Find subject heading search (OPAC Subject Headings Search) for war? returns the results shown in Figure 3-25.

![Figure 3-25. Search results after doing a find subject heading search for war?](image)

The Browse search allows users to scroll through an institution’s list of headings. For example, a Browse subject heading search (OPAC Subject Headings Search) for war? returns the results shown in Figure 3-26.
Figure 3-26.  Search results after doing a browse subject heading search for war?

In this example, the system displays the Browse Headings List that users can scroll through using the arrow buttons (Table 3-10) to find the wanted heading.

Heading Searches by Call Number

When doing an Index Selection search by call number, Voyager accepts Dewey call numbers that have more than one decimal point as well as call numbers that only have a decimal point after the Dewey root/Cutter combination such as 305.1 M887 no.2 and 506 N56 v.8. Also, normalization of Dewey call numbers including dates was adjusted to ensure proper sorting in call number indexes such as 321 A65 1998.

Regarding the display of call numbers with 852‡k and 852‡m (call number prefix and suffix) fields, you can include prefixes and suffixes in all of Voyager’s call number displays.

When you perform a Browse search for a call number with a prefix or a suffix, you see the prefix or suffix in the results list as well as in the actual record itself.

Headings Keyword Searches

The Keyword radio button is active on the Index Selection tab when the following indexes are selected from the drop-down list.

- Staff Name Headings Search
- Staff Title Headings Search
- Staff Name/Title Headings Search
• Staff Subject Search
• OPAC Name Headings Search
• OPAC Title Headings Search
• OPAC Name/Title Search
• OPAC Subject Search

Consistent with all headings searches, the **Limit** button is disabled when a headings index is selected from the drop-down list.

Command line syntax may be used with headings keyword searches. Boolean operators such as **and**, **or**, or **not** should be used to combine search strings.

Search terms in quotation marks are searched as a phrase. For example, "civil war" is not the same search as **civil AND war**.

Search results display in the Headings List dialog box without relevance ranking. See **Figure 3-27**. The headings are ordered alphabetically by normal heading.

![Headings List](image)

**Figure 3-27.**  Headings List for Headings Keyword Search

**NOTE:**
Authority record access is available via the **Authority** button.

Headings Keyword Searches are not available on the **Builder** tab.
Builder Tab and Builder Searching

The Builder tab of the Search dialog box allows you to build complex searches using multiple fields, search terms, and Boolean operators.

Builder searches are Keyword searches. Therefore, limits can be applied. See Search Limits on page 3-67.

Figure 3-28 shows the Builder tab of the Search dialog box.

Figure 3-28. Builder tab of the Search dialog box

Table 3-5 describes the Builder tab.
NOTE:
An (R) in the first column of the table designates a required entry. Unless otherwise specified, characters can be alphabetic or numeric, uppercase and/or lowercase, and may include punctuation and spaces.

Table 3-5. Description of the Builder tab

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search for (R)</td>
<td>Enter your search term(s) or phrase in the <strong>Search for</strong> field (1-149 characters). Wildcard characters are as follows.</td>
</tr>
<tr>
<td></td>
<td>• ? (question mark) Use the question mark for multiple-character, wildcard searches at the beginning, middle, or end of your search terms.</td>
</tr>
<tr>
<td></td>
<td>• % (percent sign) Use the percent sign for single-character wildcard searches.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Wildcard characters are not available for use with Z39.50 searches.</td>
</tr>
<tr>
<td>Search term options drop-down list</td>
<td>Unlabeled drop-down menu allowing the operator to determine how to search. Values are preset by the system.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Any of these</strong> places an implied or between the search terms.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All of these</strong> places an implied and between terms.</td>
</tr>
<tr>
<td></td>
<td>• <strong>As a phrase</strong> searches an if the terms are placed in quotes.</td>
</tr>
<tr>
<td>Search in</td>
<td>Drop-down menu of keyword search types. Values are preset by the system and user-defined Keyword indexes.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> MFHD keyword index searching and Journal index searching are not available in builder searching because they cannot be combined with bibliographic keyword indexes. The Journal index is a title keyword search with a journal type limit applied to it.</td>
</tr>
<tr>
<td>Boolean buttons</td>
<td>Use the <strong>And</strong>, <strong>Or</strong>, or <strong>Not</strong> buttons to conduct a boolean search with additional search criteria.</td>
</tr>
</tbody>
</table>
Table 3-5. Description of the Builder tab

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search terms</td>
<td>Unlabeled box containing your search terms and, if used, accompanying Boolean operators.</td>
</tr>
<tr>
<td>Edit</td>
<td>Allows you to edit any search term or phrase you select from the unlabeled search term box.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes any selected search term from the unlabeled search term box.</td>
</tr>
</tbody>
</table>
| Default Tab   | Identifies which tab displays as the default when the Search function is initiated.                                                                                                                        
|               | This button is inactive on the tab selected as the default.                                                                                                                                                                                                                     |
|               | At installation, the **Index Selection** tab is the default.                                                                                                                                                                                                                |
|               | This option is available on the following tabs: **Keyword**, **Index Selection**, and **Builder**.                                                                                                                                                                          |
|               | **NOTE:** This button does not display when **Retain Last Search** is selected.                                                                                                                                                                                        |
| Save Settings | Saves values on the current search tab.                                                                                                                                                                                                                                     |
|               | The search code for the index is saved.                                                                                                                                                                                                                                    |
|               | The saved settings display each subsequent time this tab is accessed.                                                                                                                                                                                                     |
|               | To change settings, enter new values on the tab and click **Save Settings**.                                                                                                                                                                                               |
|               | **NOTE:** When the index is deleted, the index code is changed, or it is suppressed, a standard error message is displayed. When the user responds by clicking **OK**, the default setting is cleared and the first index in the list and the first connector display.                            |
|               | This option is available on the following tabs: **Index Selection** and **Builder**.                                                                                                                                                                           |
|               | **NOTE:** This button does not display when **Retain Last Search** is selected.                                                                                                                                                                                        |
| Do Search     | Executes the search.                                                                                                                                                                                                                                                    |
| Cancel        | Cancels the search.                                                                                                                                                                                                                                                     |
Results from Builder searches display in the Titles Index dialog box, see Titles Index Dialog Box on page 3-42.

History Tab

The History tab (Figure 3-29) gives you access to all searches you performed during the current session. For each search you performed, it lists the search parameters and the number of records returned (#Hits).

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>Deletes the search term(s) in the Search for field.</td>
</tr>
<tr>
<td>Limit</td>
<td>Opens the Search Limits dialog box.</td>
</tr>
<tr>
<td>NOTE:</td>
<td>The Limits button is not available for Heading searches.</td>
</tr>
<tr>
<td></td>
<td>See Search Limits on page 3-67.</td>
</tr>
<tr>
<td>Remote</td>
<td>The Remote... button, if configured, allows users to search remote databases.</td>
</tr>
<tr>
<td></td>
<td>See Remote Databases on page 2-45.</td>
</tr>
<tr>
<td>URI Search</td>
<td>If configured, this button invokes a user-defined URI (Uniform Resource Identifier) to search outside the Voyager database.</td>
</tr>
<tr>
<td></td>
<td>See User-Defined Alternate Search Button on page 3-66.</td>
</tr>
</tbody>
</table>
From the History tab, you can re-execute searches previously performed or edit previous search statements.

**IMPORTANT:**
The History tab does not retain information about search limits. If you re-execute or edit a search from the History tab, any current limits in effect are used instead of any limits you previously specified.

### Titles Index Dialog Box

The Titles Index dialog box (Figure 3-30) displays the results of Keyword searches, whether conducted from the Keyword tab (a Boolean or Free Text search) or the Builder tab, and the results of left-anchored searches conducted from the Index Selection tab.

**NOTE:**
The maximum number of records returned is 10,000.
TIP:

Click the **Titles Index** button (Figure 3-30) or **Display>Titles Index** to re-access the results of the most recent Keyword search when the **Titles Index** dialog box is closed.

---

By default the **Titles Index** dialog box displays the following. (See **Search Results List Re-Sort Options** on page 3-44 for a description of sort options for displaying **Titles Index** results.)

- Relevance column (for free text searches)
- Title
- Author
- Date
The title, author, and date columns can be reconfigured to display other bibliographic data. These columns are configured on the **Search Results** tab when defining indexes in the System Administration module. See the *Voyager System Administration User’s Guide* for more information.

**NOTE:**
If your search retrieves more than 100 titles, a **Stop** button becomes active. You can then click the **Stop** button to cancel the retrieval of more records (Figure 3-31).

---

**Figure 3-32.** Stop button seen with more than 100 search results

See Table 3-6 for a description of the **Titles Index** dialog box.

**Table 3-6.** Description of the Titles Index dialog box

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Select the font used to display text in the <strong>Titles Index</strong> dialog box. <strong>NOTE:</strong> These boxes display the Unicode character set in all Voyager modules.</td>
</tr>
<tr>
<td>Sort By</td>
<td>Displays drop-down list of options to re-sort search results. See <strong>Search Results List Re-Sort Options</strong> on page 3-44.</td>
</tr>
<tr>
<td>Relevance Column</td>
<td>Displays relevance bars for Free Text searches.</td>
</tr>
<tr>
<td>Bibliographic Information Column(s)</td>
<td>Columns containing bibliographic information (for example, full title, author, and format). These are specified when defining searches in the System Administration module.</td>
</tr>
</tbody>
</table>
The following options are available for re-sorting a search results list.

- Author
- Publish Date
- Publish Date Descending
- Relevance (if used for the search)
- Title
- Search results column headers such as Format, for example

(depends on the [Global Log] settings in the Voyager.ini file; see Re-Sort Configuration Options on page 3-46 for more information)

See Figure 3-32.

These options display when a non-headings search is performed against the local database or a single remote Voyager database.

Click one of the options from the Sort By drop-down list to execute a new sort.

Optionally, you may click a column heading to invoke a Quick Sort of the search results list using the column data. See Re-Sort Configuration Options on page 3-46 for more details of configurable options.
Selecting a Quick Sort value once re-sorts the list in ascending order based on the value selected. Selecting the same Quick Sort value a second time re-sorts the list in descending order. This applies to the Quick Sort capability selectable from both the Sort By drop-down list and by clicking a column heading when configured for sort options use. See Re-Sort Configuration Options on page 3-46 for more information.

![Figure 3-33. Search results sort options](image)

**Re-Sort Configuration Options**

The Sort By options that display in the Titles Index dialog box are determined by sort options configured in the [Global Log] stanza in the Voyager.ini file. The configurable sort options are as follows:

- ServerSortList=Y/N
- ASCII_sortList=Y/N
- ASCII_sortColumn=Y/N


See Table 3-7 for the system default when no options are configured in the [Global Log] stanza.

**Table 3-7. Default Re-Sorting Options (when none are configured)**

<table>
<thead>
<tr>
<th>Option</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServerSortList</td>
<td>Y</td>
</tr>
</tbody>
</table>
Table 3-7. Default Re-Sorting Options (when none are configured)

<table>
<thead>
<tr>
<th>Option</th>
<th>Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCIISortList</td>
<td>N</td>
</tr>
<tr>
<td>ASCIISortColumn</td>
<td>N</td>
</tr>
</tbody>
</table>

**ServerSortList**

When ServerSortList=Y is implemented, the sort function utilizes Voyager indexes that follow certain rules to handle punctuation and other non-alphanumeric characters that exist in a MARC record. For example, O’Connor becomes OConnor.

When one of the following Sort By options is selected from the drop-down list (see Figure 3-32), the system automatically executes a Voyager search on the server and displays new search results based on the sort order selected.

- Author
- Publish Date
- Publish Date Descending
- Relevance (if used for the search)
- Title

**ASCIIList**

When ASCIIList=Y is implemented, the system does an alphabetic sort with diacritics removed using Visual Basic on the client to process the existing search results list into the new sort order determined by the selection of one of the following Sort By options (below the line).

- Relevance (Quick Sort)
- Title (Quick Sort)
- “Column Heading Name” (Quick Sort) such as Format (Quick Sort)

This method is faster because it does not re-execute the search query against Voyager indexed data on the server. Instead, it uses facilities on the client to process the sort. As a result, for example, leading articles are considered part of the data to sort versus ignored data as in a Voyager server sort.
**ASCIISortColumn**

When \texttt{ASCIISortColumn=Y} is implemented, the system does an alphabetic sort with diacritics removed using Visual Basic on the client to process the existing search results list into the new sort order determined by the selection (mouse click) of one of the column headings.

This method is faster because it does not re-execute the search query against Voyager indexed data on the server. Instead, it uses facilities on the client to process the sort. As a result, for example, leading articles are considered part of the data to sort versus ignored data as in a Voyager server sort.

**NOTE:**
The Quick Sort facility may be accessed through either of the following methods when the appropriate configuration is implemented in the [Global Log] stanza.

- Click the column heading for the desired sort
- Select one of the Quick Sort (below the line) options from the Sort By drop-down list

**Considerations for Re-sorting Search Results**

The following list highlights some considerations.

- When a re-sort is executed, the original sort order is lost except when relevance is used.
- If a search result is truncated to a maximum of 10,000 results, the re-sort option retrieves different results than the original set since the sort order by value is different.

The re-sort drop-down list options only display with bibliographic result sets that display a list of titles. The following are examples of types of searches that provide re-sort options.

- Keyword, Index Selection, or Builder searches
- Keyword searches with relevance and without relevance
- MFHD keyword searches
- Command line searches with relevance and without relevance
- Date searches
- Find searches
- Left-anchored, non-headings searches
- Selections on headings lists of headings with multiple titles
The **Sort By** drop-down list does not display with bibliographic results sets meeting any of the following criteria.

- A list of headings
- Browse searches
- Remote Z39.50 connections
- Remote connections to non-Voyager catalogs
- Remote connections to multiple Voyager catalogs

### Holdings Index Dialog Box

The **Holdings Index** dialog box ([Figure 3-33](#)) returns results of a Holdings Boolean search conducted from the **Keyword** tab.

**NOTE:**
The maximum number of records returned is 10,000.

![Holdings Index dialog box](image)

_Figure 3-34. Holdings Index dialog box_

The **Holdings Index** dialog box displays the following:

- Holdings Record ID
- Title
- Author
- Date
The title, author, and date columns can be re-configured to display other bibliographic data on the **Holdings Index** dialog box. These columns are configured on the **Search Results** tab when defining indexes in the System Administration module. See the **Voyager System Administration User’s Guide** for more information.

**NOTE:**
If your search retrieves more than 100 titles, a **Stop** button becomes active. You can then click the **Stop** button to cancel the retrieval of more records (Figure 3-31).

---

![Stop button](image)

**Figure 3-35.** Stop button seen with more than 100 search results

See Table 3-8 for a description of the **Holdings Index** dialog box.

**Table 3-8.** Description of the Holdings Index dialog box

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Select the font used to display text in the <strong>Holdings Index</strong> dialog box.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> These boxes display the Unicode character set in all Voyager modules.</td>
</tr>
<tr>
<td>Holdings Record Column</td>
<td>Displays the holdings record ID for holdings keyword searches.</td>
</tr>
<tr>
<td>Bibliographic Information Column(s)</td>
<td>Columns containing bibliographic information (for example, full title, author, and format). These are specified when defining searches in the System Administration module.</td>
</tr>
<tr>
<td>OK</td>
<td>After clicking the <strong>OK</strong> button, the response of the system varies depending on the type of search conducted. See [Keyword Search in the Cataloging Module](page 2-90).</td>
</tr>
</tbody>
</table>
Table 3-8. Description of the Holdings Index dialog box

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Closes the <strong>Holdings Index</strong> dialog box.</td>
</tr>
<tr>
<td>Search</td>
<td>Returns to the <strong>Search</strong> dialog box cleared of previous entries unless the <strong>Retain Last Search</strong> check box is selected in session preferences.</td>
</tr>
<tr>
<td>Select All</td>
<td>Opens all of the returned records.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Clears all selected records.</td>
</tr>
</tbody>
</table>

**Headings List Dialog Box**

Results of Index Selection headings searches display in a **Headings List** dialog box (Figure 3-35).

**NOTE:**
A left-anchored or non-headings search from the **Index Selection** tab returns results in a **Titles Index** dialog box. See **Titles Index Dialog Box** on page 3-42.

![Headings List dialog box](image)

**Figure 3-36. Headings List dialog box**

In a **Headings List** dialog box, you can view the following.

- References
- Ref/Notes
- Notes/Scope Notes
• Narrower terms
• See and/or See Also reference(s) associated with the heading

See Table 3-9 for a description of associated Headings List information.

Table 3-9. Headings List Information

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorized</td>
<td>This term displays if the heading is in the 1XX field of the authority record.</td>
</tr>
<tr>
<td>Reference</td>
<td>This term displays if the heading is not an authorized heading but is a see from reference from the 4XX fields.</td>
</tr>
<tr>
<td>Auth/Ref</td>
<td>This term displays if the heading is in the 1XX in an authority record and has references (5XX fields) in that same record and/or is itself a cross-reference in another authority record.</td>
</tr>
<tr>
<td>Note</td>
<td>This term displays if the heading’s authority record contains scope notes.</td>
</tr>
</tbody>
</table>

Optionally, headings with subdivisions display with dashes. See Figure 3-36. To implement the display of dashes for headings with subdivisions, see the description of System>Miscellaneous options in the Voyager System Administration User’s Guide.
Figure 3-37. Optional dashes for headings with subdivisions

**TIP:**
Access the **Headings List** dialog box by selecting **Display>Headings List** or by clicking the **Headings List** button (Figure 3-37).

Figure 3-38. Headings List Button

**NOTE:**
If your search retrieves more than 100 headings, the **Stop** button becomes active. You can then click the **Stop** button to cancel the retrieval of more headings (Figure 3-37).

Figure 3-39. Stop button seen with more than 100 search results
Table 3-10 describes the **Headings List** dialog box containing the search results.

### Table 3-10. Description of the Headings List dialog box

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Drop-down</td>
<td>Select the font used to display text in the <strong>Headings List</strong> dialog box.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>These dialog boxes display the Unicode character set in all Voyager modules.</td>
</tr>
<tr>
<td>[additional references]</td>
<td>Unlabeled column identifying if there are References, Ref/Notes, Notes as well as Scope Notes, Narrower terms, See and/or See Also reference(s).</td>
</tr>
<tr>
<td>Bibs Column</td>
<td>Number of bibliographic records associated with this heading.</td>
</tr>
<tr>
<td>Heading Column</td>
<td>Name of the Heading returned.</td>
</tr>
<tr>
<td>Heading Type Column</td>
<td>Type of heading returned.</td>
</tr>
<tr>
<td>OK Button</td>
<td>Active once a heading is selected. Opens the <strong>Titles Index</strong> dialog box if there are bibliographic records associated with the heading.</td>
</tr>
<tr>
<td></td>
<td>See <strong>Titles Index Dialog Box</strong> on page 3-42.</td>
</tr>
<tr>
<td>Cancel Button</td>
<td>Closes the <strong>Headings List</strong>.</td>
</tr>
<tr>
<td>Search Button</td>
<td>Opens the <strong>Search</strong> dialog box.</td>
</tr>
<tr>
<td>Authority Button</td>
<td>Opens the <strong>Reference Information</strong> dialog box. Active if there is a Ref/Note, Reference, or Note, and so on.</td>
</tr>
<tr>
<td></td>
<td>See <strong>Reference Information Dialog Box</strong> on page 3-53.</td>
</tr>
<tr>
<td>Clear All Button</td>
<td><em>Not active with a Browse search.</em> Clears the selected headings.</td>
</tr>
<tr>
<td>Copy Button</td>
<td>For browse searches only, clicking the <strong>Copy</strong> button copies the contents of the current heading into the clipboard, which may be pasted into the variable fields portion of a MARC record. It is also used when validating a heading. See the <strong>Voyager Cataloging User’s Guide</strong>. Only available in the Cataloging module.</td>
</tr>
</tbody>
</table>
Table 3-10. Description of the Headings List dialog box

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigation</td>
<td>After a browse search, use these buttons to navigate through the results.</td>
</tr>
<tr>
<td>Buttons</td>
<td></td>
</tr>
</tbody>
</table>

Reference Information Dialog Box

Additional Reference Information can be displayed for titles that display the following in the Headings List dialog box.

- Authorized
- Reference
- Note
- Ref/Note

By clicking the Authority button or right clicking the row, the Reference Information dialog box opens (Figure 3-38).

Figure 3-40. Reference Information dialog box

This dialog box lists whether authority record information is available as well as Scope Notes, Narrower terms, See and/or See Also reference(s) for the selected heading.
NOTE:
Multiple Scope Notes display in the order in which they occur in the MARC record.

The Reference Information dialog box displays information in order by type of reference and then alphabetically by heading text. The reference types should be ordered as follows.

1. Authorized Record
2. Scope Note
3. See Reference
4. Earlier Heading
5. Acronym
6. Musical Composition
7. Broader Term
8. Narrower Term
9. See Also Reference

To retrieve information about one of the references, select the appropriate reference and click the Retrieve button.

NOTE:
When the headings are retrieved from the server, they are normalized using the standard authority normalization rules to ensure that the alphabetic sort returns the headings in the proper order.

Scope Notes

Retrieve the scope notes for the heading by selecting it and clicking the Retrieve button (Figure 3-39).

---

Figure 3-41. Scope Notes for a heading
Narrower Term

Find a narrower term by selecting it and clicking the **Do Search** button. See **Figure 3-40**.

---

**Figure 3-42. Narrower term for a heading**

The system does a new search for the narrower term. See **Figure 3-41**.

---

**Figure 3-43. Search results from the narrower term**

---

**See Also**

From the **Reference Information** dialog box, the operator can do a new search for the see also term by selecting it and clicking the **Do Search** button. See **Figure 3-42**.
Figure 3-44. See Also for a heading

The system then does a new search for the see also term. Figure 3-43 displays the search results of the See Also term.

Figure 3-45. See Also search results

Select one or more authority records Dialog Box

The Select one or more authority records dialog box displays when an Authorized record is selected from the Headings List dialog box or when an Authority Record is selected and you click Retrieve from the Reference Information dialog box. See Figure 3-44.
Figure 3-46. Select one or more authority records dialog box

The records in the Select one or more authority records dialog box sort by tracing tag of the reference such as 4XX and 5XX and then alphabetically by heading within each tracing type.

NOTE:
Headings are deduped prior to being displayed on the Select one or more authority records dialog box. Therefore, fewer entries display in this dialog box than the actual count of headings.

Perform a Keyword Search

The procedure for performing a keyword search in the Voyager modules is shown in Procedure 3-7, Performing a keyword search.

Procedure 3-7. Performing a keyword search

Use the following to conduct a keyword search.

1. From the Search dialog box, click the Keyword tab.

   Result: The Keyword tab opens (see Description of the Keyword tab on page 3-28 for more information).

2. Select the wanted search option, either the Boolean radio button, the Free Text radio button, or the Holdings Boolean radio button.
3. Enter your search term(s) or phrase(s).

Result: The search can now be executed (see Figure 3-45).

Figure 3-47. Completed Keyword tab

4. Select Do Search to execute the search, Cancel to cancel the search, Clear to delete the search terms, or Limit to set limits for this search. See Setting Search Limits on page 3-78.

Result: If the above search is performed, a Titles Index dialog box opens with the results (see Figure 3-46).
Figure 3-48. Titles Index dialog box after performing a free text keyword search

If a Holdings Boolean search has been conducted the Holdings Index dialog box shows the results (see Figure 3-47).

Figure 3-49. Holdings Index dialog box

5. Select the title or holdings record you want and select one of the option buttons. See Description of the Titles Index dialog box on page 3-44 for information.
Result: If the OK button is clicked, the response of the system varies depending on the type of search conducted.

See Keyword Search in the Cataloging Module on page 1-1.

Perform an Index Selection Search

The procedure for performing an Index Selection search is shown in Procedure 3-8, Index Selection Searching.

Procedure 3-8. Index Selection Searching

Use the following to perform an Index Selection search.

1. Access the Search dialog box and click the Index Selection tab.

2. Select the type of search wanted from the drop-down menu (see Figure 3-48).

![Figure 3-50. Type of search]
OPTIONAL:
3. Select an option button of either Find, or Browse if you are performing a heading or call number search.

OPTIONAL:
4. Select a Heading Types Filter (if doing a heading or call number search). Hold the Ctrl key down to select more that one filter.

OPTIONAL:
5. Select a Locations Filter (if applicable) from the list box(es). Hold the Ctrl key down to select more that one filter.

OPTIONAL:
6. Click the Limits button to display the Search Limits dialog box and further limit your search. See Search Limits on page 3-67.

7. Enter your search term in the Search For field (see Figure 3-49).

Figure 3-51. Completed Index Selection tab

8. Click the Do Search button to perform the search.

Result: If you performed a Non-Heading search, the Titles Index dialog box shows matching titles.
If you performed a Heading search, the **Headings List** dialog box shows all matching headings. Click the heading that most closely matches what you are searching for, then click the **OK** button (or double-click the heading.) The **Titles Index** dialog box then shows the matching titles. See [Titles Index Dialog Box](#) on page **3-42**.

9. Click the item you want to select it in the **Titles Index** dialog box and click **OK**. Optionally, double-click the title to select it.

Result: If the **OK** button is clicked, the response of the system varies depending on the type of search conducted.

See [Index Selection Search in the Cataloging Module](#) on page **1-1**.

---

**Perform a Builder Search**

The procedure for Performing a Builder search is shown in [Procedure 3-9](#), Performing a Builder search.

---

**Procedure 3-9. Performing a Builder search**

Use the following to perform a Builder search.

1. Click the **Builder** tab from the **Search** dialog box.

Result: The **Builder** tab opens (see [Figure 3-50](#)).
2. Enter a search term(s) or phrase(s) in the **Search for** field.

3. Select the “any,” “all,” or “phrase” option from the drop-down list to the right of the **Search for** field. See [Description of the Builder tab](#) on page 3-39 for a description of the options.

4. Select a **Search In** field for matching the search terms.

**OPTIONAL:**

5. Click any of the Boolean operator buttons, **And**, **Or**, or **Not**, to use multiple search rows. Repeat steps 3 - 5.

Result: The row of search terms displays in the pane below the **Search In** field.

**NOTE:**

The Boolean operator does not display in the row until you enter another search term and click an additional Boolean operator button (to be used with the next search term, if you enter another).

*Figure 3-51* shows a search using multiple search terms in combination with the following.

- All three options for relationships between terms (any, all, phrase)
• Various **Search In** fields (**Title**, the default **Keyword Anywhere**, **Subject**, and **Author Name**)

• Two Boolean operators (**AND** and **OR**)

![Figure 3-53. Builder tab with multiple search terms and relationships](image)

**OPTIONAL:**

6. Edit any row of search terms by clicking the row, then the **Edit** button, then repeating steps 3 - 5.

   Delete any row of search terms by clicking the row, then clicking the **Delete** button. Delete the entire pane by clicking the **Clear** button.

**OPTIONAL:**

7. Click the **Limits** button to display the **Search Limits** dialog box and further limit your search. See **Search Limits** on page 3-67.

8. To search, click the **Do Search** button. (To cancel and close the **Search** dialog box, click the **Cancel** button.)

   Result: The **Titles Index** or **Headings List** displays the results of the search.
See Builder Search in the Cataloging Module on page 1-1.

Access/Review the History Tab

The procedure for accessing searches from the History tab is shown in Procedure 3-10, Accessing searches from the History tab.

Procedure 3-10. Accessing searches from the History tab

Use the following to access a search from the History tab.

1. Click the History tab from the Search dialog box.

   Result: The list of previous searches displays.

2. Click the row of the search you want to access.

   Result: The row highlights.

   OPTIONAL:

3. Click the Limits button.

   Result: The Search Limits dialog box displays. For information about setting limits. See Search Limits on page 3-67.

   OPTIONAL:

4. Click the Edit button.

   Result: The correct tab opens on the Search dialog box and you can edit and re-execute the search from there.

5. Click the Do Search button.

   Result: This executes the previous search that you selected.
Remote Searching

The Remote... button found on the Search dialog box enables you to select, connect to, search, and import records from other databases.

The Remote... button displays only if you have defined remote databases to which you can connect in System Administration. See the Voyager System Administration User’s Guide for details.

Remote Databases

If remote databases are defined in the Database Definitions workspace of the System Administration module, users can search these databases in the Acquisitions and Cataloging modules. See the Voyager System Administration User’s Guide for details on defining databases.

You can include your local database in the remote database search which creates a simultaneous search of local and remote databases.

If you have opened the Search dialog box and you have set up remote searches in the System Administration module, a Remote... button displays on the Search dialog box (Figure 3-54).

Figure 3-54. Remote... button on Search dialog box
Voyager Connection Options Dialog Box

When the Remote... button is clicked the Voyager Connection Options dialog box opens (Figure 3-55).

Figure 3-55. Voyager Connection Options dialog box

Use the Remote... button to select the remote database(s) from which you want to do the following.

- Search (individually or simultaneously)
- Import records from

The Voyager Connection Options dialog box lists the databases you have access to as defined in the System Administration module. The name, connection, and type of databases are set in the Database Definition workspace of the Voyager System Administration module.

NOTE:
Your local database lists.
Table 2-9 describes the Voyager Connection Options dialog box.

Table 3-11. Description of the Voyager Connection Options dialog box

<table>
<thead>
<tr>
<th>Section</th>
<th>Field/Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Locations</td>
<td>[Unnamed]</td>
<td>Column of check boxes to the left of Database Name indicating whether or not the database has been added to Selected Locations.</td>
</tr>
<tr>
<td></td>
<td>Database Name</td>
<td>The name of the database to which you can connect.</td>
</tr>
<tr>
<td></td>
<td>Type</td>
<td>The type of database such as Bibliographic or Citation.</td>
</tr>
<tr>
<td></td>
<td>Connection</td>
<td>The connection type for the database such as Voyager or Z39.50.</td>
</tr>
<tr>
<td>Selected Locations</td>
<td>Database Name</td>
<td>Lists the databases (by name) that you have selected for searching.</td>
</tr>
<tr>
<td>Information about [database name]</td>
<td>[not used]</td>
<td>Describes the database selected in the list of Available Locations. Description is drawn from the Database Definition workspace in the Voyager System Administration module.</td>
</tr>
</tbody>
</table>

Searching Remote Databases

The procedure for searching remote databases is shown in Procedure 3-??????, Searching remote databases.

Procedure 3-11. Searching remote databases

Use the following to perform a bibliographic search of one or more remote databases.

1. Click the Remote... button at the bottom right of the Search dialog box or press Alt + R on your keyboard from the Search dialog box.

Result: The Voyager Connection Options dialog box opens.

2. Click the database(s) to which you want to connect, then click the Add >> button. (Double-clicking the database name in the Available Locations also selects it.) from the list of Available Locations,
NOTE:
If you select more than one database, Voyager searches them simultaneously.

⚠️ IMPORTANT:
To search your local database along with remote database(s), select **Local Database** from the list of **Available Locations**.

Result: Selected locations/databases display in the **Selected Locations** list. A check mark displays in the box directly to the left of the selected database name in the list of **Available Locations** (see Figure 3-56).

OPTIONAL:
3. Select the database and click the **<< Delete** button to remove a database from the list of **Selected Locations**. (You can also double-click the database name in either the list of **Available Locations** or **Selected Locations**.) To remove all the databases from the list of **Selected Locations**, click the **Clear** button.

![Voyager Connection Options](image)

**Figure 3-56.** Selected locations in the Voyager Connection Options dialog box

4. Click the **Connect** button or click the **Cancel** button.

Result: If you clicked the **Connect** button, one of the following dialog boxes opens.

- If you are connecting to one database, the **Remote Search** dialog box opens (see Figure 3-56) with the name of the database displayed in the title bar. If available from the remote server, the same search types are available as those in the regular local search display.
Figure 3-57. Remote Search dialog box, Search by options

NOTE:
Default Tab and Save Settings functions are not available for remote searches.

- If you are connecting to more than one database, the Simultaneous Search dialog box opens (see Figure 3-????). The types of searches available are limited to those shared by all connected databases.
Figure 3-58. Simultaneous Search dialog box

NOTE: Default Tab and Save Settings functions are not available for remote searches.

If you clicked the Cancel button the Voyager Connection Options dialog box closes without connecting to a remote database.

⚠️ IMPORTANT:
Searches on remote and multiple databases are limited to search types available to all connected databases. Other limits may apply. For instance, connecting to multiple databases disables heading searches, and Z39.50 databases do not support search limits.

For more information on simultaneous searching, including setting up search attributes, see the Voyager System Administration User’s Guide.

5. Enter your search criteria.

Table 2-10 lists the page numbers where you can find information about performing various searches.

Table 3-12. Page references for bibliographic search tabs

<table>
<thead>
<tr>
<th>Tab</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyword</td>
<td>2-2</td>
</tr>
</tbody>
</table>
6. Click the Do Search button.

Result: One of the following occurs.

- If you are performing a single-database search (Z39.50), the **Titles Index** dialog box opens with results from the search.

- If you are performing a single-database search (Voyager-to-Voyager), either a **Titles Index** or **Headings List** dialog box displays the results.

- If you are performing a simultaneous search, the **Search Status** dialog box opens (see Figure 3-59), listing each database name and the status of each search. The **Stop Search** button displays if your search returned over 100 hits. It allows you to interrupt the search if the status is **Searching** or **Receiving**.

---

**Figure 3-59. Search Status dialog box**

For simultaneous searches, click the **Show Results** button to view the results in the **Titles Index** dialog box (see Figure 3-59).
For searches combining local and remote databases, the Titles Index dialog box displays records in the sort order specified in the System Administration module. If you are searching only remote databases, the Titles Index dialog box displays records in the sort order specified for the first database in the Voyager Connection Options dialog box. See the Voyager System Administration User’s Guide for details.

NOTE:
For simultaneous searches, the Titles Index dialog box contains a Status button and a Database column. The Status button opens the Search Status dialog box of the last search. The Database column lists the name of the database as established in the System Administration module.

7. Click the row(s) containing the item(s) from the Titles Index dialog box to select one or more items.

8. Use one or more of the following buttons to continue and complete the search.
Use... to...

OK add the item(s) you selected to the purchase order, close the Titles Index list box, and view the line item(s) in the Purchase Order dialog box.

Cancel end the search and close the Titles Index dialog box.

Search close the Titles Index dialog box and return to a new Search dialog box.

Status open the Search Status dialog box of the last search.

Refresh update the index in the event that records were updated in the Cataloging module.

Select All choose all of the records in the search results list.

Clear All de-select all selected records.

Click the Remote... button from the Search dialog box and de-select/select new databases to change the selected databases.

NOTE:
The connections you select in the Voyager Connection Options dialog box remain throughout the session unless you change them.

User-Defined Alternate Search Button

Users can add another button on the Search dialog box, providing the capability to invoke a URI (Uniform Resource Identifier) to search outside the Voyager database.

An example of this user-defined feature is shown in Figure 3-52. The button labeled Google has been set up as a URI search option to access the Google™ search page.
This alternate search function can be configured to do either of the following:

- Take the text string entered in the **Search for** field and pass it to the alternate search facility to execute when you click this uniquely-defined alternate search button
- Access the search facility without including the text string

The URI search option is defined in the `voyager.ini` file. For more information, about the setup for this feature, see the description of the `[SearchURI]` stanza in the *Voyager Technical User’s Guide*.

### Setting Search Preferences

Users can create session searching defaults to increase their searching efficiency.

**Retain Last Search**

Selecting the **Retain Last Search** check box causes the search information from your last search to be saved until the current Voyager session is exited. That way, if you want to perform the same search again, you do not have to redefine your search type and text. This check box is found in Cataloging’s **Session Defaults and Preferences** workspace on the **Work Flow** tab.
Automatic Truncation for Index Selection Searches

Selecting the **Automatic Truncation for Index Selection Searches** check box causes an Index Selection search to be automatically truncated without requiring the question mark for a truncation character. This check box is found in Cataloging’s **Session Defaults and Preferences** workspace on the **Work Flow** tab.

Display Bibliographic Record Directly If Search Results In Only One Title

Selecting the **Display Bibliographic Record Directly If Search Results in Only One Title** check box causes a bibliographic record to display directly (if a search results in only one match), as opposed to having the **Titles Index** list box display from which you can select the bibliographic record.

Search Limits

Search limits can be applied to the following searches:

- Boolean and Free Text Keyword searches from the **Keyword** tab
- Left-anchored searches from the **Index Selection** tab
- **Builder** tab searches

**IMPORTANT:**

*Limits cannot be applied to the Holdings Boolean (MFHD Keyword), Subject headings, Author headings, or Call Number headings searches.*

Users access the **Search Limits** dialog box to limit searches. Searches can be limited by Language, Location, Date, Medium, Type, Place, or Status.

In a limited search, the system compares the limit criteria selected to the code or value in the corresponding field of the bibliographic record. For example, if a search is limited to the publication date of 1960, the system checks the 008 control field in the MARC bibliographic record, date of publication field (Figure 3-53) and returns the matching results.
User's can configure the limits available in the **Search Limits** dialog box by configuring the `limits.ini` file. See [Limits.ini File](#) on page 3-70.

### Search Limits Dialog Box

*Figure 3-54* shows the **Search Limits** dialog box.

---

*Figure 3-62. Bibliographic record*

User's can configure the limits available in the **Search Limits** dialog box by configuring the `limits.ini` file. See [Limits.ini File](#) on page 3-70.

### Search Limits Dialog Box

*Figure 3-54* shows the **Search Limits** dialog box.
Table 3-11 describes the **Search Limits** dialog box.

### Table 3-13. Description of the Search Limits dialog box

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of Limits</td>
<td>Types of limits that can be imposed.</td>
</tr>
<tr>
<td>Limit Type Column</td>
<td>Type of limit selected.</td>
</tr>
<tr>
<td>Value</td>
<td>Value of the limit selected.</td>
</tr>
<tr>
<td></td>
<td>For example, if a language limit is applied, English is a possible value.</td>
</tr>
<tr>
<td>Add Button</td>
<td>Applies the limit selected in the top portion of the dialog box and displays in the bottom portion of the dialog box.</td>
</tr>
<tr>
<td>Delete Button</td>
<td>Deletes the selected limit from the bottom half of the dialog box.</td>
</tr>
<tr>
<td>Clear Button</td>
<td>Clears the selected limit from the top half of the dialog box.</td>
</tr>
<tr>
<td>Retain search limits between searches</td>
<td>Applies the limit(s) to the current search and all future searches.</td>
</tr>
<tr>
<td>OK Button</td>
<td>When clicked the system returns to the <strong>Search</strong> dialog box and the search limits defined are in effect.</td>
</tr>
</tbody>
</table>

**Limits.ini File**

Search limits are configured in the `limits.ini` file located in the `c:\Voyager\Misc` directory on the user’s computer. This file contains various stanzas which govern the type of limits available ([Limits] stanza), and the limiting criteria (search limits stanzas) seen in the **Search Limits** dialog box. **Figure 3-55** provides an example of the `limits.ini` file.

**NOTE:**
Use a text editor to edit the `limits.ini` file such as Notepad or Wordpad.
Figure 3-64. Sample limits.ini file

Limits Stanza

The [Limits] stanza defines the type and order of limits available in the Search Limits dialog box. It lists a three letter code for each type of limit:

- Language (LAN)
- Location (LOC)
- Date (DAT)
- Medium (MED)
- Type (TYP)
- Place (PLA)
- Status (STA)
If any codes are misspelled or not present, that limit type is not available. Also, the order in which the codes are listed in the stanza is the order in which the limits are listed in the Search Limits dialog box.

Figure 3-56 shows a [Limits] stanza and the corresponding Search Limits dialog box list of limits.

Figure 3-65. [Limits] stanza and the list of limits in the Search Limits dialog box

Also, for each type of limit except the location limit, there is an associated search limit stanza defining the limit criteria. For example, users wanting to limit by medium would include MED in the [Limits] stanza, and include a [Medium] stanza in the limits.ini file.

Search Limits Stanzas

The search limit stanzas in the limits.ini file correspond to the types of limits listed in the [Limits] stanza. These provide the limiting criteria for each limit type. The search limits stanzas are as follows:

- [Language]
- [Date]
- [Medium]
- [Type]
- [Place]
- [Status]

NOTE:
Operators may limit by location if LOC is listed in the [Limits] stanza. However since locations are locally defined there is no locations stanza, the list of locations to choose from is derived from the locations defined in the System Administration module, see the Voyager System Administration User’s Guide.
Rules for Search Limit Stanzas

- Stanzas can be in any order in the *limits.ini* file, they do not have to be in the same order as in the [Limits] stanza.
- Users can delete criteria by deleting the line, using the hash mark before the criteria does not work.
- Removing a search limit stanza prevents those limits from being available.
- The [Date] stanza cannot be edited.

⚠️ IMPORTANT:

See the MARC standards for information regarding the MARC Leader, 007, and 008 fields, as well as, the available codes used for languages, status, medium, and places of publication, http://www.loc.gov/marc/.

[Language] Stanza

Users can limit searches to items published in a particular language by configuring this stanza. Any language you want to limit by must be listed in this stanza.

*Figure 3-57* shows an example of part of the [Language] stanza. This stanza is editable and additional languages may be added.

```
[Language]
ENG=English
ENM=English, Middle (1100-1500)
AN=English, Old (ca. 430-1100)
AR=Arabic
CH=Chinese
DA=Danish
DE=Dutch
DUT=Dutch, Middle (ca. 1050-1350)
FRA=French
FRE=French, Middle (ca. 1400-1600)
FRE=French, Old (ca. 840-1400)
GER=German
```

*Figure 3-58* shows some of the language limits that correspond to the [Language] stanza (*Figure 3-57*) as they display in the Search Limits dialog box.
Figure 3-67. Language limits

When a language limit is applied, the system compares the language code in the 008 control field (positions 35-37) of the MARC record with the language selected in the Search Limits dialog box to find matching records.

[Date] Stanza

Users can limit searches to items published in a particular year, range of years, or before or after a particular year.

Figure 3-59 shows the [Date] stanza. This stanza is not editable.

Figure 3-68. Date stanza example

Figure 3-60 shows the date limits that correspond to the [Date] stanza (Figure 3-59) as they display in the Search Limits dialog box.

Figure 3-69. Date limits
When a date limit is applied, the system compares the date in the 008 control field (positions 07-10) of the MARC record with the date provided in the SearchLimits dialog box to find matching records.

[Medium] Stanza

Users can limit searches to the medium in which the item is published by configuring this stanza. Any medium you want to limit by must be listed in this stanza.

Figure 3-61 shows an example of the [Medium] stanza. This stanza is editable and additional medium limit codes may be added.

![Medium stanza example](image)

Figure 3-70. Medium stanza example

Figure 3-62 shows some of the medium limits that correspond to the [Medium] stanza (Figure 3-61) as they display in the SearchLimits dialog box.

![Medium limits](image)

Figure 3-71. Medium limits

When a medium limit is applied, the system compares the medium code in the first position in the 007 control field of the MARC record with the medium selected in the SearchLimits dialog box to find matching records.
[Type] Stanza

Users can limit searches to the type of item by configuring this stanza. In Voyager, types are a combination of the type of record and the bibliographic level. Any type you want to limit by must be listed in this stanza.

Figure 3-63 shows an example of the [Type] stanza. This stanza is editable and additional type limit codes can be added.

![Figure 3-63: Type stanza example]

Figure 3-72. Type stanza example

Figure 3-64 shows some type limits that correspond to the [Type] stanza (Figure 3-63) as they display in the Search Limits dialog box.

![Figure 3-73: Type limits]

Figure 3-73. Type limits

When a type limit is applied, the system creates a 2-letter code using the type of record code in the Leader control field (position 06) and bibliographic level code in the Leader control field (position 07) of the MARC record. This code is then compared to the type selected in the Search Limits dialog box to find matching records.

[Place] Stanza

Users can limit searches to items published in a particular place by configuring this stanza. Any place you want to limit by must be listed in this stanza.
Figure 3-65 shows an example of part of the [Place] stanza. This stanza is editable and additional places can be added.

```
[Place]
ak=Alaska
d=American Samoa
ad=Andorra
am=Angola
ai=Anguilla
ay=Antarctica
at=Antigua and Barbuda
ag=Argentina
az=Arizona
ar=Arkansas
ak=Armenia (Republic)
afr=Azerbaijan S.S.R.
aw=Aruba
at=Austria
au=Australia
az=Azerbaijan
af=Azerbaijan S.S.R.
bh=Bahamas
ba=Bahrain
bd=Bangladesh
bb=Barbados
be=Belarus
be=Belgium
bf=Benin
```

Figure 3-74. Place stanza example

Figure 3-66 shows some of the place limits that correspond to the [Place] stanza (Figure 3-65) as they display in the Search Limits dialog box.

Figure 3-75. Place limits

When a place limit is applied, the system compares the place code in the 008 control field (positions 15-17) of the MARC record to the place selected in the Search Limits dialog box to find matching records.

[Status] Stanza

Users can limit searches of serial records by the publication status by configuring this stanza. Any status you want to limit by must be listed in this stanza.
Figure 3-67 shows the [Status] stanza. This stanza is editable and additional status limit types may be added.

![Status stanza example](image)

**Figure 3-76. Status stanza example**

Figure 3-68 shows the status limits that correspond to the [Status] stanza (Figure 3-67) as they display in the Search Limits dialog box.

![Search Limits dialog box](image)

**Figure 3-77. Status limits**

When a status limit is applied, the system compares the status code in the 008 control field (position 06) of the MARC record with the status selected in the Search Limits dialog box to find matching records.

Limiting a Search

The procedure for setting search limits is shown in Procedure 3-11, Setting Search Limits.

**Procedure 3-12. Setting Search Limits**

Use the following to set search limits.

1. Click the Limit button to limit your search.

   Result: The Search Limits dialog box opens (see Figure 3-69).
2. Click the plus sign (+) for the limit type you want to select.

Result: This expands the list and displays the list of limit type values (see Figure 3-70).

3. Select any values from the list you want to use as limits for your search. Figure 3-71 shows the Medium limit of Computer File selected.

**NOTE:**
The Add button is not active until a specific limit is selected.
Figure 3-80. Computer File selected as search limit

4. Click the **Add** button (or double-click the value) to add the limit to the list.

Result: The limit type value you selected displays in the **Limit Type** and **Value** columns (see Figure 3-72).

Figure 3-81. Selected search limits listed in the bottom portion of the dialog box

**OPTIONAL:**

5. Click the **Retain search limits between searches** check box.
OPTIONAL:
6. To edit the limits you have chosen, select a limit type value from the **Value** column and click the **Delete** button to remove the value from the limits to be applied or click the **Clear** button to remove all limit type values from the **Value** column.

7. Click **OK** to accept the limiting criteria and return to the **Search** dialog box.

Result: The search limits are set.

---

**MFHD-Bibliographic Combined Keyword Search (optional feature)**

The MFHD-Bibliographic Combined Keyword Search provides the ability to combine holdings and bibliographic search criteria into one keyword search. This function is available through Voyager client and OPAC search facilities. (The focus of this user’s guide description is about the Voyager client capabilities.)

**NOTE:**
The MFHD-Bibliographic Combined Keyword Search is an optional feature that requires headings keyword indexes to be built. Contact Ex Libris Customer Support for more information.

In the Voyager client, the combined search may be performed as a command-line Boolean Keyword search or the Builder search function may be used.
Example: The following is an example of a command-line search for “102 Dalmatians” or “African Queen” in the motion picture collection where SPAC is the Voyager code for the indexed 901 ‡a holdings field and MP is the code representing the motion picture collection stored in the 901 ‡a. See Figure 3-73 and Figure 3-74.

Figure 3-82. MFHD-Bibliographic Combined Keyword Search - command line example

Figure 3-83. Results of MFHD-Bibliographic Combined Keyword Search
NOTE:
The 901 ‡a is used for local cataloging conventions and examples of MFHD-Bibliographic Combined Keyword Search vary from institution to institution based on what is indexed.

Setup

Voyager provides the SPAC holdings keyword definition in Voyager System Administration for use with the MFHD-Bibliographic Combined Keyword Search. See Figure 3-75. The SPAC definition may be edited and/or additional definitions may be created depending on what you have indexed in your database.

Follow the normal procedures for defining holdings keyword definitions. See the Voyager System Administration User’s Guide for more information.

Figure 3-84.  SPAC holdings keyword definition

The SPAC code may be used in a command-line search to identify the index to be searched. See Figure 3-73.
Search Options

The MFHD-Bibliographic Combined Keyword Search incorporates the following functional search options/characteristics.

- Boolean operators to include parentheses for grouping and quotes for phrases
- And, or, or not boolean logic may be used to separate each index and term/phrase combination in a command line search as in Figure 3-73

**NOTE:**
Free-text search syntax of the plus sign and asterisk is not available for command-line boolean searches.

- Search limits
- Remote searching via a Voyager-to-Voyager connection is available

**NOTE:**
The MFHD-Bibliographic Combined Keyword Search feature must be installed on each remote Voyager server and the search codes (such as SPAC) must be compatible for remote Voyager searching to work.

Search Results Display

The MFHD-Bibliographic Combined Keyword Search incorporates the following search results display characteristics.

- Search results sets display the associated bibliographic record for the MHFD-bibliographic combined search
- Search results set limit continues to be 10,000
- Search results are de-duplicated by bibliographic ID
- Search results display in the Titles Index format
- Search results columns displayed are determined by the first index in the search when multiple indexes are combined in a search per pre-existing functionality

User Considerations

In utilizing the MFHD-Bibliographic Combined Keyword Search function, be aware of the following considerations.
• MFHD keyword indexes are not available to the Z39.50 server. As a result, there is no way to incorporate a Z39.50 search into a combined MFHD-bibliographic search.

• Holdings-only search criteria (without the combined bibliographic criteria) generate bibliographic results sets. See Search Results Display on page 3-84 for more information. Use the optional Holdings Boolean Keyword search function to generate holdings results sets.

Searching in Cataloging Examples

This section discusses and provides examples of searching in the Cataloging module.

In the Cataloging module, users access the Search dialog box by clicking the Search icon in the toolbar or by selecting Search from the Record menu.

Users search for and display bibliographic, holdings, or authority records and if authorized, can edit these records.

Keyword Search in the Cataloging Module

<table>
<thead>
<tr>
<th>If the Keyword search is</th>
<th>Then the results display in... and the selected record...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean</td>
<td>The Titles Index dialog box displays. Selecting a title and clicking the OK button displays the MARC tab of the bibliographic record. See the Boolean search example on page 1-1.</td>
</tr>
<tr>
<td>Free text</td>
<td>The Titles Index dialog box displays with relevance bars. Selecting a title and clicking the OK button displays the MARC tab of the bibliographic record. See the Free Text search example on page 1-1.</td>
</tr>
<tr>
<td>Holdings Boolean (optional feature)</td>
<td>The Holdings Index dialog box displays. Selecting a holdings record and clicking the OK button displays the MARC tab of the holdings record. See the Holdings Boolean search example on page 1-1.</td>
</tr>
</tbody>
</table>

Example: Boolean search

Conduct a Boolean search to access bibliographic records relating to women and equality (Figure 2-??????).
Figure 3-85. Boolean search for a MARC record

After the search is conducted, a **Titles Index** dialog box lists the results (Figure 3-85).
Figure 3-86. Titles Index dialog box listing the results of the Boolean search

After a title is selected and the user clicks OK, the MARC tab of the bibliographic record displays (Figure 3-??????).

Figure 3-87. Selected bibliographic record displays
Example: Free Text search

Conduct a Free text search to find an item with the word zeitgeist in it (Figure 3-88).

![Search interface for a bibliographic record]

Figure 3-88. Free text search for a bibliographic record

After the search is conducted, a Titles Index dialog box lists the results (Figure 3-88).
Figure 3-89. Titles Index dialog box listing the results of the Free Text search

After a title is selected and the user clicks OK, the MARC tab of the bibliographic record displays (Figure 3-90).

Figure 3-90. Bibliographic record after conducting a Free Text search
Example: Holdings Boolean search

Conduct a Holdings Boolean search to find items belonging to the **Murray collection** (Figure 3-91). In this case, holdings records contain an additional tag with collection information.

![Search dialog](image)

**Figure 3-91. Holdings Boolean search for items belonging to the Murray collection**

After the search is conducted, a **Holdings Index** dialog box lists the results (Figure 3-91).
Figure 3-92. Holdings Index listing the results of the Holdings Boolean search

After a holdings record is selected and the user clicks **OK**, the **MARC** tab of the holdings record displays (Figure 3-93).

Figure 3-93. MARC tab of the selected holdings record displays
### Index Selection Search in the Cataloging Module

<table>
<thead>
<tr>
<th>If the Index Selection search is</th>
<th>Then the results display in...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headings</td>
<td>The <strong>Headings List</strong> dialog box displays. Select a heading and click the <strong>OK</strong> button. The <strong>Titles Index</strong> dialog box displays. Select a title and click <strong>OK</strong>. The <strong>MARC</strong> tab of the bibliographic record displays. See the <a href="#">Headings search example on page 1-1</a>.</td>
</tr>
<tr>
<td>Left-Anchored</td>
<td>The <strong>Titles Index</strong> dialog box displays with relevance bars. Select a title and click <strong>OK</strong>. The <strong>MARC</strong> tab of the bibliographic record displays. See the <a href="#">Left-anchored search example on page 1-1</a>.</td>
</tr>
</tbody>
</table>

Example: Headings search

Conduct a headings search to find an authority record for civil rights (Figure ??-??????).

![Search](image)

**Figure 3-94.** Headings search

After the search is conducted, a **Headings List** dialog box lists the results (Figure ??-??????).
Figure 3-95.  Headings List dialog box

After the wanted heading is selected and the user clicks the Authority button, the Reference Information dialog box displays (Figure ?-?????).

Figure 3-96.  Reference Information dialog box

To access the Authority record, the user clicks the Retrieve button. In this example, multiple authority records are found (Figure ?-?????).
Figure 3-97. Multiple authority records found
Select the wanted record and display it (Figure 3-97).

Figure 3-98. Authority record
Example: Left-anchored search

Conduct a left-anchored search for the title, *To The Lighthouse*, published before the year 2000 (Figure 3-99).

![Search dialogue box]

**Figure 3-99. Left anchored, limited search**

After the search is conducted, a **Titles Index** dialog box lists the results (Figure 3-100).

![Titles Index]

**Figure 3-100. Titles Index dialog box**
After a title is selected, the MARC tab of the bibliographic record displays (Figure 3-101).

![Figure 3-101. MARC tab of the bibliographic record](image)

**Builder Search in the Cataloging Module**

All **Builder** tab searches are Keyword searches. Therefore, the results are displayed in the Titles Index. Additionally, limits can be applied. See the **Builder search** example on page 1-1.

Example: **Builder search**

Conduct a remote builder search for the title, *The Bell Jar*, written by **Lucas or Plath** (Figure 3-102).
Figure 3-102. Builder search

After the search is conducted, a **Titles Index** dialog box lists the results (Figure 3-108).
Chapter 3: Creating, Opening, and Viewing Records

Figure 3-103. Titles Index dialog box

After a title is selected, the MARC tab of the bibliographic record displays (Figure 3-104).

Figure 3-104. MARC tab of the bibliographic record
Additional Options for Displaying a Record - Web Server http POST

You can display an active bibliographic or holdings record from Cataloging in WebVoyáge for example using an http POST request to send a MARC record to a web server. This is an optional feature that is set in the voyager.ini file with the [MARC POSTing] stanza. For more information regarding setup, see the Voyager Technical User’s Guide.

See Procedure 3-12, Display Record in WebVoyáge - Example, on page 3-85 for an example of displaying an active bibliographic or holdings records from the Cataloging module in WebVoyáge.

Procedure 3-13. Display Record in WebVoyáge - Example

Use the following to display an active bibliographic or holdings record in WebVoyáge.

1. Search and open a bibliographic record in the Cataloging module.

   Result: This makes the bibliographic record active.

2. (Optional) Click Get Holdings.

   Result: This makes the holdings record active.

3. Click Record > Send Record To > WebVoyáge. See Figure 3-76.

   Result: This displays the active record in WebVoyáge.

   NOTE: The active record can be determined by the highlighted Title Bar.
Chapter 3: Creating, Opening, and Viewing Records

Viewing and Editing Line Items
(Acquisitions in Cataloging)

The Cataloging in Acquisitions or Cat in the Acq feature allows you to view and edit a bibliographic record in the Cataloging module from a line item in the Acquisitions module. See the Voyager Acquisitions User’s Guide for details on Cat in the Acq.

In order to improve workflow even further, the Acquisitions in Cataloging or Acq in the Cat feature provides the second half of the two-way communication between the Acquisitions and Cataloging modules. Acq in the Cat allows you to pull up and edit a line item in the Acquisitions module from the associated bibliographic or holdings record in the Cataloging module. In this way, you can view all of the information related to a specific title without performing any additional searching, thereby saving valuable time and effort.
System Administration Setup

In order to use the Acq in the Cat feature, there is only one System Administration configuration you need to set. This configuration pertains to Acquisitions security permissions. Specifically, the operator(s) established in System Administration that you want to use the Acq in the Cat feature, must have at least view-only access to line items in Acquisitions. If the operator(s) does not have at least view-only access to line items in Acquisitions, they will not be able to use the Acq in the Cat feature. In fact, the menu option in the Cataloging module that facilitates Acq in the Cat functionality is grayed out. See 3-88 for more details on the Acq in the Cat feature.

You establish view-only access (or add/update and/or delete access) to line items in Acquisitions on the Profile Values tab of the appropriate Acquisitions/Serials Profile Definition in the System Administration module. See Figure 3-77. To access the Profile Values tab of an Acquisitions/Serials Profile Definition, select Applications>Security from the System Administration main menu, or click the Security button. The Voyager Security Configuration dialog box opens. Click the Acq/Serials Profiles button, select the profile for which you want to set permissions, and click the Profile Values tab.

For detailed information about setting permissions in Acquisitions/Serials Profile Definitions, see the "Securing Your System>Acquisitions/Serials Profile Definitions" section of the Voyager System Administration User’s Guide.
Chapter 3: Creating, Opening, and Viewing Records

Figure 3-106. Establishing at least view-only access to line items in Acquisitions

The procedure for using the Acq in the Cat function is shown in Procedure 3-13, Using the Acq in the Cat Function, on page 3-88.

Procedure 3-14. Using the Acq in the Cat Function

Use the following steps to work with the Acq in the Cat function.

1. Log into both the Cataloging and the Acquisitions modules using the same User ID and Password.

   If you are not logged into both modules, an error message displays. See Figure 3-78.
If you are logged into Cataloging and Acquisitions with different **User IDs** and **Passwords**, an error message opens. See Figure 3-79.

**Figure 3-108. Error message if logged into modules with different User IDs and Passwords**

2. Open a bibliographic or holdings record in the Cataloging module. See **Opening a Record** on page 3-8 for details on opening records.

   Result: The record opens.

3. Select **Record>View Line Items in Acquisitions**, or use the **Ctrl + M** keystroke. Depending on whether the number of line items associated with the record, the result will be different.

   Result: Line items open through Acq in the Cat function. See Figure 3-80.

Once the line item is up in the Acquisitions module, you can view and manipulate it in standard Acquisitions fashion. See the **Voyager Acquisitions User’s Guide** for details on line items.

**NOTE:**

If you have not established at least view-only access to line items in Acquisitions (in the System Administration module) for the operator(s) using the Acq in the Cat function, the **View Line Items** in Acquisitions menu option will be grayed out. See **System Administration Setup** on page 3-87 for more information on setting at least view-only access to line items in Acquisitions.
A Single Line Item

If there is one line item associated with the record you opened, selecting Record > View Line Items in Acquisitions (or Ctrl + M) causes the Acquisitions client to display with the record’s associated line item.

**NOTE:**

Line items are directly associated with bibliographic records, as opposed to holdings records, in Voyager. Thus, using Acq in the Cat from a holdings record will cause the line item to display that is associated with the holdings record’s related bibliographic record. This is because holdings and bibliographic records are linked in the Voyager system.

---

**Figure 3-109.** Line item that displays in the Acquisitions module

**Multiple Line Items**

If more than one line item is associated with the record such as the same title has multiple purchase orders or if one line item was created per copy, selecting Record > View Line Items in Acquisitions (or Ctrl + M) causes a dialog box to display in Acquisitions, summarizing all of the line items associated with the bibliographic record (see Figure 3-81). This summary is broken down into the
following 8 pieces: Line #/Status, Title, # Copies, Location(s), Funds, Line Item Type, Notes, and PO #. From this dialog box, you can view (and edit) the line item of your choice by highlighting it and clicking the Details... button.

**TIP:**
To save you time and effort, the dialog box summarizing the line items will not close (even if you pull up a line item) until you press the Close button. That way, you do not have to go back into Cataloging and repeat the steps for viewing line items in Acquisitions.

---

**Figure 3-110.** Dialog box for multiple line item matches in Acquisitions

**No Line Items**

If the record you opened does not have any associated line items, selecting Record>View Line Items in Acquisitions (or Ctrl + M) will cause the following error message to display in Cataloging (see Figure 3-82).

---

**Figure 3-111.** Message associated line items do not exist
4. Save your changes or exit when you are finished viewing the item in Acquisitions.

Retrieving Records Associated with Other Records

You can retrieve records that are related to other records. Depending on what type of record is the active record, you can retrieve records by selecting the appropriate command from the Record menu. See Table 3-12.

You can also retrieve records by clicking the appropriate toolbar button.

Table 3-14. Retrieve Options Using Record Menu

<table>
<thead>
<tr>
<th>Record Type</th>
<th>Able to Retrieve</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authority</td>
<td>None</td>
</tr>
<tr>
<td>Bibliographic</td>
<td>Authority, Holdings, or Item</td>
</tr>
<tr>
<td>Holdings</td>
<td>Items, Bibliographic</td>
</tr>
<tr>
<td>Items</td>
<td>Holdings, Bibliographic</td>
</tr>
</tbody>
</table>

You can also view all of the associated records by selecting Record> Show Associated Records (or click the Hierarchy button). From the Holdings and Items for dialog box you can select which associated record you want to retrieve.

- The procedure for retrieving holdings is shown in Procedure 3-14, Retrieve Holdings, on page 3-92.
- The procedure for retrieving authorities is shown in Procedure 3-15, Retrieve Authority, on page 3-94.
- The procedure for retrieving items is shown in Procedure 3-16, Retrieve Items, on page 3-95.

Retrieve Holdings

The procedure for retrieving holdings is shown in Procedure 3-14, Retrieve Holdings, on page 3-92.

Procedure 3-15. Retrieve Holdings

Use the following to retrieve holdings.
1. Select **Record>Retrieve Holdings** or click the **Retrieve Holdings** button (Figure 3-83).

---

**Figure 3-112. Retrieve Holdings Button**

Result: If there is only one holdings record associated with the active bibliographic record, the holdings record opens.

If the bibliographic record has more than one holdings record associated with it, the **Retrieve Holdings** dialog box opens (Figure 3-84).

---

**Figure 3-113. Retrieve Holdings dialog box**

This dialog box lists the **ID**, **Location**, and **Call Number** for all the holdings records attached to the active bibliographic record.

2. Click **New**, **Retrieve** (after selecting record to retrieve), or **Cancel**.

Result: You can enter a new record, view (retrieve) a selected record, or exit from this dialog box.
Retrieve Authority

The procedure for retrieving authority records is shown in Procedure 3-15, Retrieve Authority, on page 3-94.

Procedure 3-16. Retrieve Authority

Use the following to retrieve authority records.

1. Select Record>Retrieve Authorities.

Result: The Select one or more authority records dialog box opens (Figure 3-85), listing record numbers and names for all the authority records attached to the active bibliographic record.

![Select one or more authority records dialog box]

Figure 3-114. Select one or more authority records dialog box

2. Select the record(s) that you want to view and click OK. Click Cancel to close the dialog box without retrieving any records.

Retrieve Items

The procedure for retrieving items is shown in Procedure 3-16, Retrieve Items, on page 3-95.
Procedure 3-17. Retrieve Items

Use the following to retrieve items.

1. Select Record>Retrieve Items or click the Retrieve Items button (Figure 3-86).

```
Figure 3-115. Retrieve Items Button
```

Result: The Retrieve Items dialog box opens (Figure 3-87).

```
Figure 3-116. Retrieve Items dialog box
```

From this dialog box you can open the item record(s), open the respective holdings record, or resequence the items if there are more than one. For any of the following activities, click the Clear button to unselect all of the selected items.

Each item's location is designated as a permanent location or a temporary location. A permanent location is indicated by a capital P in parentheses (P) after the location name. A temporary location is indicated by a capital T in parentheses (T) after the location name.

2. To open the item record(s), highlight the Item record(s) that you want to view (or double-click an Item record) and click OK. Click Cancel to close the dialog box without retrieving any records.
3. To open the holdings record, highlight the appropriate Item record and click the **View Holdings** button.

4. To resequence the items, perform the following steps. Resequencing items allows you to determine in which order items display in other modules.
   a. Highlight the item(s) you want to resequence.
   b. Click the **Move Before** button (cursor changes to an up arrow) or the **Move After** button (cursor changes to a **down arrow**), depending on where you want to move the item. Click **Cancel Move** to cancel the move without resequencing the items.
   c. Point to and click the item you want to move the other item(s) before or after. The items are resequenced.
   d. If you want this order to display every time this list is displayed, click the **Save** button then click the **Cancel** button to close the **Retrieve Items** dialog box.
   e. Click the **Cancel** button before clicking the save button to close the dialog box without saving the new sequencing order of the items.

---

**Retrieve Bibliographic Record (Shortcut)**

When the holdings and/or item record displays, use **Retrieve Bibliographic Record** to quickly view the associated bibliographic record.

To access this capability, click **Record>Retrieve Bibliographic Record**, click **Get Bib** from the toolbar, or use **Ctrl+J**. See **Figure 3-17**.
Viewing Holdings Locations

To list all locations for which you are authorized, select **Edit>Show Holdings Locations** (or press Ctrl-L). The **Holdings Locations** dialog box opens (Figure 3-89).

You must be in the subfield data field of a Holdings record to access this dialog box. This command displays all holdings locations and their abbreviations for your security access level. You can use this dialog box to change or add a location to a holdings record. Place your cursor after the subfield b marker, display the valid values (Ctrl + L), highlight a location and click **OK** (or double-click a location).
Chapter 3: Creating, Opening, and Viewing Records

Linking and Unlinking Records

With the Cataloging module, you can link an item to multiple bibliographic records in order to accommodate a bound with situation. The ability to link bibliographic records and item records depends upon which type of record the active record is. See Creating and Opening Records on page 3-1 for more information.

Link Item to Bib

The procedure for linking items to bibliographic records is shown in Procedure 3-17, Linking Items to Bibliographic Records, on page 3-98.

Procedure 3-18. Linking Items to Bibliographic Records

Use the following to link items to bibliographic records.

1. Select Record>Link to bibliographic.

Result: The Link the item to a bibliographic record dialog box opens (Figure 3-90).

![Link the item to a bibliographic record dialog box](Fig3-90.png)

Figure 3-119. Link the item to a bibliographic record dialog box

2. Type the appropriate bibliographic ID in the text box. The bibliographic ID is displayed in the title bar of the bibliographic record.

3. Click OK to link the item record to the bibliographic record; click Cancel to close the Link an item to bibliographic record dialog box without linking the records.

NOTE: The ability to link bibliographic and item records in the Record menu is disabled if the system focus is not on a bibliographic or item record from the database. It also
doesn't work if the focus is on a bibliographic record from the database but the
bibliographic record has existing holdings. In such a case, linking an item to the
bibliographic record is not allowed because an existing item would already be
linked to a holdings record either for this bibliographic record or another one.

---

**Relink an Item to a Different Holdings**

If an item record is the active record, you can specify a specific holdings record to
re-link the current item record to.

**NOTE:**
Relinking an item to a different holdings will remove the link between the current
item and the original holdings.

The procedure for relinking an item to a different holdings is shown in
Procedure 3-18, Relink an Item to a Different Holdings, on page 3-99.

---

**Procedure 3-19. Relink an Item to a Different Holdings**

Use the following to relink an item to a different holdings.

1. Select **Record>Relink to a different holding**.

   Result: The **Relink the item to a holding record** dialog box opens (Figure 3-91).

   ![Relink the item to a holding record dialog box](image)

   **Figure 3-120. Relink the item to a holding record dialog box**

2. Type the appropriate holdings ID in the text box. The holdings ID is displayed in the
title bar of the item record.
3. Click OK to link the item record to the specified holdings record. Click Cancel to close the Relink the item to a holding record dialog box without linking the records.

NOTE:
The ability to relink an item to a different holdings in the Record menu is disabled if the system focus is not on a item record from the database.

Unlinking Holdings and Bib Records

With the Cataloging module, you can unlink a holdings record from multiple bibliographic records in order to eliminate a bound with situation.

NOTE:
This command is only available when a holdings record that is attached to multiple bibs is the active record.

The procedure for unlinking holdings and bibliographic records is shown in Procedure 3-19, Unlinking Holdings and Bib Records, on page 3-100.

Procedure 3-20. Unlinking Holdings and Bib Records

Use the following to unlink holdings and bibliographic records.

1. Select Record>Unlink holding from bibliographic.

   Result: The Linked Bib Records dialog box opens.

2. Select the bibliographic ID that you want to unlink the holdings record from.

   Result: The bibliographic ID is displayed in the title bar of the bibliographic record.

3. Click OK, or click Cancel.

   Result: This unlinks the bibliographic record from the holdings record or closes the dialog box without unlinking the records.
NOTE:
The ability to unlink an item from a holdings in the Record menu is disabled if the system focus is not on an item record from the database.

Copying an Item Record from an Existing Item Record

You can copy an item record from an existing item record as long as the item record is in the database (like copying MARC records). However, the barcode and template information are not copied to the record. In Session Preferences, the Item Defaults tab allows you to complete a template-like preference so that when you copy item records, information is already entered for your record.
Changing, Saving, and Printing Information

Changing Information 4-1
- Editing a Record 4-1
- Deleting a Record 4-2
- Adding a URL to an 856 Field 4-3
- Change Owning Library 4-4

Changing Records with Bibliographic Overlay/Merge in Cataloging 4-5
- Record History - Overlay/Merge 4-9

Saving and Printing Information 4-9
- Saving a Record
  - Save 4-9
  - Update Record Alert 4-10
  - Save As... 4-11
  - Save to Database 4-11
  - Saving to the Database and to a File Simultaneously 4-16
- Validating a Bibliographic Heading 4-17
- Make a Copy of a Record 4-19
- Printing a Record 4-19
- Printing Labels 4-20
  - Bibliographic Records 4-22
  - Holdings Records 4-22
  - Item Records 4-22
  - Spine and Piece Label Print Template 4-23
• Closing a Record 4-36
Changing, Saving, and Printing Information

Changing Information

This section describes the following.

- How to edit existing records in the Cataloging module
- Alternatives for saving a record
- Printing options

Editing a Record

Before you can edit a record, you must first open the record. For more information, see Opening a Record on page 3-8.

The procedure for editing a record is shown in Procedure 4-1, Editing a Record, on page 4-1.

Procedure 4-1. Editing a Record

Use the following to edit a record.

1. Display the record that you want to edit. (See Opening a Record on page 3-8 for more information.)
2. Edit the record by changing the following.

- Leader
- Fixed fields
- Variable fields

For more information on these fields, see the section about that particular record type in Bibliographic Records on page 2-3, Authority Records on page 2-29, and Holdings Records on page 2-39.

To edit a record, you can use the same commands as you use for editing a template. See Table 10-13 on page 10-23 for more information.

3. Save the record with one of the following commands: Save, Save As..., or Save to Database. (See Saving a Record on page 4-9 for more information.)

NOTE:
If you cut and paste information from a different application (such as Microsoft Word), the following characters are stripped out. See Table 4-1.

Table 4-1. Character Changes

<table>
<thead>
<tr>
<th>Character</th>
<th>ASCII Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>tab</td>
<td>ASCII 09</td>
</tr>
<tr>
<td>carriage return</td>
<td>ASCII 0D</td>
</tr>
<tr>
<td>line feed</td>
<td>ASCII 0A</td>
</tr>
<tr>
<td>subfield delimiter</td>
<td>ASCII 1F</td>
</tr>
<tr>
<td>end of field character</td>
<td>ASCII 1E</td>
</tr>
<tr>
<td>end of record character</td>
<td>ASCII 1D</td>
</tr>
</tbody>
</table>

Bibliographic Records

When you edit the bibliographic level and/or type of record in the Bibliographic Leader, a dialog box opens warning you about the incompatibility of the 008 to this changed record. If you click No or Cancel, the changes you made to the Bibliographic Leader will not be saved. If you click Yes, the changes will be saved and the incompatible portion of the 008 field displays. You can then make the changes to the 008 field.

Deleting a Record

You can delete a record from the database by selecting Record>Delete.
Chapter 4: Changing, Saving, and Printing Information

The procedure for deleting a record is shown in Procedure 4-2, Deleting a Record, on page 4-3.

**Procedure 4-2. Deleting a Record**

Use the following to delete a record.

1. Display the record from the database that you want to delete. (See Search Dialog Box on page 3-26 for more information.)

2. Select Record>Delete.

3. Click OK, or click Cancel.

Result: This deletes the record or closes the confirmation dialog box without deleting the record.

**NOTE:**

You cannot delete a bibliographic record that has holdings records attached to it, and you cannot delete a holdings record that has item records attached to it. You also cannot delete a record that has other transactions pending against it. This includes records that are checked out to patrons in the Circulation module or purchase orders in the Acquisitions module.

When you delete a record, it is saved on the server in a file called `delete.<recordtype>.marc`, where `<recordtype>` is the type of record being deleted (either bib, mfhd, or auth). For example, if you delete a bibliographic record, it is saved in the file `delete.bib.marc`. To access the deleted files on the server, contact your system administrator.

When item records are deleted, key pieces of item information are automatically archived in a log file called `delete.item`. This file is intended for audit and statistical purposes. If necessary, this file may be used to manually recreate items in Voyager.

**Adding a URL to an 856 Field**

You can automatically insert an 856 field with a URL in it into your record. Voyager automatically adds the URL on view in your web browser into a new 856 field in the record currently open in Cataloging. If you do not run Netscape or Explorer, this function may not work properly.
The procedure for adding a URL to an 856 field is shown in Procedure 4-3, Adding a URL to an 856 Field, on page 4-4.

Procedure 4-3. Adding a URL to an 856 Field

Use the following to add a URL to an 856 field.

1. Open up your web browser and pull up the Web site whose URL you want to add.

2. Open the record (or create a new record) into which you want to insert the URL.

3. Select Edit>Insert URL from Browser or click Ctrl + U.

Result: The URL will be added to a new 856 field in the record. You can then edit the new 856 field if necessary.

NOTE:
This assumes that you have the appropriate security clearance to perform this change.

Procedure 4-4. Changing Owning Library

Use the following to change the owning library.

1. Display the bibliographic record that you want to change the owning library for.

Change Owning Library

Owning libraries are assigned to locations in System Administration. Institutions must specify that bibliographic records belong to an owning library. When a user logs into Cataloging, they must select a cataloging location, which is associated with an owning library, from a list determined by their security clearance. Depending on the security clearance and on the cataloging location selected, the user will (or will not) be able to view, update, add, or delete records from various owning libraries.

The procedure for changing the owning library is shown in Procedure 4-4, Changing Owning Library, on page 4-4.

NOTE:
This assumes that you have the appropriate security clearance to perform this change.
2. Select **Record>Change Owning Library** from the Cataloging toolbar.

3. Select the appropriate owning library and click **OK**. Click **Cancel** to close the **Select an Owning Library** dialog box without changing the owning library.

   If a Cataloging Location is selected that has no associated owning library, the user will be unable to add, edit, or delete any bibliographic record.

---

### Changing Records with Bibliographic Overlay/Merge in Cataloging

This section describes the overlay/merge function, procedure, and considerations for bibliographic records in the Cataloging module.

The Overlay/Merge function in Cataloging involves two bibliographic records that already exist in the database. The two bibliographic records involved in this procedure are identified as a target bibliographic record and a source bibliographic record. These are specifically defined as explained in **Table 4-2**.

**Table 4-2. Target/Source Record Definitions for Bibliographic Merge**

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Target** | This is the record whose contents are replaced or supplemented.  
This record always remains in the database.  
The overlay/merge procedure starts with this record in the Cataloging module. |
| **Source** | This is the record whose contents, MFHDs, and items are moved to the target record.  
Optionally, this record may be deleted from the database when the overlay/merge is executed.  
Associated MFHDs and items may be relinked to the target bibliographic record. |

With Overlay, one bibliographic record is copied into another. The target bibliographic record’s contents are completely replaced.
With Merge, one bibliographic record is merged with another utilizing the existing merge profiles as defined in Voyager System Administration such as the one highlighted in Figure 4-1. Specifically, the fields in the target record that are identified in the merge profile are preserved when the source record’s fields are copied to the target record.

![Figure 4-1. System Administration merge profile example](image)

**NOTE:**
The quality hierarchy component of the merge profiles is ignored for this function given the personal review of records prior to executing this procedure.

The distinction with the overlay/merge procedure in Cataloging versus bulk import is that you may use two existing bibliographic records in the database versus importing external records.

The procedure for overlaying/merging bibliographic records is shown in **Procedure 4-5, Overlaying and Merging Bibliographic Records**, on page 4-7.
Procedure 4-5. Overlaying and Merging Bibliographic Records

Use the following to overlay/merge bibliographic records.

1. Identify/select the target bibliographic record (as defined in Table 4-2 on page 5) from available active bibliographic records in Cataloging.

2. Click Record > Overlay Bibliographic Records.

Result: The Overlay Bibliographic Records options display. See Figure 4-2.

Figure 4-2. Overlay Bibliographic Records options

3. Select the source record (defined in Table 4-2 on page 5) using one of the following methods.
   a. Select one of the active bibliographic records displayed with the Open option.
   b. Retrieve a non-active bibliographic record by record ID using the Bibliographic option. See Figure 4-3.
   c. Search for a record by using the Search option.

Result: The Overlaying and Merging Bibliographic Records dialog box displays. See Figure 4-4.
4. Select the Merge Profile you prefer from the drop-down list (see Figure 4-5) and check Relink Mfhs and Items and/or Delete Source Bib per your requirements.

5. Click Yes to process your overlay/merge request.

⚠️ CAUTION:
There is no way to undo this operation.

6. Optionally, make note or respond to messages provided in the following situations.
   a. For Relink Mfhs and Items requests where the source bibliographic record is participating in any Acquisitions module transactions such as a line item entry, the system displays a message indicating that you need to use the Acquisitions module to manually make the necessary adjustments.
b. For **Relink Mfhd and Items** requests where the source bibliographic record is participating in any Circulation module transactions, a warning message is displayed indicating that the transactions will be relinked to the target bibliographic record with Yes/No options to indicated how to proceed.

c. For **Delete Source Bib**, normal deletion rules apply. The system sends a message if it is unable to perform the deletion. For example, you must relink any MFHDs and items if you also try to delete the bibliographic record (presuming, of course, that the bibliographic record has MFHDs and items).

---

**Record History - Overlay/Merge**

The system keeps track in the bibliographic record history of overlay/merge activity between records. There is an action type of overlay that displays on the **History** tab of the bibliographic record.

Source records that are deleted are added to the deleted.bib.marc file in the rpt folder on the server. The ID of the deleted source bibliographic record may be retained in the database in the archive tables.

---

**Saving and Printing Information**

This section describes the process for saving and printing information.

**Saving a Record**

To save a record, you can select from the following toolbar options.

- File>Save
- File>Save As
- Record>Save to Database
- Record>Save to Database and Close
- Record>Save to Database and to Local File
- Record>Save to Database and to Local File and Close

Because Cataloging works with records in two locations, the database and work folders, it is important to understand where records are saved. You can always determine in which work folder a record is saved by using **File>Save As**.
NOTE: Records saved to the database are validated based on the options chosen on the Validation tab of Session Defaults and Preferences. See Validation Tab on page 10-4 for more information.

Save

You can save an active record or a template to a file in a work folder by selecting File>Save or click the Save button (Figure 4-6). This command tries to save the current record or template to the same work folder from which the record was opened. If the record was opened from a work folder, it is saved to the same work folder. However, if the record was retrieved from the OPAC, Voyager asks you to name the record or template and save it in a work folder. To save a record to a different location, use the Save As command.

Figure 4-6. Save Button

When a record is saved to a work folder, it is not validated against authority records or the MARC tag table. Also, because the Suppress From OPAC check box is not a part of the MARC 21 record, that information is not saved when the record is saved as a work record. Each time that you retrieve a work record in order to save it to the database, the Suppress From OPAC check box must be marked appropriately.

In addition, if a record is saved to a work folder and then opened in another Cataloging session for a different database, the record overlays any existing record without any duplicate checking. This is because Voyager automatically overlays any record with an identical 001. The correct procedure is to Import the record into another database.

Update Record Alert

If you modify a record and save it and Voyager discovers that the record has been modified by another user while you had the record open, Voyager displays an Update Record Alert message (Figure 4-7). This alert is activated for changes made to any record types except for item records. Changes to item records do not set off this alert.
Figure 4-7. Update record alert dialog box

If there have been changes made, the following three options are available.

- To save your changes over the changes in the database (the No button).
- To cancel your changes and preserve what is already in the database (the Cancel button).
- To view the record in the database (the Yes button). In that case, you will be able to view the current database version of the record and combine the information into your record to your satisfaction, and then save the final version of your record back to the database.

Save As...

You can save a record to a work folder (a file) at a different location by selecting File>Save As.... When you select Save As..., Voyager saves the record to a new location and/or with a new name. If the record was opened from a work folder, you can use Save As to save the record in the following ways:

- Appended to an existing work record
- To the same work folder as a new record
- To a different work folder

If the record was retrieved from the database, use Save As to save the record to a work folder.

In addition, if a record is saved to a work folder and then opened in another Cataloging session for a different database, the record will overlay any existing record without any duplicate checking. This is because Voyager automatically overlays any record with an identical 001. The correct procedure is to Import the record into another database.

Save to Database

You can save a record to the database in the following ways.
• Select **Record>Save to Database**.
• Click the **Save to Database** button (Figure 4-8).
• Press **Ctrl+B** on your keyboard.

---

**Figure 4-8. Save to Database button**

In addition, you can save a record to the database and then have the record automatically close by selecting **Record>Save to Database and Close**, or by pressing **Ctrl+Q** on your keyboard. If you are saving a record to the database via the **Save to Database and Close** function and a different process interrupts the save and close such as Authority Validation or Duplicate Detection, the record is closed once you elect to continue with the save, provided that the save is successful.

**Save and Security**

In order to save a record to the database, you need the proper security level. When saving a record to the database, Cataloging first validates the record against the MARC tag tables (see **MARC Tag Tables** on page **A-1**) and the Authority records, (see **Authority Control** on page **9-1**).

**Save and ISBN/ISSN Validation**

Validation of the ISBN and/or ISSN fields may occur automatically when you save bibliographic records to the database. This is determined by the setting selected in **Session Defaults and Preferences**. See **Table 10-2** on page **10-5** for a description of your options.

If validation should fail, you are given the option to continue and select **Save** to save the record to the database or to select **Cancel** and the record is not saved to the database.

You may also dynamically validate the ISBN or ISSN fields by selecting either of the following options from the **Record** menu without saving the record to the database. See **Figure 4-9**.

• Validate ISBNs
• Validate ISSNs
Selecting these options from the **Record** menu takes precedence over whatever settings are chosen in **Session Defaults and Preferences**.

**Figure 4-9. Record menu dynamic ISBN/ISSN validation options**

**Save and Duplicate Records**

Cataloging then checks for duplicate records. A confirmation message displays upon the successful saving of the record. If you want to save the records in your current session to the database without running MARC or Authority Control Validation, you can change the settings on the **Validation** tab in your Session Defaults and Preferences (see **Validation Tab** on page 10-4).
Save and Confirmation Message

If you do not want a confirmation message to display upon the successful saving of a record to the database, you can change the **Suppress confirmation message upon successful save** option on the **Work Flow** tab in your Session Defaults and Preferences (see **Work Flow Tab** on page 10-9).

Save Considerations

Before you can save a holdings record to the database, you must define the 852 subfield `b` with a valid location code as defined in System Administration and assigned to the appropriate Cataloging Policy and Cataloging Security Profile.

Once a holdings record is saved to the database, the title of the associated bibliographic record is displayed on the title bar of the holdings record, and on the **BibTitle(s)** tab.

When an existing record with a record status of new, such as when the **Bibliographic Leader** is set to `n`, is edited and saved to the database, the record status is automatically changed to corrected or `c`.

When a record retrieved from an existing work file is saved to the database and it has an `001`, it is treated as an existing record. Cataloging updates the record with a matching `001` in the database. When a record does not have an `001`, it is treated as a new record.

Save and Bibliographic Dedupe Detection

When a newly-copied, newly-imported, or newly-created record is saved to the database, Voyager checks for any duplicates in the database and if any are detected, the **Bibliographic Dedupe Detection** dialog box opens (Figure 4-10). This lists all of the records that are found to be duplicates according to the rules in the System Administration module. For information on duplicate matching, see the "Bibliographic Duplicate Detection Profile" section of the **Voyager System Administration User’s Guide**.

**NOTE:**
If any single index in the duplicate detection hierarchy is matched to more than 1000 records, all duplicate detection stops. Only the first 100 records above the matching threshold are returned to the client.
You can view the MARC record of any of the duplicates by selecting a record from the list and clicking **Retrieve**. Click **Clear All** to deselect all of the selected records in the list.

To add the record to the database as a new record overriding the existence of duplicates, click **Add As New Record**.

If you want the incoming record to replace or be merged with one of the records in the list, use **Procedure 4-6, Replace/Merge Incoming Record**, on page 4-15.

The procedure for replacing or merging an incoming record with a record from the Bibliographic Dedupe Detection dialog box is shown in **Procedure 4-6, Replace/Merge Incoming Record**, on page 4-15.

### Procedure 4-6. Replace/Merge Incoming Record

Use the following to replace or merge incoming records.

1. Make sure that the target record in the list and only the target record is highlighted.

2. Click the **drop-down arrow** to select with which replace or merge profile you want to import. This list only includes Replace or Merge profiles.
3. Click the **Replace/Merge using profile** button. No more duplicate checking is performed, and the record is replaced or merged according to the profile selected.

When you save a record to the database for the first time, a number is assigned to that record by the system. This record ID displays in the title bar of that record.

If you do merge or replace one of the records in the database with the incoming record, the old record is written to a replace file called `replace.<record_type>.marc`, which is located in the `/rpt` directory.

When you save a bibliographic record to the database from a work folder, the record in the work folder is automatically deleted, unless you have **Delete records from work files once saved to database** unselected in Session Defaults.

Voyager checks for duplicate records according to the **Authority** and **Bibliographic Import/Replace profile** menus set in Session Defaults. For more information, see [General Tab on page 10-2](#).

Anytime the system is performing tasks that update the bibliographic tables, you are unable to update or delete records until the system is finished processing. While processing, the system displays "The Catalog is in read-only mode. You are not allowed to update/delete any bibliographic records at this time."

## Saving to the Database and to a File Simultaneously

You can also save a record to the database and to a file simultaneously. This allows you to avoid having to do a regular **Save** and then a **Save to Database** as well. You can choose to save to the database and to a file and keep the record open onscreen by selecting **Record>Save to Database and to Local File**. You can also choose to save to the database and to a file and then to close the record once it has been saved by selecting **Record>Save to Database and to Local File and Close**.

When **Save to Database and to Local File** is selected, the bib is first saved to the database according to all of the rules regarding saving to the database (see above for more information). Then, if the save is successful, it is converted to the character set format specified for that file and then saved to a local file.

If there is no filename entered in Session Preferences, the Save to Database and to Local File option will be disabled. For more information, see [Folders/Files Tab on page 10-13](#).
NOTE:
If the record is saved to the database but is not successfully saved to the local file, a warning message will be displayed, but the record in the database will remain in its updated form.

Validating a Bibliographic Heading

You can validate a heading manually. A validated heading is one that matches an authority heading in the database. Any row that contains a tag that is under Authority Control can be checked to see if it matches an Authority Heading. You can select Record > Validate Heading to check whether it is valid. This will validate the heading in the selected row.

You can also access Heading Validation by performing a right click of the mouse in the selection column of the grid in the MARC view form. From the menu that displays, click Validate Heading in this Field.

The procedure for validating a heading is shown in Procedure 4-7, Validating a Heading, on page 4-17.

NOTE:
While Validate Heading is only performed on a single row, performing Cut, Copy, and Delete from this menu operates on all selected rows. When a menu option does not apply, it is not displayed.

Procedure 4-7. Validating a Heading

Use the following to validate a heading.

1. From an open bibliographic record, select the row you want to check by clicking in the fixed column (the empty box to the left of the Tag row).

   Result: This highlights the row and displays the arrow in the fixed column.

2. Select Record > Validate Heading from the main menu or right-click in the fixed column and select Validate Heading in this Field.

   Result: If the field is a valid Authority heading, a dialog box opens with "This heading is valid."

3. Click OK to return to the Bibliographic record.
Result: If the field is not a valid Authority heading, the Headings Index displays.

4. Browse through the Headings Index until you find the appropriate heading. Select the heading and click Replace.

Result: This copies the selected heading into the bib record in place of the invalid heading and returns you to the bib record.

NOTE: If the subject heading selected from the index is of a different index type or a different thesaurus type, the following changes may also occur:

Subject Headings

Subject headings may have their indicator 2 changed if the heading selected from the browse index is of a different type from the one being validated. Furthermore, if indicator 2, that is, the second ind changes to a 7 which indicates that the heading type is in subfield 2, the new heading may contain a subfield 2 specifying the heading type.

Non-Subject Headings

If a non-subject heading is selected from the index, upon selecting a valid heading from the list of valid headings and clicking Replace, the original tag of the bib heading being replaced may change depending on the new heading. For instance, if a personal name heading is being validated (100 tag) and a corporate heading is selected to replace it, the bib tag will change to 110 to reflect the type of the new name heading.

A record will not be given a new indicator 2 and a new tag simultaneously.

5. Right-click the mouse in the selection column of the grid in the MARC view form to display a pop-up menu with the following selections.

- Copy this field
- Cut this field
- Paste before this field
- Delete this field
- Validate the heading of this field
- Move this field up by one (moves the focus row up by one row)
- Move this field down by one (moves the focus row down by one row)
NOTE:
While Validate Heading is only performed on a single row, performing Cut, Copy, and Delete from the menu bar operates on all selected rows. When a menu option does not apply, it is not displayed.

Make a Copy of a Record

You can make a copy of a record retrieved from the database by selecting Record>Make a Copy.

The procedure for copying a record is shown in Procedure 4-8, Copy a Record, on page 4-19.

Procedure 4-8. Copy a Record

Use the following to copy a record.

1. Display the record from the database that you want to copy. (See Search Dialog Box on page 3-26 for more information.)

2. When the record is displayed, select Record>Make a Copy.

Result: A copy of the record displays. The 001 field is stripped out of the new copy. You can save this as a new record in the database and the Date of Creation is updated in the 008 fixed field, byte 00 through 05.

NOTE:
Voyager checks for duplicate records according to the preference set in Session Defaults. For more information, see General Tab on page 10-2.

You can also make a copy of records that do not come from the database by using the Save As command. For more information, see Save As... on page 4-11.

Printing a Record

You can print a bibliographic, authority, or holdings record. Currently, you cannot print item records. Even though some fixed fields do not display the information on the screen, the printout will contain a printed description of that field. To print a record, select File>Print Record from the main menu.
Printing Labels

You can print spine and piece labels by selecting File>Print Label. A spine label can be an attachment on an item for shelving purposes. A piece label can be an attachment to an item for general identification purposes.

Spine and piece labels can be customized. You can create separate spine and piece templates from bibliographic, holding, item and serial records. The templates are defined in the file spinelabel.cfg which is located in the /Misc subdirectory.

The default settings are as follows: the size of a spine label is 1 5/8" high by 9/10" wide. The size of a piece label is 1 5/8" high by 2 9/10" wide. However, this may be changed by your institution. See the section "Spine and Piece Label Print Template" for information on customizing labels.

The procedure for printing spine and piece labels is shown in Procedure 4-9, Print Spine and Piece Labels, on page 4-20.

Procedure 4-9. Print Spine and Piece Labels

Use the following to print spine and piece labels.

1. Select File>Print Label.

Result: Depending on the location of the cursor prior to selecting the Print Label command, different information automatically displays in the Print Labels dialog box (Figure 4-11). See the sections Bibliographic Records and Holdings Records for more information.
2. Mark the check box next to the type of label you want to print: **Spine Label** or **Piece Label**. Mark both check boxes to print both spine labels and piece labels.

3. Add or edit information in the spine and piece label sections.

**NOTE:**
The system automatically adjusts the text on the screen to fit the information on the appropriate label.

4. Enter the number of copies to be printed in the **Number of Copies** box. You can select any number from 1 to 9999.

5. Click the **Print** button to print the labels on the printer to which Windows is set to print. Click the **Clear** button to remove all information from the spine and piece label sections. Click the **Close** button to close the dialog box without printing the information.

**NOTE:**
Print Label will not send anything to the printer, unless some data is typed in the dialog box (in either section).
Bibliographic Records

If the active record is a bibliographic record, the following is the default information that will display in the Print Labels dialog box. See Table 4-3. You can change this information at any time before you print.

Table 4-3. Default Text in Print Labels Dialog Box - Bibliographic Record

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spine Label</td>
<td>Spine Label Name (as defined for the Location in System Administration), Address and Bib ID</td>
</tr>
<tr>
<td>Piece Label</td>
<td>Spine Label Name (as defined for the Location in System Administration), Address, Bib ID, Title, and Title Brief</td>
</tr>
</tbody>
</table>

Holdings Records

If the active record is a holdings record, the following is the default information that will automatically display. See Table 4-4. You can change this information at any time before you print.

Table 4-4. Default Text in Print Labels Dialog Box - Holdings

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spine Label</td>
<td>MFHD ID and Call Number</td>
</tr>
<tr>
<td>Piece Label</td>
<td>MFHD ID and Call Number</td>
</tr>
</tbody>
</table>

Item Records

If you select Print Label and the active record is an item record, the following information automatically displays. See Table 4-5. You can change this information at any time before you print.

Table 4-5. Default Text in Print Labels Dialog Box - Item Record

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spine Label</td>
<td>Spine Label Name (as defined for the Location in System Administration). Address and Bib ID</td>
</tr>
<tr>
<td>Piece Label</td>
<td>Spine Label Name (as defined for the Location in System Administration), Address, Bib ID, Item ID, Copy Number, and Item Barcode</td>
</tr>
</tbody>
</table>
Spine and Piece Label Print Template

The spine and piece label print template allows you to customize the appearances of spine and piece labels from bibliographic, holdings, item, and serial records. You can also create a template for a label with solely general information. You can define what kind of information displays on each label. You can customize its layout and appearance, and you can specify the number of copies that are to be printed. This information is contained in a file called `spinelabel.cfg` which is located in the `/Misc` directory on the client workstation.

For each type of information that can be printed, there are three stanzas in the template.

• [Print Options XXX] stanza
• [Print Template Spine XXX] stanza
• [Print Template Piece XXX] stanza

XXX represents the type of record or the specific names of the stanzas. For example, the bibliographic record stanzas are called [Print Options Bibliographic], [Print Template Spine Bibliographic], and [Print Template Piece Bibliographic].

**NOTE:**
*These names cannot be changed.* Altering the names causes label printing to fail.

The [Print Options XXX] stanza contains the formatting and general information regarding the label. The [Print Template Spine XXX] stanza contains the information and the layout for printing the spine label. The [Print Template Piece XXX] stanza contains the information and the layout for printing the piece label.

There is also a single [Templates] stanza at the beginning of the file.

**Templates Stanza**

The [Templates] stanza contains the list of the different types of templates that can be customized. The [Templates] stanza *cannot* be changed. Editing the [Templates] stanza in any way causes label printing to become unpredictable.

**[Print Options XXX] Stanza**

The [Print Options XXX] stanza contains formatting and other information on each type of record for which a label can be created. See Figure 4-12 for a description of the options available in the [Print Options XXX] stanza.
The [Print Template Spine XXX] and [Print Template Piece XXX] stanzas can be completely customized. Any type of information can be entered into the stanza as well as any additional text or field labels. See Figure 4-13 and Figure 4-14.

<table>
<thead>
<tr>
<th>Line #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>[Print Options Bibliographic]</td>
</tr>
<tr>
<td>2</td>
<td>StandardFont=The name of the default font</td>
</tr>
<tr>
<td>3</td>
<td>StandardFontSize=The size of the default font</td>
</tr>
<tr>
<td>4</td>
<td>AlternateFont=The name of the alternate font</td>
</tr>
<tr>
<td>5</td>
<td>AlternateFontSize=The size of the alternate font</td>
</tr>
<tr>
<td>6</td>
<td>Copies=The number of copies that are to be</td>
</tr>
<tr>
<td>7</td>
<td>printed</td>
</tr>
<tr>
<td>8</td>
<td>TabWidth=The width in inches that the tab code</td>
</tr>
<tr>
<td></td>
<td>(T) represents</td>
</tr>
<tr>
<td>9</td>
<td>Margin=The label’s left margin, in inches</td>
</tr>
<tr>
<td>10</td>
<td>SpineLabelHeight=The height of the spine label,</td>
</tr>
<tr>
<td></td>
<td>inches</td>
</tr>
<tr>
<td>11</td>
<td>SpineLabelWidth=The width of the spine label, in</td>
</tr>
<tr>
<td></td>
<td>inches</td>
</tr>
<tr>
<td>12</td>
<td>PieceLabelHeight=The height of the piece label,</td>
</tr>
<tr>
<td></td>
<td>inches</td>
</tr>
<tr>
<td></td>
<td>PieceLabelWidth=The width of the piece label, in</td>
</tr>
<tr>
<td></td>
<td>inches</td>
</tr>
</tbody>
</table>

Figure 4-12. Description of options in the [Print Options Bibliographic] stanza

Print Template Spine/Print Template Piece Stanza

The [Print Template Spine XXX] and [Print Template Piece XXX] stanzas can be completely customized. Any type of information can be entered into the stanza as well as any additional text or field labels. See Figure 4-13 and Figure 4-14.

<table>
<thead>
<tr>
<th>Line #</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>[Print Template Spine Serial Issue]</td>
</tr>
<tr>
<td>2</td>
<td>Name: \B\F102\b</td>
</tr>
<tr>
<td>3</td>
<td>Addr1: \U\F510\u</td>
</tr>
<tr>
<td>4</td>
<td>Component Name: \F600</td>
</tr>
<tr>
<td>5</td>
<td>Enum Chron: \F601</td>
</tr>
<tr>
<td>6</td>
<td>Receipt Date: \F602</td>
</tr>
</tbody>
</table>

Figure 4-13. Sample [Print Template Spine XXX] stanza
Whatever you enter in the [Print Template Spine XXX] or [Print Template Piece XXX] stanzas prints on the label. The text that you enter displays onscreen. To get specific information such as the Title from the database, you can enter Action Codes.

If you want nothing to display in the field for a particular label in the dialog box onscreen, simply enter nothing after the stanza name. If nothing is entered in a particular [Print Template Spine XXX] or [Print Template Piece XXX] stanza, nothing displays for that label or piece onscreen. However, you may still enter anything into the label or piece field in the Print Labels dialog box and print that information.

Action codes are used in these stanzas to change how the information displays on the label, and field codes are used after the \F action code to specify the information that is to be printed.

The information you enter in the [Print Template Spine XXX] and [Print Template Piece XXX] stanzas prints with the font and font size specified in the StandardFont and StandardFontSize variables in the [Print Options XXX] stanza for that type of record, unless you specify otherwise. See "Printing in the Alternate Font" and "Changing Font Size". For example, if you want the caption Item Barcode: to print, simply enter Item Barcode:.

### Action Codes

Table 4-6 contains a list of action codes that you can use to change how the information displays on the labels.

<table>
<thead>
<tr>
<th>Action Codes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>prints a blank line</td>
</tr>
<tr>
<td>\A</td>
<td>starts alternate font</td>
</tr>
</tbody>
</table>

Figure 4-14. Sample [Print Template Piece XXX] stanza
Table 4-6. Action codes descriptions

<table>
<thead>
<tr>
<th>Action Codes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\a</td>
<td>ends alternate font</td>
</tr>
<tr>
<td>\B</td>
<td>starts bold</td>
</tr>
<tr>
<td>\b</td>
<td>ends bold</td>
</tr>
<tr>
<td>\I</td>
<td>starts italic</td>
</tr>
<tr>
<td>\i</td>
<td>ends italic</td>
</tr>
<tr>
<td>\U</td>
<td>starts underline</td>
</tr>
<tr>
<td>\u</td>
<td>ends underline</td>
</tr>
<tr>
<td>\S</td>
<td>starts new font size (a two digit size must follow \S)</td>
</tr>
<tr>
<td>\s</td>
<td>ends new font size</td>
</tr>
<tr>
<td>\T</td>
<td>inserts a tab</td>
</tr>
<tr>
<td>\F</td>
<td>inserts field data (a three digit field code must follow \F)</td>
</tr>
</tbody>
</table>

**Initiating and Ending Action Codes**

The \A and \a, \B and \b, \I and \i, \U and \u, and \S and \s action codes are initiated and ended in the same way. Enter the uppercase action code before the information it is to effect, and enter the lowercase action code after the information it is to effect. For example, if you want the caption Item Barcode: to print in bold, enter:

```
\BItem Barcode: \b
```

**Printing Field Information**

To print field information, you must enter a field code after the \F action code. For example, if you entered Item Barcode: as a caption and wanted the item barcode information to be retrieved from the server and printed after the Item Barcode: caption, you enter:

```
Item Barcode: \F401
```

**Printing in the Alternate Font**

To have the item barcode information print in the alternate font and font size, you would enter the \A action code when the alternate font is to start and the \a action code when the alternate font is to end:

```
Item Barcode= \A\F401\a
```
The alternate font is specified after the `AlternateFont` variable, and the alternate font size is specified after the `AlternateFontSize` variable. Both of these display in the `[Print Options XXX] stanza for that type of record.

If you have chosen your alternate font as a barcode font, you may need to print a few lines of blank space beneath the information that is to be printed with the barcode font to ensure that the barcode does not overlap with the information beneath it. Enter the `\` (backslash) action code on a line by itself to print a blank line.

**NOTE:**
The barcode font that is included with Voyager is called Barcode 3 of 9. If you use this font as your alternate font and your scanning device requires start/stop characters, you must put an `*` (asterisk) on both sides of the field that is to be printed with the alternate font in order for your scanner to read the barcode after it is printed.

For example, if you want to print the item barcode field in the alternate font, and you have selected as your alternate font Barcode 3 of 9, you enter:

```
\A*\F401*\a
```

**NOTE:**
If you are using this barcode font, and you make it print bold (`\B\A*\F401*\a\b`), the barcode height will print taller and the digits normally beneath the barcode will not be visible; if you are using the barcode font and you make it print italic (`\I\A*\F401*\a\i`), the barcode height will print shorter. If you chose to use a different barcode font, you should read the documentation on the barcode font to determine what start/stop character must be used.

**Changing Font Size**

To change the size of the font that the information is printing in, you would enter the `\S##` action code (where `##` stands for the 2-digit size of the font) before the information, and the `\s` action code after the information (`\S24\F401\s`). If you do not enter the `\s` action code after the information, all subsequent information is printed with this new font size.

**Inserting a Blank Line**

To insert an extra line of space between different lines of information on a printout, you would enter the `\` (backslash) action code on a line by itself between the different lines of information.
Inserting a Tab

To tab a piece of information over from the left margin, you enter the \T action code before the information. The tab width that applies to this action code is specified after the TabWidth variable in the [Print Options XXX] stanza for that type of record.

Spine Label Field Codes

Table 4-7 contains the list of Generic Field Codes (100 Series). The data for the 100 Series field codes is defined through the Voyager System Administration client application.

Table 4-7. Generic Field Codes - 100 Series

<table>
<thead>
<tr>
<th>Data Displayed</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Date &amp; Time</td>
<td>100</td>
</tr>
<tr>
<td>Library Display Name</td>
<td>101</td>
</tr>
<tr>
<td>Library Name</td>
<td>102</td>
</tr>
<tr>
<td>Nuc Code</td>
<td>103</td>
</tr>
</tbody>
</table>

Table 4-8 contains the list of Bibliographic Field Codes (200 Series). A detailed definition of the data retrieved for the 200 Series field codes can be found in the Voyager System Administration User’s Guide.

Table 4-8. Bibliographic Field Codes - 200 Series

<table>
<thead>
<tr>
<th>Data Displayed</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bib_id</td>
<td>200</td>
</tr>
<tr>
<td>Title_Brief</td>
<td>201</td>
</tr>
<tr>
<td>Title (see also Title long)</td>
<td>202</td>
</tr>
<tr>
<td>Author</td>
<td>203</td>
</tr>
<tr>
<td>Imprint</td>
<td>204</td>
</tr>
</tbody>
</table>

Table 4-9 contains the list of Holdings Field Codes (300 Series). The 300 Series field codes pull the content to print from the MFHD.

Table 4-9. Holdings Field Codes - 300 Series

<table>
<thead>
<tr>
<th>Data Displayed</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mfhd_Id</td>
<td>300</td>
</tr>
<tr>
<td>Call Number - Display Format</td>
<td>301</td>
</tr>
</tbody>
</table>
Table 4-10 contains the list of Item Field Codes (400 Series). The 400 Series field codes use the data stored in the item record for printing the spine label.

Table 4-10. Item Field Codes - 400 Series

<table>
<thead>
<tr>
<th>Data Displayed</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item_Id</td>
<td>400</td>
</tr>
<tr>
<td>Item Barcode</td>
<td>401</td>
</tr>
<tr>
<td>Enumeration</td>
<td>402</td>
</tr>
<tr>
<td>Chronology</td>
<td>403</td>
</tr>
<tr>
<td>Year</td>
<td>404</td>
</tr>
<tr>
<td>Caption</td>
<td>405</td>
</tr>
<tr>
<td>Free Text</td>
<td>406</td>
</tr>
<tr>
<td>Copy Number</td>
<td>407</td>
</tr>
<tr>
<td>Item Type Code</td>
<td>411</td>
</tr>
<tr>
<td>Item Type Name</td>
<td>412</td>
</tr>
<tr>
<td>Item Type Display</td>
<td>413</td>
</tr>
<tr>
<td>Item Location Code (prints the temporary location if there is one; otherwise prints the permanent location)</td>
<td>414</td>
</tr>
<tr>
<td>Item Location Name</td>
<td>415</td>
</tr>
<tr>
<td>Item Location Display Name</td>
<td>416</td>
</tr>
<tr>
<td>Item Location Spine Label</td>
<td>417</td>
</tr>
<tr>
<td>Pieces</td>
<td>418</td>
</tr>
<tr>
<td>Price</td>
<td>419</td>
</tr>
<tr>
<td>Spine Label</td>
<td>420</td>
</tr>
</tbody>
</table>

Table 4-11 contains the list of Library Address Field Codes (500 Series). The data for the 500 Series field codes is defined through the Voyager System Administration client application.

Table 4-11. Library Address Field Codes - 500 Series

<table>
<thead>
<tr>
<th>Data Displayed</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Line 1</td>
<td>510</td>
</tr>
<tr>
<td>Address Line 2</td>
<td>511</td>
</tr>
<tr>
<td>Address Line 3</td>
<td>512</td>
</tr>
</tbody>
</table>
Table 4-11. Library Address Field Codes - 500 Series

<table>
<thead>
<tr>
<th>Data Displayed</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address Line 4</td>
<td>513</td>
</tr>
<tr>
<td>Address Line 5</td>
<td>514</td>
</tr>
<tr>
<td>City</td>
<td>515</td>
</tr>
<tr>
<td>State/Province</td>
<td>516</td>
</tr>
<tr>
<td>Zip/Postal Code</td>
<td>517</td>
</tr>
<tr>
<td>Country</td>
<td>518</td>
</tr>
</tbody>
</table>

Table 4-12 on page 30 contains the list of Received Serial Issue (600 Series). The data for the 600 Series field codes is defined through the serials retrieval process. See the Voyager Acquisitions User’s Guide for more information.

Table 4-12. Received Serial Issue Field Codes - 600 Series

<table>
<thead>
<tr>
<th>Data Displayed</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component Name</td>
<td>600</td>
</tr>
<tr>
<td>Enum Chron</td>
<td>601</td>
</tr>
<tr>
<td>Receipt Date</td>
<td>602</td>
</tr>
</tbody>
</table>

Sample Template File

Figure 4-15 is a sample label print template file.

```
Line#
1   [Templates]
2   Blank
3   Bibliographic
4   Holdings
5   Item
6   Serial Issue
7
8   [Print Options Blank]
9   StandardFont=Times New Roman
```

Figure 4-15. Sample label print template file
Figure 4-15. Sample label print template file

```
Line#
10  StandardFontSize=12
11  AlternateFont=Arial
12  AlternateFontSize=12
13  Copies=3
14  TabWidth=1
15  Margin=0.05
16  SpineLabelHeight=1.625
17  SpineLabelWidth=.9
18  PieceLabelHeight=1.625
19  PieceLabelWidth=2.9
20
21  [Print Template Spine Blank]
22  Name: \B\F102\b
23  Addr1: \U\F510\u
24  Addr2: \F511
25  Addr3: \F512
26  Addr4: \F513
27  Addr5: \F514
28  City: \F515
29  St: \F516
30  Zip: \F517
31  Country: \F518
32
33  [Print Template Piece Blank]
34  Name: \B\F102\b
35  Addr1: \U\F510\u
36  Addr2: \F511
37  Addr3: \F512
38  Addr4: \F513
39  Addr5: \F514
40  City: \F515
41  St: \F516
42  Zip: \F517
```
Figure 4-15. Sample label print template file
Figure 4-15. Sample label print template file
Figure 4-15. Sample label print template file
Figure 4-15. Sample label print template file

Line#
142  Free Text: \F406
143  Enumeration: \F402
144  Item Id: \F400
145  Year: \F404
146  Copy Number: \F407
147  Pieces:
148  Price:
149  Spine Label:
150  Item Barcode: \F401
151  Item Type Code:
152  Item Type:
153  Item Type Display:
154  Item Location Code:
155  Item Location Display Name:
156  Item Location:
157  Media Type:
158  Media Type Code:
159
160  [Print Options Serial Issue]
161  StandardFont=Times New Roman
162  StandardFontSize=12
163  AlternateFont=Arial
164  AlternateFontSize=12
165  Copies=1
166  TabWidth=1
167  Margin=0.05
168  SpineLabelHeight=1.625
169  SpineLabelWidth=.9
170  PieceLabelHeight=1.625
171  PieceLabelWidth=2.9
172
173  [Print Template Spine Serial Issue]
174  Name: \B\F102\b
Closing a Record

You can close the active record by selecting **File>Close**. This command closes the current record. If changes have been made to the record since it was last saved, you will be asked to save the changes or close without saving them. You can also close all of the records that you have open by selecting **File>Close All**.

```
Figure 4-15. Sample label print template file

<table>
<thead>
<tr>
<th>Line#</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>175</td>
<td>Addr1</td>
<td>\U \F510\u</td>
</tr>
<tr>
<td>176</td>
<td>Component Name</td>
<td>\F600</td>
</tr>
<tr>
<td>177</td>
<td>Enum Chron</td>
<td>\F601</td>
</tr>
<tr>
<td>178</td>
<td>Receipt Date</td>
<td>\F602</td>
</tr>
<tr>
<td>180</td>
<td>[Print Template Piece Serial Issue]</td>
<td></td>
</tr>
<tr>
<td>181</td>
<td>Name</td>
<td>\B \F102\b</td>
</tr>
<tr>
<td>182</td>
<td>Addr1</td>
<td>\U \F510\u</td>
</tr>
<tr>
<td>183</td>
<td>Component Name</td>
<td>\F600</td>
</tr>
<tr>
<td>184</td>
<td>Enum Chron</td>
<td>\F601</td>
</tr>
<tr>
<td>185</td>
<td>Receipt Date</td>
<td>\F602</td>
</tr>
<tr>
<td>186</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```
Cataloging & Bibliographic Record
Linking

Introduction 5-1
• Displaying Related Records 5-1
• Templates 5-5

MARC Record Derivation Using Cataloging Templates 5-8
• Multiple Subfields 5-12
• Non-Matching Subfields 5-12
• Rules and Examples for Derivation Fields 5-12
  Template Example 5-16

Session Defaults and Preferences 5-18
• Folders/Files Tab 5-18
Introduction

Once you have added at least one bibliographic record linking profile in System Administration, you can search for, review, and edit related records in the Cataloging module.

Configuration information for bibliographic record linking is located in the Voyager System Administration User’s Guide in the chapter discussing search configuration and in the WebVoyage User’s Guide in the Appendix describing WebVoyage configuration for bibliographic record linking.

For more information about searching for records in the Cataloging module, see Search Dialog Box on page 3-26.

For more information about editing or deleting records in the Cataloging module, see Changing Information on page 4-1.

Displaying Related Records

Related Records displays on the menu bar whenever a linked source record is the active record in Cataloging. Clicking Related Records displays one or more bibliographic linking profiles. If you select one of the profiles, the system retrieves any records related to the source record based on the profile.
It is the presence of the tag/subfield override in a profile and the existence of those tags/subfields in the active record that determines whether or not any profile names display from Related Records.

Before Related Records displays on the menu bar, you must have at least one bibliographic linking profile created in the Voyager System Administration module.

NOTE:
For the purpose of this discussion, assume that three linking profiles have been added to System Administration.

Table 5-1. Example of profile names and overrides

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Tag/Subfield Override</th>
</tr>
</thead>
<tbody>
<tr>
<td>776Host</td>
<td>776 ‡x</td>
</tr>
<tr>
<td>780Preceding</td>
<td>780 ‡x</td>
</tr>
<tr>
<td>785Succeeding</td>
<td>785 ‡x</td>
</tr>
</tbody>
</table>

If the source record currently active in Cataloging contains any of the tag/subfields listed in Table 5-1, Related Records displays on the menu bar.

- If the source record contained only a 776 ‡x, 776Host would be the only profile listed when Related Records is clicked.
- If the source record contained a 776 ‡x and a 780 ‡x, 776Host and 780Preceding displays in the list.
- If the source record contained all three tag/subfields, all three profile names display in the list.
Figure 5-1. Related Records listing applicable profiles for “Cinema Journal”

Figure 5-1 shows a partial display of a MARC record in the Cataloging module. Three bibliographic linking profiles are listed for the title Cinema Journal.

- 776Host
- 780Preceding
- Child Records

Selecting one of the profiles from the list retrieves any related records, based on the profile. For example, if you selected the 780Preceding profile, the system looks at the data in the 022 ‡a of the source record if that is the index defined in the profile and retrieves any records that contain the same data in the 780 ‡x.
Figure 5-2. Preceding title for “Cinema Journal” and applicable profiles

Figure 5-2 shows the result of selecting the 780Preceding profile from the Related Records menu. It also shows the profiles which apply to the preceding title, *Journal of the Society of Cinematologists*. The Related Records menu lists both the 780Preceding and 785Succeeding profiles. Selecting the 785Succeeding profile would re-display the MARC record for *Cinema Journal*.

The Related Records menu for both *Cinema Journal* and *Journal of the Society of Cinematologists* lists a profile name Child Records. Selecting that profile would result in an error message.

Figure 5-3. No related records message

Neither title is related to any child records at this point. However, both records contain an 035 ‡a which are the tag/subfield overrides for that profile.
If the system finds only one related record, it displays the record. (This depends on whether or not the “Display bibliographic record directly if search results in only one title” option is set in Options>Preferences.) If the system finds more that one related record, a dialog box opens listing all related records. You can choose one or more titles from the list to display.

In the Cataloging module, you can quickly create new related records from a source record using templates. New functionality has been added to traditional templates in order to map tag/subfield information from a source record into a target record.

See Templates for general template information. If you are already familiar with creating and editing templates, see MARC Record Derivation Using Cataloging Templates on page 5-8.

Templates

A cataloging template allows you to use a pre-defined MARC record to easily create new records. Before you can create a record, there must be at least one template in the template folder of the Voyager directory. Voyager provides you with three templates: bib.tem, auth.tem, and hold.tem (typically located in c:\voyager\catalog\templates). These templates should not be deleted.

NOTE:
Templates cannot be retroactively applied to an existing record.

You must have at least one template for each type of record that you want to create (for example, bib.tem, auth.tem, hold.tem).

The procedure for creating a new template is shown in Procedure 5-1, Creating a New Template, on page 5-5.

Procedure 5-1. Creating a New Template

Use the following to create a new template.

1. Select File>Template>New from the menu.

Result: The Create a New Record dialog box opens. See Figure 5-4.
2. Select the record type (Bibliographic, Authority, or Holdings) from the drop-down menu and click **OK**.

Result: The system template for the record type you selected displays.

3. Create the new template by completing the leader, fixed fields, and variable fields.

   For more information about the leader, fixed, and variable fields, see the *Voyager Cataloging User’s Guide*.

4. Select **File>Save As....** from the menu.

5. Enter the name you want for your template.

   The extension for the file must be `.tem`. For example, `thesis.tem`.

   **NOTE:**
   When a template is saved, it is not validated against authority records or the MARC tag table.

---

The procedure for editing a template is shown in **Procedure 5-2, Editing a Template**, on page 5-6.

---

**Procedure 5-2. Editing a Template**

Use the following to edit a template.
1. Select **File>Template>Edit** from the menu.

Result: The **Open Template File** dialog box opens. See **Figure 5-5**.

![Figure 5-5. Open Template File dialog box](image)

2. Select the template file you want to edit and click **Open** (or double-click the file).

Result: The selected template opens.

3. Edit the template by changing the leader, fixed fields, and variable fields. You can use the same commands as you use for editing a record.

   For more information about editing and the leader, fixed, and variable fields, see the **Voyager Cataloging User’s Guide**.

4. Select **File>Save** from the menu to save the template with the same name. Select **File>Save As...** to save the template with a different name. If you use **Save As...**, the extension for the file must be `.tem`.

   **NOTE:**
   When a template is saved, it is not validated against authority records or the MARC tag table.

The procedure for deleting a new template is shown in **Procedure 5-3, Deleting a Template**, on page 5-8.
Procedure 5-3. Deleting a Template

Use the following to delete a template.

1. Select File>Template>Edit from the menu.

2. Select the template you want to delete and click Open (or double-click the template).

   Result: The selected template displays.

3. Select File>Template>Delete from the menu.

   Result: The message “Are you sure you want to delete [the selected template]?” prompts you. See Figure 5-6.

4. Click Yes to delete the selected template, or click No to close the dialog box without deleting the selected template.

Figure 5-6. Verify delete template message

MARC Record Derivation Using Cataloging Templates

In the section, Templates on page 5-5, you learned how to create, edit, and delete templates for use in the Cataloging module. You can use the functionality of templates to quickly create related records.
Related records are linked to each other by coordinated subfield values. For example, the 773 ‡x in the target or child record is linked to the 022 ‡a in the source or parent record. Another example of related records is the 780 ‡x in a successor serial title is related to the 022 ‡a of the predecessor serial title.

MARC record derivation allows you to use existing template functionality to create new, related MARC records whether they are bibliographic, holdings, or authority records. The new records can include static data from the template as well as dynamically mapped subfield data from the existing source record. You can also map subfields from one type of MARC record to a different type of MARC record.

This functionality can be used with Bibliographic Record Linking, or it can be used independently.

Derivation fields provide the link when you create related records in Cataloging. These fields specify the tag and subfield data in the active (source) MARC record that is mapped into a new MARC record. The derivation fields also determine the subfield in the new record to which the data is mapped.

You can add derivation fields to an existing template or create new templates. Templates containing derivation fields are created and maintained in the same manner as standard templates.

There are two basic formats for a derivation field. See Figure 5-7.

<table>
<thead>
<tr>
<th>Line#</th>
<th>Component</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>‡&lt; 022a&gt;</td>
</tr>
<tr>
<td>2</td>
<td>‡&lt; ‡x 022a&gt;</td>
</tr>
</tbody>
</table>

**Figure 5-7. Examples of derivation fields**

See Table 5-2 and Table 5-3 for a description of the elements contained in the examples in Figure 5-7.

**Table 5-2. Description of the first example in line 1 of Figure 5-7**

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>‡</td>
<td>delimiter symbol (hex 1f)</td>
</tr>
<tr>
<td>&lt;</td>
<td>left (opening) angle bracket</td>
</tr>
<tr>
<td>022</td>
<td>tag in source record</td>
</tr>
<tr>
<td>a</td>
<td>subfield in source record</td>
</tr>
</tbody>
</table>
Table 5-2.  Description of the first example in line 1 of Figure 5-7

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>right (closing) angle bracket</td>
</tr>
</tbody>
</table>

Table 5-3.  Description of the first example in line 2 of Figure 5-7

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>‡</td>
<td>delimiter symbol (hex 1f)</td>
</tr>
<tr>
<td>&lt;</td>
<td>left (opening) angle bracket</td>
</tr>
<tr>
<td>‡</td>
<td>delimiter symbol (hex 1f)</td>
</tr>
<tr>
<td>x</td>
<td>subfield in target record</td>
</tr>
<tr>
<td>022</td>
<td>tag in source record</td>
</tr>
<tr>
<td>a</td>
<td>subfield in source record</td>
</tr>
<tr>
<td>&gt;</td>
<td>right (closing) angle bracket</td>
</tr>
</tbody>
</table>

⚠️ IMPORTANT:
*The delimiter symbol must always be immediately followed by the left (opening) angle bracket at the beginning of a derivation field.*

Other than that one exception, spacing for derivation fields is irrelevant.

Table 5-4.  Examples of spacing in derivation fields

<table>
<thead>
<tr>
<th>Correct Format</th>
<th>Incorrect Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>‡&lt;_022a&gt;</td>
<td>‡&lt;_022a&gt;</td>
</tr>
<tr>
<td>‡&lt;_‡x_022a&gt;</td>
<td>‡&lt;_‡x_022a&gt;</td>
</tr>
</tbody>
</table>

**NOTE:**
In Table 5-4, the underscore ( _ ) character in the incorrect formats indicates a space. The system automatically adds spacing in the Voyager Cataloging module. However, this spacing applies only to the display in the module. It does not translate into spacing for the WebVoyáge display of records.

So how does the system decipher this derivation field? It depends on which format has been used for the derivation fields.
If an operator wants to create a new record using a template which includes the tag, subfield, and derivation field 773 nn ‡x ‡< 022a>, the system creates the new record in the following manner:

- Reads the derivation field (‡< 022a>) in the template.
- Checks the active “source” record for an 022 tag, subfield a.

If an 022 tag is present in the source record and subfield a contains data, the systems adds a 773 tag to the new target record and maps the data in the 022 ‡a to the 773 ‡x.

If an 022 tag is present in the source record but subfield a is not present, or the 022 tag is not present in the source record, the system does not consider this a match. When a derivation field using this format does not match anything in the source record, the system adds a 773 ‡x to the new record but leaves the subfield empty.

For example, if the number 1234-5678 appears in the 022 ‡a of the source record, the system maps that number into the 773 ‡x of the new target record. That is, 773 nn ‡x 1234-5678.

The system acts differently if the second derivation field format is used. For example, if the tag, subfield, and derivation field 773 nn ‡< ‡x 022a> is added to a template, the system creates a new record in the following manner.

- Reads the derivation field (‡< ‡x 022a>) in the template.
- Checks the active source record for an 022 tag, subfield a.

If an 022 tag is present in the source record and subfield a contains data, the systems adds a 773 tag to the new target record and maps the data in the 022 ‡a to the 773 ‡x.

If an 022 tag is present in the source record but subfield a is not present, or the 022 tag is not present in the source record, the system does not consider this a match. When a derivation field using this format does not match anything in the source record, the system adds a 773 to the new record but does not add a subfield or any subfield data.

Again, if the number 1234-5678 appears in the 022 ‡a of the source record, the system maps that number into the 773 ‡x of the new target record. The difference in format determines how missing information is handled.

**NOTE:** If the chosen template does not contain any derivation fields, the system treats the template as a standard template (see Templates on page 5-5).
**Multiple Subfields**

You can add extra characters to derivation fields in order to accommodate tags which are allowed to have repeating subfields. For example, if your source record includes:

```
022 ‡a 1234-5678 ‡a 2234-5467 ‡a 3234-5467
```

and you want to map each of those subfields to separate subfields in your new record, then the derivation field displays as follows.

```
773 nn ‡< ‡x 022a>
```

The addition of the ‡x on the inside of the angle brackets maps all the 022 subfield data to separate 773 subfields as follows.

```
773 nn ‡x 1234-5678 ‡x 2234-5467 ‡x 3234-5467
```

**Non-Matching Subfields**

You can use this same format to determine how the system should handle non-matching subfields. You can decide whether or not the tags and indicators specified in the derivation field are added to the new record if there are no matching subfields in the source record.

For example, if the source record contains the following data:

```
022 nn ‡y 1234-5678
```

and you define a template with a derivation field like this:

```
773 nn ‡< ‡x 022a>
```

the new record includes only the 773 nn without any subfield data.

**Rules and Examples for Derivation Fields**

Depending on the data in the source record, and the format of the derivation fields in the template, you could have many different results. The tables beginning with Table 5-5 through Table 5-12 describe specific rules for derivation fields.

⚠️ **IMPORTANT:**
You can map a tag/subfield combination from the source record into the same tag/subfield combination or a different tag/subfield combination in the new record. In the tables below, the examples are mapping information.
from the tag/subfield combination in the source record to another, different tag/subfield combination in the target record.

Table 5-5. Example 1 - Derivation field

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the active source record contains:</td>
<td>022 nn ‡a 1234-5678</td>
</tr>
<tr>
<td>And the cataloging template contains:</td>
<td>773 nn ‡x ‡&lt; 022a&gt;</td>
</tr>
<tr>
<td>Then the new record contains:</td>
<td>773 nn ‡x 1234-5678</td>
</tr>
</tbody>
</table>

Table 5-6. Example 2 - Derivation field

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the active source record contains:</td>
<td>022 nn ‡a 1234-5678</td>
</tr>
<tr>
<td>And the cataloging template contains:</td>
<td>773 nn ‡&lt; ‡x 022a&gt;</td>
</tr>
<tr>
<td>Then the new record contains:</td>
<td>773 nn ‡x 1234-5678</td>
</tr>
</tbody>
</table>

Table 5-7. Example 3 - Derivation field

<table>
<thead>
<tr>
<th>Rule</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the derivation field has the format ‡&lt; #&lt;c&gt;, and the corresponding tag exists in the active record but the subfields do not match, or the corresponding tag does not exist in the active record, add only the tag and subfield.</td>
<td></td>
</tr>
</tbody>
</table>
Table 5-7. Example 3 - Derivation field

| If the active source record contains: | 022 nn ‡y 1234-5678 or the 022 tag does not exist in the active record |
| And the cataloging template contains: | 773 nn ‡x ‡< 022a> |
| Then the new record contains: | 773 nn ‡x (subfield data empty) |

Table 5-8. Example 4 - Derivation field

| Rule | If the derivation field has the format ‡< ‡c ##c>, and the corresponding tag exists in the active record but the subfields do not match, or the corresponding tag does not exist in the active record, add only the tag. |
| If the active source record contains: | 022 nn ‡y 1234-5678 or the 022 tag does not exist in the active record |
| And the cataloging template contains: | 773 nn ‡< ‡x 022a> |
| Then the new record contains: | 773 nn (no subfield or subfield data) |

Table 5-9. Example 5 - Derivation field

| Rule | If the format of the derivation field is ‡< ###c> and a subfield is repeated in the active bibliographic record, map all occurrences of the subfield into the new record in the order in which they appear. |
| NOTE: | This format adds one new tag followed by the subfield data separated by spaces. |
| If the active source record contains: | 022 nn ‡a 1234-5678 022 nn ‡a 2234-5678 022 nn ‡a 3334-5678 |
| And the cataloging template contains: | 773 nn ‡x ‡< 022a> |
| Then the new record contains: | 773 nn ‡x 1234-5678 2234-5678 3334-5678 |
### Table 5-10. Example 6 - Derivation field

| Rule                                                                 | If the format of the derivation field is ‡< ‡c ###c> and a subfield is repeated in the active bibliographic record, map each occurrence of the subfield into the new record in the order in which they appear.  
|                                                                      | **NOTE:** This format adds one new tag followed by the subfield data separated by the subfield specified in the derivation field.  
| If the active source record contains:                               | 022 nn ‡a 1234-5678  022 nn ‡a 2234-5678  022 nn ‡a 3334-5678  
| And the cataloging template contains:                               | 773 nn ‡< ‡x 022a>  
| Then the new record contains:                                       | 773 nn ‡x 1234-5678 ‡x 2234-5678 ‡x 3334-5678 |

### Table 5-11. Example 7 - Derivation field

| Rule                                                                 | If the derivation field has the format ‡< VRID> or ‡< ‡c VRID>, map the Voyager record ID from the active record into the new record.  
|                                                                      | If the active source record contains: 001 60349  
| And the cataloging template contains:                               | 773 nn ‡x ‡< VRID> or 773 nn ‡< ‡x VRID>  
| Then the new record contains:                                       | 773 nn ‡x 60349 |

### Table 5-12. Example 9 - Derivation field

| Rule                                                                 | In all cases, if the format of the derivation field is not valid, output it to the destination record as is.  
|                                                                      | If the active source record contains: 022 nn ‡a 1234-5678  
| And the cataloging template contains:                               | 773 nn ‡x < ‡x 022a> (should be either 773 nn ‡x ‡< 022a> or 773 nn ‡< ‡x 022a> ) |
NOTE:
If a template containing derivation fields is used to create a new record without an active source record, the system considers the derivation fields as non-matching and output information to the new record as described in Table 5-7 and Table 5-8.

Template Example

There is no limit to the number of templates you can create. They can be short templates, containing only a few tags and subfields, or very long. They can contain derivation fields or not. And, you can include derivation fields into standard templates. With the addition of derivation fields, template functionality has been expanded to now include:

- Tags and subfields with static text. You could use static text when you create multiple records using the same subject headings.
  Example: 650 nn ‡a Geography ‡b United States
- Tags with subfields used as place markers. Use the place markers as reminders to always complete those particular subfields.
  Example: 300 ‡a ‡b ‡c
- Tags with subfields using characters as place markers. Use these place markers as reminders to complete those subfields using a particular format.
  Example: 260 ‡a ‡b ‡c yyyy
- Tags with derivation fields. See the examples beginning with Table 5-5.
- Combinations of all of the above.
  Example: 300 nn ‡a #### p. : ‡b ill. ‡c ## cm.
  Example: 650 nn ‡a Geography ‡< ‡z 650z> ‡< ‡y 650y>
  Example: 100 nn ‡a Syria, Derrell, ‡e lyricist. ‡< ‡a 505r>

To illustrate the functionality of templates, consider this template created to link bibliographic records for individual songs to the bibliographic record for the CD recording.

<table>
<thead>
<tr>
<th>Then the new record contains:</th>
<th>773 nn ‡x &lt; ‡x 022a&gt; (copies the characters exactly)</th>
</tr>
</thead>
</table>

Table 5-12. Example 9 - Derivation field
Many of the tags in Table 5-13 use only derivation fields. Others use combinations, such as Tag 100 and 245. Tag 505 contains static text that is copied directly into the new record. Notice Tag 773 contains derivation fields in both the ‡< ###c> and ‡< ‡c ###c> formats for the same subfield.

**IMPORTANT:**
When you are creating new records using a template containing derivation fields, the system includes any information that has been added to the source record, even if the record has not been saved. For example, if you edited a source record by adding subject information (650abc), then created a new record using the template in Table 5-13, the new record would include the subject information from the source record even though you have not yet saved the source record to the database.

<table>
<thead>
<tr>
<th>Tag</th>
<th>Subfield Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>028</td>
<td>‡&lt; ‡a 028a&gt;</td>
</tr>
<tr>
<td>035</td>
<td>‡&lt; ‡a 035a&gt;</td>
</tr>
<tr>
<td>090</td>
<td>‡&lt; ‡a 090a&gt; ‡&lt; ‡b 090b&gt;</td>
</tr>
<tr>
<td>100</td>
<td>‡&lt; ‡a 700a&gt; ‡&lt; ‡d 700d&gt;</td>
</tr>
<tr>
<td>245</td>
<td>‡&lt; ‡a 505a&gt; ‡&lt; ‡a 505t&gt; ‡&lt; ‡h 245h&gt;</td>
</tr>
<tr>
<td>260</td>
<td>‡&lt; ‡a 260c&gt; ‡&lt; ‡b 260b&gt; ‡&lt; ‡c 260c&gt;</td>
</tr>
<tr>
<td>300</td>
<td>‡&lt; ‡a 300a&gt; ‡&lt; ‡b 300b&gt; ‡&lt; ‡c 300c&gt;</td>
</tr>
<tr>
<td>500</td>
<td>‡&lt; ‡a 500a&gt;</td>
</tr>
<tr>
<td>505</td>
<td>‡&lt; ‡a 505a&gt;</td>
</tr>
<tr>
<td>508</td>
<td>‡a ‡&lt; 508a&gt;</td>
</tr>
<tr>
<td>650</td>
<td>‡&lt; ‡a 650a&gt; ‡&lt; ‡z 650z&gt; ‡&lt; ‡y 650y&gt;</td>
</tr>
<tr>
<td>700</td>
<td>‡&lt; ‡a 700a&gt;</td>
</tr>
<tr>
<td>773</td>
<td>‡&lt; ‡a 110a&gt; ‡&lt; ‡&lt; 245a&gt; ‡&lt; 245b&gt; ‡&lt; 260a&gt; ‡&lt; 260b&gt; ‡&lt; 260c&gt; ‡&lt; ‡w 035a&gt;</td>
</tr>
<tr>
<td>773</td>
<td>‡&lt; ‡6 VRID&gt;</td>
</tr>
</tbody>
</table>
Session Defaults and Preferences

You can access the Session Defaults and Preferences dialog box by selecting Options>Preferences. From this dialog box, you can change a number of defaults which are presented on seven tabs.

- General
- Validation
- Work Flow
- Item Defaults
- Folders
- Mapping
- Colors and Fonts

The defaults you choose are saved when you exit the Cataloging module. Anyone who uses the Cataloging module on that machine begins with the same defaults that you selected unless they change them.

For more information about Session Defaults and Preferences for the Cataloging module, please see that section of the Voyager Cataloging User’s Guide.

Folders/Files Tab

Setting defaults on the Folders/Files tab is especially useful for MARC derivation of records.

If you want to use one particular template to create new MARC records, you can specify the template as a default in Session Options and Preferences in the Cataloging module.

You can enter the entire path for a default template in the appropriate box (Bibliographic, Authority, or Holdings). The filename must refer to an existing file. You can also click the ellipses button to select the template you want from the appropriate directory.

The procedure for defining a default template is shown in Procedure 5-4, Defining a Default Template, on page 5-19.
Procedure 5-4. Defining a Default Template

Use the following to define a default template.

1. Open the Cataloging module.

2. Select Options>Preferences from the menu bar. Figure 5-8.

Result: The Session Defaults and Preferences dialog box opens. See Figure 5-9.
3. Click the **Folders/Files** tab.

Result: The dialog box displays the **Folders and Files** options. See **Figure 5-10**.

---

**Figure 5-9. Session Defaults and Preferences dialog box**

**Figure 5-10. Folders/Files tab for Session Defaults and Preferences**
4. Enter the entire path to the desired template for the appropriate record type (bibliographic, authority, or holdings) in the Templates section. For example, c:\voyager\catalog\template\bib.tem.

You can also click the ellipsis button.

Result: The Select Bibliographic Template dialog box opens.

If you have not defined a Template folder on the Folders/Files tab (see Procedure 5-5, Defining a Default Folder, on page 5-23), the dialog box defaults to the Voyager directory.

5. Select the Catalog folder and click the Open button (or double-click the Catalog folder).

There are three standard folders within the Catalog folder. They are MARCTemplate, Tag Tables, and Template.

NOTE:
The default bibliographic, holdings, and authority templates are located in the Template folder. You can save any new templates that you create to that folder, but it is not required. If you are sharing templates among coworkers, you could create a Template folder on a network that everyone can access.

6. Select the Template folder and click the Open button (or double-click the Template folder).
Result: The **Select Bibliographic Template** dialog box displays a list of template files. If you have defined a Template folder on the **Folders/Files** tab, and you click the ellipsis button for a template, the **Select Bibliographic Template** dialog box defaults directly to that folder.

---

**Figure 5-12.** Template files in the Template folder

7. Select the template file you want to use and click the **Open** button (or double-click the template file).

Result: The path to the file automatically displays in the **Bib** field in the Templates section.

---

**Figure 5-13.** Bib template selected on Folders/Files tab

8. Click the **OK** button to close the **Session Defaults and Preferences** dialog box and save your changes.
NOTE:  
A file path can only be specified in the Templates section if there is one template (as opposed to multiple templates) defined for each record type.

See Procedure 5-6, Creating New Records Using Templates, on page 5-25 to learn how to use default templates when creating new MARC records.

In the Folders section, you can enter or select a default Template folder so when you want to edit an existing template, the Open Template File dialog box defaults to the specified folder. Also, if you specify a default Template folder, any new templates that you create are saved to that folder.

The procedure for defining a default folder is shown in Procedure 5-5, Defining a Default Folder, on page 5-23.

Procedure 5-5. Defining a Default Folder

Use the following to define a default folder.

1. Open the Cataloging module.

2. Select Options>Preferences from the menu bar.

Figure 5-14. Menu bar in the Cataloging module

Result: The Session Default and Preferences dialog box opens. See Figure 5-9.

3. Click the Folders/Files tab.
Result: The dialog box displays the **Folders and Files** options. See Figure 5-10.

4. In the **Folders** section, enter the entire path to the desired folder in the **Template** field. For example, `c:\voyager\catalog\template`. You can also click the ellipsis button.

Result: The **Select Directory** dialog box opens. See Figure 5-15.

![Figure 5-15. Select Directory dialog box](image)

The Select Directory dialog box should default to the Voyager directory. If not, you can browse your PCs hard drive by double-clicking the `C:` in the Directory dropdown list.

Use the Drives drop-down list to change drives if your default folder resides on a drive other than `C:`.

5. Double-click the **Catalog** folder in the Voyager directory to expand it and display the contents.

There are three standard folders within the Catalog folder. They are MARCTemplate, Tag Tables, and Template.

**NOTE:**
The default bibliographic, holdings, and authority templates are located in the Template folder. You can save any new templates that you create to that folder, but it is not required. If you are sharing templates among coworkers, you could create a Template folder on a network that everyone can access.
6. Double-click the Template folder.

7. Click the OK button in the Select Directory dialog box to save your selection to the Folders/Files tab and close the dialog box.

8. Click the OK button to close the Session Defaults and Preferences dialog box and save your changes.

See Procedure 5-7, Creating New Records Using a Default Folder, on page 5-26 to learn how to use a default folder when creating new MARC records.

Once you have created a template using derivation fields, you can begin creating new records. For more information about creating and editing MARC records in the Cataloging module, see the Voyager Cataloging User’s Guide.

If you need to create many new related records from one source record, selecting a default template is the quickest method of record creation. You can change your default template at any time.

The procedure for creating new records using templates is shown in Procedure 5-6, Creating New Records Using Templates, on page 5-25.

Procedure 5-6. Creating New Records Using Templates

Use the following to create new records using templates.

1. Search for and display the source bibliographic record.
For more information about searching in the Cataloging module, see the Voyager Cataloging User’s Guide.

2. Click the **New** button on the Cataloging toolbar.

   Result: The system automatically uses the default template defined in the **Bib** field on the **Folders/Files** tab of **Session Defaults and Preferences** to create the new record.

3. Edit the new record as necessary.

   If you are using a template containing derivation fields, make sure the information is mapped correctly. If a derivation field displays in the new record, it may be because the source record did not contain the tag specified.

4. Save the new record to the database.

   For more information about Saving options in the Cataloging module, see the “Saving and Printing Information” section of the Voyager Cataloging User’s Guide.

5. Close the new record so the source record is again active.

6. Repeat steps 2 through 5 until you have created all the necessary related records.

---

If you are creating many new related records but need to use more than one of your templates, do not define a default template in the Templates block. Instead, define the folder in the **Template** field on the **Folders/Files** tab of **Session Defaults and Preferences**.

This causes the **Open File** dialog box to open when you click the **New** button. At that point, you can choose the appropriate template for the current source record.

The procedure for creating a new records using a default folder is shown in Procedure 5-7, Creating New Records Using a Default Folder, on page 5-26.

---

**Procedure 5-7. Creating New Records Using a Default Folder**

Use the following to create new records using a default folder.

1. Search for and display the source bibliographic record.

2. Click the **New** button.
Result: The Select Bibliographic Template dialog box opens.

3. Select the appropriate template file and click Open (or double-click the template file).

   The system automatically uses the template you selected to create the new record.

4. Edit the new record as necessary.

   If you are using a template containing derivation fields, make sure the information a mapped correctly. If a derivation field displays in the new record, it may be because the source record did not contain the tag specified.

5. Save the new record to the database.

   For more information about Saving options in the Cataloging module, see the "Saving and Printing Information" section of the Voyager Cataloging User’s Guide.

6. Close the new record so the source record is again active.

7. Repeat steps 2 through 6 until you have created all the necessary related records.
Diacritics and Non-Roman Characters

Introduction 6-1
Special Character Entry 6-1
Special Character Mode 6-3
• Special Character Mode Mapping 6-3
Special Characters.cfg 6-7
• File Contents 6-7
  First Field 6-7
  Second Field 6-8
  Third Field 6-8
Microsoft Character Map 6-8
Regional Options for Non-Roman Characters 6-8
Importing Records with Non-Roman Characters 6-9
Other Diacritic Considerations 6-9
Diacritics and Non-Roman Characters

Introduction

Voyager supports Unicode™ in the Cataloging client. This provides the capability to enter diacritic and non-Roman characters in MARC records.

There are several methods for entering diacritic and non-Roman characters in Voyager MARC records such as the following.

- Special Character Entry
- Special Character Mode
- Cut & Paste from another program such as the Microsoft Character Map
- Customize Regional Options to input non-Roman characters from a different language
- Import MARC records with diacritic and non-Roman characters

Special Character Entry

The procedure for entering diacritic or non-Roman characters using Special Character Entry is shown in Procedure 6-1, Special Character Entry, on page 6-2.
**Procedure 6-1. Special Character Entry**

Use the following to enter a diacritic or non-Roman character with **Special Character Entry**.

1. **Select Special Character Entry** (Ctrl+E) from the **Edit** menu.

   **Result:** The **Special Character Entry** dialog box opens. See **Figure 6-1**.

   

   ![Special Character Entry Table](image)

   **Figure 6-1. Special Character Entry**

2. Select the diacritic character and click **Insert** or **Insert/Close**.

   **Result:** This inserts the character in the MARC record and leaves the **Special Character Entry** dialog box open or closed, respectively.
Special Character Mode

The procedure for entering a diacritic or non-Roman character using Special Character Mode is shown in Procedure 6-2, Special Character Mode, on page 6-3.

Procedure 6-2. Special Character Mode

Use the following to enter a diacritic or non-Roman character with Special Character Mode.

1. Select Special Character Mode from the Edit menu.
   Result: Special Character displays in the status bar of the Cataloging module.

2. Type the character that maps to the character you want to enter into the MARC record. See Table 6-1.
   Result: This enters the diacritic or non-Roman character into the MARC record.

3. Select Special Character Mode from the Edit menu.
   Result: This turns off Special Character Mode and returns you to your normal mode of entry.

Special Character Mode Mapping

The keyboard equivalents for entering diacritic and non-Roman characters in Special Character Mode is shown in Table 6-1.

NOTE:
The file of Special Character Mode characters can be customized to match your institution’s preferences and may not exactly match the list shown in Table 6-1. See Special Characters.cfg on page 6-7 for more information.

Table 6-1. Special Character Mode Mapping - Diacritic & Non-Roman Characters

<table>
<thead>
<tr>
<th>Description</th>
<th>Diacritic / Non-Roman Character</th>
<th>Keyboard Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script l</td>
<td>ți</td>
<td>&lt;space&gt;</td>
</tr>
<tr>
<td>Polish L</td>
<td>ści</td>
<td>!</td>
</tr>
</tbody>
</table>
Table 6-1. Special Character Mode Mapping - Diacritic & Non-Roman Characters

<table>
<thead>
<tr>
<th>Description</th>
<th>Diacritic / Non-Roman Character</th>
<th>Keyboard Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scandinavian O</td>
<td>ö</td>
<td>&quot;</td>
</tr>
<tr>
<td>D with Crossbar</td>
<td>£</td>
<td>#</td>
</tr>
<tr>
<td>Icelandic Thorn</td>
<td>□</td>
<td>$</td>
</tr>
<tr>
<td>AE Digraph</td>
<td>¥</td>
<td>%</td>
</tr>
<tr>
<td>OE Digraph</td>
<td>¦</td>
<td>&amp;</td>
</tr>
<tr>
<td>Miagkii Znak</td>
<td>§</td>
<td>,</td>
</tr>
<tr>
<td>Dot at Midline</td>
<td>`</td>
<td>(</td>
</tr>
<tr>
<td>Musical Flat</td>
<td>©</td>
<td>)</td>
</tr>
<tr>
<td>Patent Mark</td>
<td>*</td>
<td>*</td>
</tr>
<tr>
<td>Plus or Minus</td>
<td>«</td>
<td>+</td>
</tr>
<tr>
<td>O Hook</td>
<td>‹</td>
<td>′</td>
</tr>
<tr>
<td>U Hook</td>
<td>‹</td>
<td>′</td>
</tr>
<tr>
<td>Alif</td>
<td>®</td>
<td>.</td>
</tr>
<tr>
<td>alpha</td>
<td>–</td>
<td>/</td>
</tr>
<tr>
<td>Ayn</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Polish l</td>
<td>±</td>
<td>1</td>
</tr>
<tr>
<td>Scandinavian o</td>
<td>ø</td>
<td>2</td>
</tr>
<tr>
<td>d with Crossbar</td>
<td>ø</td>
<td>3</td>
</tr>
<tr>
<td>Icelandic thorn</td>
<td>′</td>
<td>4</td>
</tr>
<tr>
<td>ae Digraph</td>
<td>µ</td>
<td>5</td>
</tr>
<tr>
<td>oe Digraph</td>
<td>¶</td>
<td>6</td>
</tr>
<tr>
<td>Tverdii Znak</td>
<td>.</td>
<td>7</td>
</tr>
<tr>
<td>Turkish i</td>
<td>.</td>
<td>8</td>
</tr>
<tr>
<td>British Pound</td>
<td>¹</td>
<td>9</td>
</tr>
<tr>
<td>eth</td>
<td>o</td>
<td>:</td>
</tr>
<tr>
<td>Dagger</td>
<td>»</td>
<td>;</td>
</tr>
<tr>
<td>o Hook</td>
<td>¼</td>
<td>&lt;</td>
</tr>
<tr>
<td>u Hook</td>
<td>½</td>
<td>=</td>
</tr>
<tr>
<td>Beta</td>
<td>¾</td>
<td>&gt;</td>
</tr>
</tbody>
</table>
Table 6-1. Special Character Mode Mapping - Diacritic & Non-Roman Characters

<table>
<thead>
<tr>
<th>Description</th>
<th>Diacritic / Non-Roman Character</th>
<th>Keyboard Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gamma</td>
<td>¿</td>
<td>?</td>
</tr>
<tr>
<td>Superscript 0</td>
<td>À</td>
<td>@</td>
</tr>
<tr>
<td>Superscript 1</td>
<td>Á</td>
<td>A</td>
</tr>
<tr>
<td>Superscript 2</td>
<td>À</td>
<td>B</td>
</tr>
<tr>
<td>Superscript 3</td>
<td>À</td>
<td>C</td>
</tr>
<tr>
<td>Superscript 4</td>
<td>À</td>
<td>D</td>
</tr>
<tr>
<td>Superscript 5</td>
<td>À</td>
<td>E</td>
</tr>
<tr>
<td>Superscript 6</td>
<td>Æ</td>
<td>F</td>
</tr>
<tr>
<td>Superscript 7</td>
<td>Ç</td>
<td>G</td>
</tr>
<tr>
<td>Superscript 8</td>
<td>È</td>
<td>H</td>
</tr>
<tr>
<td>Superscript 9</td>
<td>É</td>
<td>I</td>
</tr>
<tr>
<td>Superscript +</td>
<td>Ê</td>
<td>J</td>
</tr>
<tr>
<td>Superscript -</td>
<td>Ê</td>
<td>K</td>
</tr>
<tr>
<td>Superscript (</td>
<td>Ì</td>
<td>L</td>
</tr>
<tr>
<td>Superscript )</td>
<td>Í</td>
<td>M</td>
</tr>
<tr>
<td>Subscript 0</td>
<td>Ø</td>
<td>P</td>
</tr>
<tr>
<td>Subscript 1</td>
<td>Ñ</td>
<td>Q</td>
</tr>
<tr>
<td>Subscript 2</td>
<td>Ö</td>
<td>R</td>
</tr>
<tr>
<td>Subscript 3</td>
<td>Ó</td>
<td>S</td>
</tr>
<tr>
<td>Subscript 4</td>
<td>Ö</td>
<td>T</td>
</tr>
<tr>
<td>Subscript 5</td>
<td>Ö</td>
<td>U</td>
</tr>
<tr>
<td>Subscript 6</td>
<td>Ö</td>
<td>V</td>
</tr>
<tr>
<td>Subscript 7</td>
<td>×</td>
<td>W</td>
</tr>
<tr>
<td>Subscript 8</td>
<td>Ø</td>
<td>X</td>
</tr>
<tr>
<td>Subscript 9</td>
<td>Ü</td>
<td>Y</td>
</tr>
<tr>
<td>Subscript +</td>
<td>Ü</td>
<td>Z</td>
</tr>
<tr>
<td>Subscript -</td>
<td>Ü</td>
<td>[</td>
</tr>
<tr>
<td>Subscript (</td>
<td>Ü</td>
<td>\</td>
</tr>
<tr>
<td>Subscript )</td>
<td>Ý</td>
<td>]</td>
</tr>
</tbody>
</table>
Table 6-1. Special Character Mode Mapping - Diacritic & Non-Roman Characters

<table>
<thead>
<tr>
<th>Description</th>
<th>Diacritic / Non-Roman Character</th>
<th>Keyboard Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pseudo Question Mark</td>
<td>à</td>
<td>'</td>
</tr>
<tr>
<td>Grave</td>
<td>á</td>
<td>a</td>
</tr>
<tr>
<td>Acute</td>
<td>§</td>
<td>b</td>
</tr>
<tr>
<td>Circumflex</td>
<td>â</td>
<td>c</td>
</tr>
<tr>
<td>Tilde</td>
<td>ã</td>
<td>d</td>
</tr>
<tr>
<td>Macron</td>
<td>â</td>
<td>e</td>
</tr>
<tr>
<td>Breve</td>
<td>æ</td>
<td>f</td>
</tr>
<tr>
<td>Dot Above</td>
<td>ċ</td>
<td>g</td>
</tr>
<tr>
<td>Umlaut</td>
<td>é</td>
<td>h</td>
</tr>
<tr>
<td>Hacek</td>
<td>é</td>
<td>i</td>
</tr>
<tr>
<td>Angstrom</td>
<td>ē</td>
<td>j</td>
</tr>
<tr>
<td>Ligature left</td>
<td>ē</td>
<td>k</td>
</tr>
<tr>
<td>Ligature right</td>
<td>í</td>
<td>l</td>
</tr>
<tr>
<td>High Comma off center</td>
<td>þ</td>
<td>m</td>
</tr>
<tr>
<td>Double Acute</td>
<td>ì</td>
<td>n</td>
</tr>
<tr>
<td>Candrabindu</td>
<td>ī</td>
<td>o</td>
</tr>
<tr>
<td>Cedilla</td>
<td>ð</td>
<td>p</td>
</tr>
<tr>
<td>Hook Right</td>
<td>ã</td>
<td>q</td>
</tr>
<tr>
<td>Dot Below</td>
<td>ó</td>
<td>r</td>
</tr>
<tr>
<td>Double Dot Below</td>
<td>ó</td>
<td>s</td>
</tr>
<tr>
<td>Circle Below</td>
<td>ó</td>
<td>t</td>
</tr>
<tr>
<td>Double Underscore</td>
<td>ô</td>
<td>u</td>
</tr>
<tr>
<td>Underscore</td>
<td>_</td>
<td>v</td>
</tr>
<tr>
<td>Hook Left</td>
<td>÷</td>
<td>w</td>
</tr>
<tr>
<td>Right Cedilla</td>
<td>ø</td>
<td>x</td>
</tr>
<tr>
<td>Upadhmaniya</td>
<td>û</td>
<td>y</td>
</tr>
<tr>
<td>Double Tilde first half</td>
<td>û</td>
<td>z</td>
</tr>
<tr>
<td>Double Tilde second half</td>
<td>û</td>
<td>{</td>
</tr>
<tr>
<td>High Comma Centered</td>
<td>í</td>
<td>~</td>
</tr>
</tbody>
</table>
The Special Characters.cfg file located in the Catalog folder in the Cataloging module installation directory may be customized to contain character mappings that can be used with the Special Character Mode in the Cataloging module. By default, the file is installed with the mappings identified in Table 6-1.

This file is encoded in Latin-1. Any characters outside the Latin-1 character set may be referenced in the Special Characters.cfg file using XML entity references.

An XML entity reference is in the format `&#x1234;` where 1234 is the hexadecimal representation of the Unicode (UTF-8) character.

⚠ IMPORTANT:
Literal commas in any field in this file must be encoded using the XML entity reference form. The XML entity reference for the comma is `&#x2C;`. Entity references may appear in either hexadecimal or decimal notation.

File Contents

The Special Characters.cfg file is a list of comma separated values. Each entry contains three comma separated fields. This file may contain tabs for readability.

First Field

The first field contains the value of the keyboard key that accesses the entry.

If this field is empty, the entry is only available using the Special Characters Entry form.
The first field may only contain ASCII graphic characters with code points from 32 through 127 decimal.

This field may only contain a single character.

**Second Field**

The second field contains the text to insert into the field of the MARC record.

This field may contain characters from Latin-1. Any characters from outside the Latin-1 character set must be encoded in XML entity reference format.

This field may contain an arbitrary amount of text. It is possible for this field to contain a lengthy block of text (approximately 80 characters). Although, the default file contains single-character entries.

**Third Field**

The third field contains a description of the entry. This field is optional.

It may contain Latin-1 characters and entity references.

This field may be 80 characters in length.

**Microsoft Character Map**

The Microsoft Character Map can be used to cut and paste non-Roman characters needed for Cataloging input.

Use the following path to access the Microsoft Character Map.

Start>Programs>Accessories>System Tools>Character Map

For more information about the Microsoft Character Map use the Microsoft Help and reference materials on this topic.

**Regional Options for Non-Roman Characters**

Microsoft provides operating-system-level regional language options that provide another alternative for entering non-Roman character.

Use the following path to access the Microsoft Regional Options.
Start>Settings>Control Panel>Regional Options

For more information on this topic use the Microsoft Help and reference materials.

**Importing Records with Non-Roman Characters**

Information about considerations for importing Non-Roman characters can be found in BulkImport on page C-8 and also in the Voyager Technical User’s Guide.

**Other Diacritic Considerations**

Other diacritic considerations can be found in Diacritics and MARC21 Compliance Considerations on page C-3.
Pick and Scan

Introduction 7-1
Using Pick and Scan 7-2
Pick and Scan

Introduction

Pick and Scan is a feature within Voyager’s Cataloging module designed to facilitate mass changes to item records and associated holdings records. Pick and Scan allows authorized staff to change, delete, or clear data with the simple wand of an item barcode or by processing a file that lists a group of barcodes.

Adhering to all operator security profiles including owning library security, Pick and Scan enables authorized operators to change the following.

• Holding location
• Permanent location
• Temporary location
• Permanent type
• Temporary type
• Media type
• Item status
• Statistical categories
• Bibliographic and MFHD suppress from OPAC

Pick and Scan is an especially useful tool for libraries undertaking significant inventory and maintenance projects by making it possible for staff to use scanning technology, hand-held devices, and/or batch files for processing large groups of changes.
Using Pick and Scan

The procedure for using Pick and Scan is shown in Procedure 7-1, Using Pick and Scan, on page 7-2.

Procedure 7-1. Using Pick and Scan

Use the following to work with the Pick and Scan feature.

1. Click File>Pick and Scan or Ctrl+I.

Result: The Pick and Scan dialog box opens. See Figure 7-1.

![Figure 7-1. Pick and Scan dialog box](image)

NOTE:
In order for staff to have access to Pick and Scan, one or more of the following minimum security authorizations must be specified.

- Update Item Records
- Delete Item Records
• Update Holdings Records

Depending on the operator's security level, not all Pick and Scan options may be available. If, for example, an operator doesn’t have Delete Item Record privileges, the Delete Item check box is inactive.

Figure 7-2. Permanent Location options

2. Select the desired change(s) from the options on the Item Options tab.

Click the drop-down arrow next to the desired option to view available choices.

Use the check boxes to clear or delete item information.

For examples, see Figure 7-2 and Figure 7-3.

**TIP:**
When making changes to Permanent Location, you may also want to simultaneously change the Holding Location.
Figure 7-3. Temporary Type options

**IMPORTANT:**
When the **Delete** option is selected, a pop-up warning message displays. This is the only notification received for the deletion request. See Figure 7-4.

Figure 7-4. Delete warning message

The drop-down lists display the locations stored in the operator's security profile. The default option in all cases is **No Change**, and **Clear** is provided as an option for non-required fields in the item record.
Required fields include the following fields.

- Holding Location
- Permanent Location
- Permanent Type

**NOTE:**
Pick and Scan modifications to the Holding Location option change the MFHD 852 ‡b.

The **Permanent Type** and **Temporary Type** drop-down lists display the type values stored in Voyager System Administration for **Item Types**.

The **Media Type** drop-down list displays the type values stored in Voyager Media System Administration within **Media Types**.

---

**Figure 7-5. Item Status/Clear All single step**
Especially noteworthy is the Clear All option for Item Status and Statistical Categories. The Clear All option allows operators to clear any current, non-system-applied status or statistical category and apply a new one in a single step. See Figure 7-5.

Also, notice that the Item Status drop-down list is only composed of non-system-applied statuses. It is not possible, for example, to remove a Charged status from an item. The Item Status List includes:

- At Bindery
- Cataloging Review
- Circulation Review
- Damaged
- In Process
- In Transit
- Lost--Library Applied
- Missing
- Withdrawn

When selected, the Suppressed option sets the suppress flag in the database for the bibliographic or MFHD record that is linked to the item identified for Pick and Scan. See Figure 7-6. For bound-with items, this includes all bibliographic records linked to the bound-with item record.

![Suppressed option](image)

Figure 7-6. Suppressed option

When selected, the Unsuppressed option turns off the suppress flag in the database for the bibliographic or MFHD record that is linked to the item identified for Pick and Scan.

NOTE:
The MFHD record cannot be unsuppressed if its location is marked as suppressed in the OPAC.
To change the suppress flag for bibliographic records, the user must have the following security settings in Voyager System Administration on the Profile Values tabs:

- Update checked for Bibliographic Record
- Allow Bibliographic Ownership Change.

See Figure 7-7 and Figure 7-8.

![Voyager System Administration Profile Values tab](image-url)
To change the suppress flag for MFHD records, the user must have the following security in Voyager System Administration:

- The record’s location must be in the security profile.
- The Update option must be checked for Holding Record on the Profile Values tab. See Figure 7-7.

3. Click the Items tab. See Figure 7-9.
4. Enter the identifying item information in the **Barcode** text box or the name of the file in **Select File** to process a batch of items.

5. Click the check mark button or press **Enter** to process individual Barcode entries in the **Barcode** text box or click the **Process File** button to begin batch processing from a text file.
See Figure 7-10 and Figure 7-11 regarding the **Barcode** text box processing method and Figure 7-12 and Figure 7-13 regarding the **Select File** processing method.

---

**Figure 7-11.  Check mark button**

---

**Figure 7-12.  Select File ellipsis**

---

**TIP:**

*Click the ellipsis button to access the directory of files. See Figure 7-12.*
Figure 7-13. Filename (path) entered

NOTE:
The file of barcodes created for batch processing must be a Windows (not UNIX) file delimited by carriage returns. That is, each barcode must be separated by carriage return. See Figure 7-13 and Figure 7-14.

Figure 7-14. Carriage-return-delimited file

OPTIONAL:
6. Click Print List or Save to File (.txt file type) to capture the Processing Report displayed as in Figure 7-15.
Figure 7-15. Processing report window

The bottom half of the **Pick and Scan** dialog box, a scrolling window, displays basic item information of scanned items and any error messages that may accompany the action specified.

Basic item information displayed in the Processing Report includes the following.

- Title
- Enum/chron
- Barcode
- Location
- Status

Any item field that has changed as a result of processing displays the before and after values separated by a slash. All successfully completed transactions are indicated with a status of Processed. Values that have been cleared display as `<cleared>`. Whenever a non-existent item barcode is entered, the Processing Report indicates that, too. See Figure 7-16.
One of the following general statuses is provided in the Processing Report.

- Processed.
- Unable to update item record because duplicate barcodes exist.
- Unable to update item record because barcode not found.
- Unable to read file format.

**NOTE:**
After the operator closes the Pick and Scan session, the Processing Report information is cleared and no longer available.

**TIP:**
Use the Processing Report to locate errors in the Windows barcode file used in Pick and Scan batch processing. The scrolling window keeps track of everything processed up to the point of any error. By comparing the Processing Report with the Windows file of barcodes, the operator can determine where to resume batch processing.

7. Click **Close** when Pick and Scan processing is complete.
Templates

Introduction 8-1
Creating, Editing, and Deleting Templates 8-2
• Special Considerations - Authority Templates 8-3
  System Generated Fields 8-3
  Custom Templates 8-3
  Default Preferences Setting 8-4
Templates

Introduction

A template allows you to use a pre-defined MARC record to create new records easily. Before you can create a record, there must be at least one template in the template directory in the Voyager directory. Voyager provides you with three templates.

- bib.tem
- auth.tem
- hold.tem

These templates should not be deleted.

For information about setting template preferences, see Folders/Files Tab on page 10-13.

The procedure for creating a new template is shown in Procedure 8-1, Creating a New Template, on page 8-2.

The procedure for editing a template is shown in Procedure 8-2, Editing a Template, on page 8-4.

The procedure for deleting a template is shown in Procedure 8-3, Deleting a Template, on page 8-5.
NOTE:
Templates cannot be retroactively applied to an existing record.

Creating, Editing, and Deleting Templates

The procedure for creating a new template is shown in Procedure 8-1, Creating a New Template, on page 8-2.

NOTE:
You must have at least one template for each type of record that you want to create such as bib.tem, auth.tem, or hold.tem.

Procedure 8-1. Creating a New Template

Use the following to create a new template.

1. Select File>Template>New.

2. Select the record type (Authority, Bibliographic, or Holdings) and click OK.

   Result: The system template for the record type you selected is displayed.

3. Create the new template by entering the Leader, fixed fields, and variable fields.

   For more information, see Bibliographic Records on page 2-3, Authority Records on page 2-29, and Holdings Records on page 2-39.

   For special considerations regarding authority templates, see Special Considerations - Authority Templates on page 8-3.

   Result: A template matching your requirements is completed.

4. Select File>Save As. Enter the name you want for your template. The suffix for the file must be .tem such as thesis.tem.

   NOTE:
   When a template is saved, it is not validated against authority records or the MARC tag table.
Special Considerations - Authority Templates

To provide for the most flexibility in authority record creation, Voyager Cataloging provides the following options with authority templates when validating authority records and using Create auth from the Authority Validation dialog box (see Figure 9-1).

- System generated fields
- Custom templates
- Default preferences setting

System Generated Fields

The system automatically populates the authority template with the following fields.

- 040
- 670
- 1XX and 4XX (depending on what is being validated in the authority record)

If a blank template (where no fields are specified) is created, saved, and specified as the default in Session Defaults and Preferences (see Figure 10-6 on page 10-13), the automatically generated fields display when using Create auth from the Authority Validation dialog box.

The system generated fields are based on a standard established by the Library of Congress.

Custom Templates

You may also create your own unique templates that identify fields beyond the system generated ones as described in System Generated Fields on page 8-3. Follow the steps described in Procedure 8-1, Creating a New Template, on page 8-2 to create your custom templates.

IMPORTANT:

System generated fields are also dynamically added to your template when you use Create auth from the Authority Validation dialog box. If, for example, you include an 040 field in your custom template, a duplicate 040 is generated when the authority template displays. Therefore, your custom templates do not need to include the system generated fields.
Default Preferences Setting

To eliminate any extra steps in locating a commonly used authority template, use Session Defaults and Preferences to specify the name of the template to be used as the default.

See Folders/Files Tab on page 10-13 for more information about setting defaults.

The procedure for editing a template is shown in Procedure 8-2, Editing a Template, on page 8-4.

Procedure 8-2. Editing a Template

Use the following to edit a template.

1. Select File>Template>Edit.

2. Select the template you want to edit and click Open.

   Result: The template you selected opens.

3. Edit the template by changing the Leader, fixed fields, and variable fields. For more information on these fields, see the section about that particular record type. For more information, see Bibliographic Records on page 2-3, Authority Records on page 2-29, and Holdings Records on page 2-39.

   To edit the template, you can use the same commands as you use for editing a record. See Table 10-13 on page 10-23 for more information.

4. Select File>Save to save the template with the same name. Select File>Save As to save the template with a different name. If you use Save As, the suffix for the file must be .tem.

   NOTE:
   When a template is saved, it is not validated against authority records or the MARC tag table.

The procedure for deleting a template is shown in Procedure 8-3, Deleting a Template, on page 8-5.
Procedure  8-3. Deleting a Template

Use the following to delete a template.

1. Select File>Template>Edit.
   
   Result: The Open Template File dialog box displays.

2. Select the template you want to delete and click Open.
   
   Result: The template you selected displays.

3. Select File>Template>Delete.
   
   Result: A warning message displays regarding your delete request.

4. Click OK to delete the selected template, or click Cancel to close the dialog box without deleting the selected template.

   Result: The templated is deleted or canceled per your selection.

Templated Input

Optionally, you may want to consider using Templated Input for entering and editing MARC records. This alternative provides the capability to use commonly language terms to prompt the enduser for input fields.

For a detailed explanation of using Templated Input, see Appendix D.
Authority Control

Introduction 9-1
Columns on the Authority Validation Dialog Box 9-2
Buttons on the Authority Validation Dialog Box 9-4
Global Headings Change and Preview Queue 9-6
  • Sample Global Headings Change Work Flow 9-9
    Global Change Process 9-10
    Splitting a Heading 9-14
    Heading Merge 9-14
    Name/Title Heading Change 9-14
    Buttons 9-15
Global Headings Batch Job 9-16
Authority Control

Introduction

When you select Record>Save to Database, Voyager’s Cataloging module can automatically validate the current record against the appropriate authority record. Fields that are subject to authority control (such as authors, series, and subjects), are checked against authority records in your database.

Depending on what option is selected on the Validation tab in Session Defaults and Preferences (see Session Defaults and Preferences on page 10-1), one of the following occurs.

• If all headings are valid or if Bypass Authority Control is selected, the record is saved to the database.

• If there are invalid headings and you have not selected Display all the headings, the Authority Validation dialog box opens and lists only the headings without an authority record.

• If there are invalid headings and Display all the headings is selected, the Authority Validation dialog box opens and lists all of the headings whether they are valid or not such as no authority record.

NOTE:
If you want to save bibliographic records in your current session to the database without running Authority Control Validation, you can check the Bypass Authority Control Validation option in Options>Session Defaults. Otherwise, all invalid headings must be resolved or overridden by clicking the Continue button on the Authority Validation dialog box (Figure 9-1) before the record is saved to the
database. However, the database requires that in all variable length fields each subfield indicator is followed by text even if this option is selected. A single space following the indicator is a sufficient amount of text.

Figure 9-1. Authority Validation dialog box

Columns on the Authority Validation Dialog Box

The following columns (see Table 9-1) display in the Authority Validation dialog box.

Table 9-1. Authority Validation Dialog Box

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading</td>
<td>Name, Title, Name/Title, or Subject.</td>
</tr>
<tr>
<td>Tag(s)</td>
<td>MARC record tags being validated.</td>
</tr>
</tbody>
</table>
Table 9-1. Authority Validation Dialog Box

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
</table>
| Validation     | Displays the results for validation of each tag in the record.  
  - Heading Validated - an exact match was made  
  - Cosmetic Differences - the record matches except for differences in punctuation  
  - Partial Heading Validation - some of the subfields (but not all) match a heading  
  - No Heading Validated - a match could not be found to validate the heading  

**NOTE:**  
Partial Validation works by trying to make an exact match of the subfields of the record. If it does not, it removes the rightmost subfield and performs a match based on that information. It repeats this until it makes a match or it runs out of fields, at which point it returns **No Heading Validated**.

- Partial Validation does not match based on close matches of a subfield. For example if you validate "‡a Mississippi River," a partial match never identifies "‡a Mississippi River Authority" as a candidate. For that type of matching, you must highlight the heading and click **Search** to perform a browse headings search which will list all the headings that closely but not exactly match that heading.

|近Heading | The bibliographic heading with subfield diameters.  

| Bib Heading | The bibliographic heading in the database that most closely matches the heading under validation. The following may display in the **Near Heading** column.  
  - The column may be blank indicating that the heading does not match  
  - The heading may display in a normalized form (and matches the authority heading)  
  - The headings do not match partially, or they are from another index |
## Buttons on the Authority Validation Dialog Box

The following buttons (see Table 9-2) display on the Authority Validation dialog box.

### Table 9-2. Authority Validation Dialog Box

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| Create auth | Use to generate a new Authority record. The NUC code in the 040 comes from the Cataloging location’s Owning Libraries NUC code. The Authority record’s location must correspond to the Owning Libraries Location.  
To activate the Create auth button, you must first select the error in the Authority Validation dialog by clicking the row label.  
Clicking Create auth displays an authority template if one has been selected as a default in Session Defaults and Preferences (see Table 10-5 on page 10-14) or the Select Authority Template dialog box (see Figure 9-2) displays from which you can select a template.  
See Procedure 8-1, Creating a New Template, on page 8-2 for more information about creating templates.  
NOTE: If you click Cancel from the Select Authority Template dialog box, the system generated template displays (a standard established by the Library of Congress). See http://lcweb.loc.gov/catdir/pcc/strawn.html for more information. |
| Retrieve auth| Use to retrieve an authority record when one exists.  
This button is disabled if the heading selected has no associated authority record.                                                                                                                                 |
| Copy        | Copies the selected Heading text to the clipboard. To activate the Copy button, you must first select the error in the Authority Validation dialog by clicking the row label (the grey, left column). You can then paste the Heading into the new authority record using Edit>Paste or the Ctrl+v function. |
Table 9-2. Authority Validation Dialog Box

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search</td>
<td>This button allows you to search for authority headings using the standard Search dialog. A browse search is launched with the search argument being the selected heading. If you select a heading from the browse list and click Copy, the heading is copied to the clipboard. You can then return to the record and add the heading information by selecting a point in the variable field and clicking Paste. NOTE: If the heading selected is a subdivision, the search performed is a regular find search rather than a browse.</td>
</tr>
<tr>
<td>Continue</td>
<td>This overrides all of the authority validation errors and allows Voyager to save the record to the database. This button does not create authority records for the unauthorized headings.</td>
</tr>
<tr>
<td>Close</td>
<td>This button closes the Authority Validation dialog box.</td>
</tr>
</tbody>
</table>

Figure 9-2. Select Authority Template dialog box
Global Headings Change and Preview Queue

An authority record, the 100-185 fields, contains an established name, title, name/title subdivision, or subject. Voyager's Global Headings Change process is a combination of client interface and batch jobs on the server that process the changes you make to an authority heading. When a change is made and saved to the database, you can view all of the affected heading changes in the Global Headings Change Queue activity of the Voyager Cataloging module (select from the File menu in the Cataloging main menu). You must have the proper security profile in System Administration to make these changes.

When a change to an authority heading or subdivision type (initial subfield delimiter or 18x tag of the subdivision) is made, the Global Headings Change Queue expands to a hierarchical tree, displaying all of the changes to the Authority heading as well as the associated authority fields or records. You can view the proposed changes, see the other information that is affected, and finally mark the changes that you want implemented.

NOTE:
Traced and untraced reference authority headings may be changed by the Global Headings Change Queue.

Each of the three branches of the tree (see Table 9-3 for a description) represents a different aspect of the authority heading information.

Table 9-3. Tree Descriptions

<table>
<thead>
<tr>
<th>Tree Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>First level</td>
<td>Displays the original authority record prior to changes, the 1xx or 18x.</td>
</tr>
<tr>
<td>Second level</td>
<td>Displays the modified 1xx or 18x heading, the affected headings in bibliographic records, and the bib record affected by the change.</td>
</tr>
<tr>
<td>Third level</td>
<td>Displays all authority headings affected by the changed 1xx or 18x heading in level one. Those headings affected include the 1xx, 4xx, or 5xx fields.</td>
</tr>
</tbody>
</table>

NOTE:
If a 4xx displays in the third level and its level one heading is not a subdivision (for example, you have a 4xx pointing to a 1xx that is the same as the 4xx), it is a sign of a conflicting authority record.

The levels of the tree are shown in Figure 9-3.
In order for Global Headings Changes to be completed, three batch processing jobs must be run. They must be run in the following order.

1. Job 11
2. Job 12
3. Job 13

For more information, see the Voyager Technical User’s Guide.

Each job only processes records that have had the previous job run on them. If you run the same job consecutively, it is ignored the second time.

The Bibs column (bibliographic count) that displays in level two of the Global Headings Change Queue tree indicates the number of times the authority heading occurs in a bibliographic record. The bibliographic count that displays in the preview queue displays the number of bibliographic records to be processed with the new heading. See Figure 9-4.

**IMPORTANT:**

Any records to be processed through the Global Headings Change Queue must not be manually changed between each step of the batch job. If changes are made manually, the records in which changes were made are removed from the queue.
Figure 9-4. Global Heading Change & Preview Queues

NOTE:
If you have a bibliographic record with a name/title heading that, for example, contains both a 1xx and a 240, 243, or 245 or it contains a 400, 410, 411, 700, 710, 711, 800, 810, or 811, it is only changed if an authority record which contains a name/title heading is changed. If a non-name/title authority record such as a name authority heading with a matching 1xx heading is changed, this has no effect on a name/title bibliographic record.

For example, suppose you have a bibliographic record that contains the following.

100 ‡a Adams, John Q.
243 ‡a My life with Abigail : a biography

You also have authority record #1 that has the name but not the title in the 1xx, as in the following example.

100 ‡a Adams, John Q.

If you change the 100 ‡a of authority record #1 to Adams, John Quincy, the above bibliographic record is not changed.

Assume you have an authority record #2 that contains a name/title heading, such as the following example.

100 ‡a Adams, John Q. ‡t My life with Abigail : a biography
If you changed the 100 ‡a of authority record #2 to Adams, John Quincy, that change is reflected in your bibliographic record.

Sample Global Headings Change Work Flow

The following is an example of the Global Change workflow.

a. A change is made to an authority heading by an online edit, online replace, import, or Bulk Import and saved to the database.

The change is automatically queued up to the Global Headings Change Queue.

b. Open the queue by pressing Ctrl + G or by selecting File>Global Headings Change from the main menu.

The heading that is visible is the old authority heading, before it was changed. The Authority record can be viewed by clicking the heading and then clicking the Auth... button.

c. The first batch/server process (batch job 11) is run.

d. The first stage of change displays in the Global Headings Change Queue. You can view the heading changes that were made to the original Authority record.

e. Run the second batch job (batch job 12) and view the Global Headings Change Queue again.

f. This allows you to view changes that are to be made to authority and bibliographic records that have that heading. To see a list of bibliographic records associated with the new heading, highlight the new heading and click the Preview button. The bib records display in the lower portion of the Global Headings Change dialog box.

g. Place a check in the process flag check box (or highlight the new heading and click the Process button). The process flag marks the change to be executed by the batch job and identifies those check boxes to initiate the change.

h. Running the third batch job (batch job 13) completes the changes that have been checked and saves them to the database.

An alternative method of making these changes without the Global Headings Change Queue is to change the records directly. You can bring up the bibliographic records that have the old authority heading and update all of the references manually. This removes the heading from the queue.
Global Change Process

For more information on batch jobs 11-13, see the Voyager Technical User’s Guide.

a. When a change is made to an authority record and saved to the database, the record with the change displays in the Global Headings Change Queue as it used to be before the changes were made. See Figure 9-5. This is the first level of heading changes in the tree structure.

![Global Headings Change Queue](image)

Figure 9-5. Global Heading Preview: Initial State

You can view the full Authority record in MARC format by highlighting the record and clicking the Auth button. See Figure 9-6.
Figure 9-6. Global Change Preview: Authorities Records

b. Running the first batch job causes Voyager to add the second level of heading changes to the tree structure. These are the changes that are intended to be made. The **Process** flag displays at this level. This flag allows you to select which changes you want to have processed by the third batch job.

c. Running the second batch job causes Voyager to add the third level of headings changes to the tree structure. These are the authority record headings that would be affected by the change. This batch job creates the entries in the preview queue, displaying any Authority records with 5XX fields.

When you view the **Global Headings Queue**, you are able to select which changes are to be processed. Each change and its corresponding updates are the result of an authority heading change.

After running the second batch job you can also view any bibs associated with this heading by highlighting the heading and clicking the **Preview** button. This displays the changed heading, and enables the **Bib** button which displays the complete record. The top section of the **Global Headings Change Queue** only displays the old heading and the heading change.

Before you run the third batch job, you must specify which changes you want to make by checking the **Process?** box.

d. Running the third batch job makes all of the changes to the bibliographic and/or authority records that had the **Process** flag turned on in the **Global Headings Queue** dialog box.
Original Heading

The first thing displayed when you open the global headings screen is the original heading. See Figure 9-7 and Table 9-4.

Figure 9-7. Level One of Tree: Original Heading, outlined

Table 9-4. Original Heading Information Displayed

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auth ID</td>
<td>The authority record ID of the changed heading.</td>
</tr>
<tr>
<td>Heading (old)</td>
<td>The original heading for the record.</td>
</tr>
<tr>
<td>Operator</td>
<td>The operator who made the change.</td>
</tr>
<tr>
<td>Date</td>
<td>The date the change was made.</td>
</tr>
<tr>
<td>Index Type</td>
<td>The type of heading index.</td>
</tr>
</tbody>
</table>

Proposed New Heading

The next thing that displays below the old heading is the new heading. See Figure 9-8 and Table 9-5. This displays the complete new heading as it will look after the changes have been made. You must check the box to the left of the new heading in order to make the change. There may be more than one proposed new heading, such as when a subdivision is changed.
Any items that display below the new heading are the other affected authority headings (see Figure 9-9 and Table 9-6) such as a 5XX or, in the case of a subdivision change, a 1XX. Depending on the changes being made, there may or may not be any affected authority headings to be changed. That is, no affected authority headings may display in the dialog box.
Splitting a Heading

You may want to split a heading such as vaccine and vaccination. If 90 percent of the records will be vaccine, it might be a good idea to complete Global Change for 100 percent of the records and change the 10 percent that will go under vaccination manually.

Heading Merge

In order to merge headings, you can create a brief or provisional authority record to attach to the old headings and then change the heading and leave the old authority record there until after the Global Change. After the Global Change, you can delete the dummy authority record.

Name/Title Heading Change

If you have a bibliographic record with a name/title heading that, for example, contains both a 1xx and a 240, 243, or 245 or it contains a 400, 410, 411, 700, 710, 711, 800, 810, or 811, it is only changed if an authority record which contains a name/title heading is changed. If a non-name/title authority record with a matching 1xx heading is changed, there is no effect on the bibliographic record.

Behavior of the Dialog Box

In order to display the Preview Change Queue, you must highlight a new heading in the upper portion of the dialog box. Click the Preview button and any bib records affected by the change display in the lower portion of the dialog box. If more than 250 bib records are affected by the change, the first 250 records display. Click the Next button to retrieve the remainder of the bib records. If you make any changes such as deleting a record, the count only reflects the number displayed compared to the number remaining that you have not retrieved. Only when you have retrieved all of the records does the count reflect the real total in the queue.

Table 9-6. Authority Headings Information Displayed

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hdg Type</td>
<td>Specifies the type of heading that contains the heading being changed.</td>
</tr>
<tr>
<td>Auth ID</td>
<td>The authority record ID.</td>
</tr>
<tr>
<td>1XX Heading</td>
<td>Specifies the authorized heading.</td>
</tr>
</tbody>
</table>
Buttons

The following (Table 9-7) describes the different button options.

Table 9-7. Button Descriptions

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process</td>
<td>Highlight the new heading by clicking it and click the Process button to flag the row to save changes to the database in a batch job.</td>
</tr>
<tr>
<td>Clear</td>
<td>Highlight the heading by clicking it and then click the Clear button to prevent the batch program from processing the heading such as remove the Process flag.</td>
</tr>
</tbody>
</table>
| Search | Performs a browse search on the original heading or old heading. Saving a record to the database allows you to search it.  

**NOTE:**  
If the heading selected is a subdivision, the search performed is a regular find search rather than a browse. |
| Preview | Display any heading change by selecting it and clicking Preview. |
| Auth | Displays the authority record. |
| Delete | Deletes the selected changes from the Global Headings Change Queue. |

When bib records are displayed after clicking the Preview button, the following buttons (see Table 9-8) display with the bib records in the lower portion of the dialog box.

Table 9-8. Button Description for Preview Display

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next</td>
<td>Retrieves more bib records if more than 250 records are affected by the heading change.</td>
</tr>
<tr>
<td>Bib</td>
<td>Displays the bibliographic record.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes a bib record from the preview list. It will not be included in the heading change.</td>
</tr>
</tbody>
</table>
Global Headings Batch Job

See the *Voyager Technical User’s Guide* for a description of how to run each of the Global Headings batch jobs. Refer to jobs 11, 12, and 13 of the Cataloging batch job.
Session Defaults and Menu Options

Session Defaults and Preferences 10-1
• General Tab 10-2
• Validation Tab 10-4
• Work Flow Tab 10-9
• Item Defaults Tab 10-11
• Folders/Files Tab 10-13
• Mapping Tab 10-15
• Colors/Fonts Tab 10-16

Cataloging Menus 10-19
• Main Workspace Menu Options 10-19
  File Menu - Main Workspace 10-20
  Record Menu - Main Workspace 10-20
• Display Menu - Main Workspace 10-21
• Options Menu - Main Workspace 10-21
• Help Menu 10-21
• Menu Options After Working with Active Records 10-22
  File Menu - Working with Active Records 10-22
  Edit Menu - Working with Active Records 10-23
  Record Menu - Working with Active Records 10-24
  Related Records Menu - Working with Active Records (Bibliographic Records Only) 10-26
  Item Menu - Working with Active Records (Item Records Only) 10-27
  Display Menu - Working with Active Records 10-27
Session Defaults and Preferences

You can access the Session Defaults and Preferences dialog box by selecting Options>Preferences. From this dialog box, you can change a number of defaults which are presented on several tabs.

- General
- Validation
- Work Flow
- Item Defaults
- Folders
- Mapping
- Colors/Fonts

After you select your defaults, click OK to accept them or click Cancel to close the dialog without applying any of your selections.

The defaults you choose are saved when you exit the Cataloging module. Preferences are machine specific. If more than one person uses the same workstation, each person uses the same defaults.
General Tab

Customize the options on the General tab (see Figure 10-1) to match your preferences using Table 10-1 for a description of each option.

![Cataloging Session Defaults and Preferences: General tab](image)

**Figure 10-1. Cataloging Session Defaults and Preferences: General tab**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Holdings/Item default location</td>
<td>Select the default location for all holdings and item records that you create by clicking the drop-down arrow.</td>
</tr>
<tr>
<td>Call Number Hierarchies</td>
<td>Select the call number hierarchy which is used to pull call number information from a bib record into a holdings record. You can also select None from the list of options.</td>
</tr>
</tbody>
</table>
Table 10-1. General tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bibliographic Import/Replace Profile</td>
<td>Select the appropriate Import/Replace profile from this drop-down menu. These profiles are defined by your system administrator and specify what actions are taken when duplicate records are found during an import. If your profile removes records that are currently in the database and replaces them with the imported record, or merges the existing record with a new record, the old records are archived on the server in the file replace.&lt;recordtype&gt;.marc. If your profile does not replace records that are currently in the database, the imported duplicate records are archived on the server in the file discard.&lt;recordtype&gt;.marc. Records rejected because they don’t match are archived in the file reject.&lt;recordtype&gt;.marc. To access the deleted and discarded files on the server, or for more information on specific profiles, refer to &quot;Bibliographic Duplicate Detection Profiles&quot; in the Voyager System Administration User’s Guide.</td>
</tr>
<tr>
<td>Authority Import/Replace Profile</td>
<td>Select the appropriate Import/Replace profile from this drop-down menu. These profiles are defined by your system administrator and specify what actions are taken when duplicate records are found during an import. If your profile removes records that are currently in the database and replaces them with the imported record, or merges the existing record with a new record, the old records are archived on the server in the file replace.&lt;recordtype&gt;.marc. If your profile does not replace records that are currently in the database, the imported duplicate records are archived on the server in the file discard.&lt;recordtype&gt;.marc. Records rejected because they don’t match are archived in the file reject.&lt;recordtype&gt;.marc. To access the deleted and discarded files on the server, or for more information on specific profiles, refer to &quot;Authority Duplicate Detection Profiles&quot; in the Voyager System Administration User’s Guide.</td>
</tr>
<tr>
<td>Delete records from work files once saved to database</td>
<td>Select this check box to automatically delete a record(s) from your work files, once you save that record to the database.</td>
</tr>
</tbody>
</table>
Validation Tab

Customize the options on the Validation tab (see Figure 10-2) to match your preferences using Table 10-2 for a description of each option.

Table 10-1. General tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete records from import file once saved to database</td>
<td>Select this check box to automatically delete the record(s) you import from an import file, once you save that record to the database.</td>
</tr>
<tr>
<td>Add a subfield 'a' to a new field</td>
<td>Select this option to add a subfield ‘a’ automatically to the field when a new field is added to a record using the Insert field before (F3) and Insert field after (F4) commands.</td>
</tr>
<tr>
<td>Display MARC Views maximized</td>
<td>Select this option to open a record in its maximized form automatically.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If this option is selected and you have more than one record open at one time, you only see the top record. The other records open behind the top record. You can use the Window&gt;Cascade command to minimize and view all open records. This is important to remember if you select the Close All command from the File menu.</td>
</tr>
</tbody>
</table>

Table 10-2. Validation tab options

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete records from import file once saved to database</td>
<td>Select this check box to automatically delete the record(s) you import from an import file, once you save that record to the database.</td>
</tr>
<tr>
<td>Add a subfield 'a' to a new field</td>
<td>Select this option to add a subfield ‘a’ automatically to the field when a new field is added to a record using the Insert field before (F3) and Insert field after (F4) commands.</td>
</tr>
<tr>
<td>Display MARC Views maximized</td>
<td>Select this option to open a record in its maximized form automatically.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If this option is selected and you have more than one record open at one time, you only see the top record. The other records open behind the top record. You can use the Window&gt;Cascade command to minimize and view all open records. This is important to remember if you select the Close All command from the File menu.</td>
</tr>
</tbody>
</table>
Chapter 10: Session Defaults and Menu Options

Figure 10-2. Session Defaults: Validation tab

Table 10-2. Validation tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cataloging formats</td>
<td>Select one of the Cataloging formats.</td>
</tr>
<tr>
<td></td>
<td>• Marc21</td>
</tr>
<tr>
<td></td>
<td>• Oclc</td>
</tr>
<tr>
<td></td>
<td>• Rlin</td>
</tr>
<tr>
<td></td>
<td>See Tag Tables and MARC Validation on page A-4 for more information.</td>
</tr>
<tr>
<td>Bypass MARC Validation</td>
<td>Select this option to stop the validation of records against the MARC tag tables when you save to the database. More information regarding tag tables is available in MARC Tag Tables on page A-1.</td>
</tr>
<tr>
<td></td>
<td>See Figure 10-3 for an example of the message window that displays when this option is not selected and invalid characters are found when attempting to store a record in the database.</td>
</tr>
</tbody>
</table>
### Table 10-2. Validation tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bypass MARC21 Character set validation</td>
<td>Select this option to prevent the validation of records against the MARC21 character set when you save to the database. When this option is not selected, the MARC21 Repertoire.cfg file stored in the Catalog folder of the Voyager software on each PC is used for character set validation.</td>
</tr>
<tr>
<td>List all the errors</td>
<td>Select this option to display a list of all the errors resulting from the MARC validation. This option is used in combination with Bypass MARC Validation.</td>
</tr>
<tr>
<td>Show errors one at a time</td>
<td>Select this option to display each error individually that results from the MARC validation. This option is used in combination with Bypass MARC Validation.</td>
</tr>
<tr>
<td>Bypass Authority Control Validation</td>
<td>Selected this option to stop the validation of records against the authority records when you save to the database. When this option is not selected, only the heading types selected in the Heading Types group box undergo authority validation.</td>
</tr>
<tr>
<td>Bypass Decomposition of accented characters for MARC21</td>
<td>Select this option to prevent the decomposition of characters for MARC21. Leave this option unchecked for MARC21 compliance. Some non-Voyager data entry methods may utilize composed characters, characters that store two component parts (diacritic and alphabetic character) as a single character with its own unique internal value such as when using a non-U.S. keyboard. For MARC21 compliance, characters with diacritics must be stored as two separate component pieces. (See Diacritics and MARC21 Compliance Considerations on page C-3 for more information.) This feature addresses this issue.</td>
</tr>
<tr>
<td>Display all the headings</td>
<td>Select this option to have any of the heading types display in the Authority Validation dialog box along with the validated headings. Only the headings in error display when this option is not selected.</td>
</tr>
</tbody>
</table>
Table 10-2. Validation tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bypass ISBN validation</td>
<td>Select this option to prevent the validation of the following fields when a bibliographic record is saved to the database:</td>
</tr>
<tr>
<td></td>
<td>• 020‡a</td>
</tr>
<tr>
<td></td>
<td>• 024‡a with first indicator of 3</td>
</tr>
<tr>
<td></td>
<td>If this option is not selected, validation occurs to insure compliance with the ISBN format.</td>
</tr>
<tr>
<td>Bypass ISSN validation</td>
<td>Select this option to prevent the validation of the 022‡a when a bibliographic record is saved to the database.</td>
</tr>
<tr>
<td></td>
<td>If this option is not selected, validation occurs to insure compliance with the ISSN format.</td>
</tr>
</tbody>
</table>
Table 10-2. Validation tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>856 link servers</td>
<td>Use these options to specify the location of the server(s) that resolves the URN, DOI, and/or Image Server links.</td>
</tr>
<tr>
<td><strong>URN/DOI:</strong></td>
<td>URN (Uniform Resource Name) and DOI (Digital Object Identifier) work different from the URL (Uniform Resource Locator) addresses.</td>
</tr>
<tr>
<td></td>
<td>The URN or DOI links in the link-capable fields of the MARC record do not point directly to the item. Instead, the URN or DOI link specification is first routed through a handler server which then maps the URN or DOI to the physical location of the digital item.</td>
</tr>
<tr>
<td></td>
<td>You must specify the URL addresses of your URN and DOI handler servers in the URN and DOI fields on the Validation tab of the Session Defaults and Preferences window.</td>
</tr>
<tr>
<td></td>
<td>When you verify the integrity of a URN or DOI link by selecting Verify Hypertext links from the Record menu (see Links - Verify Hypertext Links for Bibliographic Records on page 2-23), the URN or DOI link in a link-capable field is appended to the address of the URN or DOI handler server.</td>
</tr>
<tr>
<td></td>
<td>For information about entering URN or DOI links in the link-capable fields of a MARC record, see Links - DOI and URN Link Examples on page 2-23. Also, for information about what needs to be set up for URN or DOI links to be successful in WebVoyáge, see the Voyager WebVoyáge User’s Guide.</td>
</tr>
<tr>
<td><strong>Image Server:</strong></td>
<td>The Image Server field designates which viewer to use to bring up an Image Server link.</td>
</tr>
<tr>
<td></td>
<td>You may specify the location of the Voyager Image Server executable (the full path must be given such as c:\sym-trix\iadms.exe), or the location of a browser interface program (such as <a href="http://XXX/cgi-bin/scandoc.cgi">http://XXX/cgi-bin/scandoc.cgi</a>, where XXX is the machine on which the program is located). Scandoc.cgi is the interface which, when used with ImageServer, uses a browser instead of Scandoc to view the images.</td>
</tr>
<tr>
<td></td>
<td>The default value for this field is blank.</td>
</tr>
<tr>
<td>Heading Types - Name</td>
<td>Select this option to have Name heading types validated.</td>
</tr>
<tr>
<td>Heading Types - Title</td>
<td>Select this option to have Title heading types validated.</td>
</tr>
</tbody>
</table>
Chapter 10: Session Defaults and Menu Options

Table 10-2. Validation tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading Types - Name/Title</td>
<td>Select this option to have <strong>Name/Title</strong> heading types validated.</td>
</tr>
<tr>
<td>Heading Types - Subject</td>
<td>Select this option to have <strong>Subject</strong> heading types validated.</td>
</tr>
<tr>
<td>Heading Types - Subdivision</td>
<td>Select this option to have <strong>Subdivision</strong> heading types validated.</td>
</tr>
<tr>
<td></td>
<td><strong>Subdivision</strong> can only be selected if <strong>Subject</strong> is selected.</td>
</tr>
</tbody>
</table>

Figure 10-3. Invalid MARC21 Characters message when storing record

Work Flow Tab

Customize the options on the **Work Flow** tab (see Figure 10-4) to match your preferences using Table 10-3 for a description of each option.
Table 10-3. Work Flow tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
</table>
| Retain last search                   | Select this check box to save the last search performed in the Search dialog box. The last search is saved until the current Cataloging session is exited.  

The system retains this preference selection from Cataloging session to session based upon your operator ID.  

**NOTE:** Retain last search overrides the Default Tab and Save Settings functionality located on the Search dialog box. Therefore, you must clear the Retain Last Search checkbox in order to utilize the Default Tab and Save Settings functions. See Table 3-3 on page 3-28, Table 3-4 on page 3-32, and Table 3-5 on page 3-39 for more information. |
| Automatic truncation for non keyword searches | Select this check box to automatically truncate non-keyword searches (such as Headings searches) without requiring the question mark (?) as a truncation character. |
Chapter 10: Session Defaults and Menu Options

Table 10-3. Work Flow tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display bibliographic record directly if search results in only one title</td>
<td>Select this check box to automatically display a bibliographic record if only one record is available as a result of the search.</td>
</tr>
<tr>
<td>Always create a holding when adding holdings to a bib (that is, do not show existing holdings first)</td>
<td>Select this option to be placed in Add mode automatically when a bibliographic record already has holdings and a new one is to be added either by clicking the New Hldgs button on the menu bar or selecting Record&gt;Create Holdings.</td>
</tr>
<tr>
<td>Display item record directly if item retrieve results in only one item</td>
<td>Select this check box to automatically display an item record directly when only one record is available as a result of your search.</td>
</tr>
<tr>
<td>Sequence new items at top</td>
<td>Use this option when creating a new item record to tell the server to add the new item at the top of the sequence instead of the bottom of the sequence.</td>
</tr>
<tr>
<td>Sequence new e-items at top</td>
<td>Use this option when creating a new e-item record to tell the server to add the new e-item at the top of the sequence instead of the bottom of the sequence.</td>
</tr>
<tr>
<td>Check for Duplicate Item Barcodes</td>
<td>Use this option to specify that when the user adds an item record or a barcode to an existing item the software checks if the barcode is already used in other items. If so, the user receives a warning and has the option to cancel the add item or the add barcode operation, or to save it anyway. If this is unchecked, the software does not check for the presence of duplicate barcodes.</td>
</tr>
<tr>
<td>Suppress confirmation message upon successful save</td>
<td>Select this check box to suppress the confirmation message that displays after a record has been successfully saved to the database.</td>
</tr>
</tbody>
</table>

Item Defaults Tab

Customize the options on the Item Defaults tab (see Figure 10-5) to match your preferences using Table 10-4 for a description of each option. These default settings affect what is displayed when creating item records. The initial item type default is determined by the default settings (see Cataloging - Policy Definitions in the Voyager System Administration User’s Guide) for the Cataloging location selected when you log in.
### Table 10-4. Item Defaults tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Type</td>
<td>Select the default <strong>Item Type</strong> to display when creating item records. This defaults to the selection made in Cataloging - Policy Definitions in Voyager System Administration for the location you selected when logging in to the Cataloging module. This is a required field.</td>
</tr>
<tr>
<td>Temp. Loc.</td>
<td>Select the default <strong>Temp. Loc.</strong> to display when creating item records.</td>
</tr>
<tr>
<td>Temp. Type</td>
<td>Select the default <strong>Temp. Type</strong> to display when creating item records.</td>
</tr>
<tr>
<td>Status</td>
<td>Select the default <strong>Status</strong> to display when creating item records.</td>
</tr>
<tr>
<td>Stat. category</td>
<td>Select the default <strong>Stat. Category</strong> to display when creating item records.</td>
</tr>
<tr>
<td>Enum</td>
<td>Enter the default <strong>Enum</strong> to display when creating item records.</td>
</tr>
<tr>
<td>Chron</td>
<td>Enter the default <strong>Chron</strong> to display when creating item records.</td>
</tr>
<tr>
<td>Year</td>
<td>Enter the default <strong>Year</strong> to display when creating item records.</td>
</tr>
</tbody>
</table>
Chapter 10: Session Defaults and Menu Options

Chapter 10: Session Defaults and Menu Options

Folders/Files Tab

Customize the options on the Folders/Files tab (see Figure 10-6) to match your preferences using Table 10-5 for a description of each option.

Table 10-4. Item Defaults tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caption</td>
<td>Enter the default <strong>Caption</strong> to display when creating item records.</td>
</tr>
<tr>
<td>Free text</td>
<td>Enter the default <strong>Free text</strong> to display when creating item records.</td>
</tr>
<tr>
<td>Spine</td>
<td>Enter the default <strong>Spine</strong> information to display when creating item records.</td>
</tr>
<tr>
<td>Copy</td>
<td>Enter the default <strong>Copy</strong> number to display when creating item records.</td>
</tr>
<tr>
<td>Pieces</td>
<td>Enter the default <strong>Pieces</strong> number to display when creating item records.</td>
</tr>
</tbody>
</table>

Figure 10-6. Session Defaults: Folders/Files tab
Table 10-5. Folders/Files tab options for Session Defaults and Preferences

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Templates</td>
<td>Enter the template file name for each of the record types, bibliographic, holdings, and authority. This establishes a default template format that automatically displays when creating a new record. Optionally, click the ellipses button to select a template. The file name must refer to an existing file.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> A default template must be specified in the Auth field for an authority template to automatically display when creating a new authority record from the Authority Validation dialog box (Figure 9-1). See Table 9-2 on page 9-4 for more information.</td>
</tr>
<tr>
<td>Folders</td>
<td>In the Folders group box, you can enter or select a default folder so that when you open a work record and/or template and import a record, the Open dialog box defaults to the specified folder.</td>
</tr>
<tr>
<td>Work Files</td>
<td>In the Work Files group box, you can enter the names of the files to which you want your records automatically saved when you use the Save or Save As feature. If you enter a filename in a field, you will not be prompted for a filename when saving records of that type. You can specify a different file for bibliographic, holdings and item records. If you enter a filename, a record will be automatically saved to this file instead of prompting you for a filename. If the file does not exist it will be created the first time Cataloging attempts to save to the file.</td>
</tr>
<tr>
<td>Save to Local File</td>
<td>In the Save to Local File group box, you can specify the file to which you want bibliographic records to be saved when you use the Save to Database and to Local File option (with or without Close). Enter the filename in the File field or click the ellipses to search for the file to which you want to save. Click the Character Set drop-down arrow to select the character set format in which you want the records to be saved.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If no filename is entered into the File field, the Save to Database and to Local File option is disabled. If the file is specified but does not currently exist, it is created at the next Save to Database and Local File.</td>
</tr>
</tbody>
</table>
Mapping Tab

Customize the options on the **Mapping** tab (see Figure 10-7) to match your preferences using [Table 10-6](#) for a description of each option.

Voyager Cataloging allows you to import records from other formats. Use the Mapping tab to identify the format of the records being imported (locally or remotely).

Saving records to the database affects validation and separate tag tables are available to save to based on the record format type you choose. See MARC Tag Tables on page A-1 for more information.

![Figure 10-7. Session Defaults: Mapping tab](#)
You can change the background color and the text color for your records. You can define the colors displayed for the following records.

- MARC Views (variable fields)
- Record Hierarchy

**Table 10-6. Mapping tab options for Session Defaults and Preferences**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
</table>
| Expected Character Set of Imported Records Local Import | Use the Local Import drop-down menu to select the character set of the records being imported locally. Your choices include the following.  
  • Latin-1 (non-Unicode)  
  • MARC21 MARC-8 (non-Unicode)  
  • MARC21 UTF-8  
  • OCLC (non-Unicode)  
  • RLIN legacy (non-Unicode)  
  • Voyager legacy (non-Unicode)  
  This provides the information needed by the system to map the incoming records to Unicode UTF-8 encoding. |
| MARC Mapping for OCR Data Tag Indicator 1 Indicator 2 Subfield | This feature is used specifically in conjunction with Image Server. This feature applies to the sending of Full-Text OCR data (text read from a non-searchable image stored in Image Server) from the Image Server program to an active bibliographic record in Cataloging. Once the OCR data is inserted into an active bibliographic record, the data is then searchable through Voyager.  
  Specify the Tag, Indicator 1, Indicator 2 and Subfield where OCR data should be inserted into an active bibliographic record. If you do not specify this information, the following defaults will be used: Tag: 500, Indicator 1: none, Indicator 2: none, Subfield: a.  
  **NOTE:**  
  A maximum of 1600 characters will fit into a single field of a MARC record. Each time a field reaches this limit, another identical field will be created into which the rest of the data will be inserted. In addition, it should be noted that the maximum record size for a MARC record in Voyager is 64K. |
### Global Headings Change Hierarchy

The procedure for changing colors and fonts is shown in Procedure 10-1, Changing Colors and Fonts, on page 10-17.

**Procedure 10-1. Changing Colors and Fonts**

Use the following to change colors and fonts.

1. Click the button for the type of record to which you want to change the color.

Your choices are the following (see Table 10-7).

**Table 10-7. Record types available for color change**

<table>
<thead>
<tr>
<th>Color/Fonts Tab Dialog Box Group</th>
<th>Record Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>MARC views (variable fields)</td>
<td>• Bibliographic</td>
</tr>
<tr>
<td></td>
<td>• Holdings</td>
</tr>
<tr>
<td></td>
<td>• Authority</td>
</tr>
<tr>
<td></td>
<td>• Conversion</td>
</tr>
</tbody>
</table>
Table 10-7. Record types available for color change

<table>
<thead>
<tr>
<th>Color/Fonts Tab Dialog Box Group</th>
<th>Record Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Hierarchy</td>
<td>• Bibliographic</td>
</tr>
<tr>
<td></td>
<td>• Holdings</td>
</tr>
<tr>
<td></td>
<td>• Item</td>
</tr>
<tr>
<td></td>
<td>• Bound With</td>
</tr>
<tr>
<td>Global Heading Change Hierarchy</td>
<td>• Level 1: Old Heading</td>
</tr>
<tr>
<td></td>
<td>• Level 2: New Heading</td>
</tr>
<tr>
<td></td>
<td>• Level 3: Auth Heading</td>
</tr>
<tr>
<td>Search Result Colors</td>
<td>Suppressed Records.</td>
</tr>
<tr>
<td></td>
<td>Use this option to display bibliographic and</td>
</tr>
<tr>
<td></td>
<td>holdings records in a different color in the</td>
</tr>
<tr>
<td></td>
<td>staff search results lists if these records have</td>
</tr>
<tr>
<td></td>
<td>been suppressed in the database from the OPAC.</td>
</tr>
</tbody>
</table>

Result: A menu of options displays.

**TIP:**

*Change the Conversion colors to highlight records that display in Cataloging but were not converted.* (These are the same records that are identified by nc in the Title Bar. See Non-Converted Records (nc) on page C-4 for more information.)

2. Select **Text Color,** Back color, or Reset Color depending on the color you want to change.

Result: The **Color** dialog box opens.

3. Select a color and click **OK.**

Result: The color is displayed in the **Sample** box.

**NOTE:**

To reset the colors for one type of record to the default, click the record type button and select **Reset Color** from the submenu.

4. Click the drop-down arrow for **Row Marker Symbol** to select the type of indicator used to identify the current row in MARC records.
Result: This sets the row marker symbol to your preference.

5. Click the drop-down arrow for font **Name** to select the font to be used.

Result: This changes the font to the one you prefer.

![TIP:](image)

*The Lucida Sans Unicode (or if you have Microsoft Office fonts installed, Arial Unicode MS) font provides a broad spectrum of characters for the Unicode environment.*

6. Click the drop-down arrow for **Font Size** to select the font size.

Result: This changes the font size to the one you prefer.

7. Check the **Font Bold** check box to specify that the text displayed in the Variable Fields is bold.

Result: This changes the font weight preference to bold.

---

**Cataloging Menus**

The Voyager Cataloging module provides you with the ability to create, update, and save MARC 21 records.

**NOTE:**
Some of the menus only display after you create or open a record or highlight text in an open record.

**Main Workspace Menu Options**

The following menu options are available after logging in to the main cataloging workspace.
File Menu - Main Workspace

The contents of the **File** menu are shown in Table 10-8.

**Table 10-8. File Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Record</td>
<td>Displays the option to open a work record.</td>
</tr>
<tr>
<td>Template</td>
<td>Displays options for creating and editing templates.</td>
</tr>
<tr>
<td>Login Info</td>
<td>Displays your user name, operator ID, and location.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Displays the Print dialog box.</td>
</tr>
<tr>
<td>Print Label</td>
<td>Displays the Print Labels dialog box for printing a spine label and/or a piece label.</td>
</tr>
<tr>
<td>Global Headings Change (Ctrl+G)</td>
<td>Displays the Global Headings Change Queue.</td>
</tr>
<tr>
<td>Pick and Scan (Ctrl+I)</td>
<td>Displays the Pick and Scan dialog box to process mass changes (change, delete, clear, or suppress records) to item records and associated holdings and bibliographic records by authorized staff.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Cataloging module.</td>
</tr>
</tbody>
</table>

Record Menu - Main Workspace

The contents of the **Record** menu are shown in Table 10-9.

**Table 10-9. Record Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Provides the options to create new authority or bibliographic records.</td>
</tr>
<tr>
<td>Search</td>
<td>Displays the Search dialog box for retrieving records from the database.</td>
</tr>
<tr>
<td>Retrieve by record id</td>
<td>Provides the option to retrieve the record by its record ID number.</td>
</tr>
<tr>
<td>Retrieve by barcode</td>
<td>Provides the option to retrieve a record by its barcode number.</td>
</tr>
<tr>
<td>Import</td>
<td>Provides the option to import records into the Voyager database from a new file.</td>
</tr>
</tbody>
</table>
Display Menu - Main Workspace

There are no active Display menu options until a record search has been completed.

Options Menu - Main Workspace

The contents of the Options menu are shown in Table 10-10.

Table 10-10. Options Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
<td>Displays the Session Defaults and Preferences dialog box that provides options on the following tabs.</td>
</tr>
<tr>
<td></td>
<td>• General</td>
</tr>
<tr>
<td></td>
<td>• Validation</td>
</tr>
<tr>
<td></td>
<td>• Work Flow</td>
</tr>
<tr>
<td></td>
<td>• Item Defaults</td>
</tr>
<tr>
<td></td>
<td>• Folders/Files</td>
</tr>
<tr>
<td></td>
<td>• Mapping</td>
</tr>
<tr>
<td></td>
<td>• Colors/Fonts</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Use this option to toggle the display of the toolbar on and off.</td>
</tr>
<tr>
<td>Toolbar Text</td>
<td>Use this option to toggle on and off descriptive text that displays under the toolbar icons.</td>
</tr>
<tr>
<td>Toolbar Tips</td>
<td>Use this option to toggle on and off the tips that display when you hover over a particular icon on the toolbar with your cursor.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Use this option to toggle on and off the display of the status bar.</td>
</tr>
</tbody>
</table>

Help Menu

The contents of the Help menu are shown in Table 10-11.

Table 10-11. Help Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Displays a list of Cataloging help topics.</td>
</tr>
</tbody>
</table>
Menu Options After Working with Active Records

The menus dynamically display additional options after you begin to work with bibliographic, holdings, item, and authority records.

File Menu - Working with Active Records

The contents of the **File** menu are shown in Table 10-12.

### Table 10-12. File Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work Record</td>
<td>Displays options for opening and deleting work records.</td>
</tr>
<tr>
<td>Template</td>
<td>Displays options for creating, editing, and deleting templates.</td>
</tr>
<tr>
<td>Login Info</td>
<td>Displays your user name, operator ID, and location.</td>
</tr>
<tr>
<td>Save (Ctrl+S)</td>
<td>Saves the active work record to the location from which it was opened.</td>
</tr>
<tr>
<td>Save As (Ctrl+A)</td>
<td>Saves the active record in a new location such as a work file.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the active record.</td>
</tr>
<tr>
<td>Close All</td>
<td>Closes all of the active records such as bibliographic, holdings, item, and/or authority.</td>
</tr>
<tr>
<td>Print Setup</td>
<td>Displays the Print dialog box.</td>
</tr>
<tr>
<td>Print Record (Ctrl+P)</td>
<td>Prints the active record.</td>
</tr>
<tr>
<td>Print Label</td>
<td>Displays the Print Labels dialog box for printing a spine label and/or a piece label.</td>
</tr>
<tr>
<td>Global Headings Change (Ctrl+G)</td>
<td>Displays the Global Headings Change Queue.</td>
</tr>
</tbody>
</table>

### Table 10-11. Help Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ex Libris on the Web</td>
<td>Provides the option to connect to the Ex Libris internet home page or to Voyager Support Web.</td>
</tr>
<tr>
<td>About Cataloging</td>
<td>Displays the copyright notice and version number of your copy of Voyager Cataloging.</td>
</tr>
</tbody>
</table>
Chapter 10: Session Defaults and Menu Options

Table 10-12. File Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick and Scan (Ctrl+I)</td>
<td>Displays the Pick and Scan dialog box to process mass changes (change, delete, clear, or suppress records) to item records and associated holdings and bibliographic records by authorized staff.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the Cataloging module.</td>
</tr>
</tbody>
</table>

Edit Menu - Working with Active Records

The contents of the Edit menu are shown in Table 10-13.

Table 10-13. Edit Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut (Ctrl+X)</td>
<td>Cuts the highlighted text and places it on the clipboard.</td>
</tr>
<tr>
<td>Copy (Ctrl+C)</td>
<td>Copies the highlighted text and places it on the clipboard.</td>
</tr>
<tr>
<td>Paste (Ctrl+V)</td>
<td>Inserts the text stored on the clipboard and pastes the rows above the target row.</td>
</tr>
<tr>
<td></td>
<td>All of the MARC view records contain a dummy row that displays at the end of the variable fields. The purpose of the dummy row is to allow you to paste into the last editable row since the action of paste will insert the information before the marked row.</td>
</tr>
<tr>
<td></td>
<td>You cannot do anything to the dummy row except copy above it. You can paste the information, entire rows, that you have copied from an open or closed row.</td>
</tr>
<tr>
<td></td>
<td>Selecting multiple rows are achieved by holding down the Ctrl key and clicking the rows.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If you cut and paste information from a different application such as Microsoft Word, some characters are stripped out.</td>
</tr>
<tr>
<td>Insert Field Before (F3)</td>
<td>Adds a blank MARC field before the active field.</td>
</tr>
<tr>
<td>Insert Field After (F4)</td>
<td>Adds a blank MARC field after the active field.</td>
</tr>
</tbody>
</table>
Record Menu - Working with Active Records

The contents of the **Record** menu are shown in **Table 10-14**.

**Table 10-14. Record Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Provides the options to creates new authority or bibliographic records.</td>
</tr>
<tr>
<td>Search</td>
<td>Displays the Search dialog box for retrieving records from the database.</td>
</tr>
<tr>
<td>Make a Copy</td>
<td>Copies the active record. It must have been retrieved from the database.</td>
</tr>
<tr>
<td>Change Owning Library</td>
<td>Changes the owning library of the current bibliographic record.</td>
</tr>
<tr>
<td>Retrieve by record id</td>
<td>Provides the option to retrieve the record by its record ID number.</td>
</tr>
<tr>
<td>Retrieve by barcode</td>
<td>Provides the option to retrieve a record by its barcode number.</td>
</tr>
</tbody>
</table>

**Table 10-13. Edit Menu**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Field (Del)</td>
<td>Deletes the active MARC field. This field or sub-field cannot then be pasted elsewhere.</td>
</tr>
<tr>
<td>Unselect Text (F11)</td>
<td>Unselects the currently selected text.</td>
</tr>
<tr>
<td>Insert Subfield (F9)</td>
<td>Adds a blank MARC subfield with delimiter.</td>
</tr>
<tr>
<td>Edit Cell (F8)</td>
<td>Positions cursor for editing.</td>
</tr>
<tr>
<td>Special Character Entry (Ctrl+E)</td>
<td>Displays the Special Character Entry dialog box and allows you to select a special character to enter in your record.</td>
</tr>
<tr>
<td>Special Character Mode (Ctrl+D)</td>
<td>Allows you to change your keyboard to a special character mode.</td>
</tr>
<tr>
<td>Show Marc Values (F2)</td>
<td>Displays a selection table with all valid MARC values for the active field or subfield.</td>
</tr>
<tr>
<td>Show Holdings Locations (Ctrl-L)</td>
<td>Displays all available holdings locations and abbreviations for your security access level.</td>
</tr>
<tr>
<td>Insert URL from Browser (Ctrl+U)</td>
<td>Creates a new 856 field containing the URL of the page currently displayed in your Web browser.</td>
</tr>
</tbody>
</table>
### Table 10-14. Record Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlink holding from bibliographic</td>
<td>Unlinks a holdings record from multiple bibliographic records.</td>
</tr>
<tr>
<td>Relink holding to bibliographic</td>
<td>Relinks the current item record to a different holdings record</td>
</tr>
<tr>
<td>Show Associated Records</td>
<td>Displays holdings, bibliographic and item records associated with the active record.</td>
</tr>
<tr>
<td>Retrieve Bibliographic Record</td>
<td>Retrieves the bibliographic record associated with the holdings or item record displayed.</td>
</tr>
<tr>
<td>Retrieve Holdings</td>
<td>Retrieves the holdings records for the active record.</td>
</tr>
<tr>
<td>Create Holdings</td>
<td>Creates a new holdings record for the active record.</td>
</tr>
<tr>
<td>Retrieve Items</td>
<td>Retrieves the item records for the active holdings record.</td>
</tr>
<tr>
<td>Create Items</td>
<td>Creates a new item record for the active holdings record.</td>
</tr>
<tr>
<td>Retrieve Authorities</td>
<td>Retrieves the authority records for the active record.</td>
</tr>
<tr>
<td>View Line Items in Acquisitions (Ctrl+M)</td>
<td>Allows you to automatically pull up and edit a purchase order line item in the Acquisitions module from an open bibliographic or holdings record in the Cataloging module. Both the Cataloging and Acquisitions modules must be open and logged into with the same user ID and password.</td>
</tr>
<tr>
<td></td>
<td>Causes a bibliographic record call number to be automatically inserted into the 852h and 852i fields of a holdings record. You do not need to have the bibliographic record to which the holdings record is associated open; only the holdings record.</td>
</tr>
<tr>
<td>Get call number from bib record (Ctrl+N)</td>
<td>Verifies hypertext links in the active record.</td>
</tr>
<tr>
<td></td>
<td>See Links - Verify Hypertext Links for Bibliographic Records on page 2-23, Verify Hypertext Links - Authority Records on page 2-35, and Verify Hypertext Links - Holdings Records on page 2-54 for more information.</td>
</tr>
</tbody>
</table>
The Related Records menu only displays when a linked source record (bibliographic) is the active record.

This menu displays one or more bibliographic linking profiles.

The system retrieves any records related to the source record based on the profile selected from the menu list.
Chapter 10: Session Defaults and Menu Options

For more information, see Displaying Related Records on page 5-1.

Item Menu - Working with Active Records (Item Records Only)

The contents of the Item menu are shown in Table 10-15. This menu is only available when an item record is the active record.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Status (Ctrl + S)</td>
<td>Displays status information that can be assigned to and/or removed from an item such as damaged, missing, in transit, or withdrawn.</td>
</tr>
<tr>
<td>View Statistics (Ctrl + T)</td>
<td>Displays statistical category assignments for an item that can be added and/or removed.</td>
</tr>
<tr>
<td>View Notes (Ctrl + N)</td>
<td>Displays any note associated with the item record.</td>
</tr>
<tr>
<td>View Barcodes (Ctrl + A)</td>
<td>Displays the Barcodes dialog box for adding or deleting barcodes from an item record.</td>
</tr>
</tbody>
</table>

Display Menu - Working with Active Records

The contents of the Display menu are shown in Table 10-16.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headings List</td>
<td>Displays the list of headings found in the most recent search.</td>
</tr>
<tr>
<td>Title Index</td>
<td>Displays the list of titles found in the most recent search.</td>
</tr>
</tbody>
</table>
Options Menu - Working with Active Records

The contents of the Options menu are shown in Table 10-17.

Table 10-17. Options Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
<td>Displays the Session Defaults and Preferences dialog box that provides options on the following tabs.</td>
</tr>
<tr>
<td></td>
<td>• General</td>
</tr>
<tr>
<td></td>
<td>• Validation</td>
</tr>
<tr>
<td></td>
<td>• Work Flow</td>
</tr>
<tr>
<td></td>
<td>• Item Defaults</td>
</tr>
<tr>
<td></td>
<td>• Folders/Files</td>
</tr>
<tr>
<td></td>
<td>• Mapping</td>
</tr>
<tr>
<td></td>
<td>• Colors/Fonts</td>
</tr>
<tr>
<td>Hide Fixed Fields</td>
<td>Hides the fixed fields of your records, so you can see more of the variable fields.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Use this option to toggle the display of the toolbar on and off.</td>
</tr>
<tr>
<td>Toolbar Text</td>
<td>Use this option to toggle on and off descriptive text that displays under the toolbar icons.</td>
</tr>
<tr>
<td>Toolbar Tips</td>
<td>Use this option to toggle on and off the tips that display when you hover over a particular icon on the toolbar with your cursor.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Use this option to toggle on and off the display of the status bar.</td>
</tr>
</tbody>
</table>

Window Menu - Working with Active Records

The contents of the Window menu are shown in Table 10-18.

Table 10-18. Window Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tile</td>
<td>Arranges multiple windows so they do not overlap.</td>
</tr>
<tr>
<td>Cascade</td>
<td>Arranges multiple windows so they overlap.</td>
</tr>
<tr>
<td>Arrange Icons</td>
<td>Arranges icons for minimized windows at the bottom of the main window.</td>
</tr>
</tbody>
</table>
Table 10-18. Window Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window 1, 2...</td>
<td>Lists currently open document windows. A check mark displays in front of the active document window. Select one to make that record active. The long number is the record ID.</td>
</tr>
</tbody>
</table>

Help Menu - Working with Active Records

The contents of the Help menu are shown in Table 10-19.

Table 10-19. Help Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help Topics</td>
<td>Displays a list of Cataloging help topics.</td>
</tr>
<tr>
<td>Ex Libris on the Web</td>
<td>Provides the option to connect to the Ex Libris internet home page or to Voyager Support Web.</td>
</tr>
<tr>
<td>About Cataloging</td>
<td>Displays the copyright notice and version number of your copy of Voyager Cataloging.</td>
</tr>
</tbody>
</table>
MARC Tag Tables

Introduction

The MARC tag tables define various types of records, fields, and subfields for bibliographic and authority records. The tag tables are located in the \Voyager\Catalog\Tagtable directory on the client PC. See Figure A-1. Tag tables are configuration files identified by the .cfg file extension.

The tag table configuration files can be modified to match your requirements. They can be edited using a program such as Notepad which is provided with the Windows operating system.

NOTE:
Configuration files can be saved and edited using any word processor. However, they must be saved in ASCII format. ASCII format supports alphabetic, numeric, and special characters represented by a 7-bit binary number for up to 128 possible characters.

When you open the \Voyager\Catalog\Tagtable directory, you will see the following structure.
The OCLC, RLIN, and MARC21 folders in the directory contain specific sets of tag tables used solely in the Cataloging module. These tag tables are used for MARC validation. If you open these directories, you see a long list of files as in Figure A-2.

The Country.cfg and Lang.cfg files are tag tables that are used by the Cataloging module for country and language codes. (For the Circulation module, the country and language codes are stored in a file called circbib.cfg located in the circulation directory and the country and language codes for the Acquisitions module are stored in the acqbib.cfg located in the misc directory.)
Appendix A: MARC Tag Tables

Figure A-2. Various configuration files/tag tables in the MARC21 directory

In the OCLC, RLIN, and MARC21 directories, all the files that begin with the letter A pertain to authority records, all the files that begin with the letter B pertain to bibliographic records, and all the files that begin with the letter H pertain to holdings records. After the letters A, B, or H, each of the filenames includes the word marc followed by a number and an xx. The number and xx indicate the field range to which the file pertains. For example, Amarc3xx.cfg pertains to authority record fields in the 300 range, and Hmarc2xx.cfg pertains to holdings record fields in the 200 range.

Filenames that do not include a number but include the word fix pertain to the fixed fields including Leader fields for the particular record type. For example, Bmarcfix.cfg pertains to bibliographic record fixed fields.

In the OCLC, RLIN, and MARC21 directories there is a file called master.cfg. This file provides a high-level outline of the fields included in authority, bibliographic, and holdings records for each one’s tag table format.
NOTE:
When modifications are made to a specific configuration file, it may also be necessary to make a corresponding change in the `master.cfg` file in that folder.

Tag Tables and MARC Validation

The tag tables are used in the Cataloging module to validate your MARC records as they are saved to the database. The main configuration file, `master.cfg`, can be edited to include or exclude authority, bibliographic, holdings, or local files in the MARC validation process. Certain fields can also be identified as mandatory validation checks for compliance with the OCLC, RLIN, and MARC21 formats.

The Cataloging module validates MARC records against one of three different tag tables formats, OCLC, RLIN, or MARC21. These three formats display as options in **Session Defaults and Preferences** Cataloging formats. See Figure A-3. If you do not want one or more of these formats available as MARC validation choices, you can delete the directory from `\Voyager\Catalog\Tagtable` and the Cataloging module does not display them as options.

![Figure A-3. Cataloging format choices for MARC validation](image)

If you save a record to the database in Cataloging with MARC validation turned on and an inconsistency or error is found against the tag tables, you receive an error report. See Figure A-4. This alerts you to the inconsistency or error discovered so that you can make the necessary changes to the record. If you do not make the changes necessary to validate the record against the tag tables, you are not able to save the record to the database.
NOTE:
MARC validation can be bypassed if you check the Bypass MARC Validation or
Bypass MARC21 Character set validation check box on the Validation tab of
Session Defaults and Preferences.

Figure A-4. Sample report if MARC validation finds an error while saving a record
to the database

Structure of MARC Tag Tables Overview

All the MARC tag tables contain similar structural components. For the most part,
they all begin with comments (see Figure A-5) and subsequently, stanzas (see
Stanzas in the MARC Tag Tables on page A-6) outlining fields and/or their
contents and values.

TIP:
In order to keep track of the updates you make to the tag tables, record
your additions, edits, and/or deletions at the beginning of each
configuration file in the comment area. In the Table A-5 example, notice
that the initials of the tag table editor are included to keep track of who
performed the modifications.
Stanzas in the MARC Tag Tables

MARC tag tables are divided into sections called stanzas. Stanzas are generally located after the comment area at the beginning of a configuration file.

Stanza Names

Each stanza begins with a name or a title enclosed in square brackets such as [410]. The stanza name is unique within each configuration file. Stanzas are the main component of the tag tables. They define contents and values on both a high and a low level for each tag table format. For example in the Bmarcfix.cfg file of the RLIN directory, the [490] stanza provides details about the 490 field of bibliographic records including valid subfields and their values.

Stanzas That Reference Other Stanzas

Stanzas in the tag tables can also reference other stanzas, ones that provide more detail about particular fields, subfields, or templates. For example in the Bmarcfix.cfg file of the MARC21 directory, the [007Code] stanza defines the possible values for the 007 fixed field of bibliographic records. This stanza includes the templates used for each possible value such as subfield a for Maps uses the 007_Map template. Since the [007Code] stanza references the

```plaintext
# comment your work! EJW
# comment starting date 7/22/97 EJW
# sorted authority, bib, & Mfhd sections 7/22/97 EJW
# added bib 261 and 262 8/11/97 /ES
# deleted bib 211, 212, 214, 350, 503, 539, 590-599 /8/11/97 /ES
# added 856 to holdings 1/6/98 EJW
# added authority fields for subdivision records 2/24/98 EJW
# changed RecFormat code im description 3/10/98 HB
# changed RecFormat of im = Audio to im = Music 5/21/98 ES
# update # 3 8/13/98 KLD
# added 'u' as a Holding value in RecFormat 5/4/99 ES
```

Figure A-5. Sample comment area of a tag table
007_Maps template and that template is not defined in the [007Code] stanza, there must be another stanza in the Bmarcfix.cfg file called [007_Map]. This stanza provides the details about that particular template type.

**NOTE:**
Stanzas that are referenced by other stanzas can be located either directly after the stanza that references them or all together at the end of a configuration file.

**Stanza Components**

In Figure A-6, there are three sample stanzas taken from the Hmarc0xx.cfg file of the MARC21 tag table format. These stanzas outline the 014 linkage number field of holdings records.

```
[014]
0=a 0A
1=b 0A
2=z 1A
3=9 0A
Subfa=Linkage number
Subfb=Source of number
Subfz=Cancelled/invalid linkage number
Subf9=Old holdings linkage number

[014Ind1]
0=0
1=1
Value0=Holdings record number
Value1=Bibliographic record number

[014Ind2]
0=_
Value_=Undefined
```

Figure A-6. Sample stanzas from the Hmarc0xx.cfg file for MARC21 format
MARC tag field/ indicator field

This is the name of the stanza. In Figure A-6, this is [014], [014Ind1], and [014Ind2].

MARC subfield

In Figure A-6, there are four subfields defined as a, b, z, and 9.

Software order number

These numbers are only used by the software itself and are insignificant to the actual user. In Figure A-6, there are four software order numbers 0, 1, 2, and 3.

Subfield rule definition

The value 0 or 1 indicates if the field is repeatable. 0 means it is a non-repeatable field and 1 means it is a repeatable field. In Figure A-6, subfields a, b, and 9 are non-repeatable fields and subfield z is a repeatable field.

Subfield rule definition

The subfield rule value either A, M, or O indicates whether the field is applicable, mandatory, or optional. A means the field is applicable, M means it is mandatory, and O means it is optional. In Figure A-6, all the subfields are applicable with a value of A. None are mandatory or optional.

⚠️ IMPORTANT:

These values are used during MARC validation in the Cataloging module. The system gives particular attention to mandatory subfields, those with a value of M. If it is a mandatory subfield and no value is set for it in the Cataloging module, you get a warning message when you try to save the record indicating that you have left out a mandatory field.

Subfield and subfield definition

The subfield/subfield definition stanza component describes the values that you input to the subfield in the Cataloging module. In the Cataloging module when you press F2 with your cursor in the appropriate subfield, the values entered in this component display. In Figure A-6, subfield a is the linkage number, subfield b is the source of number, subfield z is the cancelled/invalid linkage number, and subfield 9 is the old holdings linkage number.
Appendix A: MARC Tag Tables

Indicator value

Valid indicator values are specified in this component of the stanza. In Figure A-6, the valid values for indicator 1 of the 014 field are 0 and 1 as defined in the second last stanza; and the valid value for indicator 2 of the 014 is 0 as defined in the last stanza.

Indicator and indicator definition

The indicator/indicator definition component specifies the indicator values for the indicators of MARC fields. In Figure A-6, the definition for valid value 0 is holdings record number, and the definition for valid value 1 is bibliographic record number. The definition for valid value 0 is undefined for indicator 2 of the 014 field. In the Cataloging module when you press F2 and your cursor is in the appropriate indicator field, the values entered in this component display.

Xmarcfix.cfg Tag Tables

There are three Xmarcfix.cfg tag tables.

- Amarcfix.cfg
- Bmarcfix.cfg
- Hmarcfix.cfg

These files define the valid values for the fixed fields of authority, bibliographic, and holdings records for each tag table format, OCLC, RLIN, and MARC21.
CAUTION:
One or more spaces must be used after a comma to separate the different components of information specified in the .cfg tag tables. Do not use tabs.

Grid Templates

In tag tables, you can define grid templates as per your preferences. These templates determine how the grid for fixed fields displays in the Cataloging module. See Figure A-9.

The templates used for a specific field/subfield have their own stanzas that can be defined immediately following the stanza that references them or all together at the end of the configuration file. See Figure A-8 for a sample template for subfield a.
In the Cataloging module, the template in Figure A-8 displays the grid as illustrated in Figure A-9 for the 006 fixed field of bibliographic records.

The procedure for accessing the 006 field grid is shown in Procedure A-1, Accessing the 006 Field Grid, on page A-11.

Figure A-8. Sample 006_Books stanza in a Bmarcfix.cfg file

<table>
<thead>
<tr>
<th>Illustrations 1,</th>
<th>006/008BooksIllustrations,</th>
<th>1, 1, _</th>
</tr>
</thead>
<tbody>
<tr>
<td>Illustrations 2,</td>
<td>006/008BooksIllustrations,</td>
<td>2, 1, _</td>
</tr>
<tr>
<td>Illustrations 3,</td>
<td>006/008BooksIllustrations,</td>
<td>3, 1, _</td>
</tr>
<tr>
<td>Illustrations 4,</td>
<td>006/008BooksIllustrations,</td>
<td>4, 1, _</td>
</tr>
<tr>
<td>Audience,</td>
<td>006/008BooksAudience,</td>
<td>5, 1, _</td>
</tr>
<tr>
<td>Form Of Item,</td>
<td>006/008BooksItem,</td>
<td>6, 1, _</td>
</tr>
<tr>
<td>Contents 1,</td>
<td>006/008BooksContents,</td>
<td>7, 1, _</td>
</tr>
<tr>
<td>Contents 2,</td>
<td>006/008BooksContents,</td>
<td>8, 1, _</td>
</tr>
<tr>
<td>Contents 3,</td>
<td>006/008BooksContents,</td>
<td>9, 1, _</td>
</tr>
<tr>
<td>Contents 4,</td>
<td>006/008BooksContents,</td>
<td>10, 1, _</td>
</tr>
<tr>
<td>Govt. Publications,</td>
<td>006/008BooksGovtPub,</td>
<td>11, 1, _</td>
</tr>
<tr>
<td>Conf. Publications,</td>
<td>006/008BooksConfPub,</td>
<td>12, 1, 0</td>
</tr>
<tr>
<td>Festschrift,</td>
<td>006/008BooksFestschrift,</td>
<td>13, 1, 0</td>
</tr>
<tr>
<td>Index,</td>
<td>006/008BooksIndex,</td>
<td>14, 1, 1</td>
</tr>
<tr>
<td>Literary Form,</td>
<td>006/008BooksLiteraryForm,</td>
<td>16, 1, 0</td>
</tr>
<tr>
<td>Biography,</td>
<td>006/008BooksBiography,</td>
<td>17, 1, _</td>
</tr>
</tbody>
</table>

Procedure A-1. Accessing the 006 Field Grid

Use the following to access the 006 field grid.

1. Click the 006 button on the MARC tab.
2. Click the New button.
Result: The **Additional Materials Characteristics** dialog box opens. See Figure A-9.

![Figure A-9. Grid for the 006 field of a bibliographic record](image)

### Defining Your Own Keyboard Shortcuts

In the stanzas of the new tag tables, you are able to specify keyboard access keys/shortcuts for each tab of the fixed field grid templates. This allows you to use a keyboard shortcut as opposed to the mouse to access a certain tab.

You define a keyboard shortcut via the ampersand (&) symbol in the stanzas defining the various tabs of a fixed field grid. See **Figure A-7**.

The keyboard equivalents employ the **Alt** key plus a letter or number that you designate within the appropriate stanza. The letter you designate as the keyboard equivalent is underlined in the Cataloging module on the corresponding tab.

**NOTE:**
The & (ampersand) is stripped out of the string when it is displayed in the form title bar.
For instance, instead of accessing the Books tab using the mouse, you may want to use the Alt+b keystroke. To set this up, you place an & (ampersand) in front of the letter you want to use in combination with the Alt key in the appropriate Xmarcfix.cfg file such as a=&Books as in Figure A-7. In the Cataloging module using this example, the Books tab displays with B in Books underlined. See Figure A-10.

![Sample keyboard shortcut for the Books tab](image)

Figure A-10. Sample keyboard shortcut for the Books tab

**NOTE:**
You can only designate one keyboard equivalent at a time. If you define more than one, only the last one will be used.

**Stanzas in the Xmarcfix.cfg Tag Tables**

There are three types of stanzas in each of the Xmarcfix.cfg tag tables.

- Code type or tab stanzas
- Grid template stanzas
- Drop-down menu selection stanzas

**NOTE:**
The order and the structure of these stanzas is hierarchical. The code type stanzas define what tabs display for fixed fields in the Cataloging module. The
grid template stanzas define the grid that displays once you select a tab for a fixed field. The drop-down menu stanzas define the selections you have on a particular grid.

**Code Type/Tab Stanzas [00xCode]**

Code types essentially define what tabs display in the Cataloging module for each fixed field. To access these tabs, you click the Leader, 006, 007, or 008 buttons from the MARC tab of an authority, bibliographic, or holdings record. Remember that holdings records do not have 006 field, and authority records do not have 006 or 007 fields.

For example if you click the 007 button on the MARC tab of a bibliographic record, the tab selections as illustrated in Figure A-11 display based on what is defined in the MARC tag tables in the Bmarcfix.cfg file.

![Figure A-11. Code types/tabs that display in the Cataloging module for a bibliographic record](image)

Once you select a tab from the Cataloging module, and click the **New** button, a grid displays with all the possible values for that particular tab/code type.

**Types of Code Type/Tab Stanzas**

There are four stanzas for code types/tabs for each tag table format.
Each stanza pertains to a particular fixed field. For example, [000Code] pertains to the Leader field.

⚠️ IMPORTANT: Do not change the names of the four code type/tab stanzas [000Code], [006Code], [007Code], and [008Code]. These stanza headings are used by the program to look for the tab data for their respective 00x type. Altering these stanza names or adding additional stanzas with these names will cause unpredictable results.

The [00xCode] stanzas define the following.

- The name of the tabs that display in the Cataloging module for each record type.
- The order of the tabs that display in the Cataloging module for each record type.
- The template used for each tab in the Cataloging module for each record type.

Names of Tabs in the Cataloging Module

The [006Code], [007Code], [008Code], and [000Code] stanzas of the Xmarcfix.cfg tag tables define the names of the tabs that display in the Cataloging module for the fixed fields of each record type. The names of the tabs are listed directly after the stanza name. See Figure A-12. The letter at the beginning of each line is called the code type. This is an industry standard and should not be altered. This value is also used by the program to reference other values in other stanzas.
The specifications in Figure A-12 display as shown in Figure A-13 when the **006** button on the **MARC** tab of a bibliographic record using MARC21 format in the Cataloging module is selected.

```
[006Code]
a=&Books, 006_Books
c=&Printed Music, 006_Music
d=Manuscript Music, 006_Music
e=Printed Map, 006_Maps
f=&Manuscript Map, 006_Maps
g=&Projected Medium, 006_Visual
i=&Nonmusical Sound, 006_Music
j=Musical Sound, 006_Music
k=&2-D Nonprojectable, 006_Visual
m=Computer File, 006_Computer
o=&Kit, 006_Visual
p=Mixed Material, 006_Mixed
r=&3-D Artifact, 006_Visual
s=&Serial Control, 006_Serials
t=Manuscript Language, 006_Books
```

**Figure A-12.** Code type examples from the [006Code] stanza of a Bmarcfix.cfg file for MARC21 format
Order of Tabs in the Cataloging Module

The order that the tabs are displayed in the Cataloging module depends on the order of the lines in the [00xCode] stanzas of the Xmarcfix.cfg files. You can alter the tab layout as per your preferences as long as you cut and paste whole stanza rows.

For example, to display the Printed Music tab before the Books tab in the bibliographic record 006 grid, change the [006Code] stanza in the Bmarcfix.cfg file to the order highlighted in Figure A-14.

```plaintext
[006Code]
c=P&rinted Music, 006_Music
a=&Books, 006_Books
...
```

Figure A-13. The result in the Cataloging module of the [006Code] stanza in the Bmarcfix.cfg file

Figure A-14. Arrangement of tabs
Grid Templates in the Cataloging Module

The grid template declaration indicates the template that the program uses for each tab of the fixed fields. These templates are indicated on the far right column of each [00xCode] stanza in the Xmarcfix.cfg files.

In the example in Figure A-14, the Printed Music tab uses a template called 006_Music. Tabs can use either the same template or they can use different templates. The contents and structure of each template is defined in the [00x_???] template stanzas. See Template Stanzas [00x_???] for more information.

Template Stanzas [00x_???]

[00x_???] stanzas in Xmarcfix.cfg files have five columns in which you define the following for each record type.

- The selections you have on the grid for each code type/tab in the Cataloging module.
- Whether the grid includes drop-down menus or text boxes. If drop-down menus are included, this stanza references the name of the drop-down menu stanza in which valid selections are outlined.
- The character position for values in the records, integer values.
- The length of the selection.
- Default values for drop-down menus and masks for text boxes.

⚠️ IMPORTANT:
Template configuration stanzas must have five comma-delimited entries/columns per line, or the program will not function properly.

See Figure A-15 for an example of a template configuration stanza from a Bmarcfix.cfg file using the MARC21 tag table format.
IMPORTANT:
You can only modify column 1 and column 5 in this particular stanza type, unless a new MARC standard is implemented or an error is discovered.

Figure A-15. Sample template configuration stanza from a Bmarcfix.cfg file

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
<th>Column 1</th>
<th>Column 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>008PublicationStatus,</td>
<td></td>
<td>Publication Status,</td>
<td>008PublicationStatus,</td>
</tr>
<tr>
<td>&lt;&lt;&lt;&lt;TEXT&gt;&gt;&gt;&gt;,</td>
<td>Date 1 (yyyy),</td>
<td>7, 4, aaaa</td>
<td></td>
</tr>
<tr>
<td>&lt;&lt;&lt;&lt;TEXT&gt;&gt;&gt;&gt;,</td>
<td>Date 2 (yyyy),</td>
<td>11, 4, aaaa</td>
<td></td>
</tr>
<tr>
<td>Country,</td>
<td>Place of Publication,</td>
<td>15 3, xx_</td>
<td></td>
</tr>
<tr>
<td>006/008BooksIllustrations,</td>
<td>Illustrations 1,</td>
<td>18, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksIllustrations,</td>
<td>Illustrations 2,</td>
<td>19, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksIllustrations,</td>
<td>Illustrations 3,</td>
<td>20, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksIllustrations,</td>
<td>Illustrations 4,</td>
<td>21, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksAudience,</td>
<td>Audience,</td>
<td>22, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksItem,</td>
<td>Form of Item,</td>
<td>23, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksContents,</td>
<td>Contents 1,</td>
<td>24, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksContents,</td>
<td>Contents 2,</td>
<td>25, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksContents,</td>
<td>Contents 3,</td>
<td>26, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksContents,</td>
<td>Contents 4,</td>
<td>27, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksGovtPub,</td>
<td>Govt. Publication,</td>
<td>28, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksConfPub,</td>
<td>Conf. Publication,</td>
<td>29, 1, _</td>
<td></td>
</tr>
<tr>
<td>006/008BooksFestschrift,</td>
<td>Festschrift,</td>
<td>30, 1, 0</td>
<td></td>
</tr>
<tr>
<td>006/008BooksIndex,</td>
<td>Index,</td>
<td>31, 1, 0</td>
<td></td>
</tr>
<tr>
<td>006/008BooksLiteraryForm,</td>
<td>Literary Form,</td>
<td>33, 1, 0</td>
<td></td>
</tr>
<tr>
<td>006/008BooksBiography,</td>
<td>Biography,</td>
<td>34, 1, _</td>
<td></td>
</tr>
<tr>
<td>Language,</td>
<td>Language,</td>
<td>35, 3, eng</td>
<td></td>
</tr>
<tr>
<td>008ModifiedRecord,</td>
<td>Modified Record,</td>
<td>38, 1, _</td>
<td></td>
</tr>
<tr>
<td>008CatalogingSource,</td>
<td>Cataloging Source,</td>
<td>39, 1, d</td>
<td></td>
</tr>
</tbody>
</table>
Column 1

The first column of the stanza is the description that is displayed for a particular tab in the Cataloging module. See Figure A-17. This column can be changed to match your preferences such as for internationalization purposes.

Column 2

This column is used for two purposes.

- To define the name of the drop-down menu stanza name that will define the valid values for that particular drop-down menu.
- To define that field as a text box (non-drop-down menu box) at which point a stanza defining the textbox is not required.

For the latter, the keyword <<<TEXT>>> is used.

NOTE:

<<<TEXT>>> is a reserved term used to describe to the program that the grid cell has text entered into it from the user and not from a drop-down menu stanza. When using this value, a mask value has to be entered into the last column of the stanza. See Column 5 on page A-20 for a description of mask values. Any attempt to use this value for a drop-down menu stanza name will be ignored by the system, and it will automatically be made into a text box.

Column 3

This column defines the character position of this value in the record (integer value) as defined in the MARC standard.

Column 4

This column defines the length of the selection. This should match the length of the key of the drop-down menu selection (integer value).

Column 5

This column serves two purposes.

- Default value for the drop-down menu.
- Mask for the text box.
Although the default for this column is a value set to be appropriate for all users ( _ for Unknown or not specified), you can change it. If you do change it, make sure the value is valid or an unpredictable error may occur.

**TIP:**

Make a backup copy of every locally edited configuration file in a separate file location.

If the default for the drop-down menu does not exist in the possible list of selections, nothing will be displayed as a default; and you can still make other selections as normal. The text mask is defined to use the following characters. See Table A-1.

Table A-1. Text Masking Options

<table>
<thead>
<tr>
<th>Text Mask</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>any digit</td>
</tr>
<tr>
<td>9</td>
<td>any digit or space</td>
</tr>
<tr>
<td>#</td>
<td>any digit or sign</td>
</tr>
<tr>
<td>L</td>
<td>any letter</td>
</tr>
<tr>
<td>?</td>
<td>any letter or space</td>
</tr>
<tr>
<td>A</td>
<td>any letter or digit</td>
</tr>
<tr>
<td>a</td>
<td>any letter, digit, or space</td>
</tr>
<tr>
<td>&amp;</td>
<td>any character</td>
</tr>
</tbody>
</table>

Thus, in Figure A-16, you can enter any combination of 4 digits or spaces for the Date 1 field. The number of characters in the mask must equal the fourth column entry.

```
[008_Books]
Publication Status, 008PublicationStatus, 7, 1, _
Date 1 (yyyy), <<<TEXT>>>), 8, 4, 9999
```

**Figure A-16. Using Text Mask Characters in [008_Books] Stanza**

The sample template configuration stanza in Figure A-16 results in the template in the Cataloging module as seen in Figure A-17.
Figure A-17. Result in Cataloging module of the sample template configuration stanza

Drop-Down Menu Selections Stanzas [xxx]

In these stanzas, you input all the selections you want available from the drop-down menus for the fixed field grids in the Cataloging module. A sample stanza indicating drop-down menu selections for books is highlighted in Figure A-18.

```
[006/008BooksBiography]
_ = No biographical material
 a = Autobiography
 b = Individual biography
 c = Collective biography
 d = Contains biographical information
 | = No attempt to code
```

Figure A-18. Sample stanza defining drop-down menu options for the 006 and 008 fields
NOTE:
You can input drop-down menus for more than one field. In Table A-18, the values for the drop-down menu pertain to both the 006 and the 008 fields.

The stanza in Figure A-18 generates the drop-down menu shown in Figure A-19 to display in the Cataloging module.

![Image of drop-down menu]

Figure A-19. Result in the Cataloging module of the sample drop-down menu stanza

Shortcut for Entering Numerical Data

When working with numerical data and the program sees a ~ (tilde) to the left of the equal sign, it creates a list of values for these numbers and inserts them into the drop-down list. The values on either side can be positive or negative, and can go in ascending or descending order. However, they must be whole integer values (from -32,768 through 32,767). The left side of the tilde gets displayed first and the right gets displayed last. Input the numerical range of 001 to 999 for running time as 001~999=Running time.

NOTE:
The ~ (tilde) character is used in the key portion of the drop-down menu stanzas to expand a numerical range in the drop-down menu instead of typing out the entire range. Using this value in the key of a drop-down menu stanza especially with non-numerical data can have unpredictable results. Avoid using it in this way.
Voyager Call Number Logic / Processing

Call Number Indexing

In Voyager 2001.1, call number functionality is expanded to provide greater flexibility with different classification schemes, the rules used to determine how call numbers are indexed. Voyager is enhanced to recognize and store 852 information specified with a first indicator of 7 and an associated code in subfield 2 (‡2). This enhancement applies to both online and bulk call number entry and update for specific ‡2 codes.

Voyager uses 852 first indicator values 0 - 3, 7, and 8 as defined in the MARC 21 Format for Holdings Data. See Table B-1 for a detailed list of 852 first indicator values.

Table B-1. 852 first indicator values

<table>
<thead>
<tr>
<th>1st Indicator Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>blank</td>
<td>No information provided. (Blank also indicates <em>not</em> indexed.)</td>
</tr>
<tr>
<td>0</td>
<td>Library of Congress (LC) classification.</td>
</tr>
<tr>
<td>1</td>
<td>Dewey Decimal classification.</td>
</tr>
<tr>
<td>2</td>
<td>National Library of Medicine (NLM) classification.</td>
</tr>
<tr>
<td>3</td>
<td>Superintendent of Documents (SuDOC) classification.</td>
</tr>
<tr>
<td>7</td>
<td>Source specified in subfield 2</td>
</tr>
<tr>
<td>8</td>
<td>Other scheme</td>
</tr>
</tbody>
</table>
Additionally, non-standard values "c" and "u" are used by Voyager. See Table B-2.

**Table B-2. 852 first indicator non-standard values**

<table>
<thead>
<tr>
<th>1st Indicator Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>Canadian Commissioner of Documents (CACODOCS) classification</td>
</tr>
<tr>
<td>u</td>
<td>Universal Decimal Classification (UDC)</td>
</tr>
</tbody>
</table>

Several subfield 2 codes used in combination with first indicator 7 are implemented in Voyager 2001.1. These codes identify the rules for sorting and normalizing call numbers for different classification schemes. See Table B-3 for a list of these codes.

**Table B-3. Subfield 2 Codes**

<table>
<thead>
<tr>
<th>‡2 Codes</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cacodoc</td>
<td>Canadian documents.</td>
</tr>
<tr>
<td>oldyale</td>
<td>Old Yale classification.</td>
</tr>
<tr>
<td>udc</td>
<td>Universal Decimal Classification.</td>
</tr>
<tr>
<td>cammain</td>
<td>Cambridge main library classification.</td>
</tr>
<tr>
<td>cammed</td>
<td>Cambridge medical library classification.</td>
</tr>
<tr>
<td>camgen</td>
<td>Cambridge generic library classification</td>
</tr>
<tr>
<td>dnal</td>
<td>National Agricultural Library (NAL) classification</td>
</tr>
</tbody>
</table>

**NOTE:**
The CACODOCS classification and the UDC classification can be specified in two ways. See Table B-4.

**Table B-4. CACODOCS and UDC classifications**

<table>
<thead>
<tr>
<th>1st Indicator Value</th>
<th>Subfield Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>‡2 cacodoc</td>
<td>Canadian Commissioner of Documents (CACODOCS) classification</td>
</tr>
<tr>
<td>c</td>
<td></td>
<td>Canadian Commissioner of Documents (CACODOCS) classification</td>
</tr>
<tr>
<td>7</td>
<td>‡2 udc</td>
<td>Universal Decimal Classification (UDC)</td>
</tr>
</tbody>
</table>
With these changes to Voyager 2001.1, creation of other non-standard classification codes is possible as a special request. For other non-standard codes to be implemented, normalization rules need to be written and codes added to the Voyager schema as valid codes. Use of any new non-standard code requires a call number index regen to index the existing records with this code. To place a request for development of a non-standard classification code, contact Customer Support.

**IMPORTANT:**

For libraries upgrading to Voyager 2001.1 and currently using the UDC, Old Yale, or Cambridge classification schemes, a call number index regeneration is required.

### Call Number Sorting and Searching

There are two aspects to sorting and searching by call number that are of significance relative to Voyager’s processing logic.

- How the data is interpreted and stored when input to a Voyager database (How records are saved).
- How the search text is processed and results displayed for a call number search (how users search).

How the data is stored/normalized determines how it can be sorted and search results are affected not only by how the data is stored but also by how the search text is processed.

### Call Number Input/Normalization Process (Records Saved)

When a call number is entered into the database, Voyager evaluates what type of call number it is such as LC, Dewey Decimal, National Library of Medicine, Cambridge Main, and so on. Once this type is determined Voyager uses a corresponding classification scheme (see Table B-1, Table B-2, and Table B-3) that contains the rules used for normalizing the call number. The process of

---

### Table B-4. CACODOCS and UDC classifications

<table>
<thead>
<tr>
<th>1st Indicator Value</th>
<th>Subfield Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>u</td>
<td></td>
<td>Universal Decimal Classification (UDC)</td>
</tr>
</tbody>
</table>
normalizing the call number formats the call number so that Voyager can more accurately search and sort call numbers. For example, alpha characters are stored in their uppercase format to insure consistency in sorting.

To identify a holdings record as using the Cambridge Main classification scheme, the following, for example, can be specified.

852 7_ ǂb CAT ǂh S250.c.200.16 ǂ2 cammain

This example uses a combination of first indicator 7 and subfield 2 (ǂ2) to identify the classification scheme. The first indicator or the first indicator in combination with a subfield in the MARC 21 Format for Holdings Data (MFHD) identifies which classification scheme is to be used for formatting the call number for storage in Voyager.

Call Number Searching and Display Results

Voyager normalizes the content of the search text entered for a call number index search. Similar to the process used when storing call number information, Voyager evaluates the search content to determine if the call number fits the LC classification scheme, the Dewey Decimal classification scheme, and so on. It then processes the normalized search content against the normalized call number field to generate a list of results.

NOTE:
The classification schemes utilized by a library are identified and stored in the system at implementation time and, in general, are not changed. Additionally, at implementation time, the processing order of the classifications schemes is specified. Typically, the LC classification scheme is identified as the first classification Voyager checks when processing a call number. However, for libraries using other classification schemes more commonly, the more commonly preferred classification scheme can be identified as the first to process against by Voyager.
Voyager with Unicode Considerations

Voyager with Unicode Overview

The implementation of Unicode in the Voyager product set is scheduled in phases.

The first phase of the Unicode implementation includes the following.

- Cataloging
- WebVoyáge
- Search and MARC Display Functions in the Acquisitions, Circulation, and Media Scheduling modules

The remaining Voyager modules continue to support data in the Latin-1 format.

Function Enhanced in Cataloging for Font Options and Input of Non-Roman Text

Operators can search for, display, and edit the contents of all MARC records using Unicode whether or not the record contains non-Roman characters.

The font in the Cataloging module can be changed to support a variety of languages. See Procedure 10-1, Changing Colors and Fonts, on page 10-17 for more information.
The Voyager with Unicode release supports all the standard Microsoft® Windows™ keyboard and input methods allowing cataloging staff the ability to input non-Roman text using any standard keyboard.

With the flexibility of Voyager with Unicode, it is possible to input text that is not part of the MARC21 standard. Optionally, the Cataloging module provides a feature that can be selected to validate that a Unicode record contains only characters that conform to the MARC21 standard. See Validation Tab on page 10-4 for more information.

**Characteristics of a Unicode-Formatted Record in Voyager**

Unicode-formatted records can be identified by the ninth position of the Leader. The ninth position contains the letter a. See Figure C-1.

Non-Unicode records contain a space in the ninth position.

![Figure C-1. Leader Ninth Position](image)

**NOTE:**
Tag tables do not allow anything to be specified for position 9 in the Leader since it is used to identify Unicode records.
Diacritics and MARC21 Compliance Considerations

Diacritic characters have two components, the alphabetic character and the diacritic symbol. For example, ç is made up of c and „.

Non-Unicode databases store the diacritic symbol followed by the alphabetic character as two separate characters. For example, français is stored as fran¸cais. This practice of storing characters is influenced by the MARC21 standard.

Unicode databases store the alphabetic character first and then the diacritic character as two separate characters. For example, français is stored as franc¸ais. Also, the diacritic character may be stored as a single entity such as ç.

It is possible that when using certain Windows-based programs, diacritic characters are generated with a different internal value that allows the two components to be stored as one character. This may occur in the Voyager environment when you copy a diacritic character from a Windows-based program and paste it into a Voyager record. Voyager has the flexibility to store the diacritic character in this alternative format as a single character.

NOTE:
Even though a diacritic character may be stored as two separate components, the system displays it as one character.

MARC21 Compliance Considerations

When exchanging records with MARC21 compliant systems, the standard dictates that in almost all cases the diacritic character be stored as two component pieces, the diacritic symbol first followed by the alphabetic character.

When exporting from the Voyager with Unicode system, simply indicate MARC21 MARC8 code M with the –a parameter (–aM) when running bulk export; and the system handles the order of the alphabetic character and the diacritic for the receiving MARC21 compliant system. See the Voyager Technical User’s Guide for more information regarding bulk export.

Additionally, you can use the decomposition feature selectable on the Validation tab in Session Defaults and Preferences in the Cataloging module (see Validation Tab on page 10-4 for more information) to translate single-entity, non-Roman characters into two components so that there is an alphacharacter and diacritic for MARC21 compliance.
Considerations for Records Imported or Converted to Unicode

For existing Voyager systems, records in the database need to be converted to the Unicode UTF-8 encoding for the Voyager with Unicode release. This process is separate and distinct from importing non-Unicode records into an existing Voyager with Unicode database.

See Database Conversion on page C-4 and BulkImport on page C-8 for a description of the conversion and import processes and considerations.

(See the Voyager Technical User’s Guide for information about exporting records from a Voyager with Unicode database.)

Database Conversion

When a non-Unicode Voyager database is converted to a Voyager with Unicode database, the following record processing occurs.

- Each record is analyzed to determine if it is a Unicode encoded record. (The system checks the ninth position of the Leader. See Characteristics of a Unicode-Formatted Record in Voyager on page C-2.)
- Non-Unicode records are converted to the Unicode UTF-8 encoding format.
- Any non-recognizable characters are replaced with a Unicode substitution character.
- Records that cannot be converted to Unicode are viewable in the Cataloging module with nc (not converted) displayed in the Title Bar. See Non-Converted Records (nc) on page C-4 for more information.
  
Also, if appropriate options have been selected in Session Defaults and Preferences, non-converted records display in a different color. See Colors/Fonts Tab on page 10-16 for more information.

- Log files are generated as part of the conversion process. See Message Logs on page C-5 for more information. These log files can be used to diagnose records that do not convert successfully to Unicode UTF-8 encoding.

Non-Converted Records (nc)

A non-converted record can be viewed and corrected in the Cataloging module and subsequently saved as a Unicode record.
IMPORTANT:
For a record to display in the Cataloging module, there must be an a in the 9th position of the Leader. Therefore, you see both nc in the Title Bar and an a in the 9th position of the Leader. This may seem like a contradiction. However, the letter a in the 9th position of the Leader does not become a permanent component of the record until the record is saved to the database.

CAUTION:
Be certain to make all corrections to the nc record before saving it to the database. When the nc record is saved to the database, the letter a is stored in the 9th position of the leader permanently identifying the record as Unicode formatted along with any remaining inaccuracies and substitute characters.

Message Logs

The database conversion process produces a log file for bibliographic, holdings, and authority records. The log files are named as follows.

- log.#####.bib
- log.#####.mfhd
- log.#####.auth

(Where ##### is the job/process ID number)

Records containing fields that fail to convert to Unicode are still visible in the Cataloging, WebVoyage, Acquisitions, Circulation, and Media Scheduling modules subsequent to the conversion process.

A review of the records with errors is necessary to make corrections not handled by the conversion process. The error (warning) logs provide a variety of useful information to assist with the reivew of records with errors. See Table C-1, Table C-2, Table C-3, and Table C-4 for a description of the information that is provided.
NOTE:
There are two levels of error and warning messages, record-level and field level.

Table C-1. Record-Level Warnings & Errors

<table>
<thead>
<tr>
<th>Warning/Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>leader 9 is not space</td>
<td>This is a warning. An attempt is made to convert from Voyager encoding to Unicode. This warning may indicate corrupt data or reflect a staff input error.</td>
</tr>
<tr>
<td>leader 9 is 'a'</td>
<td>This is an error. There is not attempt made to reconvert a record that is already defined as a Unicode record.</td>
</tr>
<tr>
<td>066 Error</td>
<td>This is an error. This indicates that the character sets in the 066 are not supported by the converter.</td>
</tr>
</tbody>
</table>

Table C-2. Log Information Provided for Field-Level Warnings & Errors

<table>
<thead>
<tr>
<th>Warnings &amp; Errors Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>The record type and ID of the record.</td>
</tr>
<tr>
<td>The index within the record of the field that generated the error. (This is the index within all the field of the record not within fields with the same tag.)</td>
</tr>
<tr>
<td>The tag of the field that generated the error.</td>
</tr>
<tr>
<td>The text c-&gt;8 indicates that the conversion was from Voyager encoding to Unicode.</td>
</tr>
</tbody>
</table>

The error type is specified as follows.

- **Page=** indicates to which code page (MARC character subset) the source character belongs. This is a number that corresponds to specific code pages. See Table C-3 for a list of the code pages.
- **At** indicates the position within the field of the source character that caused the problem.
- A hexadecimal dump of the source character and the following seven characters is provided.
- An ASCII dump of the source character and the following seven characters.
  If the source character or any following characters are control characters or diacritics (their code point value is not between 32 and 127), they display as periods.
Table C-3. Code Page Numbering

<table>
<thead>
<tr>
<th>Code Page Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Latin text with ALA diacritics</td>
</tr>
<tr>
<td>1</td>
<td>CJK characters (the EACC set)</td>
</tr>
<tr>
<td>2</td>
<td>Arabic</td>
</tr>
<tr>
<td>3</td>
<td>Cyrillic</td>
</tr>
<tr>
<td>4</td>
<td>Greek</td>
</tr>
<tr>
<td>5</td>
<td>Hebrew</td>
</tr>
<tr>
<td>6</td>
<td>MARC-8 Greek characters (alpha, beta, gamma)</td>
</tr>
<tr>
<td></td>
<td>(Logged as a loose translation)</td>
</tr>
<tr>
<td>7</td>
<td>MARC-8 superscript and subscript numbers</td>
</tr>
<tr>
<td></td>
<td>(Logged as a loose translation)</td>
</tr>
</tbody>
</table>

Table C-4. Specific Warnings & Errors

<table>
<thead>
<tr>
<th>Warning/Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>loose char</td>
<td>This is a warning. This indicates that a character that is not strictly part of the Voyager encoding has been converted. Carriage returns,</td>
</tr>
<tr>
<td></td>
<td>line feeds, and MARC-8 superscript and subscript numbers are some examples of characters that are converted and raise this warning.</td>
</tr>
<tr>
<td>no char to combine to</td>
<td>This is a warning. This indicates that a Voyager encoding combining character was stored at the end of a subfield where it lacks a base</td>
</tr>
<tr>
<td></td>
<td>character to combine to. In this case, the conversion places a space preceding the combining character in the converted record.</td>
</tr>
<tr>
<td>undefined char</td>
<td>This is an error. This error occurs when the converter encounters data in the source record that cannot be mapped to Unicode. The specific</td>
</tr>
<tr>
<td></td>
<td>characters that cannot be mapped differ from code page to code page.</td>
</tr>
</tbody>
</table>
**BulkImport**

When importing records using BulkImport, the following record processing occurs:

- The system checks the Bulk Import Rule defined in the Voyager System Administration module to determine the character set mapping of the incoming records.

  If MARC21 UTF-8 (the only Unicode encoding option) is selected, the system expects the letter `a` to be stored in position 9 of the Leader. See [Characteristics of a Unicode-Formatted Record in Voyager](#) for more information.

  All the other options are non-Unicode, and the system expects a space to be stored in position 9 of the Leader.

- Position 9 of the Leader is analyzed to determine if it matches the Bulk Import Rule specified in Voyager System Administration. If the Leader position does not contain the expected value, the record is not imported and an error is logged in the standard BulkImport message logs.

  For a summary of BulkImport processing and results, see Table C-5.

- After a record passes the check on the 9th position of the Leader, the system converts the remaining fields according to the mapping information provided in the Bulk Import Rule.

  If the record contains characters that cannot be converted, an error is logged in the standard BulkImport message logs; and the record is not imported.

<table>
<thead>
<tr>
<th>Mapping (Expected Character Set of Imported Records)</th>
<th>Leader Position 9 Contents</th>
<th>Conversion Result</th>
<th>Processing Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>MARC21 UTF-8</td>
<td>a</td>
<td>No Conversion</td>
<td>Load into Database</td>
</tr>
<tr>
<td>MARC21 UTF-8</td>
<td>Space</td>
<td>Error Out &amp; Log</td>
<td></td>
</tr>
<tr>
<td>OCLC (non-Unicode)</td>
<td>a</td>
<td>Error Out &amp; Log</td>
<td></td>
</tr>
<tr>
<td>OCLC (non-Unicode)</td>
<td>Space</td>
<td>Successful</td>
<td>Load into Database</td>
</tr>
<tr>
<td>OCLC (non-Unicode)</td>
<td>Space</td>
<td>Failure</td>
<td>Error Out &amp; Log</td>
</tr>
<tr>
<td>RLIN legacy (non-Unicode)</td>
<td>a</td>
<td>Error Out &amp; Log</td>
<td></td>
</tr>
<tr>
<td>RLIN legacy (non-Unicode)</td>
<td>Space</td>
<td>Successful</td>
<td>Load</td>
</tr>
<tr>
<td>RLIN legacy (non-Unicode)</td>
<td>Space</td>
<td>Failure</td>
<td>Error Out &amp; Log</td>
</tr>
<tr>
<td>Latin-1 (non-Unicode)</td>
<td>a</td>
<td>Error Out &amp; Log</td>
<td></td>
</tr>
</tbody>
</table>
Subfield Character

The subfield character (‡) continues to be recognized as a subfield delimiter character and cannot be used as content in a record. It is reserved for this purpose.

The subfield character (‡) can be entered using the following methods.

- Enter the character from the keyboard
- Click Edit > Insert Subfield (F9)
- Select Options > Preferences > Add a subfield ‘a’ to a new field

Cataloging Templates

Templates created in the Cataloging module starting with the Voyager with Unicode release must be created as Unicode templates. This implies that the ninth position of the Leader must be set to a. See Characteristics of a Unicode-Formatted Record in Voyager on page C-2 for more information.

Analyzing Inconsistencies

There are different options for diagnosing inconsistencies in Unicode text.
Hexadecimal Value

One method for determining the hexadecimal values of non-Roman and Roman characters is to copy the text into an editor such as Microsoft WordPad and use Alt+X to display the hexadecimal value.

Resources

For more information on a variety of topics related to Unicode, browse the following site.

www.unicode.org
Templated Input

What is Templated Input?

Templated Input provides a common-language alternative for entering and editing MARC records. For example, the MARC 245 field can be labeled Title instead of 245. (See Figure D-31 on page D-37.) With Templated Input, MARC record fields are mapped to their corresponding values through modifiable templates.

Templated Input may be used to create records for special collections.

Templated Input Requirements

A separate Voyager Cataloging user ID must be created specifically for use with Templated Input. More than one Templated Input user ID may be created.

Creating Templated Input User IDs

Templated Input requires that a user ID be created with specific options selected in Voyager System Administration. In particular, the Use Templated Forms check box must be selected. See Figure D-1. Optionally, you may decide what add, delete, and/or update authority you give to the Templated Input user ID.
NOTE:
If the **Use Templated Forms** check box is inactive, Contact Customer Support for assistance.

For more information about setting up a Voyager Cataloging user ID, see the **Voyager System Administration User’s Guide**.

Figure D-1. Use Templated Forms check box (Voyager System Administration)

**Login for Templated Input**

Logging in to Voyager Cataloging for Templated Input follows the same procedure as for normal cataloging usage. The only difference is the special user ID and password created specifically for the purpose of Templated Input.

After successful login, the usual Voyager Cataloging dialog box displays. See **Figure D-2**. The normal Voyager Cataloging features are the same when using Templated Input except for working with templates.
Creating Records with Templated Input

Procedure D-1. Creating Records with Templated Input

Use the following to create a new record in the Cataloging module using Templated Input.

1. Click the New button.

   Result: The Select a MARC Template dialog box displays. See Figure D-3
2. Select a template from the available list and click **OK**.

   (The selected template uses the mapping values defined in the configuration files for MARC record fields. For more information about creating template configuration files, see Template Configuration Files on page D-5.)

   Result: The selected template displays. See Figure D-31 on page D-37.

---

**Retrieving/Editing Records with Templated Input**

**Procedure D-2. Retrieving/Editing Records with Templated Input**

Use the following to retrieve/edit a record in the Cataloging module using Templated Input.

1. Use **Search** to locate the record you want to edit.
Result: The selected record displays using the appropriate Templated Input form.

The Voyager Cataloging module selects the appropriate Templated Input form based on the mapping for bytes 06 and 07 of the MARC leader field in the record. See Template.ini File on page D-5 for more details.

2. Click Save to DB to save your changes.

Result: The record is updated in the database.

Template Configuration Files

Two types of files are required for using templated input in the Cataloging module: one primary configuration file (template.ini), and one template definition file for each defined template. The template configuration files for Templated Input templates are in the MARCTemplate directory of the Cataloging folder on each PC on which Voyager Cataloging is installed.

The template.ini file contains basic information and definitions about the templates, while separate template definition files contain more specific information about each template. The template.ini file must reside in the \Voyager\Catalog\MarcTemplate directory on a local machine, while template definition files can reside on any drive. Both the template.ini file and the template definition files can be modified and customized to individual needs.

NOTE:
The template.ini and template definition files are not modifiable in the Cataloging module itself, but in any text editor application such as Microsoft Notepad®.

Template.ini File

The template.ini file is the primary configuration file for templated input, and defines templates to be used to create and edit records. The file can be modified as needed (for example, if a new template needs to be added). The template.ini file contains three stanzas: [New Templates], [Edit Templates], and [NonFiling].

Figure D-4 shows an example of a template.ini file.
Line#
1 [New Templates]
2 NewSerial.cfg
3 NewBook.cfg
4
5 [Edit Templates]
6 as=EditSerial.cfg
7 am=EditBook.cfg
8
9 [NonFiling]
10 1=a
11 2=an
12 3=the
13 4=der
14 5=die
15 6=das__
16 7=le
17 8=la
18 9=les
19 10=l
20 11=il
21 12=la
22 13=lo
23 14=gli
24 15=gl
25 16=le
26 17=el

Figure D-4. Sample template.ini File
Appendix D: Templated Input

[New Template] Stanza

This stanza includes the filenames and locations of the templates to be used for creating new bibliographic records. The files can have any name. Although examples shown here contain the file extension .cfg, this is not required.

Lines 1 through 3 of Figure D-4 on page D-6 show an example of a [New Templates] stanza indicating the file names and location of two templates for creating new bibliographic records.

NOTE:
It is not necessary to provide the full file path for the templates. Cataloging will look for the files in the C:\Catalog\MARC_TEMPLATE directory. It is only necessary to include the full file path if templates are not located in the directory mentioned above.

[EditTemplates] Stanza

This stanza details which template files should be used to edit existing bibliographic records. It contains the mapping of two characters, bytes 06 and 07 of the MARC record leader, to the template required to edit the record (see lines 5 through 7 of Figure D-4 on page D-6).

The first character is matched to byte 06 of the leader field, and the second character is matched to byte 07 of the leader field. The first template, specified in the [Edit Templates] stanza, to match the leader character values of the record being opened will be used to edit that record.

For example, if you open a file with a leader as in Figure D-5 (with an 06 of a and an 07 of s), and your [Edit Templates] stanza is as in Figure D-6, the record will be opened using the EditSerial.cfg template configuration file.

<table>
<thead>
<tr>
<th>Line#</th>
<th>Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>18=los</td>
</tr>
<tr>
<td>28</td>
<td>19=las</td>
</tr>
<tr>
<td>29</td>
<td>20=den</td>
</tr>
<tr>
<td>30</td>
<td>21=det</td>
</tr>
<tr>
<td>31</td>
<td>22=de</td>
</tr>
</tbody>
</table>

Figure D-4. Sample template.ini File (Continued)
Figure D-5. Sample MARC record leader

Figure D-6. Sample [Edit Templates] stanza

NOTE:
If the leader information of the record you wish to edit does not contain the leader information specified in the [Edit Templates] stanza, the Cataloging client will prevent you from accessing the record.

[NonFiling] Stanza

This stanza contains a numbered list of valid non-filing articles which are used to automatically create non-filing indicators for appropriately templated fields.

Lines 9 through 31 of Figure D-4 on page D-6 is a sample [NonFiling] stanza outlining 21 non-filing articles.

Template Configuration (.cfg) Files

Template configuration files provide detailed information about templates listed in the template.ini file. They control the form and values of each template, and are modifiable using any text editor. As many template configuration files can be created as needed, and can be located either on a local machine (local PC), or on a network, as long as definitions in the template.ini file point to the correct file location.

IMPORTANT:
If using the configuration files on local PC’s, copy the files to the proper directory (\Catalog\MARCTemplate is the default) on each PC after editing them.
Template definition files contain three main stanzas. The remaining stanzas are control specification stanzas where you establish the formats and types of boxes used by the template operator, as well as the information used as the control values.

1. The [General] stanza defines the name of the template as displayed to the template operator

2. The [BibInitialization] stanza defines what fields will be pre-defined for new bibliographic records. This information is not visible to the template operator, and gets placed into every record created with that template.

3. The [BibMarcMapping] stanza defines the fields of the bibliographic record which have values chosen by the template operator (as opposed to preset default values), and what controls those values are based on.

NOTE:
Having 008 character position specifications in both the [BibInitialization] and [BibMarcMapping] stanzas produces one 008 in the record, and any information for the same character position from the [BibMarcMapping] stanza overrides the information entered in the [BibInitialization] stanza.

Placing information for other fields in both the [BibInitialization] and [BibMarcMapping] stanzas results in multiple fields in the record.

The following is an example of a template definition file for creating new bibliographic records for monographs.
Figure D-7. Sample Template Definition File
Figure D-7. Sample Template Definition File (Continued)

<table>
<thead>
<tr>
<th>Line#</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>Caption=Creator:</td>
</tr>
<tr>
<td>32</td>
<td>NoValue=Y</td>
</tr>
<tr>
<td>33</td>
<td>SameLine=Tovid</td>
</tr>
<tr>
<td>34</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Type=TextBox</td>
</tr>
<tr>
<td>37</td>
<td>Caption=Title:</td>
</tr>
<tr>
<td>38</td>
<td>Width=wide</td>
</tr>
<tr>
<td>39</td>
<td>Scroll=0</td>
</tr>
<tr>
<td>40</td>
<td>Lines=2</td>
</tr>
<tr>
<td>41</td>
<td></td>
</tr>
<tr>
<td>42</td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>Type=TextBox</td>
</tr>
<tr>
<td>44</td>
<td>Caption=General Note</td>
</tr>
<tr>
<td>45</td>
<td>Width=wide</td>
</tr>
<tr>
<td>46</td>
<td>Scroll=1</td>
</tr>
<tr>
<td>47</td>
<td>Lines=2</td>
</tr>
<tr>
<td>48</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Type=TextBox</td>
</tr>
<tr>
<td>51</td>
<td>Caption=Abstract:</td>
</tr>
<tr>
<td>52</td>
<td>Width=wide</td>
</tr>
<tr>
<td>53</td>
<td>Scroll=1</td>
</tr>
<tr>
<td>54</td>
<td>Lines=5</td>
</tr>
<tr>
<td>55</td>
<td></td>
</tr>
<tr>
<td>56</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>Type=TextBox</td>
</tr>
<tr>
<td>58</td>
<td>Caption=Physical Format:</td>
</tr>
<tr>
<td>59</td>
<td>SameLine=T</td>
</tr>
<tr>
<td>60</td>
<td></td>
</tr>
<tr>
<td>61</td>
<td></td>
</tr>
</tbody>
</table>
Figure D-7. Sample Template Definition File (Continued)
[General] Stanza

This is a required stanza that contains one variable: Caption=. The Caption= variable defines the actual name (as opposed to the filename), of the template that the operator sees in the list of available templates as well as any other place it is necessary to refer to a template by name. The name for the template itself can be any combination of letters, numbers, and/or symbols. Choosing a descriptive template name facilitates easy identification for the operator (for example, choosing “New Book” for a template used to create new bibliographic records for books).

Figure D-8  (from Lines 1 and 2 of Figure D-7 on page D-10) is an example of a [General] stanza that defines the template name the operator sees in the Voyager Cataloging module (see Figure D-9).

<table>
<thead>
<tr>
<th>[General]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caption=New Book</td>
</tr>
</tbody>
</table>

Figure D-8. Sample [General] stanza

Select a MARC Template

<table>
<thead>
<tr>
<th>MARC Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Book</td>
</tr>
<tr>
<td>New Serial</td>
</tr>
</tbody>
</table>

Figure D-9. Result of New Book Caption variable in the [General] Stanza
[BibInitialization] Stanza

This optional stanza defines what fields will be pre-defined for new bibliographic records. It is optional because it pertains only to creating new bibliographic records, and will be ignored if the template is used to edit an existing record.

The [BibInitialization] stanza defines initial values for certain byte positions of the MARC leader field, as well as all byte positions for the MARC 006, 007, and 008 fields. Remember, byte positions start with 0, so the first byte position is the 0 byte position. Also, as with all MARC records, there can only be one Leader (000) specification and one 008 field. However, there can be multiple 006 and 007 fields.

NOTE:
Remember that these values are constant in all records controlled by the template, and will be invisible to the operator. To set character position values based on user input, add them to the [BibMarcMapping] stanza (see Using Multiple Control Properties in a Single Stanza on page D-42).

Leader field

In the [BibInitialization] stanza, the byte positions that can be defined for the MARC leader field are as follows: 06, 07, 08, 17, 18, and 19. All others are fixed, or set by the program or database. Elements of the leader (000) specification (which is numeric notation for the leader in the template configuration files) can be initialized by creating a variable consisting of the field name, followed by a forward slash, followed by the byte position, an equals sign, and the value of the byte position. Only single byte positions can be defined.

Figure D-10 leader field elements in a [BibInitialization] stanza for creating a new serial record that indicates that the type of record (000/06) is a language material, the bibliographic level (000/07) is a monograph, and the encoding level (000/17) is unknown.
006 and 007 Fields

Single or multiple 006 and 007 fields may be initialized by creating a variable that consists of the field name, followed by the equals sign, and the value for the entire field. Use vertical bars to represent MARC21 fill characters, and underscores to represent byte positions that are left blank.

⚠️ CAUTION:
The person creating the templates should be sure that the right number of byte positions are being used for 007 definitions. The program either cuts off or pads 007s if they are too long or short.

Figure D-11 shows an example of a default value for a 007 field in the [BibInitialization] stanza.

008 Field

For each new record created using templates, the program will automatically generate an 008 field. The [BibInitialization] stanza allows for the provision of overriding values for any chosen position in the 008 field. Elements of the 008 field may be initialized by creating variables that consist of field names, followed by a forward slash, followed by the byte position, and optionally by a dash and the byte range. Single bytes use only the byte position. Multiple byte definitions are defined by specifying the first byte position, a dash, and the end byte position. Use an underscore to signify blanks, and the vertical bar to represent MARC21 fill characters. For an example, see Figure D-12.
The following is an example of override values for three positions in the 008 field, indicating that the form of item (008/23) is braille, the government publication (008/28) is federal/national, and the item is a festschrift (008/30).

<table>
<thead>
<tr>
<th>Position</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>008/23</td>
<td>f</td>
</tr>
<tr>
<td>008/28</td>
<td>f</td>
</tr>
<tr>
<td>008/30</td>
<td>1</td>
</tr>
</tbody>
</table>

**Figure D-12. Sample 008 field**

### Variable Fields

This part of the [BibInitialization] stanza supplies default values for variable MARC record fields in the 010 to 999 range. To define default values for variable fields, provide the appropriate field tag, a colon, the first and second indicators, another colon, a subfield indicator, and the entire contents of the subfield. It is possible to specify as many subfields on a line as desired, but the definition of each variable field must all be on one line. Use a vertical bar to represent the MARC21 delimiter character, and spaces (as opposed to underscores) to specify indicators to be left blank. For an example of variable fields in the [BibInitialization] stanza, see **Figure D-13**.

*Figure D-13* is an example of default values for two variable MARC fields, indicating the physical description (300 field) of the item as well as a language note (546 field).

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>300</td>
<td>:</td>
</tr>
<tr>
<td>546</td>
<td>:</td>
</tr>
</tbody>
</table>

**Figure D-13. Sample variable MARC record fields**

### Overview of Templates Produced by Template Configuration Files

The control specification stanzas of the template configuration files (lines 13 through 65 of **Figure D-14**) determine the layout of the template, and the values (information) associated with the combination box items available for selection by the template operator. These stanzas are named for the boxes which they define, but need not have the same name as that seen by the template operator.
The [BibMarcMapping] stanza (lines 1 through 11 of Figure D-14) determines how the information entered by the operator gets placed into the record being created.

Though the control specification stanzas must be placed further down in the template configuration files from the [BibMarcMapping] stanza, it is easier to understand the Templated Input process by explaining the control specification stanzas first.
Figure D-14.  Sample [BibMarcMapping] and control specification stanzas (Page 1 of 3)

~

Line#

1  [BibMarcMapping]
2  035:--:|a<accessionno.text>
3  040:--:|a<creator.text>
4  245:1<title.nonfiling>:|a<title.text>
5  500:--:|a<generalnote.text>
6  538:--:|a<physicalformat.text>
7  650:-0:|a<subject1.text>
8  650:-0:|a<subject2.text>
9  650:-0:|a<subject3.text>
10  700:1-:|a<personalauthor.text>
11  710:2-:|a<corporateauthor.text>
12
13  [accessionno]
14     Type=TextBox
15     Caption=Accession no.:
16
17  [creator]
18     Type=TextBox
19     Caption=Creator:
20     NoValue=Y
21     SameLine=T
22
23  [title]

24     Type=TextBox
25     Caption=Title:
26     Width=wide
27     Scroll=0
28     Lines=2
29
30  [generalnote]
Figure D-14. Sample [BibMarcMapping] and control specification stanzas (Page 2 of 3)
In Templated Input, operator-modifiable data is input through the use of controls. There are two types of controls used in templated input: combination (or drop-down) boxes and text boxes. Each box has a corresponding stanza associated with it where you define the parameters of the box, including the layout of it and the values associated with the items available for selection by the template operator.

Both combination (combo) boxes and text boxes share the elements shown in Figure D-1, some of which are required, some of which are optional.

### Table D-1. Shared elements

<table>
<thead>
<tr>
<th>Element</th>
<th>Required or Optional</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>required</td>
<td>Indicates the type of control, either combination box or text box.</td>
<td>ComboBox or TextBox</td>
</tr>
<tr>
<td>Caption</td>
<td>required</td>
<td>Name to be displayed to the operator just above the control on the template.</td>
<td>Any</td>
</tr>
<tr>
<td>Width</td>
<td>optional</td>
<td>Amount of horizontal space taken up by the control.</td>
<td>Narrow, Medium, or Wide.</td>
</tr>
</tbody>
</table>

Figure D-14. Sample [BibMarcMapping] and control specification stanzas (Page 3 of 3)
Appendix D: Templated Input

Combination Boxes

Combination boxes are useful if operators must be presented with a limited number of choices, (for example, if a field for a record is to have a value of either microfilm, or microfiche). These displayed choices can consist of very general information which does not require familiarity with MARC record formats. Using codes from Voyager tag table files, or values entered manually, you then can attach more specific MARC record information to the values displayed to the template operator. You can also attach multiple values to each option available to the template operator, so the same box can be used for multiple MARC record fields.

You can configure combination boxes to pull values out of another MARC configuration file (tag table file) or you can enter the values into the stanzas in the template configuration files themselves. The tag table files reside in the C:\Voyager\Catalog\TagTable directory on each PC on which the Voyager Cataloging Module is installed.

Combination Boxes Using Other Configuration Files

The control to specify a configuration file to pull values from is the source element.

Source= element

If the combination box will be filled by data pulled from a MARC configuration file (tag table file), the definition of the combination box must include the Source= element. This element indicates where data for the combination box is to be pulled from. Provide this information in the following format:

Table D-1. Shared elements (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Required or Optional</th>
<th>Description</th>
<th>Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>SameLine</td>
<td>optional</td>
<td>Whether or not the control should display on the same horizontal line as the previous control. A value of True means the program will display the control on the same line to the right of the previous control (if there is room). A value of False (the default) will display the control on the left edge of the next line on the template.</td>
<td>True or False</td>
</tr>
</tbody>
</table>
Source=Name of configuration file/name of stanza to extract information from in the source file.

**NOTE:**
Only a partial file path is needed because the program will automatically start looking in the `\catalog` subdirectory.

The example in Figure D-15 directs the program to look in the `BookRegularity` stanza in the `Bmarcfix.cfg` file.

![Source=Bmarcfix.cfg/BookRegularity](image)

**Figure D-15. Sample Source= element line**

If the contents of the combination box will be filled with the contents of `Source=`, then an optional `Display=` element may be set. The `Display=` element determines how the contents of the `Source=` information will display to the operator (in the combination box).

**Display= Element**

This element sets what displays in each line of the combination box. It has one of three possible values: v (default), c, cv, or vc. The value c represents display of the actual MARC code itself, while v represents display of the value of the contents. vc or cv represent combinations of MARC code and values of contents.

**NOTE:**
The `Display=` element in stanzas using the `Source=` element differs from the `Display=` element used in stanzas which do not draw information from tag table files.

*Figure D-16* shows an example of the `Source=` element and the `Display=` element (in a `[frequency]` stanza). *Figure D-17* shows the `[006/008SerialsFrequency]` stanza (from the `Bmarcfix.cfg` file) which the `Source=` element in the `[frequency]` stanza draws the information from for the combination box. *Figure D-18* shows the `frequency` combination box as created by the `[frequency]` stanza in *Figure D-16*.

*Figure D-19* shows what the box would look like if the `Display=` element were set to v (or left blank).
Figure D-16. Sample stanza using the Source= and Display= elements

[frequency]
Type=combobox
Caption=frequency
Source=Bmarcfix.cfg/006/008SerialsFrequency
StartUpDefault=r
Display=cv
Width=Narrow
[006/008SerialsFrequency]
_ = No determinable frequency
a = Annual
b = Bimonthly
c = Semiweekly
d = Daily
e = Biweekly
f = Semiannual
g = Biennial
h = Triennial
i = Three times a week
j = Three times a month
m = Monthly
q = Quarterly
s = Semimonthly
t = Three times a year
u = Unknown
w = Weekly
z = Other
| = No attempt to code

Figure D-17. [006/008SerialsFrequency] stanza in the Bmarcfix.cfg file
Combination Box Values Set in Template Configuration Files

If the information for the combination box is not available in the Voyager tag table files, all of the items to present in the combination box must be listed in the corresponding stanza. Keep in mind, the program does not sort items listed for inclusion in combination boxes, rather it will list items in the order in which they display in the stanza for the combination box at hand.

There are up to four variables, or control properties, associated with each item in the combination box. Two of these properties, Code and Display, are required.

- **Display** is the control property seen by the template operator. Set these values to something the template operator would recognize.

**NOTE:**
The Display= element in stanzas using the Source= element differs from this Display= control property.

- **Code** is the default property placed into the resulting MARC record.

The remaining two, Equivalent and Other, are optional. These two properties are extra variables which you can assign values to, to be placed into the record (if you have the same information, which needs to be placed into different MARC record fields in different formats, for example). For an example using these two
control properties, see Using Multiple Control Properties in a Single Stanza on page D-42. The values of the properties are set here, while their placement into the MARC records is detailed in the [BibMarcMapping] stanza.

Table D-2 shows the 4 control properties for combination boxes which do not draw information from tag table files. Lines 7 through 10 of Figure D-20 show an example set of control property value specifications.

Table D-2. Combination box control property types

<table>
<thead>
<tr>
<th>Element</th>
<th>Required or Optional</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>required</td>
<td>An abbreviation or other symbolic representation for the item. This element is required even if it is not used in a template. It must be the first element defining each of the items to be listed in the combination box. It is not displayed to the operator.</td>
</tr>
</tbody>
</table>
| Display   | required             | The text to be presented to the operator in the combination box itself.  
**NOTE:** The exception to the above is when using the Source= element in a combination box control stanza. In that case, the Display control property tells the template whether to display the code and value, or just the code, from the tag table file. For more information, see Source= element on page D-21. |
| Equivalent| optional             | A piece of information associated with the item which may be needed in a template definition. It is not displayed to the operator. |
| Other     | optional             | An additional piece of information associated with the item which may be needed in a template definition. This element may have any name. This element is not displayed to the operator. |
Text boxes are useful if operators must enter text for placement directly into a MARC record field.

You can configure text boxes to count the number of non-filing characters and enter that number into the MARC record. Text box configuration in the control specification stanzas is straightforward. Table D-3 lists the possible layout specifications for text boxes (all of which are optional).

Table D-3. Text box layout variables

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DefaultValue</td>
<td>Specifies text for display in the text box when creating a new bibliographic record, or when editing a bibliographic record that does not have any data for the field or subfield. If an existing record does have data for that field or subfield, then the data will fill the text box when the record is loaded.</td>
</tr>
<tr>
<td>Lines</td>
<td>Specifies the number of vertical lines to be taken up by the text box. The default is 1 if this is not set.</td>
</tr>
</tbody>
</table>
Table D-3. Text box layout variables (Continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll</td>
<td>Specifies whether or not a vertical scroll bar will display at the right edge of a text box. Valid values are True, in which case a scroll bar will display, and False, (default) in which case a scroll bar will not display.</td>
</tr>
</tbody>
</table>

```
[tight]
Type=TextBox
Caption=Title:
Width=wide
Scroll=0
Lines=2
```

Figure D-21. Sample [title] stanza

The stanza in Figure D-21 produces the display in Figure D-44.

Figure D-22. Sample Text Box Display

[BibMarcMapping] Stanza

You configure the MARC record placement of the information entered into the combination and text boxes in the [BibMarcMapping] stanza. This is where you establish what information to pull from which boxes and how the information gets placed into the MARC fields of the record.

For example, if you want the value of the Code property selected in the Size combination box to get placed into the 300c, and the value of the Other property into the 500a, in the resulting record, enter a line in the [BibMarcMapping] stanza as in Figure D-23.
Figure D-23. Sample 300c and 500a specification in the [BibMarcMapping] stanza

For each MARC field, it is necessary to supply the field number, followed by a colon, both indicators (fixed values, spaces, or symbols), another colon, the subfield indicator (vertical bar with subfield character), and the control specification for that field/subfield. Enter control specifications in the following format:

<controlname.controlproperty>

Based on the [size] stanza in Figure D-24, if the template operator selected Letter size newsletter from the Size combination box, the resulting 300c and 500a fields in the MARC record would be as in Figure D-25 (once the record was saved).

```plaintext
300:--:|c<size.code>.
500:--:|a<size.other>
```

Figure D-24. Sample [Size] stanza

```
[size]
Type=combobox
Caption=Size
Width=Narrow
SameLine=T

Code=21.6 X 27.94 cm.
Display=Letter size newsletter
Equivalent=8.5 X 11 in.
Other=Print copies of department newsletters avail. in dept. office.

Code=21.6 X 35.56 cm.
Display=Newspaper
Equivalent=8.5 X 14 in.
Other=Print copies of school newspapers avail. in stacks.
```
Figure D-25. Sample 300c and 500a created from Size combination box

For more information about combination boxes, see Combination Boxes on page D-21.

[BibMarcMapping] stanza elements

The following is an example of a [BibMarcMapping] stanza contained within a template definition file for editing serials. It outlines 10 MARC fields which contains operator-modifiable information, including the system control number field or accession number field (035), which must be further detailed in another stanza in the template entitled, [accessionno]. Likewise, the MARC field for cataloging source or creator (040), must be further detailed in a separate stanza entitled, [creator]. The last component contained in the angle bracket, .text, indicates that the component is a text box (as opposed to combination box) in which the operator can input free text data.
Leader Elements

Elements of the Leader (designated in template configuration files as 000) can be mapped by creating a variable that consists of the field name, followed by a forward slash, followed by the byte position, followed by an equals sign, and then the object to be used to edit that particular element. Only byte positions 06, 07, 08, 17, 18, and 19 can be edited. Do not attempt to specify other byte positions in the leader. Remember that byte positions start with a 0.

The following example of leader field 17 indicates that the encoding level element (000/17), takes its value from the code control property of the combination box created by the [enclvl] stanza.

000/17=<enclvl.code>
006 and 007 Fields

Parts of one or more of these fields can be mapped to controls in the template by creating a variable consisting of the field name, followed by an equals sign, and the values and object names for the entire field. A vertical bar is used to represent MARC21 fill characters, and an underscore is used to represent byte positions to be left blank. One 006 or 007 is created for each line.

**TIP:**
If you are creating a template for multiple material forms (like video tapes, music and books) or for material forms which have more than one possible specification (like music), make sure that a control (template user input) rather than a fixed value is being specified for the first byte position (byte position zero). If your template is for one material form which only has one possible specification, put the 00 character positions of the 006 and 007 in the [BibInitialization] stanza.

The following is an example of a MARC 007 field in the [BibMarcMapping] stanza, indicating the position eleven (generation code) of the 007 field takes its value from a combination box called generat.

```
007=hd|afb___ba<generat.code>a
```

008 Field

Elements in the 008 field can be mapped to controls in the template by creating variables consisting of the field name, followed by a forward slash, followed by the byte position, and optionally by a dash and the byte range. Single bytes use only the byte position, while multiple byte definitions are defined by specifying the first byte position, then a dash, and the end byte position. The variable is followed by the equals sign, and the name and property of the object that provides the data for these byte positions.

The following is an example of the 008 field in the [BibMarcMapping] stanza which indicates that the country of publication code (008/15-17), takes its value from the Code control property of the combination box called country.

```
008/15-17=<country.code>
```

Other Variable Fields

For each variable field or part of each variable field available for user modification, it is necessary to supply the field name, followed by a colon, both indicators (fixed values, spaces, or objects), another colon, the subfield indicator (vertical bar with subfield character), and the contents of that subfield (may be fixed). You may
specify as many subfields on a line as you wish, but the definition of each variable field must all be on one line. As with the 006 and 007 fields, one field is created in the record for each variable field in the [BibMarcMapping] stanza.

Figure D-27 shows an example of MARC variable fields in [BibMarcMapping], indicating that the contents of the title (245a) field should be set from the text box called, title. The note (500a) field indicates that the contents of the field should be set from a text box called, note.

| 245: :|a<title.text> |
| 500: :|a<note.text> |

Figure D-27. Sample 245 and 500 field template specifications in the [BibMarcMapping] stanza

**IMPORTANT:**

For each control property specified in the [BibMarcMapping] stanza, a corresponding control property value line must exist in each control group for the combination box stanza being referred to. For example, if you configure the template to enter the <agency.other> value into a MARC field, you must have an Other= line with information in it for each control property group in the [Agency] stanza. If you do not provide a property value for the control selected by the template operator in the drop-down box, nothing will be placed into that field (or subfield) in the record.

In setting up a combination box using content from either a MARC configuration file (tag table file), or content listed in the combination box itself, the optional elements in Table D-4 can be set.

<table>
<thead>
<tr>
<th>Table D-4. Combination box optional elements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
</tr>
<tr>
<td>NoValue</td>
</tr>
</tbody>
</table>
Figure D-28 shows part of a [BibMarcMapping] stanza that defines from where data for the MARC 521 field will be pulled. In this case, data is pulled from a combination box entitled, audience. The value it pulls from that combination box comes from the Code control property value corresponding to the Display item selected from the drop-down box.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DefaultCode</td>
<td>Sets the initial value of the combination box for new or existing bibliographic records that do not have data set for that field or subfield. If this is not set, then the combination box will display the first available value upon opening a new record, or the existing value upon opening an existing record.</td>
</tr>
<tr>
<td>DefaultValue</td>
<td>Similar to DefaultCode, except that a value and not a code is offered. Either DefaultCode or DefaultValue can be set at one time. If DefaultCode is set, then DefaultValue will not be read.</td>
</tr>
</tbody>
</table>

Figure D-28. Sample line in the [BibMarcMapping] stanza

The instruction in Figure D-28 must be followed further down in the template definition file by the stanza in Figure D-29 (outlining a combination box definition for possible destinations for a new serial).
The definition in Figure D-29 produces the display in Figure D-30.

The definition in Figure D-29 produces the display in Figure D-30.

Figure D-29. Sample Combination Box Definition

The definition in Figure D-29 produces the display in Figure D-30.

Figure D-30. Sample Combination Box Display

Use the following to put Figures D-28 through D-30 into a sample workflow.

1. The template operator selects the Children item from the drop-down list in the Intended Audience combination box (see Figure D-30).

   Based on the [BibMarcMapping] line in Figure D-28, the template is configured to place the Code value from of the selected item in the Intended Audience box into the 521a, so:

2. The template locates the set of controls, in the [audience] stanza, which include the Display control value of Children (see Figure D-29), and pulls the Code control value (Children’s book) from that set of controls.
3. Once the record is saved, this **Code** control value is placed into the 521a of the record.

If you change the control property specified in **Figure D-28** to `<audience.equivalent>`, the appropriate value for the **Equivalent** control property is placed into the 521a (in this case **Ages 6-10**).

Example of Converting Operator Entered Information to MARC Records

**Figure D-31** shows an example of a new record template as seen by the template operator in The Voyager Cataloging module. It consists of a number of text boxes and drop-down boxes. For the purposes of this illustration, we consider one text box (the **Source** text box), and one drop-down box (the **Size** drop-down box).
The properties of the Source text box in this example are governed by the control specification stanza in Figure D-32.
The specific variables in this stanza are discussed in [BibMarcMapping] Stanza Using Text Boxes on page D-44. This stanza determines how the text box appears to the template operator (in the Voyager Cataloging module).

How the information entered into the text box by the operator gets placed into the MARC fields of the record being created using this template is determined by the [BibMarcMapping] stanza. This is where you establish what information to pull from which boxes and how the information gets placed into the MARC fields of the record.

For example, if you want the information entered into the Source text box to get placed into the 773t in the resulting record, you might enter a line in the [BibMarcMapping] stanza as in Figure D-33.

```
773:0#:|t<source.text>
```

**Figure D-32. Sample control specification stanza**

For each MARC field, it is necessary to supply the field number, followed by a colon, both indicators (fixed values, spaces, or objects), another colon, the subfield indicator (vertical bar with subfield character), and the control specification for that field/subfield. The control specification uses the following format:

```
<controlname.controlproperty>
```

The `controlname` in Figure D-33 is `source`, so Voyager uses the information entered into the box created by the [Source] stanza.

The `controlproperty` in Figure D-33 is `text`, which means that the information from the text box (created by the Source stanza) is placed into the MARC field as the text entered by the operator.
If the template operator entered text into the **Source** box as in *Figure D-34*, the resulting field (773t) in the MARC record would be as in *Figure D-35* (once the record was saved).

---

**Figure D-34.  Sample Source box text**

<table>
<thead>
<tr>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Philosophy Department Newsletter, March issue</td>
</tr>
</tbody>
</table>

---

**Figure D-35.  Sample 773t created from Source box text**

| 773 0# | t Philosophy Department Newsletter, March issue |

---

**Sample Combination Box**

The properties of the **Size** combination box in this example are governed by the control specification stanza in *Figure D-36*. 
The specific variables in this stanza are discussed in Combination Boxes on page D-21. This stanza determines how the combination box appears to the template operator (in The Voyager Cataloging module). Since this stanza is for a combination box, it is also where you enter the values for each individual control property.

The possible control properties for combination boxes are Code, Display, Equivalent, and Other. The control properties are essentially variables, the values of which you set in the control specification stanzas. Display is the control property value the operator sees in the combination boxes (Figure D-37 shows the Display control property values in the Size combination box created by the control specification stanza in Figure D-36.

<table>
<thead>
<tr>
<th>Line#</th>
<th>Line Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>[size]</td>
</tr>
<tr>
<td>2</td>
<td>Type=combobox</td>
</tr>
<tr>
<td>3</td>
<td>Caption=Size</td>
</tr>
<tr>
<td>4</td>
<td>Width=Narrow</td>
</tr>
<tr>
<td>5</td>
<td>SameLine=T</td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Code=21.6 X 27.94 cm.</td>
</tr>
<tr>
<td>8</td>
<td>Display=Letter size newsletter</td>
</tr>
<tr>
<td>9</td>
<td>Equivalent=8.5 X 11 in.</td>
</tr>
<tr>
<td>10</td>
<td>Other=Print copies of department newsletters avail. in dept. office.</td>
</tr>
<tr>
<td>11</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Code=21.6 X 35.56 cm.</td>
</tr>
<tr>
<td>13</td>
<td>Display=Newspaper</td>
</tr>
<tr>
<td>14</td>
<td>Equivalent=8.5 X 14 in.</td>
</tr>
<tr>
<td>15</td>
<td>Other=Print copies of school newspapers avail. in stacks.</td>
</tr>
</tbody>
</table>

Figure D-36. Sample control specification stanza
Each item available for selection in drop-down boxes is created by the Display control property values in each control stanza.

In the sample control specification stanza in Figure D-36 on page D-40, the two control property stanzas (lines 7 through 10 and lines 12 through 15) are shown in Figure D-38.

Figure D-38.  Control stanzas

Again, think of the three other control properties (Code, Equivalent, and Other as variables, the values of which you enter for placement into the MARC fields of your records according to the [BibMarcMapping] stanza. In this example, the Code property is used for the size measurements of the material in centimeters, the Equivalent property for the measurements in inches, and the Other property for print material availability notes which happen to correspond to the material sizes.
A more detailed explanation of this example (including a corresponding BibMarcMapping sample) can be found in Using Multiple Control Properties in a Single Stanza on page D-42.

Using Multiple Control Properties in a Single Stanza

The example in this section illustrates the use of multiple control properties in a single stanza.

For a school and department news template, if the print material availability corresponds to the size of the newsletters, you can attach the print material availability note to the Size drop down items. Instead of creating a separate stanza and control properties, you can use the .other property in the [size] stanza for the print material availability.

In this example, the template operator sees the display control property values in the Size drop-down box (see Figure D-39 for an illustration, and lines 13 and 18 of Figure D-40 for the Display control values used in the drop-down box).

Figure D-39. Size drop-down values as seen by the template operator

When the operator makes a selection in the drop-down box and saves the record, the template:

1. Pulls the corresponding size.code control property value from the [size] stanza and puts the value into the 300c field of the record.
2. Pulls the corresponding size.other control property value from the [size] stanza and puts the value into the 500a field of the record.
Figure D-40.  Excerpt of sample [BibMarcMapping] stanza

Figure D-41 on page D-44 shows a sample record, illustrating the preceding example. This example shows how the 300c and 500a are populated if the operator selects Letter size newsletter from the Size box (see lines 12 through 15 of Figure D-40 for the control properties used by the template in this example).
Controls that are text boxes have a property name of either .text (default), or .nonfiling, which is only specified for indicators of certain fields (for example, the 245 field). The .nonfiling property tells Voyager to look for nonfiling words in the text entered into the text box, based on the [nonfiling] stanza of the template.ini file.

Figure D-42 shows part of a [BibMarcMapping] stanza which defines from where data for the MARC 245 field is pulled. In this case, data is pulled from a text box entitled, title, and if the text begins with a nonfiling word, the nonfiling word count (including spaces) will be entered into the second indicator of the 245 field.

```
245:1<title.nonfiling>:|a<title.text>
```
The above instruction must be followed by (further down in the template definition file), the following stanza (outlining a text box definition for the title field of a new book record).

```
[title]
Type=TextBox
Caption=Title:
Width=wide
Scroll=0
Lines=2
```

**Figure D-43. Sample [title] stanza**

The definition in Figure D-43 produces the display in Figure D-44.

**Figure D-44. Sample Text Box Display**

Figure D-45 shows a sample title in the Title text box of a template. Figure D-47 shows the title, as entered into the record by Voyager, based on the 245 [BibMarcMapping] stanza specification in Figure D-46. Notice that the second indicator of the 245 in the record sample in Figure D-47 contains the “4” indicating the number of non-filing characters in the title (The ).

**Figure D-45. Sample title in the Title text box**
Figure D-46. Sample 245 [BibMarcMapping] specification

```
245:1<title.nonfiling>::|a<title.text>
```

Figure D-47. Sample title as it appears in the record

The following is the part of a [BibMarcMapping] stanza that defines from where data for the MARC 520 field is pulled. In this case, data is pulled from a text box entitled, abstract.

```
520:3_:|a<abstract.text>
```

This instruction must be followed by the stanza in Figure D-48 (outlining a scrolled text box definition for the abstract field of a new book record) in the order that you want it to display in the template (in relation to the other box specification stanzas).

```
[abstract]
Type=TextBox
Caption=Abstract:
Width=wide
Scroll=1
Lines=5
```

Figure D-48. Sample [abstract] stanza

The definition in Figure D-48 will produce the display in Figure D-49.
Figure D-49. Sample Text Box Display with Scroll
Index

Symbols

! (exclamation point), 3-29
% (percent sign), 3-29
* (asterisk), 3-29
+ (plus sign), 3-29
? (question mark), 3-29

Numerics

006 field, 2-6–2-9
  in [Bibinitialization] stanza, D-15
  in [BibMarcMapping] stanza, D-32
007 control field
  position 01, 3-86
007 field
  bibliographic, 2-9–2-11
  holdings, 2-42
  in [Bibinitialization] stanza, D-15
  in [BibMarcMapping] stanza, D-32
008 control field
  position 06, 3-89
  position 07-10, 3-86
  position 15-17, 3-88
  position 35-37, 3-85
008 field
  authority, 2-32–2-33
  bibliographic, 2-12–2-14
  holdings, 2-45–2-47
  in [Bibinitialization] stanza, D-15
  in [BibMarcMapping] stanza, D-32
010 field, 2-18
505 field, 2-25
856 field, 4-3

A

about this document, xxxvii

accessing search history, 3-68
Acq in the Cat, 2-29, 3-111
setup, 3-112
Acquisitions in Cataloging, 2-29
action codes, 4-25
Adding an 856 field, 4-3
asterisk (*), 3-29
audience
of this document, xxxvii
Auth/Ref additional references, 3-53
Authority button, 3-55, 3-104
Authority control, 9-1–9-2
Authority Control Validation, 10-6
Authority records
  008 field, 2-32–2-33
  colors of, 10-16
  description, 2-29
  History tab, 2-38
  leader, 2-30–2-31
  MARC tab, 2-30
  retrieving, 3-119
  Select one or more authority records dialog box, 3-59
  System tab, 2-36
  variable fields, 2-34–2-35
authority records
  hypertext links, 2-35
Authorized additional references, 3-53, 3-56
Available Locations section
  Voyager Connection Options dialog box, 3-71

B

batch file processing (Pick and Scan), 7-1, 7-11
Bib De-Duping, 4-14
Bib field
  Session Defaults and Preferences, Cataloging module, 5-22
Bib heading validation, 4-17
[Bibinitialization] stanza, D-9, D-14
bibliographic record
  merge, 4-5
  overlay, 4-5
Bibliographic Record Linking
  profile, 5-2
bibliographic record search
  builder search, 3-65
Bibliographic records
006 field, 2-6-2-9
007 field, 2-9-2-11
008 field, 2-12-2-14
505 field, 2-25
colors of, 10-16
creating
description, 2-3-2-4, 2-26
from Image Server, 3-23
history tab, 2-27
leader, 2-4-2-6
linking to other records, 3-123, 3-124, 3-126
MARC tab, 2-4
suppress from OPAC, 2-27, 2-57
System tab, 2-25
unlinking from holdings, 3-125
variable fields, 2-14-2-25
verify hypertext links, 2-23
bibliographic records
hypertext links, 2-23
link-capable fields/subfields, 2-20
retrieval shortcut, 3-121
[BibMarcMapping] stanza, D-9, D-28

Bibs column
Headings List, 3-55
Boolean button, 3-40
Boolean keyword search, 3-96
Boolean operators, 3-39
Boolean radio button, 3-28
bound with, 2-58, 3-9, 3-10, 3-123, 3-125, 10-18
bracket, left (opening) angle
element in derivation field, 5-9
bracket, right (opening) angle
element in derivation field, 5-10
Browse Headings List dialog box, 3-37
Browse radio button, 3-33
browse search, 3-36, 3-64
builder search
deleting search terms, 3-41
editing search terms, 3-41
builder searching, 3-39, 3-65
Cataloging, 3-107
Builder tab, 3-39, 3-65
button
Authority, 3-55, 3-104
Boolean, 3-40
Connect, 3-72
Default Tab, 3-30, 3-34, 3-41
Headings List, 3-54
Limit, 3-30, 3-35, 3-42, 3-89
Remote, 3-30, 3-35, 3-42, 3-69, 3-71

Save Settings, 3-41
Show Results, 3-75
Status, 3-76
Stop, 3-45, 3-51, 3-54
Stop Search, 3-75
Titles Index, 3-44

C

call number searching, 3-37
Caption element, D-20
Cat in the Acq, 2-29, 3-111
Catalog folder, 5-21, 5-24
Cataloging
builder searching, 3-107
keyword searching, 3-96
non-keyword searching, 3-103
searching examples, 3-96
Cataloging in Acquisitions, 3-111
Cataloging module
record
maintaining, 5-1
searching for, 5-1
Related Records
displaying, 5-1-5-5
Related Records menu, 5-1
example, 5-3
Session Defaults and Preferences, 5-18-5-25
defining a default folder, 5-23-5-25
defining a default template, 5-19-5-23
Folders/Files tab, 5-18-5-25
template, 5-5-5-8
creating, 5-5-5-6
defining a default, 5-19-5-23
deleting, 5-8
editing, 5-6-5-7
saving Related Records, 5-17
using to create new record, 5-25-5-27
using to create Related Records, 5-8-5-18
check box
Retain search Limits between searches, 3-91
Closing
Cataloging, 1-5
records, 4-36
Code control property, D-25
Code element, D-26
Colors of records, 10-16
command line search, 3-30
command searching, 3-30
comments
about this document, xli
configuration file
Special Characters.cfg, 6-7
Connect button, 3-72
Connection column
Voyager Connection Options dialog box, 3-71
control name, D-29, D-38
control property, D-29, D-38
Code, D-25
Equivalent, D-25
Other, D-25
conventions used
in this document, xxxix
Copy button, 4-17
Copying a record, 4-19
Creating
bibliographic record
from Image Server, 3-23
records, 3-1–3-5, 3-7
templates, 8-2
derivation field, 5-9–5-17
element
bracket, left (opening) angle, 5-9
bracket, right (opening) angle, 5-10
delimiter symbol, 5-9
subfield, 5-9
tag, 5-9
example, 5-12–5-16
format, 5-9
multiple subfields, 5-12
non-matching subfield, 5-12
reading, 5-11
rule, 5-12–5-16
diacritic characters
entering, 6-2
diacritic mode, 6-3
diacritics, 6-1, 6-3
dialog box
Browse Headings List, 3-37
Headings List, 3-52, 3-65, 3-67, 3-75, 3-103
Holdings Index, 3-50, 3-62, 3-96, 3-101
Reference Information, 3-56, 3-57, 3-104
Remote Search, 3-72
Search, 3-26, 3-27, 3-39
Search Limits, 3-64, 3-67, 3-68, 3-80, 3-89
Search Status, 3-75
Select Bibliographic Template, 5-21, 5-22, 5-27
Select Directory, 5-24
Select one or more authority records, 3-59
Session Defaults and Preferences, 3-78, 5-18, 5-19, 5-23
Simultaneous Search, 3-73
Titles Index, 3-43, 3-44, 3-61, 3-64, 3-67, 3-75, 3-96, 3-97, 3-99, 3-103, 3-106, 3-108
Voyager Connection Options, 3-70, 3-71
Display Bibliographic Record Directly If Search Results In Only One Title, 3-79
Display element, D-22, D-26
Display menu, 10-21, 10-27
document summary, xxxviii
DOI, 2-20
DOI and URN link examples, 2-23
Duplicate Barcode, 2-61
Duplicate Checking, 4-14
dynamic noise word reduction, 3-31
E

Edit menu, 10-23
[Edit Templates] stanza, D-7
Editing
  records, 4-1–4-2
  templates, 8-4
editing
  search terms in builder search, 3-41
element
  Caption, D-20
  Code, D-26
  DefaultCode, D-34
  DefaultValue, D-27, D-34
  derivation field
    bracket, left (opening) angle, 5-9
    bracket, right (opening) angle, 5-10
    delimiter symbol, 5-9
    subfield, 5-9
    tag, 5-9
  Display, D-22, D-26
  Equivalent, D-26
  Lines, D-27
  NoValue, D-33
  Other, D-26
  SameLine, D-21
  Scroll, D-28
  Source, D-21
  Type, D-20
  Width, D-20
Equivalent control property, D-25
Equivalent element, D-26
example
  for derivation field, 5-12–5-16
  exclamation point (!), 3-29
Exiting, 1-5

F

feedback, customer, xli
field
  007 control
    position 01, 3-86
  008 control
    position 06, 3-89
    position 07-10, 3-86
    position 15-17, 3-88
    position 35-37, 3-85
authority
  008, 2-32
  variable, 2-34
Bib, 5-22
bibliographic
  005, 2-6
  006, 2-6
  007, 2-9
  008, 2-12
  880, 2-14
  variable, 2-14
holdings
  007, 2-42
  008, 2-45
  variable, 2-47
Leader control
  position 06, 3-87
  position 07, 3-87
Search For, 3-29, 3-34
Search for, 3-40
Search In, 3-40
search type drop-down, 3-33
Template, 5-24
field codes, 4-28
file
  initialization
    template.ini, D-5
  initialization
    limits.ini, 3-81
    Voyager.ini, 3-47
File menu, 10-20, 10-22
files on a server examples, 2-22
Find radio button, 3-33
find search, 3-36, 3-64
folder
  Catalog, 5-21, 5-24
  default
    using to create new record, 5-26
    defining a default, 5-23–5-25
    MARCTemplate, 5-21, 5-24
    Tag Tables, 5-21, 5-24
    Template, 5-21, 5-24
Folders section
  Folders/Files tab, Cataloging module, 5-23
  Template field, 5-24, 5-26
Folders/Files tab, 5-18–5-25
  defining a default folder, 5-23–5-25
  defining a default template, 5-19–5-23
  Folders section, 5-23
Index

Template field, 5-24, 5-26
Templates section, 5-21
bib field, 5-22
Font
bold, 10-19
size, 10-19
Free text keyword search, 3-96, 3-99
Free Text radio button, 3-28

G

[General] stanza, D-9, D-13
get call number from bib record, 2-48
Getting Started, 1-1
prerequisite skills and knowledge, 1-1
global headings change, 9-6
batch job, 9-16

H

Heading column
Headings List, 3-55
Heading Type column
Headings List, 3-55
Heading Types Filter, 3-34, 3-64
Headings Index, 4-17
Headings List
Bibs column, 3-55
Heading column, 3-55
Heading Type column, 3-55
Headings List button, 3-54
Headings List dialog box, 3-52, 3-65, 3-67, 3-75, 3-103
headings search
results, 3-55
headings searching, 3-32, 3-63, 3-103
Help menu, 10-21, 10-29
History tab, 3-42, 3-68
authority record, 2-38
sorting, 2-39
bibliographic record, 2-27
sorting, 2-28
holdings record, 2-58
sorting, 2-59

holding records
hypertext links, 2-54
hypertext links - authority records, 2-35
hypertext links - bibliographic records, 2-23
hypertext links - holdings records, 2-54

I

Image Server
creating bibliographic record, 3-23
Image Server link examples, 2-22
Importing records, 3-10–3-14
index selection
searching, 3-32, 3-63
Index Selection tab, 3-32
index selection tab, 3-63
Information about... section
Voyager Connection Options dialog box, 3-71

Holdings Boolean keyword search, 3-96, 3-101
Holdings Boolean radio button, 3-28
Holdings boolean search results, 3-50, 3-51
Holdings Index
Holdings Record column, 3-51
Holdings Index dialog box, 3-50, 3-62, 3-96, 3-101
holdings keyword definition
SPAC, 3-94
Holdings Record column
Holdings Index, 3-51
Holdings records
007 field, 2-42
008 field, 2-45–2-47
colors of, 10-16
create, 3-5
description, 2-39
get call number from bib record, 2-48
History tab, 2-58
leader, 2-40–2-42
linking to other records, 3-123, 3-124, 3-126
locations, 3-122
MARC tab, 2-40
retrieving, 3-117–3-118
suppress from OPAC, 2-40
System tab, 2-55
unlinking from bibs, 3-125
variable field, 2-47
Verify Hypertext links, 2-23

Holdings records
hypertext links, 2-54
hypertext links - authority records, 2-35
hypertext links - bibliographic records, 2-23
hypertext links - holdings records, 2-54

IN-5
initialization file
limits.ini, 3-81
template.ini, D-5

Insert URL from Browser, 4-3

intended audience
of this document, xxxvii

Invalid records, 3-22
ISBN validation, 4-12, 10-7, 10-26
ISSN validation, 4-12, 10-7, 10-26

Item menu, 10-27

Item records
create, 3-7
description, 2-60
linking to other records, 3-123, 3-124, 3-126
resequencing, 3-121
retrieving, 3-120
statistical categories, 2-69–2-70
statuses, 2-64–2-67

J

journal index searching, 3-40

K

keyword search
Boolean, 3-96
Free text, 3-96, 3-99
Holdings Boolean, 3-96, 3-101
results, 3-43, 3-45
keyword searching, 3-27, 3-60
Cataloging, 3-96
Keyword tab, 3-27, 3-60

L

Labels, spine and piece, 4-20
language search limit, 3-79, 3-82
[Language] stanza, 3-84
Leader
authority, 2-30–2-31
bibliographic, 2-4–2-6
holdings, 2-40–2-42
Leader control field
position 06, 3-87
position 07, 3-87
left-anchored search results, 3-45
left-anchored searching, 3-32, 3-63, 3-103, 3-106
Limit button, 3-30, 3-35, 3-42, 3-89
limiting your search, 3-79
not allowed, 3-79
[Limits] stanza, 3-82
limits.ini file, 3-80, 3-81
Lines element, D-27
link text, 2-20
link text examples, 2-22
link-capable fields/subfields, 2-20
Linking records, 3-123, 3-124, 3-126
unlinking holdings from bibs, 3-125
links
DOI and URN link examples, 2-23
files on a server, 2-22
Image Server, 2-22
link text examples, 2-22
overview, 2-20
table of contents, 2-25
thumbnail images, 2-25
URL examples, 2-21
location search limit, 3-79, 3-82
Locations
holdings, 3-122
Locations Filter, 3-64
Locations Filter List, 3-34
Logging in, 1-4

M

MARC fields
in [BibInitialization] stanza, D-16
in [BibMarcMapping] stanza, D-32
MARC leader field, D-14, D-31
MARC Record Derivation
derivation field, 5-9–5-17
derivation field example, 5-12–5-16
format, 5-9
multiple subfields, 5-12
non-matching subfield, 5-12
reading, 5-12
rule, 5-12–5-16
explanation, 5-8–5-9
overview, 5-8–5-12
using cataloging template, 5-8–5-18
example, 5-16–5-17
saving record, 5-17
MARC standards, 3-84
MARC tab, 2-4, 3-98, 3-100, 3-102, 3-107, 3-109
authority record, 2-30
holdings record, 2-40
MARC tag tables, A-1–A-23
MARC validation, 10-5
MARCTemplate directory, D-5
MARCTemplate folder, 5-21, 5-24
mass changes (Pick and Scan), 7-1
medium search limit, 3-79, 3-82
[Medium] stanza, 3-86
Menus
description of, 10-19
Display, 10-21, 10-27
Edit, 10-23
File, 10-20, 10-22
Help, 10-21, 10-29
Item, 10-27
Options, 10-21, 10-28
Related Records, 10-26
Window, 10-28
merge bibliographic records, 4-5
MFHD keyword index searching, 3-40
MFHD-Bibliographic Combined Keyword Search, 3-92

N
narrower term, 3-58
[New Template] stanza, D-7
NOISEWORDFILTER, 3-31
[NonFiling] stanza, D-8
non-keyword searching
Cataloging, 3-103
Note additional references, 3-53, 3-56
NoValue element, D-33

O
On-line shelf list, 3-34
OPAC
Table of Contents in, 2-25
Verify Hypertext links, 2-23
OPAC headings search, 3-33
OPAC, suppress from
bibliographic records, 2-27, 2-57
holdings records, 2-40
Opening
records, 3-8–3-9
option
authority
OK to export, 2-37
bibliographic
OK to export, 2-26
Suppress from OPAC, 2-27
holdings
OK to export, 2-56
Suppress from OPAC, 2-57
Options, 10-1
Options menu, 10-21, 10-28
Other control property, D-25
Other element, D-26
overlay bibliographic records, 4-5
Overlaying and merging bibliographic records, 4-7
source record, 4-5
target record, 4-5
owning library, 4-4

P
Passwords, 1-4
percent sign (%), 3-29
photocopying
documentation, xi
Pick and Scan, 7-1
holding location, 7-1
item status, 7-1
media type, 7-1
permanent location, 7-1
permanent type, 7-1
statistical categories, 7-1
suppress from OPAC, 7-1, 7-6
temporary location, 7-1
temporary type, 7-1
Unsuppressed, 7-6
Piece labels, 4-20
place of publication search limit, 3-79, 3-82
[Place] stanza, 3-87
plus sign (+), 3-29
Preferences
cataloging options, 10-1
Colors/Fonts tab, 10-16
Folders/Files tab, 10-13
General tab, 10-2
Item Defaults tab, 10-11
Mapping tab, 10-15
Validation tab, 10-4
Work Flow tab, 10-9
Print Template stanza
action codes, 4-25
changing font size, 4-27
initiating and ending action codes, 4-26
inserting a blank line, 4-27
inserting a tab, 4-28
printing field information, 4-26
printing in the alternate font, 4-26
Printing
action codes, 4-25
alternate font, 4-26
field codes, 4-28
labels, 4-20
records, 4-19
spinelabel.cfg, 4-23
templates, 4-23, 4-30
publication status search limit, 3-79, 3-82
purpose
of this document, xxxvii

Q
question mark (?), 3-29
quick sort, 3-46
Quitting, 1-5

R
radio button
Boolean, 3-28
Browse, 3-33
Find, 3-33
Free Text, 3-28
Holdings Boolean, 3-28
Record
authority, 2-29–2-35
bibliographic, 2-3–2-25, 4-2
closing, 4-36
colors of, 10-16
copying, 4-19
creating, 3-1–3-5, 3-7
deleting, 4-2–4-3
description of, 2-1
description of
editing, 4-1–4-2
holdings, 2-39
importing, 3-10–3-14
invalid, 3-22
item, 2-60
linking, 3-123
opening, 3-8–3-9
printing, 4-19
retrieving
authority, 3-119
holdings, 3-117–3-118
item, 3-120
saving, 4-9
templates, 8-1–8-5, 10-14
types, 2-2
unlinking, 3-123
validate heading, 4-17
validation, 9-1–9-2
record
creating with a default template, 5-25
creating with template, 5-25–5-27
Record menu
Overlaying Bibliographic Records, 4-8
record type
creating template, 5-6
Ref/Note additional references, 3-56
Reference additional references, 3-53, 3-56
Reference Information dialog box, 3-56, 3-57, 3-104
reissue
reason for, xxxvii
Related Record
source record, 5-2
Related Records
Cataloging module
saving, 5-17
Related Records menu, 10-26
Cataloging module, 5-1
element, 5-3
Index

Relevance column
  Titles Index, 3-45
Remote button, 3-30, 3-35, 3-42, 3-69, 3-71
remote databases
  searching, 3-71
Remote Search dialog box, 3-72
remote searching, 3-69
reproduction, of documentation, xl
Resequencing items, 3-121
re-sort, 3-46
re-sort configuration, 3-47
results
  headings search, 3-55
  holdings boolean search, 3-50, 3-51
  keyword search, 3-43, 3-45
  left-anchored search, 3-45
Retain Last Search, 3-78
Retain search limits between searches check box, 3-91
retrieving
  search limits between searches, 3-81
Retrieve bibliographic records
  shortcut, 3-121
Retrieving
  authority, 3-119
  holdings, 3-117–3-118
  item, 3-120
rule
  for derivation field, 5-12–5-16

S

SameLine element, D-21
Save Settings button, 3-41
Saving
  records, 4-9
  to database, 4-11
saving
  Related Records, 5-17
Scroll element, D-28
search
  holdings boolean results, 3-50
  keyword results, 3-43
  OPAC headings, 3-33
  staff headings, 3-33
Search dialog box, 3-26, 3-39
  Builder tab, 3-39
  Index Selection tab, 3-32
  Keyword tab, 3-27
Search for, 3-40
Search For field, 3-29, 3-34
Search In, 3-40
search limit
  date, 3-79, 3-82
  language, 3-79, 3-82
  Limit Type column, 3-81
  list of limits, 3-81
  location, 3-79, 3-82
  medium, 3-79, 3-82
  place of publication, 3-79, 3-82
  publication status, 3-79, 3-82
  setting, 3-89
  type, 3-79, 3-82
  Value, 3-81
search limits
  stanza, 3-83
Search Limits dialog box, 3-64, 3-67, 3-68, 3-80, 3-89
search preferences
  setting, 3-78
Search Result Colors, 10-18
search results
  headings searches by call number, 3-37
  headings/index selection, 3-32, 3-63
  headings/non-keyword, 3-103
  history tab, 3-43
  journal index, 3-40
  keyword, 3-27, 3-60
  left-anchored, 3-63, 3-103, 3-106
  limits, 3-43, 3-79
MFHD keyword index, 3-40
remote databases, 3-69, 3-71
retain last search, 3-78
unable to limit, 3-79
URI option, 3-30, 3-35, 3-42, 3-77
with relevance, 3-28
without relevance, 3-28
[SearchURI] stanza, 3-78
Security
logging in, 1-4
see also, 3-58
Select Bibliographic Template
dialog box, 5-21, 5-22, 5-27
Select Directory
dialog box, 5-24
Select one or more authority records dialog box, 3-59
Selected Locations section
Voyager Connection Options dialog box, 3-71
Session Defaults and Preferences
Cataloging module, 5-18–5-25
Folders/Files tab, 5-18–5-25
Cataloging Options, 10-1
Colors/Fonts tab, 10-16
dialog box, 5-18, 5-19, 5-23
Folders/Files tab, 10-13
General tab, 10-2
Item Defaults tab, 10-11
Mapping tab, 10-15
Validation tab, 10-4
Work Flow tab, 10-9
Session Defaults and Preferences dialog box, 3-78
setting
search limits, 3-89
search preferences, 3-78
Show Results button, 3-75
Simultaneous Search dialog box, 3-73
sort by, 3-46
sorting
History tab
authority, 2-39
bibliographic, 2-28
holdings, 2-59
Source element, D-21
source record, 4-5
Related Record, 5-2
SPAC, 3-94
Special Character Entry, 6-1
Special Character Mode, 6-3
Special Character Mode mapping, 6-3
Special Characters.cfg, 6-7
Spine Label Print Template, 4-23
Spine labels, 4-20
spinelabel.cfg, 4-23
staff headings search, 3-33
stanza
[Print Options ...], 4-23
[Print Options Bibliographic], 4-23
[Print Template Piece ...], 4-24
[Print Template Piece Bibliographic], 4-23
[Print Template Spine ...], 4-24
[Print Template Spine Bibliographic], 4-23
[Templates], 4-23
[Bibinitialization], D-9, D-14
[BibMarcMapping], D-9, D-28
[Date], 3-85
[Edit Templates], D-7
[General], D-9, D-13
[Language], 3-84
[Limits], 3-82
[Medium], 3-86
[New Template], D-7
[NonFiling], D-8
[Place], 3-87
search limits, 3-83
[SearchURI], 3-78
[Status], 3-88
[Type], 3-87
Voyager.ini [Global Log], 3-47
Statistical categories for items, 2-69–2-70
status (publication) search limit, 3-79, 3-82
Status button, 3-76
[Status] stanza, 3-88
Statuses for items, 2-64–2-67
Stop button, 3-45, 3-51, 3-54
Stop Search button, 3-75
subfield
element in derivation field, 5-9
multiple
in derivation field, 5-12
non-matching
in derivation field, 5-12
System tab
authority record, 2-36
bibliographic record, 2-25
holdings record, 2-55

T

tab
Index

Builder, 3-39, 3-65
History, 3-42, 3-68
Index Selection, 3-32
index selection, 3-63
Keyword, 3-27, 3-60
MARC, 3-98, 3-100, 3-102, 3-107, 3-109
table of contents links, 2-25
tag
element in derivation field, 5-9
Tag Tables folder, 5-21, 5-24
Tag tables, MARC, A-1–A-23
target record, 4-5
template, 5-5–5-8
creating, 5-5–5-6
default
authority, 5-5, 5-21, 5-24
bibliographic, 5-5, 5-21, 5-24
defining, 5-19–5-23
holdings, 5-5, 5-21, 5-24
using to create new record, 5-25
deleting, 5-8
editing, 5-6–5-7
Related Records
creating, 5-8–5-18
derivation field, 5-9–5-17
example, 5-16–5-17
explanation, 5-8–5-9
overview, 5-8–5-12
saving, 5-17
using to create new record, 5-25–5-27
template configuration files
in Templated Input, D-5, D-8
Template field, 5-26
Session Defaults and Preferences, Cataloging module, 5-24
Template folder, 5-21, 5-24
Template, Spine Label Printing, 4-23
template.ini file, D-5
Templated Input
combination box, D-20, D-21
creating records with, D-3
ing, D-2
editing records, D-4
logging in, D-2
requirements, D-1
retrieving records, D-4
Select a MARC Template, D-3
setup in Voyager System Administration, D-2
template configuration files, D-5, D-8
text box, D-20, D-27
user IDs, D-1
using multiple control properties in single stanza, D-42

Templates
creating, 8-2
default, 10-14
deleting, 8-5
description of, 8-1
ing, 8-4
Templates section
Folders/Files tab
Cataloging module, 5-21
Folders/Files tab, Cataloging module
bib field, 5-22
thumbnails, 2-22
Titles Index
Relevance column, 3-45
sort by, 3-46
Titles Index button, 3-44
Titles Index dialog box, 3-43, 3-44, 3-61, 3-64, 3-67, 3-75, 3-96, 3-97, 3-99, 3-103, 3-106, 3-108
truncation
searching, 3-79
Type column
Voyager Connection Options dialog box, 3-71
Type element, D-20
type search limit, 3-79, 3-82
[Type] stanza, 3-87

Unicode
BulkImport, C-8
cataloging templates, C-9
database conversion, C-4
diacritics, 6-1, C-3
font options, C-1
Leader position 9, C-2
MARC21 compliance considerations, C-3
message logs (database conversion), C-5
nc in the Title Bar, C-4
non-converted records, C-4
overview, C-1
Special Character Entry, 6-1
subfield character, C-9
Unicode character set, 3-45, 3-51, 3-55
Uniform Resource Identifier (URI), 3-30, 3-35, 3-42,
Unlinking records, 3-125
Update, 4-10
update record alert, 4-10
URI, 2-20
URI search option, 3-30, 3-35, 3-42, 3-77, 3-78
URL, 2-20
URL examples, 2-21
URN, 2-20
user-defined alternate search button, 3-77

Validating records, 9-1–9-2
Validation
  Authority Control Validation, 10-6
  ISBN, 4-12, 10-7, 10-26
  ISSN, 4-12, 10-7, 10-26
  MARC, 10-5
  MARC21 Character set validation, 10-6
validation of bib heading, 4-17
Variable fields
  505 field, 2-25
  authority, 2-34–2-35
  bibliographic, 2-14–2-25
  font bold for, 10-19
  font sizes of, 10-19
  holdings, 2-47
Verify Hypertext links, 2-23
view
  holdings locations, 3-122
  line items, 3-111
Voyager Connection Options dialog box, 3-70, 3-71
  Available Locations section, 3-71
  Connection column, 3-71
  Database Name column, 3-71
  Information about... section, 3-71
  Selected Locations section, 3-71
  Type column, 3-71
Voyager.ini
  [Global Log] stanza, 3-47
voyager.ini file
    URI search option, 3-78

Width element, D-20
wildcard characters, 3-29
Window menu, 10-28
Work files, 4-9
work space
  Database Definitions, 3-69